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7

Introduction

TimeWizard version 3.7 offers both new features and enhancements. This guide sup-
plements the TimeWizard Administrator’s Guide to explain the changes in the
Administrator application. Changes in the TimeWizard.enterprise application are
explained in the TimeWizard.enterprise User’s Guide.

In addition to the features described in the following chapters, users will find
TimeWizard.enterprise easier to access and exit.

If you use TimeWizard.enterprise on a corporate intranet, you can allow your
employees to access TimeWizard.enterprise without logging in to the application.
Depending on a property setting, users who log on to the intranet with a valid user
ID are also recognized as valid TimeWizard users. When these intranet users enter
the TimeWizard address in their browsers, their employee home pages will display.
For further information on this property setting, consult the TimeWizard Installation
Guide.

If your employees use Microsoft’s Internet Explorer browser with TimeWizard.enter-
prise, you can activate a safety feature with a TimeWizard property setting. TimeWiz-
ard.enterprise will then prompt employees to save any unsaved changes when they
attempt to leave a timesheet. A warning message will display if they try to exit the
timesheet or select another period, department, or employee before timesheet modi-
fications have been saved. Users can also choose to leave the timesheet if they do not
want to save their changes.
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9

Managing Employees’
Employment Dates

TimeWizard prevents employees from entering time before their employment start
dates and after their termination dates. By setting an active date and inactive date for
an employee, you define the valid range of employment dates.

Any dates occurring before the designated “Active Date” that are in the same period
as the active date will display read-only timesheet cells, which cannot be edited. Sim-
ilarly, any dates occurring after the designated “Inactive Date” that are in the same
period as the inactive date will display read-only timesheet cells. Other periods
before and after the valid employment range do not display, regardless of the prefer-
ence setting for “Periods Past” and “Periods Forward.”

Objective

1. Setting an employee’s active and inactive dates
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Objective 1:  Setting an employee’s active and inactive dates

In addition to defining an employee’s current status as “Active” or “Inactive,” you
can set a specific employee start or “Active Date” and termination or “Inactive Date”
(Figure 2.1). Employees cannot enter time for dates before the active date or after the
inactive date.

When you add a new employee to TimeWizard (Employees > Employee Detail), the
default employee status is “Active” and the Active Date text box displays the current
day’s date. You may edit the active date or change the employee status to “Inactive.”
If you later change the employee’s status from “Inactive” to “Active,” the active date
will automatically change to the current date. For further information on adding a
new employee, refer to Chapter 11, “Working with Employees,” in the version 3.6
TimeWizard Administrator’s Guide.

You can define an active date without entering an inactive date, which may be added
later. Whenever you change an employee’s status to “Inactive,” the inactive date will
automatically change to the current day’s date. You can also edit this date. While the
employee status is “Inactive,” the display for the active date is read-only and cannot
be edited.

Setting an inactive date does not automatically change the employee status from
“Active” to “Inactive” after the specified date. You must change the status to “Inac-
tive” separately. The specified inactive date may be an anticipated date. When an
employee’s status is defined as “Inactive,” the employee and the employee’s depart-
ment owner cannot view any of the employee’s timesheets. 
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Chapter 2 • Managing Employees’ Employment Dates 11

Example If you enter “04/03/01” in the Active Date box, and if the employee’s status is
“Active,” the employee can enter time for April 3, but not for April 2 or earlier dates.
If you enter “06/28/01” in the Inactive Date box, the employee can enter time for
June 28, but not for June 29 or later dates. Even if the employee’s status is “Active”
and the employee’s preference profile allows editing 12 periods forward, neither the
employee or the employee’s manager can add time for June 29 or later.

To set an employee’s active and inactive dates:

1. Click on the Employees icon  or select 
Tools > Employees from the TimeWizard main 
menu to open the Employees window.

2. Click on the employee row and click on the 

Edit Employee icon  (or double-click on 

the employee row) to open the Employee 
Detail dialog box for the selected employee.

3. To set the employee’s active date while the 
employee’s status is Active, enter the date in 
the Active Date text box.

4. To set the employee’s inactive date, enter the 
date in the Inactive Date text box.

5. Click “Apply” to save the settings and remain 
in the dialog box or click “OK” to save the set-
tings and exit the dialog box.

Figure 2.1
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Customizing the Assignments
Display

The display feature enables you to customize how employee assignments appear on
TimeWizard.enterprise timesheets. You can also display assignments differently for
different employees or groups of employees.

For example, you may not want to display the Resource Code column for employees
who use only unclassified assignments. You may want to head the second column
“Client” for some employees and “Project” for other employees.

By creating a display profile, you can determine the following assignment display
properties in the Time Reporting frame:

• Selection of columns to display

• Column headings

• Column display order (left to right)

• Column sort number (sorting priority)

• Column sort order (ascending or descending)

You can also rename the ETC/Bal column.

You are not required to make any display profiles. TimeWizard uses a default display
profile if you do not create any. The default profile is determined by your Activities
setup in the Custom Fields area. If you prefer, you can assign some employees to cus-
tom display profiles and let TimeWizard use the default profile for all other employ-
ees.

A timesheet user can also determine the assignment sorting criteria for the user’s
individual timesheet. Sorting criteria that is changed from a timesheet takes prece-
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dence over criteria set in the employee’s display profile in the Administrator applica-
tion.

For more information on setting up custom fields, see Chapter 3, “Defining
TimeWizard Custom Fields,” in the TimeWizard Administrator’s Guide. To learn to
sort assignments from a timesheet, see Chapter 5, Objective 4, “Sorting assignments
on your timesheet,” in the TimeWizard.enterprise User’s Guide.

Objectives

1. Creating a display profile

2. Assigning members to a display profile

3. Editing a display profile

4. Deleting a display profile
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Objective 1:  Creating a display profile

To create a display profile, you define the profile and set its properties. Before creat-
ing profiles, consider how you will group employees for assignment to the profiles.
Employees can be grouped by department, employee code, salary code, or custom
lists of employees that you determine. After creating the profiles, continue with
Objective 2 to assign members (i.e., employees) to the profiles.
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When you set the properties for a display profile, you can enter a new name for the
ETC/Bal column, but you cannot hide it from the display or change its position in
the Time Reporting frame.

To create a display profile:

1. Click on the Display Settings icon  on the 

toolbar, or select Tools > Business Rules > Dis-
play from the main menu, to open the Display 
window (Figure 3.3).

2. Click on the Add Profile  icon on the tool-

bar or select Profile > Add Profile from the 

menu to open the Display Profile dialog box 
(Figure 3.1).

3. Type the profile name in the Profile Name box.

4. Type the profile description in the Description 
box.

5. Continue with the steps below to set the pro-
file properties.

Figure 3.1
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To set display profile properties:

1. In the Display Profile dialog box (Figure 3.2), 
enter a new name in the Column Name box of 
each existing heading you want to rename.

2. Click in the Display check box of each existing 
column you want to display.

3. To select the order in which the checked col-
umns display from left to right, click on their 
Display Order drop-down boxes and select 
position numbers.

“1” indicates the first column on the left.

4. To change the sorting priority of the assign-
ment rows, click on their Sort Number drop-
down boxes and select priority rankings.

Assignment rows are sorted first by the names 
in the column designated “1.” Within the first 
grouping, rows are sorted by names in the col-
umn designated “2,” and so on.

5. To change the sort order of the assignment 
rows to descending, click on their Sort Order 
drop-down boxes and select “Descending.” 

“Ascending” (the default) sorts from the 
smallest number to the largest and from A to 
Z. “Descending” sorts from the largest num-
ber to the smallest and from Z to A.

6. Click on “Apply” to save the settings and 
remain in the dialog box, or click on “OK” to 
save the settings and close the dialog box.

Figure 3.2
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Objective 2:  Assigning members to a display profile

Originally, all employees are assigned to the default display profile. You can assign
some or all employees to custom display profiles, but an employee can be a member
of only one profile at a time.

Before assigning members to profiles, you select one employee grouping method to
be used for all display profiles. The possible grouping methods are as follows:

• Department

• Employee Code

• Salary Code

• Custom

The Custom grouping method enables you to select specific employees to assign to
profiles, regardless of the employees’ department, employee code, or salary code.

After employee assignments are made, changing the grouping method removes
assignments from custom profiles and returns all employees to the default profile.
You can change employee assignments or edit a display profile without changing the
grouping method.

For more information about grouping methods, see Objective 1, “Understand
Employee and Activity Grouping Methods,” of the Introduction to Section Six in
the TimeWizard Administrator’s Guide.

In the Display window, you can select multiple members in the following ways:

To select members in sequence:

1. Click on the top member row you want to select.

2. Hold down the Shift key and click on the bottom row you want to select. All
rows from the top row you click to the bottom row you click will be selected.

To select members not in sequence:

1. Click on one member row.

2. Hold down the Control key and click on an additional member row.

3. Continue to hold down the Control key and click on additional member rows as
needed. Each row you click will be selected. 
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To assign members to a display profile:

1. Click on the Display Settings icon  (Tools 

menu > Business Rules > Display) to open the 
Display window (Figure 3.3).

2. Click on the Employee Members Grouped By 
drop-down box at the bottom of the window 
and select a grouping method.

3. To limit which members will display, if desired, 
click on the Dept. Code, Emp. Code, or Salary 
Code drop-down boxes in the upper left and 
select a code. This optional selection does not 
need to match the selected grouping method.

4. Click on the Retrieve button in the upper right 
to display the profile names and the member-
ship of the default profile.

5. With <default> highlighted in the Display Pro-
file frame on the left, drag and drop each 
appropriate employee or group of employees 
from the Members frame on the right to the 
appropriate display profile on the left.

6. To view the membership of a profile, click on 
the profile name. Its members will display in 
the Members frame.

7. To change an assignment, click on the mem-
ber’s current profile. Drag and drop the mem-
ber from the Members frame to the desired 
profile.

Figure 3.3
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If the selected grouping method is Custom, you can sort the displayed Members list
by employee name or employee ID by clicking on the corresponding heading.

Objective 3:  Editing a display profile

When you change the display settings in a profile, you automatically change those
settings for all of the employees assigned to the profile.

Objective 4:  Deleting a display profile

When you delete a display profile, its members return to the default display profile.
You can delete any profile except the default profile. 

To edit a display profile:

1. Click on the Display Settings icon  (Tools menu > Business Rules > Display) 

to open the Display window.

2. Click on the Retrieve button in the upper right to display the profile names.

3. Do one of the following to open the Display Profile dialog box for the profile you 
want to edit:

• Select the profile and click on the Edit Profile  icon on the toolbar.

• Select the profile and select Edit Profile from the Profile menu.

• Double-click on the profile name.

4. Modify the profile settings as desired.

5. Click “Apply” to save the settings and remain in the dialog box, or click “OK” to 
save the settings and close the dialog box.
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To delete a display profile:

Figure 3.4

1. Click on the Display Settings icon 

 on the toolbar, or select 

Tools > Business Rules > Display 
from the main menu, to open the 
Display window.

2. Click on the Retrieve button in the 
upper right to display the profile 
names in the left frame.

3. Select the profile you want to 
delete and do one of the following:

• Click on the Delete Profile icon. 

• Select Delete Profile from the Pro-
file menu.

4. In the prompt window (Figure 3.4), 
click on “Yes” to delete or “No” to 
cancel the delete action.
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Working with the Calendar

The calendar feature enables you to have time entered automatically on employees’
timesheets for holidays. You determine the activity, resource code, detail codes, and
amount of time to be entered. You can choose different settings for different employ-
ees and for different holidays.

In contrast to TimeWizard AutoPopulate, the calendar feature does not require you
to set data for an entire period. Also unlike AutoPopulate, the calendar feature does
not require additional setup in timesheets.

You can also use the calendar feature to facilitate the use of timesheet rules. Your
company may use a timesheet rule that requires a minimum number of hours on
each submitted timesheet. The timesheet of an employee whose start or termination
date falls in the middle of a period might not have the required hours. The calendar
feature can adjust the timesheet rule hours proportionately when the rule is applied
to the timesheet of such an employee.

To pre-populate timesheets with holiday data, you first create one or more calendar
profiles containing the desired settings. Next you assign employees or groups of
employees to the profiles. You then add a calendar interface in the Interface Control-
ler.

From the Interface Controller, you can run the calendar process manually or sched-
ule it to run automatically at specified intervals.

To use the calendar feature only for timesheet rules, you create one or more calendar
profiles for “nonworking days.” As the final step, you assign employees or groups of
employees to these profiles. Unlike calendar profiles for holidays, profiles for non-
working days do not use the Interface Controller.

If you want to use the calendar feature for both holidays and nonworking days, you
must associate the holiday and nonworking day settings for a group of employees
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with the same calendar profile. Employees or groups of employees can be assigned to
only one calendar profile at a time.

For information on using the Interface Controller, see “Introduction to the
TimeWizard Interface Controller” in Section Seven of the TimeWizard Administra-
tor’s Guide, particularly Objective 3, “Navigate the Interface Controller window” and
Objective 4, “Execute TimeWizard Interfaces.” To run the interface at scheduled
times, also see Objective 6, “Set up the Interface Interval.”

Objectives

1. Creating a calendar profile

2. Setting up a calendar profile for holidays

3. Setting up a calendar profile for nonworking days

4. Assigning members to a calendar profile

5. Editing a calendar profile

6. Deleting a calendar profile
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Objective 1:  Creating a calendar profile

The first step in creating a profile for holidays or nonworking days is to save a name
and description for the profile. If you will use the profile for holidays, you next select
the activity, resource code, detail codes, dates, and the hours to apply to the dates. If
you will use the profile for other nonworking days, you designate specific days of the
week as nonworking days.

Before creating profiles, consider how you will group employees for assignment to
the profiles. Employees can be grouped by department, employee code, salary code,
or custom lists of employees that you determine. After creating the profiles and
selecting settings, you will assign members (i.e., employees or groups of employees)
to the profiles.
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To create a calendar profile:

1. Click on the Calendar icon  on the tool-

bar, or select Tools > Business Rules > Calendar 
from the main menu, to open the Calendar 
window (Figure 4.1).

2. Click on the Add Profile  icon on the tool-

bar or select Profile > Add Profile from the 

menu to open the Calendar Profile dialog box 
Figure 4.2).

3. Type the profile name in the Profile Name box.

4. Type the profile description in the Description 
box.

5. Click “Apply” to save your entries. Follow the 
steps below to continue setting up the profile.

Figure 4.1
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The Calendar Profile dialog box (Figure 4.2) gives you access to the Manage Holi-
days dialog box and the Manage Nonworking Days dialog box.

Objective 2:  Setting up a calendar profile for holidays

The Manage Holidays dialog box (Figure 4.3) enables you to view any existing set-
tings for a calendar profile and gives you access to dialog boxes for completing the
initial setup or editing an existing setup. Data displayed in the Manage Holidays dia-
log box cannot be modified from within the Manage Holidays box.

An amount of hours set in a profile will not replace an amount of hours that was
entered on a timesheet before the calendar process is run.

To access the management dialog boxes:

1. In the Calendar Profile dialog box (Calendar > 
Calendar Profile), do one of the following:

• Click on the Holidays button to manage hol-
idays

• Click on the Nonworking days button to 
manage nonworking days for employees 
who start or end a job in mid-period

2. Continue with Objective 2 to set up a calendar 
profile for holidays or Objective 3 to set up a 
calendar profile for nonworking days.

Figure 4.2
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If you want a profile to include multiple holidays, you can select different settings for
each holiday in the Add Holidays dialog box (Figure 4.4). You can set different activ-
ities, resource codes, detail codes, and amounts of time. For the profile in Figure 4.4,
four holiday hours have been set for December 24, 2002, and eight hours have been
set for December 25 and other holidays. 

In the Add Holidays dialog box, after selecting an activity, hours, and a date, you
must click on the Apply button before any of the following steps:

• Selecting a different activity for another date

• Selecting a different resource code for the same activity and another date

• Selecting a different detail code for the same activity and another date

When you click on “Apply,” the saved dates disappear from the Add Holidays dialog
box and display in the Manage Holidays dialog box.

To access the Add Holidays dialog box:

1. In the Manage Holidays dialog box (Calendar > 
Calendar Profile > Mange Holidays), if no holi-
day data displays, click on the Add button to 
open the Add Holidays window.

2. If data displays in the Manage Holidays dialog 
box, see Objective 5, “Editing a calendar pro-
file.”

Figure 4.3

TWAGSUPP37.book  Page 28  Friday, June 7, 2002  4:40 PM



Chapter 4 • Working with the Calendar 29

To set up holidays:

1. In the Add Holidays dialog box (Calendar > 
Calendar Profile > Manage Holidays > Add 
Holidays), click on “Retrieve” in the upper 
right to display all activities. Or, use the filter 
drop-down boxes in the top frame to narrow 
the list and then click on “Retrieve.”

2. From the retrieved activity list, select an activity 
to include in the profile.

3. From the Resource Assignments frame in the 
lower left, select a resource code for the activ-
ity to form a resource assignment to include.

4. From each detail code drop-down box in the 
Detail Codes frame, select a code to include 
with the selected resource assignment.

5. In the Selected Hours box in the lower right, 
enter the amount of time for a holiday date 
for the selected assignment.

6. In the calendar in the lower right, locate the 
date for the selected hours and assignment. 
Click on the left arrow beside the month and 

year to display previous months; click on the 
right arrow to display following months.

7. Set the date by doing one of the following:

•  Double-click on the date in the calendar

• Select the date and click on “Set Date” in 
the lower right

• Enter the date in the Date box below the 
calendar and click on “Set Date”

The selected date and hours display in the list 
to the left of the calendar.

8. To delete dates and hours, select the list row 
and click on “Delete” in the lower right.

9. To add other dates to the profile for the 
selected assignment, repeat steps 5 - 7.

10. To add other dates to the profile with another 
resource code, detail code, or activity, click 
“Apply” before repeating all needed steps.

11. Click “OK” to save the settings and close the 
box.

Figure 4.4
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Objective 3:  Setting up a calendar profile for nonworking days

If your company uses a timesheet rule to enforce the minimum number of hours on
submitted timesheets, you may want to create and set up a calendar profile for “non-
working days.” New employees who start work after the first business day of the
period or employees who separate from the company before the last business day of
the period might have less than the required number of hours on their timesheets.
Calendar profiles for nonworking days are used so that their timesheets can be vali-
dated and submitted for approval.

In contrast to calendar profiles for holidays, profiles for nonworking days are not
used to enter time on timesheets. Instead, TimeWizard calculates how much of the
timesheet rule hours should be applied to an employee’s timesheet. The calculation is
based on the following three factors:

1. The number of hours stipulated by the timesheet rule for the employee’s prefer-
ence profile (Hours for the rule are set in Administrator > Tools menu > Business
Rules > Define Timesheet Rules. The rule is assigned to the preference profile in
Administrator > Preferences window > Preference Profile > Timesheet Rules.)

2. The employee’s active or inactive date (set in Administrator > Employees >
Employee Detail window)

3. The nonworking days set in the employee’s calendar profile

Nonworking days are the days of the week when the employee does not usually work.
If the employee’s usual workweek is Monday through Friday, then Saturday and Sun-
day are the employee’s nonworking days.

Using these factors, TimeWizard determines the proportion of the timesheet rule
hours to apply to employees, or groups of employees, who are assigned to particular
calendar profiles.

The Manage Nonworking Days dialog box

The Manage Nonworking Days dialog box (Figure 4.5) incorporates three functions
in one window: completing an initial setup, viewing an existing setup, and editing an
existing setup. If you have not created the calendar profile to be used for the non-
working days, see Objective 1: “Creating a calendar profile.”

If you want to include most days of the week in the profile, you can add all days in
one step and then remove the ones you want to exclude.
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Objective 4:  Assigning members to a calendar profile

Originally, all employees are assigned to the default calendar profile. You can assign
some or all employees to custom calendar profiles, but an employee can be a member
of only one profile at a time.

Before assigning members to profiles, you select one employee grouping method to
be used for all calendar profiles. The possible grouping methods are as follows:

To manage nonworking days:

1. In the Calendar Profile dialog box for the 
selected profile (Calendar > Calendar Profile), 
click on the Nonworking days button to open 
the Manage Nonworking Days dialog box.

2. In the Nonworking Days box on the right, view 
any existing days currently set for the selected 
profile.

3. To add a day to the profile, select the day in 
the Days box on the left and click on the right 
arrow button between the boxes.

The day moves to the Nonworking Days box 
on the right.

4. To move all days to the Nonworking Days box, 
click on the double right arrow button.

5. To remove a day from the profile, select the 
day in the Nonworking Days box and click on 
the left arrow button between the boxes.

The day moves to the Days box on the left.

6. To remove all days from the Nonworking Days 
box, click on the double left arrow button.

7. Click on “Apply” to save the profile settings 
and remain in the dialog box, or click on “OK” 
to save the settings and close the dialog box. 

Figure 4.5
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• Department

• Employee Code

• Salary Code

• Custom

The Custom grouping method enables you to select specific employees to assign to
profiles, regardless of the employees’ department, employee code, or salary code.

After member assignments are made, changing the grouping method removes assign-
ments from custom profiles and returns all employees to the default profile. You can
change member assignments or edit a calendar profile without changing the group-
ing method.

For more information about grouping methods, see Objective 1, “Understand
Employee and Activity Grouping Methods,” of the Introduction to Section Six in
the TimeWizard Administrator’s Guide.

In the Calendar window, you can select multiple members in the following ways:

To select members in sequence:

1. Click on the top member row you want to select.

2. Hold down the Shift key and click on the bottom row you want to select. All
rows from the top row you click to the bottom row you click will be selected.

To select members not in sequence:

1. Click on one member row.

2. Hold down the Control key and click on an additional member row.

3. Continue to hold down the Control key and click on additional member rows as
needed. Each row you click will be selected. 
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To assign members to a calendar profile:

1. Click on the Calendar icon  on the tool-

bar, or select Tools > Business Rules > Calendar 
from the main menu, to open the Calendar 
window.

2. Click on the Employee Members Grouped By 
drop-down box at the bottom of the window 
and select a grouping method.

3. To limit which members will display, if desired, 
click on the Dept. Code, Emp. Code or Salary 
Code drop-down boxes in the upper left and 
select a code. This optional selection does not 
need to match the selected grouping method.

4. Click on the Retrieve button in the upper right 
to display the profile names and the member-
ship of the default profile.

5. With <default> highlighted in the Calendar 
Profiles frame on the left, drag and drop each 
appropriate employee or group of employees 
from the Members frame on the right to the 
appropriate profile on the left.

6. To view the membership of a profile, click on 
the profile name. Its members will display in 
the Members frame.

7. To change an assignment, click on the mem-
ber’s current profile. Drag and drop the mem-
ber from the Members frame to the desired 
profile.

Figure 4.6
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If the selected grouping method is Custom, you can sort the displayed Members list
by employee name or employee ID by clicking on the corresponding heading.

Objective 5:  Editing a calendar profile

When you change the settings in a calendar profile, you automatically change those
settings for all of the employees assigned to the profile.

.

To access a calendar profile for editing:

1. Click on the Calendar icon  on the toolbar, or select Tools > Business Rules 
> Calendar from the main menu, to open the Calendar window.

2. Click on the Retrieve button in the upper right to display the profile names.

3. Do one of the following to open the Calendar Profile dialog box for the profile 
you want to edit:

• Select the profile and click on the Edit Profile icon on the toolbar.

• Select the profile and select Edit Profile from the Profile menu.

• Double-click on the profile name.

4. To edit settings for nonworking days, continue with the steps in the box below.

5. To edit settings for holidays, continue with the steps in the second box below.

To edit nonworking day settings:

1. Open the Calendar Profile dialog box for the selected profile, as described 
above.

2. Click on the Nonworking days button.

3. Edit the settings by following the steps in Objective 3: “Setting up a calendar 
profile for nonworking days,” as needed.

4. Click on “OK” to save the settings and close the dialog box.
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To edit holiday settings:

1. Open the Calendar Profile dialog box for the 
selected profile, as described above.

2. Click on the Holidays button to open the Man-
age Holidays dialog box (Figure 4.3).

3. To add another activity to the profile for an 
additional holiday date, click on the Add but-
ton to open the Add Holidays dialog box. Fol-
low the steps in Objective 2 to set up holidays.

4. To delete a holiday row from the Manage Holi-
days box, select the row and click on the 
Delete button. Continue to modify the profile 
or click on “Close” to close the box.

5. To edit a holiday row, select the row and click 
on the Edit button to open the Edit Holiday 
dialog box (Figure 4.7).

6. In the Edit Holiday dialog box, to edit a date, 
select the date and hours row, select the 
desired date in the calendar (or enter it in the 
Date box), and click “Apply.”

7. To edit hours, select the date and hours row, 
edit the hours in the Selected Hours box, and 
click “Apply.” You can combine this step with 
step 6.

8. To delete one or more date and hours rows, 
select the rows and click on “Delete selected 
date(s)” below the date and hours rows.

9. To edit a resource code, select the date, click 
on the Resource Code drop-down box in the 
lower left frame, and select the desired code.

10. To edit a detail code, select the date, click on 
the detail code drop-down box in the Detail 
Codes frame, and select the desired code.

11. To edit resource or detail codes for multiple 
dates, multi-select the date and hours rows.

12. Click “Apply” to save the settings and remain 
in the dialog box, or click “OK” to save the 
settings and close the dialog box.

Figure 4.7
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To edit an activity holiday setting, you must delete the activity’s holiday row in the
Manage Holidays dialog box and use the Add Holiday dialog box to make your new
selection. You cannot edit an activity in the top frame of the Edit Holiday dialog
box.

If you want to edit resource codes or detail codes for multiple dates, you can select
multiple date and hours rows in the Edit Holiday dialog box and apply your changes
to all the selected dates at one time. You can also delete multiple date and hours rows
at one time. (See Objective 4: “Assigning members to a calendar profile” to learn to
use multiple selection.)

While multiple date and hours rows are selected in the Edit Holiday dialog box, the
calendar that displays in the lower right, the Selected Hours box above the calendar,
and the Date box below the calendar are disabled.

Objective 6:  Deleting a calendar profile

When you delete a calendar profile, its members return to the default calendar pro-
file. You can delete any profile except the default profile. 
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To delete a calendar profile:

Figure 4.8

1. Click on the Calendar icon  
on the toolbar, or select Tools > 
Business Rules > Calendar from the 
main menu, to open the Calendar 
window.

2. Click on the Retrieve button in the 
upper right to display the profile 
names in the left frame.

3. Select the profile you want to 
delete and do one of the following:

• Click on the Delete Profile icon. 

• Select Delete Profile from the Pro-
file menu.

4. In the prompt window (Figure 4.7), 
click on “Yes” to delete or “No” to 
cancel the delete action.
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Working with Submittal Notes
in TimeWizard.enterprise

When timesheet users submit a timesheet for approval, they save a submittal note.
Depending on a property setting, you may set TimeWizard.enterprise to display only
the standard submittal note or to display a text box for composing an original sub-
mittal note, as well.

A timesheet user can choose not to leave a note by saving a blank original note.

You can view employees’ submittal notes in the Approval History window in the
same way you view other approval notes, whether you perform approvals in Admin-
istrator, the client/server timesheet, or TimeWizard.enterprise. If you use the Approv-
als Inbox of TimeWizard.enterprise, you can view submittal notes in the Approval
History frame of the Inbox. (See Chapter 12, Objective 5, “Showing Approval His-
tory,” in the TimeWizard.enterprise User’s Guide.)

Employees can view their own submittal notes by using the View Approval History
feature of the TimeWizard.enterprise timesheet.

If you want TimeWizard.enterprise to display only the standard submittal note, you
need not take any action in the properties file. The default property setting displays
the standard submittal note. To change the property setting to allow original submit-
tal notes, refer to the TimeWizard Installation Guide.
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Setting Report Parameters in
TimeWizard.enterprise

In the TimeWizard.enterprise Reports area, you define most parameters for
TimeWizard standard reports by selecting the parameters from list boxes. Some list
boxes allow you to select multiple values or items. For example, for the parameter
“departments_owned,” you can select all of the departments you own that you want
to include in one report. (See Figure 4.1.)

To select multiple parameter values in sequence:

1. Click on the first parameter value in the sequence you want to select.

2. Hold down the Shift key and click on the last parameter value in the sequence
you want to select.

To select multiple parameter values not in sequence:

1. Click on a parameter value you want to select.

2. Hold down the Control key and click on each additional parameter value you
want to select.

If a parameter box does not allow you to highlight more than one value or item at a
time, the selected report does not process multiple values for that particular parame-
ter.
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Figure 6.1
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If a parameter box is labeled “From,” type the starting date of the first period in the
range you want to select. If a parameter box is labeled “To,” type the ending date of
the last period in your range. (See Figure 4.2.)

If the parameter box is labeled “Missing Timesheet Hours Threshold,” you can use
the default value of “1.00” (hour) or edit the value. A timesheet with less than the
amount of hours in this box is considered to be “missing.”

For further information on setting parameter values, see the TimeWizard Guide to
Reports.

Figure 6.2
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Filtering and Backing Up
DataBridge Interfaces

The DataBridge feature enables you to create automated links to export data from
TimeWizard into other systems within your organization, such as Human Resources
and Accounting systems. To learn the fundamentals of setting up and running an
interface, please see “Introduction to the TimeWizard Interface Controller” in Sec-
tion 7 of the TimeWizard Administrator’s Guide. To learn to use the DataBridge fea-
ture, see Chapter 24, “Working with the DataBridge Toolkit,” in the Administrator’s
Guide.

A DataBridge filter specifies your selection criteria for transactions records in an
export. TimeWizard now gives you the option of applying your date criteria auto-
matically to multiple DataBridge interfaces. This function is particularly useful when
your filters are set to include transactions through a specified period ending date or
transactions between two specified dates.

The DataBridge window also enables you to make a backup copy of your DataBridge
setup specifications, including export variable definitions, filtering criteria, and an
output target profile. If you change your DataBridge specifications, you can keep a
copy of the specifications used on previous dates. You can also use a backup copy in
case of power failure during the execution of a DataBridge interface or for trouble-
shooting purposes.

Objectives

1. Applying filter dates to all DataBridges

2. Backing up DataBridge interface settings

3. Importing a DataBridge backup
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Objective 1:  Applying filter dates to all DataBridges

If you have multiple DataBridge interfaces, you can set the date criteria for all the
DataBridge filters simultaneously. This function will set the date criteria for both
normal and historical transactions. Using this function will not set any other
DataBridge filter criteria, such as criteria to include open or closed periods or
approved or unapproved transaction data.

To use this function, first select the DataBridge interface containing the date criteria
you want to use. Then select “Apply Filter Dates to All DataBridges” in the
DataBridge Script Editor window for the selected interface (Figure 5.1).

You can open the DataBridge Script Editor from the Interface Controller in the fol-
lowing four ways:

1. Double-click on the DataBridge interface ID or application name you want to
use.

2. Select the DataBridge interface row and select Setup Options from the main
Interface menu.

3. Select the DataBridge interface row and click on the Setup Options icon  on

the toolbar.

4. Select the DataBridge interface row, right-click on the ID or interface type, and
select Setup Options from the popup menu.

When you use this function, the filter dates are applied only to the DataBridge inter-
faces currently residing in the Interface Controller. When you close the DataBridge
Script Editor, this function is no longer selected. It will not apply to any DataBridge
interfaces you add in the future unless you select the function again.
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Objective 2:  Backing up DataBridge interface settings

The export function

You can save a copy of your DataBridge interface settings by using the DataBridge
export function. Unlike executing a DataBridge interface, this export function does
not transmit transaction records to an external system. Instead, it saves only the
DataBridge settings and stores them in text files within the TimeWizard directory. If
you change your DataBridge settings, you can keep copies of settings you used on
each specific date.

To apply filter dates to all DataBridges:

1. In the Interface Controller, select the 
DataBridge interface whose dates you want to 
use.

2. Open the DataBridge Script Editor as described 
above.

3. Click on the “Filters” tab to open the Filters 
tab page.

4. Confirm that the filter date criteria are correct 
for both normal and historical transactions or 
edit as needed.

5. Select “Apply Filter Dates to All DataBridges” 
in the upper part of the window.

6. Click “Close.”

Figure 7.1
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You cannot use the export function when more than one DataBridge interface resides
in the Interface Controller.

The export function saves DataBridge settings in six files, with the current date and
time at the start of each file name. You can save DataBridge settings from different
dates without overwriting the files.

The Defaults subdirectory

Before using the export function for the first time, you will need to make a subdirec-
tory to store the exported files. Within the TWIAS subdirectory of your main
TimeWizard directory, make a subdirectory named “Defaults” or “defaults.” Once
the Defaults subdirectory has been created, you can export files to it many times.

To export DataBridge settings:

1. If you do not have a Defaults subdirectory, cre-
ate one named ”Defaults” or “defaults” in the 
TWIAS subdirectory.

2. In the Interface Controller, open the 
DataBridge Script Editor by double-clicking the 
DataBridge interface ID (or, with the row 
selected, select Setup Options from the Inter-

face menu, click the Setup Options icon , 
or right-click the interface type or ID and select 
Setup Options from the popup menu).

3. Set up the interface script, filters, and output.

4. Click on the Export command button in the 
upper right of the window.

Figure 7.2
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Objective 3:  Importing a DataBridge backup

If you want to use previous settings that no longer appear in a DataBridge interface,
you can enter settings from exported backup files by using the DataBridge import
function. You may import settings to a specific DataBridge interface even when more
than one DataBridge interface is in the Interface Controller.

To import DataBridge settings, you must first remove the time and date from the
names of the six files you want to use. The imported data overwrites existing settings
in the selected DataBridge in the Interface Controller with the settings from the text
files.

To import DataBridge settings:

1. In your TimeWizard file directory, open the 
Defaults subdirectory in the TWIAS subdirec-
tory.

2. Delete the date and time from the names of 
the six files you want to import.

3. In the Interface Controller, select the 
DataBridge interface whose settings you want 
to replace.

4. Open the DataBridge Script Editor by double-
clicking the DataBridge interface ID (or, with 
the row selected, select Setup Options from 
the Interface menu, click the Setup Options 

icon , or right-click the interface type and 

select Setup Options from the popup menu).

5. Click on the Import command button in the 
upper right of the window (see Figure 5.2).
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Deleting Headers from Table
Retrievals

The Table Retrieval feature enables you to create automated links to import data into
TimeWizard from other systems within your organization, such as Human Resources
and Accounting systems. To learn the fundamentals of setting up and running an
interface, please see “Introduction to the TimeWizard Interface Controller” in Sec-
tion 7 of the TimeWizard Administrator’s Guide. To learn to use the Table Retrieval
feature, see Chapter 25, “Working with the Table Retrieval,” in the Administrator’s
Guide.

You can use a database or a flat file as the data source for a Table Retrieval. A flat file
may contain a header in the first row of the file. TimeWizard enables you to prevent
the import of header text into a data cell of a TimeWizard database when you per-
form a Table Retrieval.

Objective

1. Deleting a Header from a Table Retrieval
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Objective 1:  Deleting a Header from a Table Retrieval

Identifying your data source type as a flat file (Figure 6.1) gives you the option of
preventing header text from being imported to a data cell of a TimeWizard database
table. If you identify your data source type as a database, you will not need this
option, and it will not display.

If you do not select “File Contains Header” in the Table Retrieval setup options,
TimeWizard processes every row of the file as data. 

To delete a header from a Table Retrieval:

1. In the Interface Controller, open the Table 
Retrieve setup window by double-clicking the 
Table Retrievals interface ID (or, with the row 
selected, select Setup Options from the Inter-

face menu, click the Setup Options icon , 

or right-click the interface type or ID and select 
Setup Options from the popup menu).

2. After entering a name for the retrieval set and 
adding a map table, select Flat File as the data 
source type.

3. Select the file type and enter the file name.

4. Select “File Contains Header.”

5. Click “Apply” to save the settings and remain 
in the window or click “OK” to save the set-
tings and exit the window.

Figure 8.1
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Synchronizing TimeWizard
with Microsoft Project and

Business Engine ProjectServer

If you link TimeWizard to both Microsoft Project (MSP) and Business Engine
ProjectServer, changes you make to activities in MSP are carried out in TimeWizard.
This chapter discusses how TimeWizard synchronizes activity and assignment status
with MSP when MSP is connected to ProjectServer. For other information about
ProjectLinks, consult the specific TimeWizard User’s Guide for the ProjectLink your
organization uses.

Closing an activity in MSP

When you close an activity in MSP and TimeWizard retrieves MSP/Project Server
data, TimeWizard automatically closes the activity in the TimeWizard database. The
retrieval also closes any resource assignments and employee assignments that are
based on the activity.

TimeWizard logs the last transaction date as the “actual finish” date. If no transac-
tion data has been saved for an assignment, TimeWizard uses the actual finish date
that was posted in MSP/ProjectServer for the activity and all associated assignments.

If you want to close a resource assignment or employee assignment without closing
the activity on which it is based, you must close the assignment directly in TimeWiz-
ard—not through the retrieval. If you subsequently execute an update from
TimeWizard to MSP/ProjectServer, the update will display an actual finish date for
the assignment in MSP/ProjectServer.
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Opening an activity in MSP

When you open a previously-closed activity in MSP and TimeWizard retrieves
MSP/Project Server data, TimeWizard automatically opens the activity in the
TimeWizard database.

Opening an activity during a retrieval from MSP/ProjectServer does not open any
associated assignments in TimeWizard. You control which assignments you want to
reopen in TimeWizard after the retrieval.

If you open a resource assignment or employee assignment directly in TimeWizard, a
subsequent update will open the assignment in MSP/ProjectServer.
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I N T R O D U C T I O N

Understanding the Basics

Remembering English 101
If you can recall seventh grade English and the six types of questions—who, what, when,
where, why, and how—then you are well on your way to understanding the basic structure of
TimeWizard. At the product’s simplest level, it serves to answer these same questions:

Who is working?

The answer to this question lies in the TimeWizard Employees area (see Section 4: Managing
Resources), which compiles the list of resources who are able to make time entries in the
TimeWizard system.

What are they working on?

The answer to this question lies in the TimeWizard Activities and Assignments area (see Sec-
tion 5: Managing Projects), which compiles the list of jobs on which the employees can work.

What types of time are they charging to the task?

This type of detailed information can be gathered in TimeWizard and shared with appropri-
ate departments company-wide. For example, Payroll may be interested in different types of
Paycodes charged and Human Resources may be interested in non-project hours (e.g., holi-
day, sick leave, maternity leave) charged. The answer to this question lies in two areas:

• The TimeWizard Custom Fields and Code Values areas (see Section 2: Customizing
TimeWizard) enable you to customize TimeWizard to gather the specific informa-
tion  that is important to your company.

• The TimeWizard timesheet detail code area (see the TimeWizard Timesheet User’s
Guide) is where the employees can stipulate such details as what type of time (i.e.,
regular time or overtime) they charged to the task.



TimeWizard

Introduction • Understanding the Basics16

When did they work?

The answer to this question lies in three areas:

• The TimeWizard Approval Period area (see Section 3: Defining the Approval Pro-
cess)  defines when the employees can work.

• TimeWizard Business Rules (see Section 6: Applying Your Business Rules) enable
you to set up user preferences that define the duration of each employee’s workday
and work week.

• The TimeWizard timesheet (see the TimeWizard Timesheet User’s Guide) is where the
employees stipulate when (i.e., on what specific day) they did work.

Where are they working?

This type of detailed information may only be important because different work locations
(e.g., at headquarters or off-site) get billed differently. The answer to this question lies in two
areas:

• The TimeWizard Detail Code Value area (see Section 2: Customizing TimeWizard)
can define such details as where the employees can work.

• The TimeWizard timesheet detail code area  (see the TimeWizard Timesheet User’s
Guide) is where the employees can stipulate such details as where (i.e., at what loca-
tion) they did work.

Why are they working?

Only the employee can answer this question. And even if the response is “Because you told me
to,” that answer can be sent in the form of a TimeWizard note. Transaction notes, for ex-
ample, are attached to specific actions on the timesheet.

How long did they work on the job?

The answer to this question lies in the TimeWizard timesheet, where the employees stipulate
exactly how long they worked on a job on a certain day.

TimeWizard is not ready to answer these questions right out of the box. You have to set
parameters, get more specific on the questions you want answered, and nurture the product
along the way—sounds a lot like raising children! But it will help you to keep everything in
perspective to remember that, at its basic level, TimeWizard is designed to answer those six
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simple questions.

But What Does the Employee Get Out of It?

It may be easy for you to see the advantages of using TimeWizard but quite another for your
company’s employees to recognize the benefits to them. To that end, we recommend that you
review the TimeWizard Timesheet User’s Guide and the TimeWizard Timesheet Manager’s Guide
so that you have a complete perspective of how your company’s employees will use the appli-
cation.

In the day-to-day management of your company, department owners and project managers
break down your company’s projects into a number of activities, which are then assigned to
the employees (depending on their skills and areas of expertise). However, planning a project
and assigning employees to do the work is only part of the process. To be effective, managers
need to know how much time is being spent on various activities assigned to each employee.
Once the activities are in progress, managers also need to know how much more time is
required for completion of these tasks. This is where TimeWizard becomes an invaluable tool.

Using TimeWizard, employees see the activities to which they are assigned on their timesheets
when they login. These assignments can be pulled directly from an external project manage-
ment system, eliminating the need for redundant data entry. The employees then enter the
time they have spent working on the individual assignments, noting the number of hours
planned for each assignment and the number of hours spent to date. Employees— who know
best the effort and time required to complete the work—then can adjust the estimate to
complete (hours remaining to complete the assignment). This data can then be updated to a
project management system so that the project manager is fully informed.

Let’s Review the Value of this Process:

• Managers see the true current status of their projects and can consult with the em-
ployees working on the activities to intervene when necessary to add additional re-
sources, modify the schedule, make adjustments to the scope, or take whatever ac-
tion is deemed appropriate.

• Employees working on the projects benefit directly, because there are no surprises
when the completion date arrives and the work is not complete. The communica-
tion with management has been ongoing and accomplished with very little effort on
the employee’s part.

• Managers are armed with the data needed to justify any corrective actions to man-
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agement levels above.
• Employees are no longer expected to complete 60 hours of effort in 40 hours of

time! Managers can use the historical knowledge gathered by TimeWizard for future
planning. By collecting accurate data from the source (the employees working on the
activities), managers can make more accurate estimates in future project plans.

• Over-commitment of resources is reduced. Using the knowledge gathered by
TimeWizard, managers can see the impact of new assignments on resources. This
enables managers to reassign the work to available resources or shift the work to
more appropriate time frames before commitments are made.

In short, TimeWizard provides the information and means of communication necessary to
keep your managers and employees in synch and to make your company stronger, more
effective, and more competitive.

Objectives

1. Navigate the TimeWizard Administrator’s Guide
2. Execute the TimeWizard Administrator
3. Log on to the TimeWizard Administrator
4. Change your password
5. Access the About dialog box
6. Send e-mail from TimeWizard
7. Use On-line Help
8. Set up printing specifications
9. Exit the TimeWizard Administrator
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Objective 1: Navigate the TimeWizard Administrator’s Guide

Can you draw me a map?

At the beginning of this Introduction, we discussed what TimeWizard is designed to do. Now,
let’s see how this manual is designed to walk you through the steps of setting up the system.
Each section in the manual is comprised of chapters that guide you through specific objec-
tives. As you complete each section, you will be prepared to proceed to the next section, which
in turn has its own chapters and objectives. In addition, this manual often presents special
notes or tips to help you understand key points. Table I.1 explains each icon used in this
manual. As you start your journey of setting up TimeWizard for your company, we suggest
that you stay on the path that this manual lays out for you.

This guide presumes that your mouse is programmed for right-handed use.

Section 1: Implementing TimeWizard

Put the TimeWizard CD in your computer’s CD drive and get started. TimeWizard utilizes
InstallShield’s Install Wizard, which helps guide you through each step of installation. This
section also helps you set up the TimeWizard database, which is necessary for you to use the
system.

Table I.1: TimeWizard Guide Icons
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Section 2: Customizing TimeWizard

Tell TimeWizard what categories of data you want to capture. You will define these categories
for three areas: Activities, Detail Codes, and Employees. For example, Activity categories may
include “Project,” “Subproject,” “Job Number,” and “Description.” Detail Code categories
may include “Shift,” “Billing Number,” and “Cost Type.” Employee categories may include
“Department Code,” “Employee Code,” and “Salary Code.”

Then, assign attributes, or values, to each category. For example, a Detail Code category called
“Shift” may have attributes called “Morning,” or “Evening,” and “Graveyard.” An Employee
category called “Employee Code” may have attributes called “Full-time,” “Part-time,” and
“Contract.” An Activity category called “Projects” may have attributes called “TW3,”
“TWInstall,” and “WebSite.”

Section 3: Define the Approval Process

Decide which is a higher priority for your company:

• Tracking employees’ hours to help monitor departmental objectives
• Tracking collective hours charged to specific activities to help manage projects

Your answer will drive how your company approves (that is, validates) the data that TimeWizard
gathers.

Then, decide how often your company needs to lock timesheet data, and define the approval
periods to match. The frequency with which you establish approval periods may depend on
the payroll distribution cycle or how up-to-date you require the actuals to be in your project
management system.

Section 4: Managing Resources

Compile a group of employees who are allowed to use TimeWizard. Each employee will be
characterized by certain attributes. For example, does the employee work full-time? What is
the employee’s salary level? And in what department does the employee work?

Section 5: Managing Projects

Give the employees something to do—that is, create activities in the system. To create activi-
ties, we use attributes from each Activity category to make unique activities. For example,



TimeWizard

21Introduction • Understanding the Basics

using the categories “Resource,” “Project,” “Subproject,” “Job Number,” and “Description”
we could create the activity: ProDev, TW3, Documentation, 154, Writing specs for TimeWizard
DataBridge.

Then, put each employee to work on the right activity by making assignments. (In TimeWizard,
employees use the timesheet to charge time on their own assignments to activities.)

Section 6: Defining Business Rules

Give some users special permissions. Place restrictions on other users. In this section, you learn
how to set up TimeWizard to reflect your own company’s business rules. These include the
following:

• Preferences that define “standard” workdays for your employees
• Permissions that stipulate who can go where in the TimeWizard system
• Access lists that control which employees can work on certain activities
• Detail code rules that control what types of time certain employees can charge to

certain activities
• Activity pools that stipulate which project managers have approval authority over

which activities
• Standard notes that ensure that communication throughout the system is coherent

and consistent
• Report category access lists that control which employees can produce which busi-

ness reports

Section 7: Sharing TimeWizard Data with Other Systems

Stop entering the same data more than once. Get your company’s departments to start sharing
data so that the whole company can benefit. TimeWizard’s Interface Controller enables you to
use your application of choice for all of your business efforts. For example, you may prefer to
manage your projects and activities in Microsoft Project 98 and your Human Resources ef-
forts in PeopleSoft. Interfaces with these systems enable you to populate TimeWizard with the
appropriate project and personnel records. Once the data is approved or updated, TimeWizard
can update your external system, making manual updates unnecessary.
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Objective 2: Execute the TimeWizard Administrator

Once you have successfully installed TimeWizard and set up the TimeWizard database, you
can execute the application and log on.

Executing TimeWizard

To execute TimeWizard, follow these steps:

1. Double-click on the “TimeWizard Administrator” icon         in the TimeWizard
group window.

2. Windows 95 users, position your cursor over the TimeWizard menu item on the
Start button menu and then click on TimeWizard.

Figure I.1

Logging On to TimeWizard

To log on, follow these steps:

1. Select your login ID from the the drop-down menu. Scroll
through the list to locate and select your ID. You also can
begin typing your logon ID in the Login ID text box; as you
type, TimeWizard searches ahead for a match.

2. When your login name appears in the text box, press tab
or click on the Password text box

3. Enter your password in the text box.

4. Click “OK” or press <Enter> on your keyboard to open
the application.

Figure I.2

Objective 3: Log on to TimeWizard Administrator

Your default login ID is “TWADMIN” and default password is “bendar.”

Be sure that you do not have the Caps Lock on.
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Objective 4: Change Your Password

System access and security is critical in any shared environment, because it prevents unautho-
rized access to user data, which in most cases contains important personal information. The
use of a password feature enables a system to provide for controlled-access security for user
data.

Passwords should be simple to remember by the user but difficult for others to determine. We
recommend you change your password immediately to prevent unauthorized access to the
TimeWizard functions. Once the default password for the login ID “TWADMIN” has been
changed, you cannot use this login ID to enter the Administrator application and change the
password if you forget the new password. Designating multiple employees as Administrators
(Employees > Employee Detail window) with Advanced Permissions (Permissions > Permis-
sions Profile) is encouraged. Such an Administrator can change another employee’s password
and grant permissions, but cannot change the password for the login ID “TWADMIN.”

Because of encryption limitations, do not use uppercase for your password. In addition, do
not begin or end your password with the letter “a.”

Changing Your Password

To change your password, follow these steps:

1. From the File menu, select Change Password to open the
“Change Password” dialog box.

2. Enter your current password in the “Enter Old Password” box.

3. Enter a new password in the “Enter New Password” box.
Passwords for TimeWizard Administrator must be exactly six
characters long. You may use any combination of lowercase

letters, numbers or special characters. Remember not to
use uppercase and not to begin or end with “a.”

4. Enter the new password in the “Confirm New Password”
box to confirm it.

5. Click on “OK” to return to the TimeWizard main
window.

Figure I.3
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Objective 5: Access the About dialog box

The “About TimeWizard” dialog box gives you a quick glimpse of your TimeWizard contract
information. Use it as a reference to view information including the name of the license
owner, the number of licenses in your contract, your customer ID, and your product serial
number.

Accessing the About dialog box

To access the About dialog box, follow either of
these steps:

1. Select Help > About TimeWizard from the main
menu.

2. Click the About icon on the TimeWizard Administra-
tor toolbar.

Figure I.4

Sending e-mail from TimeWizard

To access the send e-mail from TimeWizard,
follow this step:

1. Click the send mail icon         on the TimeWizard
toolbar or select File > Send Mail from the main
menu to open an e-mail system dialog box, such as
the Choose Profile dialog box associated with
Microsoft Outlook (Figure I.5).

2. Select your e-mail system or set up a new mail
profile.

3. In the example dialog box, click “OK” to open your
e-mail system. (Your dialog box may differ but will
function similarly.)

Figure I.5

Objective 6: Send e-mail from TimeWizard

You can send e-mail directly from TimeWizard Administrator if you have a MAPI 1.0 com-
pliant mail system, such as Microsoft Mail or Microsoft Exchange. For assistance with setting
up a new e-mail profile, see your network administrator for instructions specific to your e-
mail application.
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Objective 7: Use On-line Help

TimeWizard is equipped with extensive on-line help files that, like this manual, guide you
through the TimeWizard system.

You can approach the on-line help files in either of two ways:

1. To start with the content page and work your way through in a forward progression,
select the Contents tab from the TimeWizard Help main screen.

2. To search for specific information, select the TimeWizard Help Index tab. Then
select a specific entry and click the “Display” command button.

The help screen often contains more information than is displayed in the window. You can
scroll the help screen by using the scroll bars, or you can use your keyboard in the following
manner:

• To scroll down by one line, use the “down arrow” key.
• To scroll up by one line, use the “up arrow” key.
• To scroll the help topic down by one screen or “page,” use the “page down” key.
• To scroll the help topic up by one screen or “page,” use the “page up” key.
• To scroll to the end of the topic, press the <Ctrl> and <End> keys.
• To scroll to the beginning of the topic, press the <Ctrl> and <Home> keys.

TimeWizard does not support mouse scroll wheels.

Clicking on the green text with a solid underline will link you to another topic. Clicking on
the green text with a dotted underline will open a temporary pop-up window. You can close
the pop-up window by clicking once more with the mouse.

Help topics can be viewed one at a time from within the Help window by choosing the Next
and Previous commands on the Help menu. These commands display the next or previous
help topic as listed in the topic list so you can skim through a number of help topics before
closing the window.

At the bottom of most help topics, a small list of related topics appears. You can open and read
any of these topics by double-clicking on the topic name. This allows you to jump between
related topics quickly.
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Objective 8: Set up printing specifications

TimeWizard uses your default printer for printing your timesheet. Click “Printer Setup” to
select a different printer, or change the printer settings for the printer on which you want to
print the timesheet report.

Using the online help

Figure I.6

To use the online help, follow this step:

1. Click on the Help icon         on the TimeWizard toolbar or
select Help > Help Index from the main menu to open the
Help window.

2. From the Help Contents or Index selections, simply click on
the topics of choice to find the information you need.

3. To close Help, press the <Esc> key on your keyboard or
select Close from the Help menu. When you close Help, you
return to your last location in TimeWizard before you
opened the Help window.
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Objective 9: Exit the TimeWizard Administrator

When you have completed your work in TimeWizard Administrator you may exit the appli-
cation.

Setting up printing specifications

Figure I.7

To set up printing specifications, follow these steps:

1. Select “Printer” (File > Printer) to open the Printer Setup
dialog box.

2. Select the appropriate printer from the printer menu.

3. Click “Setup” to specify printer setup preferences. Follow
the setup instruction supplied by your printer vendor.

4. Click “OK” to save printer settings and exit the dialog
box.

Exiting TimeWizard Administrator

To exit the TimeWizard Administrator, follow these steps:

1. Click on the Exit icon        on the TimeWizard Administrator toolbar or choose Exit from the File menu
(File > Exit).

2. TimeWizard displays the Exit dialog box. Click OK to exit the program.
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Summary

In this Introduction, we introduced you to the benefits of time accounting and discussed the
steps outlined by each section of this manual. In addition, you learned the basics of the
TimeWizard system, such as how to log in and exit the TimeWizard Administrator, customize
your password, use the on-line help feature, and send information via your company’s e-mail.
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Implementing TimeWizard

In this section, you learn to install the TimeWizard Network, Administrator, and
Timesheet files onto your appropriate machines. TimeWizard provides a simple

database setup that is performed only once during the initial setup of your TimeWizard
system.

In addition, TimeWizard enables you to maintain the database effectively by remov-
ing old or unused data. Once several periods have been closed and you no longer need
to make historical corrections to that data, you can archive those periods, i.e., copy
the old data and remove it from the TimeWizard database. If you have any unneeded
activity and employee records in TimeWizard database, you can purge—completely
remove—that data.

Introduction to TimeWizard Installation

Chapter 1: Installing TimeWizard
Chapter 2: Working With the TimeWizard Database
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Introduction to TimeWizard
Installation

In this Introduction, you are introduced to the basic concepts that concern the installation of
TimeWizard.enterprise and the TimeWizard Network, Administrator, and Timesheet files onto
your appropriate servers and client-level machines. In addition, we discuss items—such as the
software license agreement and technical support—that you should consider before perform-
ing an installation.

Objectives

1. Understand the TimeWizard Application Environment
2. Prepare to Install TimeWizard
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Objective 1: Understand the TimeWizard Application Environment

The TimeWizard client/server installation consists of three sections:

1. Network

• TimeWizard Interface Application Server (IAS) and log files
• Reports
• Database setup
• TimeWizard Registration

2. Administrator

3. Timesheet

The TimeWizard Network install resides on your application/file server, visible to all client
machines. The Administrator and Timesheet installs reside on appropriate client machines.

If you are installing TimeWizard from an installation CD, you must copy the Timwiz.ini file
from the application server to all client machines.

If you are performing the setup from a network to a client machine, the Timwiz.ini file is
copied automatically.
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Running the Interfaces from an Application Server

Import and export processes tend to consume substantial computer resources. In the interest
of efficiency, security, and convenience, the TimeWizard data interfaces must be run on an
application server, with the execution initiated and controlled from a TimeWizard Adminis-
trator client workstation.

The Administrator application does not have to be running for the scheduler/interfaces to run.

Figure I.1 illustrates the TimeWizard Application Environment, which outlines the relation-
ship between the TimeWizard administror/client machines, the TimeWizard.enterprise web
server, the TimeWizard database, and the application server.

Figure I.1
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Setting up the TimeWizard Server Application

The server application is stored and executed on an application server. The server application
also is required to be in run mode at all times. The traffic signal displayed on the application
server’s main window indicates whether the service status is active or inactive. The green light
indicates it is active; the red light indicated it is inactive. In addition you can start or stop the
service manually, if necessary.

You are required to assign a port number for the application/service in the SERVICES file on
the application server. The TimeWizard server application requires a unique port number on
the server machine.

For example, you could assign a port number as follows in the
\\WINNT\SYSTEM32\SERVICES file:

tw_serv 10014/tcp tw_serv
tw_serv 10014/udp

The InterfaceApp.ini file keeps Interface applications information such as Status, Start time,
and Stop time. The file gets created every time when TimeWizard server starts. It has three
sections:

• Interface Application, which keeps status information for Interface applications
based on the control ID, which can be viewed in the Interface Controller.

• Start Time, which keeps date and time stamp when an application has started
based on the control ID.

• Stop Time, which keeps date and time stamp when an application has stopped
execution based on the control ID.

Setting up the TimeWizard Administrator Application

In the TimeWizard Administrator system Hosts file, you are required to declare the TCP/IP
address of the application server where the TimeWizard server application resides.

In addition, you must also identify the HostName and Port number under the [Application
Server] heading in the TimWiz.ini file:

HostName = Dev005
Port = 10014
IP Address = DEV0005
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Objective 2: Prepare to Install TimeWizard

Before you install TimeWizard, consider the following:

You will need the following to install TimeWizard successfully:

• The drive letter of the CD-ROM drive where you will insert the TimeWizard
installation CD-ROM

• The drive letter of the hard drive (your application/file server) where you want
TimeWizard installed

• The TimeWizard CD-ROM and this manual

Read the Software License Agreement

Be sure to read the license agreement before you install TimeWizard. This document informs
you of your rights as a purchaser of the product as well as the limitations and responsibilities to
which you agree by using TimeWizard.

E-mail System Requirements

If you have a MAPI 1.0-compliant e-mail system, users will be able to send e-mail messages
from TimeWizard Administrator and from the client/server TimeWizard timesheet. In addi-
tion, you can choose to have e-mail messages sent automatically to client/server timesheet
users upon approval or rejection of their timesheets by managers.

If you have an SMTP mail server, users will be able to send e-mail messages from
TimeWizard.enterprise. In addition, you can choose to have e-mail messages sent automati-
cally to TimeWizard.enterprise users upon approval or rejection of their timesheets by manag-
ers.

The TimeWizard Exception Processor can send e-mail messages to specified individuals re-
garding exceptions, such as missing approvals or rejected timesheets. For information on sys-
tem setup procedures for the Exception Processor, see the TimeWizard Implementation Guide.
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Technical Support

LaborLogix, Inc. provides free technical support for 30 days following TimeWizard installa-
tion. After that time, you may purchase a technical support contract.

For technical assistance with TimeWizard, contact a technical representative at LaborLogix,
Inc.:

Phone: 1-(888) 463-9973

Fax: (301) 718-5141

Email: Support@LaborLogix.com

When you contact us, please have the following ready for the technical support staff:

• Your company name
• Your company’s telephone and fax numbers
• Your TimeWizard serial number
• Information about your computer configuration—such as your database

management system.
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1C H A P T E R

Installing TimeWizard

The TimeWizard installation process utilizes the InstallShield wizard, which displays dialog
boxes to help guide you through each installation step. Objective 1 of this chapter covers
installation dialog boxes 1-4. After you complete installation dialog boxes 1-4 and accept the
TimeWizard Software License Agreement, you may proceed to Objectives 2, 3, or 4 to select
and install specific TimeWizard files to your system.

Objectives

1. Start the TimeWizard Installation
2. Complete the TimeWizard.enterprise Installation
3. Configure the browser settings for TimeWizard.enterprise
4. Complete the TimeWizard Administrator Server/TimeWizard IAS Installation
5. Complete the TimeWizard Timesheet Client Installation
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Objective 1: Start the TimeWizard Installation

The first steps in installing TimeWizard include the license agreement, database selection, and
user registration. These dialog boxes are identical for each product installation.

3. Or click the Start button and then select “Run” from
the Start button menu.

Then in the Run dialog box, type the drive specifica-
tion followed by the file name “Setup” (or click on
the Browse command button to locate the setup file)
and click OK.

4. TimeWizard launches the InstallShield Wizard, which
guides you through the rest of the installation process.

Starting the TimeWizard Installation

To start the TimeWizard Installation, follow these steps:

1. Insert the TimeWizard CD-ROM into the CD-ROM drive.

2. Open Windows Explorer to view the contents of the
TimeWizard Install CD.

Then in the TimeWizard CD contents display (in Windows
Explorer) double-click on the TimeWizard Setup icon
to open the TimeWizard Install Welcome dialog box and
begin the installation process.

Figure 1.1

There are instances during the installation process when TimeWizard may display a dialog
box that prompts you to take a certain action before proceeding.
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Example 1: If you have an earlier version of the application installed, TimeWizard displays a message
suggesting that you abort the current installation until you have uninstalled the earlier version.
(See Figure 1.2.)

Example 2: Before installing TimeWizard.enterprise, you first should install the NetDynamics Application
Server. If TimeWizard cannot detect the NetDynamics Application Server, it displays a mes-
sage suggesting that you exit the TimeWizard installation and install NetDynamics before
proceeding. (See Figure 1.3.)

Example 3: To install TimeWizard Administrator, you must be operating on Windows NT. If TimeWizard
cannot detect the Windows NT operating system, it displays a message suggesting that you
exit the TimeWizard installation and install on a Windows NT system. (See Figure 1.4.)

Figure 1.2

Figure 1.3

Figure 1.4
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Installation Dialog Box 1: Welcome

1. This dialog box explains that the installation
process will copy TimeWizard files to your
computer. It recommends that you exit all
Windows programs before proceeding.

2. Click Next to continue or Cancel to exit the
installation.

Figure 1.5

Installation Dialog Box 2: Database Selection

1. This dialog box enables you to select which
database files are copied to your system. The
choices are Oracle, Microsoft SQL. Your selection
depends on which database you use currently.

2. Click Back to return to the previous dialog box or
Next to continue or Cancel to exit the installation.

Figure 1.6
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Installation Dialog Box 3: User Information

1. Enter your name and company as you would like
for those entries to appear in the TimeWizard
registration. By default, TimeWizard populates
the data fields based on settings from the host
machine system registry.

2. Enter the Activation Key in the data field. The
activation key is supplied with the software.

If necessary, call TimeWizard Technical
Support for assistance with your activation
key.

3. Click Back to return to the previous dialog box or
Next to continue or Cancel to exit the installation.

Figure 1.7
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Objective 2: Complete the TimeWizard.enterprise Installation

After you complete installation dialog boxes 1-4 and accept the TimeWizard Software License
Agreement, you may begin to select and install specific TimeWizard.enterprise files to your
system.

The files available for download depend on the TimeWizard activation key you entered in
dialog box 3.

Installation Dialog Box 5: Language Selection

1. This dialog box enables you to select one or
more language files to copy to your system.
TimeWizard.enterprise currently is available in
English, French, and German.

2. Click Back to return to the previous dialog box
or Next to continue or Cancel to exit the
installation.

Figure 1.9
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Installation Dialog Box 6: Select Components

1. This dialog box enables you to select the
components you want to install and to clear
the components you do not want to install.

For each component selected,
TimeWizard displays a file description.
In addition TimeWizard displays a
running tally of space required for all
selected components as well as the
space available on your C: drive.

2. Click Back to return to the previous dialog box
or Next to continue or Cancel to exit the
installation.

Figure 1.10

Installation Dialog Box 7: Destination Location

1. This dialog box enables you to select a destina-
tion folder in which all of the selected compo-
nents will be installed. The default destination is
the C: drive of the host computer. Click the
Browse command button specify a new
destination.

2. Click Back to return to the previous dialog box or
Next to continue or Cancel to exit the installation.

Figure 1.11
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Installation Dialog Box 8: Destination Location (NetDynamics)

1. This dialog box enables you to select a
destination folder in which all of the
NetDynamics-based Project files will be installed
and a destination folder in which all of the Help
files will be installed. The default destination of
each is the C: drive of the host computer. Click
the Browse command button to specify a new
destination.

2. Click Back to return to the previous dialog box,
or Next to continue, or Cancel to exit the
installation.

Figure 1.12

Installation Dialog Box 9: Select Program Folder

1. This dialog box enables you to name the Program
folder in which all of the TimeWizard timesheet
program icons will be installed. The default name
of the Program folder is TimeWizard 3.0.

2. Click Back to return to the previous dialog box, or
Next to continue, or Cancel to exit the installa-
tion.

Figure 1.13
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Installation Dialog Box 10: Application Server Address

1. Enter the IP address of the application server in
the data field.

2. Enter the Host name of the application server in
the data field.

3. Click Back to return to the previous dialog box
or Next to continue or Cancel to exit the
installation.

Figure 1.14

Installation Dialog Box 11: Start Copying Files

1. This dialog box summarizes your installation
settings and gives you a final opportunity to alter
any selections.

2. Click Back to return to the previous dialog box or
Next to continue or Cancel to exit the installation.

Note: Clicking Next begins the TimeWizard
installation.

3. Click Finish to complete Setup.

Figure 1.15
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Objective 4: Complete the TimeWizard Administrator/TimeWizard IAS Installation

After you complete installation dialog boxes, you may begin to select and install any combina-
tion of specific TimeWizard files to your server.

The files available for download depend on the TimeWizard activation key you entered in
dialog box 3.

Stop! It is not time to run TimeWizard. You must first do the following:

Figure 1.16

Configuring the browser settings

To configure the browser settings,
follow these steps:

1. Open the NetDynamics Command Center.

2. Click on the Connection Processor Service
from the hierarchy in the left frame of the
NetDynamics Command Center sreen.

3. Click on the Browsers tab.

4. Make sure the Frames Support, Dynamic
Frames Support, and Java Script Enabled
check boxes are checked for MSIE4 and
Mozilla/4.

5. Save the changes.

6. Select Action > Restart from the main menu
to restart the CP Service.

7. Select Utilities > Clear Cache to clear cache.

These are not default settings.

Objective 3: Configure the browser settings for TimeWizard.enterprise

There are specific browser settings required for TimeWizard.enterprise that you can set in
NetDynamics from the command center.  All kinds of browser errors can occur in
TimeWizard.enterprise without these set.



TimeWizard

47Chapter One • Installing Time Wizard

Installation Dialog Box 5: Language Selection

1. This dialog box enables you to select one or
more language files to copy to your system.
TimeWizard client-server currently is available
in English only.

2. Click Back to return to the previous dialog box
or Next to continue or Cancel to exit the
installation.

Figure 1.17

Installation Dialog Box 6: Select Components

1. This dialog box enables you to select the
components you want to install and to clear
the components you do not want to install.

For each component selected,
TimeWizard displays a file description.
In addition TimeWizard displays a
running tally of space required for all
selected components as well as the
space available on your C: drive.

2. Click Back to return to the previous dialog box
or Next to continue or Cancel to exit the
installation.

Figure 1.18
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Installation Dialog Box 8: Select Program Folder

1. This dialog box enables you to name the
Program folder in which all of the TimeWizard
timesheet program icons will be installed. The
default name of the Program folder is
TimeWizard 3.0.

2. Click Back to return to the previous dialog box
or Next to continue or Cancel to exit the
installation.

Figure 1.20

Installation Dialog Box 7: Destination Location

1. This dialog box enables you to select a destina-
tion folder in which all of the selected compo-
nents will be installed. The default destination is
the C: drive of the host computer. Click the
Browse command button specify a new
destination.

2. Click Back to return to the previous dialog box or
Next to continue or Cancel to exit the installation.

Figure 1.19
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Installation Dialog Box 9: Application Server Address

1. Enter the IP address of the application server in
the data field.

2. Enter the Host name of the application server in
the data field.

3. Click Back to return to the previous dialog box or
Next to continue or Cancel to exit the installation.

Figure 1.21

Installation Dialog Box 10: Start Copying Files

1. This dialog box summarizes your installation
settings and gives you a final opportunity to
alter any selections.

2. Click Back to return to the previous dialog box
or Next to continue or Cancel to exit the
installation.

Clicking Next begins the TimeWizard
installation.

3. Click on radio button to restart the computer
now or later, then click on Finish to complete
Setup.

Figure 1.22
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Figure 1.23

Installation Dialog Box 5: Timesheet Documentation Selection

1. TimeWizard displays a Question dialog box asking
whether you want to install the Timesheet
documentation.

2. Click Yes or No to continue.

Objective 5: Complete the TimeWizard Timesheet Client Installation

After you complete installation dialog boxes 1-4 and accept the TimeWizard Software License
Agreement, you may begin to install TimeWizard timesheet files to your client machine.

The files available for download depend on the TimeWizard activation key you entered in
dialog box 3.
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Figure 1.24

Installation Dialog Box 6: Destination Location

1. This dialog box enables you to select a destina-
tion folder in which all of the TimeWizard
timesheet files will be installed. The default
destination is the C: drive of the host computer.
Click the Browse command button specify a new
destination.

2. Click Back to return to the previous dialog box or
Next to continue or Cancel to exit the installation.

Installation Dialog Box 7: Select Program Folder

1. This dialog box enables you to name the
Program folder in which all of the TimeWizard
timesheet program icons will be installed. The
default name of the Program folder is
TimeWizard 3.0.

2. Click Back to return to the previous dialog box
or Next to continue or Cancel to exit the
installation.

Figure 1.25
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1. This dialog box summarizes your installation
settings and gives you a final opportunity to
alter any selections.

2. Click Back to return to the previous dialog box
or Next to continue or Cancel to exit the
installation.

Clicking Next begins the TimeWizard
installation.

3. Click on Finish to complete Setup.

• Set up the TimeWizard Database. See Chapter 2 for complete instructions.

• For Oracle: The Database Administrator must create an alias for the Oracle server.
The Oracle user must be assigned a role that includes connect, DBA, a n d
resource privileges.

For Oracle, three table spaces are required: TWMAIN, TWIndexes, and TWInterfaces. In
addition, the DBA should work with a TimeWizard technical support representative to deter-
mine sizing requirements for the database, based on volume projections for number of users
and activities.

Summary

Once you have completed installing the TimeWizard application, your next step is to set up
the TimeWizard database and registration.

Installation Dialog Box 8: Start Copying Files

Figure 1.26
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Working With the TimeWizard
Database

In this chapter, you learn how to set up or upgrade your TimeWizard Database and register
the system. TimeWizard provides a simple database setup that is performed only once during
the initial setup of your TimeWizard system. The completion of the database setup also writes
all database connection information to the Timwiz.ini file.

Before running database setup, you must copy the “twreg.dat” registration file to the network
TimeWizard directory. This file is provided by a TimeWizard technical support representative
and is necessary for you to register licensing information to the database.

If you upgraded TimeWizard from an earlier version of the TimeWizard 3.x product line, you
may want to continue using the same TimeWizard database, which already contains your
organization’s employees, assignments, and other data. In that case, you will upgrade the
database instead of performing the database setup for a new database.

Objectives

1. Execute the Database Setup or Database Upgrade
2. Set Up the TimeWizard Database
3. Modify Your TimeWizard Database Setup
4. Register TimeWizard
5. Upgrade the TimeWizard Database
6. Purge Data from Your TimeWizard Database
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Objective 1: Execute the Database Setup or Database Upgrade

The TimeWizard database setup is a separate executable from the TimeWizard Administrator.

Objective 2: Set Up the TimeWizard Database

TimeWizard provides a simple database setup that is performed only once during the initial
setup of your TimeWizard system. Table 2.1 explains each area and command button avail-
able in the Setup Database window. If you are upgrading from an earlier version of the
TimeWizard 3.x product line and want to use your existing TimeWizard database, continue
with Objective 5 instead of setting up a new database.

Do not use uppercase passwords for the database password. In addition, due to encryption
limitations, do not begin or end with the letter “p.”

Executing the Database Setup or Upgrade

To execute the database setup or upgrade,
follow these steps:

1. Locate the TimeWizard group window.

2. Double-click on the database icon        in the
TimeWizard Group window or select “Database
Setup” from the TimeWizard Start Menu folder to
open the Database Setup Login window.

3. Select DB Setup or Upgrade.

4. Enter the Database Setup password in the data field.
The password was supplied with your TimeWizard
software.

If necessary, call TimeWizard Technical
Support for assistance with your Database
Setup password.

Figure 2.1
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4. In the Database Characteristics area, click or tab to
specify the name of the server on which the TimeWizard
database resides.

If you selected Oracle 7.x or Oracle 8.x as your
Database Server, enter all letters in the Server

Name in uppercase. If you selected Oracle 7.x, enter the
symbol “@” as the beginning of the Server Name.

5. In the Database Characteristics area, click or tab to
specify the name of the TimeWizard database.

If you selected Oracle 8.x as your Database
Server, make the Database Name exactly the

same as the Server Name.  If you selected Oracle 7.x,
make the Database Name the same as the Server Name,
but without “@.”

6. In the Database Characteristics area, click or tab to
specify the file name prefix for the database archive.

7. In the Database Characteristics area, click or tab to
specify the user name of the database owner.

Setting Up the TimeWizard Database  (continued on page 54)

1. In the Setup Database window, click on the drop-down box at
the top of the screen to display a list of valid DBMS Servers.
Click on the appropriate server used by your company.

This selection must be in synch with your database selection
during TimeWizard installation. If your installation
selection was either Sybase or SQL, your database

server options are either Sybase or MS SQL Server. If your
installation selection was Oracle, your database server options
are either Oracle 7.x or Oracle 8.x (for Oracle 8i, select Oracle
8.x).

2. In the Language area, select a language for the database. This
selection must be in synch with your language selection(s)
during TimeWizard installation.

You may only have one language selection per
database.

3. In the Decimal Representation area, click or
tab to specify whether you want to represent decimals by a
period or a comma.

To set up the TimeWizard database, follow these steps:
Figure 2.2
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Objective 3: Modify Your TimeWizard Database Setup

Setting Up the TimeWizard Database  (continued from page 53)

8. In the Database Characteristics area, click or tab to specify the
password of the database owner.

Do not use uppercase passwords for either the
database password or the user-level TimeWizard

password—lowercase only!

9. In the Application Server Characteristics area, click or tab to
specify the path to the directory on your server where the
Network TimeWizard files have been installed.

10. In the Application Server Characteristics area, click or tab to
specify the name of the application server machine.

11. In the Application Server Characteristics area, click or tab to
specify the port number of the application server machine.

12. Once you have entered the appropriate information in
all the fields, click on the Execute command button to
begin the database setup. If errors occur during the
database setup, TimeWizard displays a message
advising you to check the log file for detailed error
messages. In this event, seek assistance from your
Database Administrator or a TimeWizard technical
representative.

13. Follow the steps in Objective 4 of this chapter to
register TimeWizard.

14. Click on the Done command button to complete the
process and exit the Setup Database window.

You may not change the DBMS.

2. Click on the Modify command button at the bottom of
the Setup Database window. TimeWizard displays the
Warning dialog box. Click OK to continue.

3. Click on the Done command button to complete the
process and exit the Setup Database window.

To modify your TimeWizard database setup, follow these steps:

 Modifying Your TimeWizard Database

1. Edit the boxes you want to modify. You can change the
physical location (server) on which the TimeWizard
database resides.  You also can change the database
name, password, or path for TimeWizard files, as well as
modify the archive prefix. (See Objective 2 for rules for
these text boxes.)

Figure 2.3
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Table 2.1: Set up Database Data and Commands

dnaataDesabataDputeS

sdnammoC

noitanalpxE

revreSesabataD .noitallatsnidraziWemiTgnirudnoitcelesesabatadruoyhtiwhcnysniebtsumnoitcelessihT

roesabySrehtieerasnoitporevresesabatadruoy,LQSroesabySrehtiesawnoitcelesnoitallatsniruoyfI

.revreSLQSSM

.x.8elcarOrox.7elcarOrehtieerasnoitporevresesabatadruoy,elcarOsawnoitcelesnoitallatsniruoyfI

egaugnaL .noitallatsnidraziWemiTgnirudnoitcelesegaugnalruoyhtiwhcnysniebtsumnoitcelessihT

.esabatadrepnoitcelesegaugnalenoevahylnoyamuoY:etoN

noitatneserpeRlamiceD .ammocarodoirepaybslamicedtneserperottnawuoyrehtehwyficepsotuoyselbanesihT

emaNrevreS ees,sesabatadelcarOroF(.sediseresabataddraziWemiTehthcihwnorevresehtfoemanehtsisihT

).2evitcejbO

emaNesabataD ).2evitcejbOees,sesabatadelcarOroF(.esabataddraziWemiTehtfoemanehtsisihT

xiferPemaNevihcrA .evihcraesabatadehtrofxiferpemanelifehtsisihT

)renwOBD(emaNresU .renwoesabatadehtfoemanresuehtsisihT

)renwOBD(drowssaP .renwoesabatadehtfodrowssapehtsisihT

tonoD!ylnosdrowssapesacrewolesu—drowssapesabatadehtrofsdrowssapesacreppuesutonoD:etoN

".p"rettelehthtiwdrowssapesabatadehtdneronigeb

roFhtaPrevreSnoitacilppA

seliFdraziWemiT

.selifnoitacilppakrowtendraziWemiTehtfonoitacolehtseificepssihT

emaNtsoHrevreSnoitacilppA .enihcamrevresnoitacilppaehtfoemanehtsisihT

rebmuNtroPnoitacilppA .enihcamrevresnoitacilppaehtforebmuntropehtsisihT

nottuBdnammoCretsigeR .drowssapnoitartsigerehtretneuoyhcihwni,xobgolaidnoitartsigerehtsneponottubdnammocsihT

nottuBdnammoCeliFgoL ynasretnedraziWemiThcihwotnielifgolehtfoemanehtyficepsotuoyselbanenottubdnammocsihT

.putesesabatadehtgniruddetarenegscitsongaidrorre

nottuBdnammoCetucexE .ssecorpputesesabatadehtsetucexenottubdnammocsihT

nottuBdnammoCyfidoM .putesesabatadgnitsixenayfidomotuoyselbanenottubdnammocsihT

yreverofelifini.ziwmiTehtetadpuotyrassecentiekamelifini.ziwmiTehtotsnoitacifidomynA:etoN

.llatsnitneilc

nottuBdnammoCgoLweiV detarenegscitsongaidrorreynatroperhcihw,selifgolgnitsixeweivotuoyselbanenottubdnammocsihT

.putesesabatadehtgnirud



TimeWizard

Section One • Implementing Time Wizard58

Objective 4: Register TimeWizard

TimeWizard registration stamps the database with the product serial number and your
company’s license information.

Registering TimeWizard

To register TimeWizard, follow these steps:

1. Click on the Registration command button at the bottom of
the Setup Database window to open the TimeWizard
Registration dialog box (see Figure 2.4).

2. Specify whether this is a new registration or an upgrade
version to open the appropriate registration password dialog
box (see Figure 2.5).

3. Enter your TimeWizard password, provided to you by your
TimeWizard representative.

4. Click “Done.” TimeWizard executes the registration
process automatically and returns to the Setup Database
window.

Figure 2.4 Figure 2.5

Objective 5:  Upgrade the TimeWizard Database

To continue using your current TimeWizard database after upgrading the application from an
earlier version of the TimeWizard 3.x product line, perform a database upgrade instead of
setting up a new database.

After upgrading your TimeWizard database, you do not have to register TimeWizard again.
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Objective 6: Purge Data from Your TimeWizard Database

The purge function in TimeWizard allows you to delete unneeded data from your TimeWizard
database. TimeWizard saves purged data to tab-delimited ASCII files in directories that you
specify. You may choose to purge unneeded data to prevent your TimeWizard database from
becoming too large and cumbersome. Carefully consider which data to purge. Purged data
will not be available for TimeWizard Reports or export to external systems.

Making a backup of your TimeWizard database before using the purge function is highly
recommended.

Upgrading the TimeWizard Database

To upgrade the TimeWizard database,
follow these steps:

1. In the Upgrade Database window, review the
current setup information about your
TimeWizard database. To modify information,
click or tab to a text box and follow the rules in
Objective 2 regarding input for these boxes.

2. Click on the Upgrade command button. If
errors occur during the database upgrade,
TimeWizard displays a message advising you to
check the log file for detailed error messages.
In this event, seek assistance from your
Database Administrator or a TimeWizard
technical representative.

3. When you receive the message, “Database
upgrade completed successfully,” click on the
Done command button to complete the
process and exit the Upgrade Database
window.

Figure 2.6
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Purge Criteria

Approval periods, activities, employees, or departments that meet the criteria below may be
purged.

• An approval period can be purged if any and all previous periods are being purged.

• An activity can be purged if no transactions (i.e., timesheet hours) exist for any
associated employee assignment in any period. (Purging an activity purges all associ-
ated resource assignments and employee assignments.)

• An employee can be purged if no transactions exist for the employee in any period.

• A department can be purged if none of the department’s employees have the Depart-
ment status “Pending” or “Approved” for any period. However, the default depart-
ment, i.e., the highest level of the hierarchy in the Departments window, cannot be
purged.

Because approval periods that contain transactions can be purged, you can purge activities or
employees that have transactions by first purging the periods that contain those transactions.
Similarly, you can purge departments that have “Pending” or “Approved” timesheets by first
purging the periods with those statuses. WARNING: When you purge a period, the period is
purged for all employees.

If you purge the current approval period, no employees will be able to log in to their timesheets.
Purge the current period only when you intend to create a new current period immediately.

TimeWizard treats an audit record in the database as a transaction, even when no transaction
is displayed on the employee’s timesheet. If a transaction has been cleared from a timesheet
after the audit time has elapsed or during an Historical Correction, the employee or associated
activity cannot be purged while the period exists in the database.

The Purge Window

The Purge window contains four tab pages, one for each category of data that you may select
(see Figure 2.7). The upper frame of each tab page displays all the data eligible to be purged
from the selected category. While any rows are selected, you cannot open a different tab page.

The Log Files Path text box is located in the lower left frame. Here you will enter the directory
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path where you want purged data to be stored in ASCII files.

The status frame is located in the lower right. The total number of rows available to be purged
in the selected category, i.e., the number of rows in the upper frame, displays at the top of the
status frame. The left column in the status frame lists all the TimeWizard database tables that
may be affected by a purge in the selected category. While rows are selected in the upper
frame, the middle column of the status frame, “Selected,” displays the number of database
records that will be deleted from the corresponding database tables if you proceed with the
purge.

After you complete a purge, the right column of the status frame, “Deleted,” displays the
number of database records that were successfully deleted from the corresponding database
tables. The Total Available Rows indicator is updated to reflect the new number of rows in the
upper frame after the purge. The numbers of deleted records in the column “Deleted” will
display until you choose another tab or exit the Purge window.

Because the purge process removes the selected rows from the upper frame, the column “Se-
lected” will display zeros after the purge has been executed. If you want to compare the num-
ber of rows deleted with the number of rows that were selected for each table, note the num-
bers from the column “Selected” before clicking on the Purge command button.

Figure 2.7
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Purging Data from your TimeWizard databasePurge Preparations

Make a backup of your TimeWizard database.

Create a subdirectory for each category of data that you will purge. The purge function creates
a separate ASCII file for each affected database table every time you purge. TimeWizard
names each file with the date, time, and table name. (With United States English operating
systems, the file name format is mmddyy_hhmm_tablename. With German or French operating
systems, the file name format is ddmmyy_hhmm_tablename.) Because different categories of data,
such as activities or employees, affect some of the same tables, file names for purged data may
be nearly identical. To avoid confusion, make separate subdirectories for each category of
data.

Before purging data from the database, users of all TimeWizard applications connected to that
database should exit the applications. The NetDynamics application that runs on the applica-
tion server for TimeWizard.enterprise must be stopped prior to the purge.

To purge data, follow these steps:

1. Select Purge from the TimeWizard Tools menu (Tools >
Purge) to open the Purge window.

2. Click on the tab of the category of data you want to
purge:

Figure 2.8

• Periods
• Activities
• Employees
• Departments

Purging Data from your TimeWizard database (continued on page 61)
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3. Select the item(s) you want to purge by clicking on the
desired row(s) in the upper frame.

To select multiple rows in sequence, click on the
top row you want to select and press <Shift> +

click on the bottom row you want to select. To select
multiple rows not in sequence, click on the top row you
want to select and press <Control> + click on each
additional row you want to select.

You can select all rows on the tab page by clicking on the
Select All command button. This action will select rows
that may become visible only by scrolling downward.

A message displays on the bottom of the tab page to
warn that “Selected Row(s) will be permanently deleted
from the following tables.”

4. To deselect rows, click on the Deselect All command
button. You may now select another set of rows on this
tab page, select a different tab page, or safely exit the

Purging Data from your TimeWizard database (continued from page 60)

If you have an Oracle database, you cannot select more than 254 records at one time.

Purge window.

5. In the Log Files Path text box, enter the directory path in
which you want to store the ASCII files of purged data. To
choose an existing path, click on the Browse button. To
create a new path, type the path in the text box and then
click on the Create button. A directory path must display
in the Log Files Path box to complete the purge.

To add a new subdirectory to an existing path, browse to
select the path, type a backslash (\) and the new
subdirectory name, and click on the Create
button.

6. To complete the purge process, click on the Purge
command button. A dialog box will open to ask whether
you want to delete the selected rows permanently from
the database. Click on Yes to complete the purge or No
to return to the Purge window.
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Summary

In this chapter you have learned the steps necessary to set up or upgrade your TimeWizard
database and to purge data as necessary.



2
S E C T I O N  T W  O

Customizing TimeWizard

TimeWizard and Top Hits

Consider TimeWizard as a jukebox that just arrived at your diner—without any
music pre-installed. You have some decisions to make before your customers can

enjoy it. First, you must decide what styles of music your customers want to hear—
Rock, Country, Dance/Pop? Then, you must select specific song titles within each
style of music—“Fly Away,” by Lenny Kravitz; “That Don’t Impress Me Much,” by
Shania Twain; or “It’s Not Right But It’s Okay,” by Whitney Houston?

When you have finished adding the musical styles and selections, your jukebox be-
comes unique to your establishment, different from any other because of the choices
made to please your specific customers.

This is not so different from the steps needed to customize TimeWizard for your
company. TimeWizard in one company is different from TimeWizard in any other
company, because each customer customizes the system to meet very specific needs.

First—just as you selected styles of music for the jukebox—you must decide what
categories of information the system must capture. This is driven by the needs of your
customers, or rather the departments in your company with which TimeWizard will
share data. Such categories of information could be Projects and Subprojects for your
Project Manager “customers,” or Shift and Pay Code for your Payroll “customers.”

Next, you must select specific values within each category. Just as each style of music
needs songs to play on the jukebox, each category of information needs specific values
to work in TimeWizard. Such values could be as simple as Shift designations (e.g.,
Shift 1, Shift 2, and Shift 3) for your Payroll “customers.”

This section includes

Chapter 3: Defining TimeWizard Custom Fields
Chapter 4: Assigning Code Values to the Custom Fields
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3C H A P T E R

Defining TimeWizard Custom
Fields

TimeWizard is designed to integrate with a variety of other corporate systems—such as those
used in Project Management, Accounting, Payroll, Information Services, and Billing depart-
ments. Custom fields define the broad categories of information that TimeWizard will cap-
ture and then share with the applications used by these other corporate departments.

Before you begin entering custom fields in to the TimeWizard system, you must be
able to answer these questions:

• With what systems does your company want TimeWizard to interface, that is, what
other software applications will share data with TimeWizard? Examples include project
management applications such as Microsoft Project 98, Primavera P3, or Business
Engine Project Server. Or ERP systems such as PeopleSoft, Baan, or SAP.

• What data do you need to capture in TimeWizard? Only the departments that use
the other systems can answer this question. For example, project managers need
project information such as how much time has been charged against a particular
project. Human Resource managers need employee information such as how much
sick leave a particular employee has used. Payroll managers need pay code informa-
tion such as how much regular time or overtime an employee worked in a given
week.

When you have consulted the appropriate department managers and have all the answers to
the preceding questions, you can begin to set up TimeWizard custom fields.

Objectives

1. Navigate the Custom Fields window
2. Define activities fields
3. Define detail codes fields
4. Define employee fields
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5. Apply default definitions to custom fields
6. Modify custom field data

Objective 1: Navigate the Custom Fields window

TimeWizard has three categories in which you can setup custom fields: Activities, Detail
Codes, and Employees. In the Custom Fields window, each Custom Field category is repre-
sented as a tab.  Table 3.1 explains the role of each category in TimeWizard. Table 3.2 explains
the contents and options available in all of the Custom Field windows. Specific instructions
concerning the setup procedures are explained in following objectives.

Navigating the Custom Fields window

1. Click on the Custom Fields icon.

2. Select Tools > Custom Fields from the TimeWizard main
menu.

To open the Custom Fields window, follow either of
these steps:

Figure 3.1
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Table 3.2: Custom Fields Window Contents

Table 3.1: Custom Field Category
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Objective 2: Define activities fields

You can identify key and non-key fields that define an activity in your TimeWizard system.
The key fields define a unique record in the TimeWizard database. The non-key fields define
additional data that you want to capture for each activity record.

Each field may be defined to up to 255 characters.

Example Figure 3.2 shows an example Activities dialog box in which we have defined three key activity
fields named “Project,” “Task,” and “Phase.” In this example, we also entered four non-key
activity fields named “GL#,” “GL Name,” “Job ID,” and “Job Name.” We enabled the dis-
play option for the key fields only. We enabled the quickfilter option for all fields.

Defining activities fields

Figure 3.2

1. Click on the Activities tab to open the Activities custom
fields dialog box (Tools > Custom Fields > Activities).

2. Click the Caption text box and enter the name of the field.

3. Click on the Length text box and enter the desired
maximum length of data the field is to contain in the
timesheet.

4. Enable the display and quickfilter options for each key and
non-key field as desired.

5. Click “Apply” to save the settings but remain in the
Custom Fields window, or click “OK” to save the settings
and exit the Custom Fields window.

The Timesheet Display window at the bottom of the Activities
Custom Fields window illustrates how your
activities custom fields configuration appears on
the timesheet. Only fields for which you enabled
the Display option are shown in the Timesheet
Display window (and consequently on the
timesheet).

To define activities fields, follow these steps:
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Objective 3: Define detail codes fields

In this section, you define Detail Code fields that specify what types of time an employee may
apply to a timesheet transaction. The Detail Codes Custom Field dialog box consists of ten
fields for user-defined detail codes.

You must define at least one detail code custom field.

Example Figure 3.3 shows an example Detail Codes Custom Fields dialog box in which we defined
detail code fields entitled “Cost Type,” “Billing Code,” and “Pay Code (1-3).”

Defining detail codes fields

Figure 3.3

1. Click on the Detail Codes tab to open the
Detail Codes Custom Field dialog box (Tools >
Custom Fields > Detail Codes).

2. Click the Caption text box and enter the name
of the code.

3. Click on the Length text box and enter the
desired maximum length of data the code is to
contain in the timesheet.

4. Click on “Apply” to save the settings but
remain in the Custom Fields window, or click
“OK” to save the settings and exit the Custom
Fields window.

To define detail codes fields, follow these steps:
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Objective 4: Define employee fields

Employee fields and their associated values enable you to define the fields that make up an
employee record in TimeWizard. There are four preset employee key fields:

• Resource Code
• Department Code
• Employee Code
• Salary Code

You also have the option of customizing eight non-key fields.

Defining employee fields

To set up employee fields, follow these steps:

1. Click on the Employees tab of the Custom Fields window.

2. For each of the preset key fields—Resource Code,
Department Code, Employee Code, Salary Code—specify
the length (see Table 3.1).

3. For the Department Code, Employee Code, Salary Code
fields, specify whether or not you want to use the
quickfilter option (see Table 3.1).

4. Click “Apply” to save the settings but remain in the
Custom Fields window, or click “OK” to save the settings
and exit the Custom Fields window.

Figure 3.4

Example Figure 3.4 shows an example Employees custom field dialog box that contains the four pre-
defined fields: Resource field, Department Code field, Employee Code Field, and Salary
Code Field. In addition, we added two non-key fields: “SSN,” and “Employee Status.”
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Objective 5: Apply default definitions to custom fields

At any time during the custom field definition process, you can revert to the default settings in
any custom field row for any of the categories. On previously unused cells, the default setting
is “<unused>.”

Applying defaults

To apply defaults, follow these steps:

1. Select the incorrect field.

2. Click the “Defaults” command button to open the Apply Defaults dialog box (see Figure 3.4).

3. Select your preference to apply defaults to current field, current row, or all rows.

4. Click “OK” to execute the Defaults command.

Figure 3.5

Objective 6: Modify custom field data

You should consider very carefully any modifications to your TimeWizard custom field defi-
nitions, because such modifications may affect the meaning of historical data (e.g., within
current, closed or archived periods). If you alter the meaning of historical data, you possibly
change data relationships throughout TimeWizard.

Modifying custom field data

To modify custom field data, follow these steps:
1. Click on the custom field category tab that contains the data

you want to change (i.e., the tabs for Activities, Detail Codes,
or Employees).

2. Click the appropriate cell and overwrite its content as
desired.

3. When you attempt to save the settings (“Apply” or “OK”),
TimeWizard displays a warning to remind you of the
ramifications of such modifications (see Figure 3.6).

If you do not want to save the changes:

Click “No” to return to the selected dialog box without
saving the changes.

If you want to save the changes:

Click “Yes” to exit the TimeWizard warning dialog box.

4. Click “Apply” to save the settings but remain in the
Custom Fields window, or click “OK” to save the settings
and exit the Custom Fields window.

Figure 3.6
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Summary

In this chapter, you have learned how to define the broad categories of information that
TimeWizard will capture and then share with the applications used by these other corporate
departments. In the next chapter, you learn how to add values to each TimeWizard custom
field category.
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4C H A P T E R

Assigning Code Values to the
Custom Fields

In the introduction to this section, we compared TimeWizard to a jukebox—with the custom
fields compared to musical styles and the code values compared to specific songs within each
style. We also stated that the style and song selections are driven by the preferences of your
customers. With that in mind, we suggested in Chapter 3 that you consult the appropriate
department managers to review their needs. In this chapter, we show you how to put those
decisions to work by adding code values to each TimeWizard custom field category—i.e.,
Activity, Detail Codes, and Employees. TimeWizard users (i.e., your company’s employees)
can then select those values on their timesheets to better define their transactions.

For example, if your company’s Payroll managers needed TimeWizard to capture pay code
information, you could have set up a detail code custom field entitled “Pay Codes.”  For
TimeWizard to capture specific information  within this custom field category, you could add
specific pay code values, such as “regular time” or “overtime.”

Objectives

1. Navigate the Code Values window
2. Assign activity code values to activity fields
3. Assign detail code values to detail code fields
4. Assign code values to employee code fields
4a. Assign employee code values to employee fields
4b. Assign salary code values to employee fields
4c. Assign resource code values to employee fields
5. Assign code values to DataBridge targets
6. Modify or delete code values
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Objective 1: Navigate the Code Values window

The Custom Field categories—Activities, Detail Codes, and Employees—comprise the tabs
in the upper Code Values window. As you click from one tab to another, the lower tabs
represent key (preset or custom) and required fields associated with each Custom Field cat-
egory. Table 4.1 explains each area of the Code Values window.

Navigating the Code Values window

Figure 4.1

1. Click the Code Values icon on the toolbar.

2. Select Tools > Code Values from the TimeWizard main menu.

To open the Code Values window, follow these steps:

Table 4.1: Code Value Fields
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Objective 2: Assign activity code values to activity fields

Within each Activity field, you can assign specific values. You later will use unique combina-
tions of these activity values to build unique activities.

Once you use an activity code to build an activity, it can no longer be deleted.

Assigning activity code values to activity fields

To assign activity code values to an activity field, follow these steps:

1. Click on the Activities category tab to open the Activities
dialog box.

2. Click on the activity custom field tab for which you want to
assign a value.

3. Click “Add.”

4. Click on each blank text box to define the code
values by typing the code, name, and description (if
desired). The “code” and “name” are required fields
for all code values. Once you have entered the code,
click “Apply” (or press the tab key on your
keyboard), and TimeWizard enters the name
automatically.

Figure 4.2

Example In the example custom field definitions in Chapter 3,  the example Activities Codes dialog
box in Figure 4.2 contains custom fields for Project, Task, and Phase (displayed as the lower
tabs). In this example, we assigned multiple code values for the Project field.
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Objective 3: Assign detail code values to detail code fields

The code values that you assign to each Detail Code Custom Field category specify what types
of data an employee may associate with a particular timesheet hours entry. For example, using
multiple detail code values, an employee may divide a 10-hour work day into 8 hours of
regular time and 2 hours of overtime.

Once you use a detail code in a business rule or timesheet transaction, it cannot be deleted.

Assigning detail code values to detail code fields

To assign detail code values to detail code fields, follow these steps:

1. Click on the Detail Codes category tab to open the Detail
Codes dialog box.

2. Click on the detail codes custom field tab for which you
want to assign a value.

3. Click “Add.”

4. Click on each blank text box to define the code
values by typing the code, name, and description (if
desired).

Figure 4.3

Example Based on the example custom field definitions in Chapter 3, the example Detail Codes dialog
box in Figure 4.3 contains custom fields for Cost Type, Billing Code, and Pay Codes 1-4
(displayed in the lower tabs). In this example, we assigned have assigned multiple code values
for the Cost Type field.
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Objective 4: Assign code values to employee code fields

The Employees tab of the Code Values window is comprised of three of the four preset
employee key fields: Employee Code, Salary Code, and Resource Code. You complete the
customization process for the Department field in the TimeWizard Administrator Depart-
ments window. Once you use an employee code in an employee record, it cannot be deleted.

Objective 4a: Assign employee code values to employee fields

Employee code values enable you to specify a unique designation for each employee. For
example, you may use employee code values to designate whether an employee is full-time,
part-time, or contract.

Assigning employee code values to employee fields

To assign employee code values to employee fields, follow these steps:

1. Click on the Employees tab (upper right) of the Custom
Fields window.

2. Click on the Employees Code tab (lower left) of the
Employees dialog box.

3. Click the Add command button to add an empty
value text box.

4. For each new value, enter the employee code, name,
and description (see Table 4.1).

Figure 4.4

Example Based on the example custom field definitions in Chapter 3,  the example Employees dialog
box in Figures 4.4 contains custom fields for Employee Code, Salary Code, and Resource
Code (displayed in the lower tabs). In this example, we assigned multiple code values for the
Employee Code field.
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Objective 4b: Assign salary code values to employee fields

Salary code values enable you to specify a unique salary-level designation for each employee.
For example, you may use salary code values to designate which labor rates are associated with
an employee.

Assigning salary code values to employee fields

To assign salary code values to employee fields, follow these steps:

1. Click on the Employees tab (upper right) of the Custom
Fields window.

2. Click on the Salary Code tab (lower middle) of the
Employees dialog box.

3. Click the Add command button to add an empty
value text box.

4. For each new value, enter the salary code, name,
allowable rates, and description (see Table 4.1).

Figure 4.5

Example Based on the example custom field definitions in Chapter 3,  the example Employees dialog
box in Figures 4.5 contains custom fields for Employee Code, Salary Code, and Resource
Code (displayed in the lower tabs). In this example, we assigned multiple code values for the
Salary Code field.
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Assigning resource code values to employee fields

To assign resource code values to employee fields, follow these steps:

1. Click on the Employees tab (upper right) of the Custom
Fields window.

2. Click on the Resource Code tab (lower right) of the
Employees dialog box.

3 Click the Add command button to add an empty
value text box.

4. For each new value, enter the resource name
(see Table 4.1).

Figure 4.6

Example Based on the example custom field definitions in Chapter 3,  the example Employees dialog
box in Figures 4.6 contains custom fields for Employee Code, Salary Code, and Resource
Code (displayed in the lower tabs). In this example, we assigned multiple code values for the
Resource Code field.

Objective 4c: Assign resource code values to employee fields

Resource code values enable you to categorize your employee by specific talent designations.
One employee may qualify for multiple resource codes. For example, you may use resource
code values to assign an unclassified resource—e.g., any employee qualified to do the job—to
an activity rather than assigning an individual employee.
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Objective 5: Assign code values to DataBridge targets

A key feature of the TimeWizard software is that it enables you to run two-way exchanges of
information—from TimeWizard into other corporate systems and from other corporate sys-
tems into TimeWizard. This feature reduces data entry (thereby reducing human error and
increasing accuracy) and gets TimeWizard and all your departmental systems in synch. The
bulk of interface setup and maintenance is explained in Section 7: Sharing TimeWizard Data
with Other Systems; however, the first step is in the TimeWizard Code Values section.

Just as you have assigned functional values to other TimeWizard fields—Activities, Detail
Codes, and Employees—you do the same for a new field introduced here: the DataBridge
Target field. The values you assign to this area designate certain external systems as targets for
regular DataBridge exports from TimeWizard.

Once you use a DataBridge code to export data, it can no longer be deleted.

Assigning code values to export targets

To assign code values to export targets, follow these steps:

1. Click on the Export Targets category tab to open the Export
Targets dialog box.

2. Click “Add.”

3. Click on each blank text box to define the export
target code values by typing the target name and
description (if desired). TimeWizard automatically
generates the target ID.

Figure 4.7
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Example The example DatabBridge Targets dialog box in Figure 4.7 contains two values that designate
external systems Peoplesoft and SAP as targets for regular updates from TimeWizard. Now
that we have identified these DataBridge targets to the TimeWizard system, we later will be
able to continue the interface setup and maintenance in Section 7: Sharing TimeWizard Data
with Other Systems.

Objective 6: Modify or delete code values

TimeWizard allows you to modify or delete code values as long as no activities, transactions,
employees, or business rule profiles have been assigned to the values. If you attempt to modify
or delete a value that has such associations, TimeWizard displays an error message explaining
that it will not alter the value.

Modifying or deleting code values

To modify or delete code values, follow these steps:

1. Click on a custom field category to open the appropriate
dialog box.

2. Click on the tab of the custom field for which you want to
modify data (if necessary).

3. Click on the “name” or “description” field to select
it.

4. Modify the information as needed:

• Overwrite existing data.

• Click “Delete.”
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Summary

In this chapter, you have learned how to add functionality to each TimeWizard custom field
category—i.e., Activity, Detail Codes, and Employees—by assigning specific code values.
TimeWizard users (i.e., your company’s employees) can then select those values on their
timesheets to better define their transactions. In addition, you were introduced to TimeWizard’s
ability to run two-way exchanges of information and took the first steps toward setting up the
interfaces by designating export targets.



3
S E C T I O N  T H R E E

Defining and Working in
the Approval Process

Your employees enter detailed data in their timesheets, but how would you use
the raw data? Timesheet data becomes the most useful when it is collected in

defined batches, validated, and approved.

TimeWizard offers two types of approval process to help you gather time accounting
information in the form best suited to your organization’s needs. Because you must
choose one of the two types before deploying TimeWizard, this section helps you
understand the purpose of each.

You also must decide the length of time, in days, of each work period for which you
want to collect and approve timesheet data. These periods of time, called “approval
periods,” do not need to be of uniform length.

First, this section will introduce you to the concepts behind approvals. Next, you
will learn to set the approval process type and define approval periods in TimeWizard.
Then, you will learn to view and edit employees’ timesheets and to approve and
reject timesheet data in your organization’s approval process.

This section includes

Chapter Five: Selecting the Right Approval Process for Your Company
Chapter Six: Entering Approval Periods
Chapter Seven: Working in Your Employees’ Timesheets
Chapter Eight: Approving and Rejecting Timesheets for Departments
Chapter Nine: Approving and Rejecting Timesheet Assignments
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Selecting the Right Approval Process
for Your Company

Before you select an approval process and begin to set up approval periods in your TimeWizard
database, you need to answer these questions from a company standpoint:

1. Who or what drives the approval process?
2. Which individuals should belong to selected approval hierarchies?
3. When or how often does your company need to lock data? (Locked data cannot be

modified, except by authorized employees using an auditable correction process.)

We explore each question in the objectives of this chapter. Other sections and chapters of
this guide discuss how you can customize and set up TimeWizard to gather valuable business
data, but the decisions you make in this chapter control how all of that data is validated
within your TimeWizard system, as well as in other corporate systems with which TimeWizard
shares data.

Based on the answers to these questions, you will set TimeWizard to use one of the following
two approval processes:

• Department approvals process (for exclusively department-oriented environments)
• Integrated approvals process (for activity-oriented or combination department/

activity-oriented environments)

Once you have set the approval process, typical approval actions are as follows:

1. Employees enter time on their timesheets for the days within a defined approval
period.

2. When timesheets are complete (i.e., all time and appropriate detail codes for the
current approval period have been entered), the employees submit the timesheets
for higher approval. (Department owners submit the timesheets of employees who
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do not have the preference setting to submit them.) Submitting a timesheet locks
the timesheet data.

3. Based on a global preference setting for the approval process type, authorized de-
partment owners, authorized project managers, or both approve or reject submit-
ted timesheet data. Rejected data is unlocked so that it can be corrected and then
resubmitted for approval.

4. Once all required approvals have been made, the information has been validated
and is ready to be sent to other corporate systems (e.g., payroll, billing, or project
management applications).

Objectives

1. Choose an approvals process
2. Decide which individuals should belong to selected approval hierarchies
3. Decide when or how often your company needs to lock data
4. Set TimeWizard Global Preferences

Objective 1: Choose an approvals process

Which of the following do you want to accomplish in your company?

• Tracking of employees’ hours to help monitor departmental objectives
• Tracking of hours worked on specific activities to help manage projects

TimeWizard enables you to attain either or both of these goals.

In a department-driven environment, the approval process is guided primarily by the pay-
ment cycle of the company. Timesheet data must be validated and locked so that Payroll can
cut the checks. In the department approvals process, an approver can approve or reject
timesheet data for members of a particular department.

In an activity-driven environment, the approval process is guided primarily by the need for
efficient project management. In the integrated approvals process, an approver can approve
or reject timesheet data for employees with particular assignments. This is ideal for cross-
functional project teams, whose team members may belong to different departments. You
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have the option of sending approved activity data to an external project management appli-
cation. Locked actuals (i.e., actual starts, actual hours worked, actual finishes) can be re-
trieved automatically and compared with planned starts, hours, and finishes in the project
management system.

In a combination environment, department managers and project managers both have a
need to approve timesheet data. The integrated approvals process incorporates departmen-
tal approvals and activity approvals. You can send timesheet data that has been validated by
both department managers and project managers to a project management system, to Pay-
roll, and to other corporate systems.

In Objective 4, you will specify your approvals process selection in the TimeWizard Global
Preferences dialog box.

Objective 2: Decide which individuals should belong to selected approval hierarchies

Establishing an approval hierarchy—that is, who approves the timesheets for each em-
ployee—encourages accountability and ensures that the timesheet data is validated before it
is used for business purposes. For the timesheet approval “chain of command” to com-
mence, the timesheet data must first be submitted for approval. In Chapter 16, “Setting Up
Preferences,” you will set a preference that determines whether timesheet owners can sub-
mit their own timesheets. If timesheet owners submit timesheets, individuals accept respon-
sibility for their own timesheet entries. If timesheet owners cannot submit timesheets, then
department owners must submit them. A submittal locks a timesheet against any impermis-
sible alterations during the approval process.

In a department approvals process, the first person to approve the submitted timesheet
could be a department manager or director and is the approver who validates the submitted
timesheet data.  If departments validate timesheet data so that it can be sent to Payroll, then
the final approver—be that the second, third, or other approver—is fiduciary and accepts
responsibility for the amount of the payroll in the payment cycle.

If multiple approvals are required, each approval must occur at a successively higher depart-
ment level in the TimeWizard department tree (see Chapter 10, “Setting Departmental
Approval Definitions”).
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In an integrated approvals process, department approvals are followed by activity approvals.
If your organization needs only activity approvals, the number of required department
approvals can be set to “1.” Then the timesheet submittal will fulfill the requirement for one
department approval, and the timesheet will be available for activity approvals.

In the activity approvals portion of the process, only one approval is required per assign-
ment. The timesheet submittal does not serve as an activity approval. An employee’s timesheet
may include multiple assignments, each under the supervision of a different activity approver.
An activity approver may be authorized to approve multiple activities and the associated
assignments. The approvers are project managers who are ultimately responsible for validat-
ing the hours accrued for a project.

Objective 3: Decide when or how often your company needs to lock data

The length of the approval cycle in a department-oriented environment often depends on
your payroll cycle. The timesheet data must be approved, validated, and locked before the
payroll process can continue. Consequently, whether your payroll is distributed on the 1st
and 15th of the month, every two weeks, or monthly, the approval cycle should coincide
with the payroll cycle.

The length of the approval cycle in an activity-oriented environment depends on how you
use your project management system. You establish automated retrievals of actuals from
TimeWizard to your project management application based on how up-to-date you require
the actuals to be in your system. Complete the following statement: “Our project manage-
ment reports must be accurate as of ...” Your answer—whether it is “one week,” “two
weeks,” or any other span of time—defines the duration of your TimeWizard approval
periods.

Your approval process may need to satisfy different needs for different departments. In a
combination department/activity-oriented environment, the approval process still needs a
hierarchy of accountability but requires a compromise between project reporting and pay-
ment cycles. One possible scenario is that of a company that distributes paychecks biweekly
but must update its project management systems weekly. In this example, weekly approval
periods would be set up. The project management system would be fed locked and approved
data weekly, and the Payroll department could collect data every two weeks.
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Objective 4: Set TimeWizard Global Preferences

After you choose either the department approvals process or the integrated approvals pro-
cess, you specify your selection in the TimeWizard Global Preferences window. The window
also includes other specifications that are discussed in Table 5.1.

Your selection of either the department approvals process or the integrated approvals pro-
cess affects the entire approval process for your company’s time accounting data. If you feel
that you need to change your selection at a later date, we highly recommend that you make
the change only when the following two conditions have been met:

1. All approval periods for which the old approvals process was used are closed.
2. No timesheets have been submitted for the approval periods for which the new

approvals process will be used.

Meeting these conditions is necessary to protect the integrity of your data.
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Table 5.1: Global Preferences
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Setting TimeWizard Global Preferences

To set TimeWizard global preferences, follow these steps:

Figure 5.1

1. Click on the Global Preferences icon          or select Tools >
Global Preferences from the main menu.

2. Specify whether you want TimeWizard to close activities
when all associated resource assignments are closed.

3. Specify whether you want TimeWizard to close resource
assignments when all associated employee assignments are
closed.

4. Specify whether you want to use the department approvals
process or the integrated approvals process.

5. If you specified Integrated Approvals in step 4 above,
click on the Activity Display drop-down box and
select how you want activities to display in the
activity approvals windows of the Integrated
Approvals area.

6. Enter the number of seconds you desire for the
TimeWizard audit time.

7. Click on Apply to save the settings and remain in the
dialog box or click on OK to save the settings and exit
the dialog box
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Summary

Now that you have been introduced to the TimeWizard approval processes, you should be
better prepared to define an approvals process for your company. The deciding question is
usually: Is your company driven by payroll deadlines, by project deadlines, or both? The
department approvals process approves data associated with specific departments (usually at
intervals coinciding with payroll periods). The integrated approvals process combines de-
partment approvals with approvals of data associated with specific activities (often used in
project management).

The approval process type and approval hierarchy determine who approves the timesheet
data. You have also been introduced to approval periods that determine when timesheet data
is locked and becomes available for approval. In addition, you have learned to set TimeWizard
Global Preferences.

In the next chapter, you will learn how to set up approval periods in TimeWizard. For more
information about activities and assignments, see Section 5.
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Entering Approval Periods

In Chapter 5, what did you decide you wanted to accomplish in your company: To track
employees’ hours to help monitor departmental objectives, to track collective hours charged
to specific activities to help manage projects, or both?

In addition, how often did you decide that your company needed to lock its timesheet data? If
you chose a department-oriented approach, then the timesheet data must be approved, vali-
dated, and locked before the payroll process can continue. Consequently, whether your pay-
roll is distributed on the 1st and 15th, every two weeks, or monthly, the approval period cycle
should be concurrent. If you chose an activity-oriented approach, then the approval period
cycle (i.e., the frequency in which you establish automated retrievals of actuals from TimeWizard
to your project management system) depends on how up-to-date you require the actuals to be
in that system. You can accomodate activity approvals or a combination of department and
activity approvals by choosing the integrated approvals process.

Now that you understand the big picture of approval processes and have decided which ap-
proval process your company is going to use—either department approvals or integrated
approvals—we can leave the process discussion for a moment and actually set up approval
periods in your TimeWizard system. An approval period is the length of time, in days, during
which your company wants to capture time accounting data. Once you have set up approval
periods, TimeWizard can gather and lock timesheet data according to your approval process,
making the timesheet entries available for approval and validation. When an approval period
is closed, no more time may be charged to any timesheet in that period without an auditable
correction process. Regardless of which approval process approach you have decided to take,
the steps to set up and maintain an approval period are the same.
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Opening the Approval Periods window

Figure 6.1

Objectives

When you have finished this chapter, you should be able to do the following:

1. Navigate the Approval Periods window
2. Set up a “standard” set of approval periods
3. Customize or maintain an approval period
4. Delete approval periods
5. Close-Out approval periods

Objective 1: Navigate the Approval Periods window

The Approval Periods window enables you to setup your approval period parameters, custom-
ize or enter sets of approval periods, and maintain your approval periods. Table 6.1 includes
explanations of all areas and tools in the Approval Period window.

1. Select Tools > Approval Periods from the TimeWizard Administrator main
menu.

2. Click the Approval Period icon on the TimeWizard Administrator toolbar.

You can do the following in the Approval Period window:

• Define your company’s approval periods (e.g., monthly,
bi-weekly, or customized), using the Standard Periods area

• Setup “standard” sets of approval periods, using the Begin On/End For Year
area

• Customize/maintain periods, using the Period Definition area (and the insert,
delete, or add command buttons)

• Close-out approval periods

To open the Approval Period window, follow either of these
steps:
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Table 6.1: Approvals Window Areas & Tools

Objective 2: Set up a “standard” set of approval periods

The Standard Periods area and the “Begin On/End For Year” area of the Approval Periods window
enable you to define your own approval periods based on commonly used cycles—i.e., 1st and
15th, every two weeks, etc. Once you set up approval periods based on these “standard” selections,
you have the option of moving forward as-is or customizing your own unique cycle (see Objective
3).

If you know that the pattern of your approval periods will remain constant (e.g., 1st and 15th,
every two weeks, etc.), you may find it convenient to produce approval periods for a full year
or to the end of the current year. When you need to add additional approval periods beyond
that point, select the last period and generate more on to the end.
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Figure 6.2

1. Go to the Standard Periods area of the Approval Periods
window. (see Figure 8.2)

2. Click on the radio button that reflects your company’s
standard work period.

3. If you select either “26 Periods (two-week)” or “52 Periods
(weekly),” a “Week Begins On:” drop-down box appears.
(see Figure 8.3)

4. Select the first day of your company’s standard work week.

5. Go to the “Begin On/End For Year” area of the Approval
Periods window.

To set up a standard set of approval periods, follow these steps:

Setting up a standard set of approval periods

6. Enter the desired starting date in the “Begin On” text
box.

The begin date must match the day of the week
indicated in the “Week Begins On” text box.

7. Select the year through which you
want to setup an approval period in the “End For Year”
data window.

8. Click on “Generate” to create your approval period
(displayed in the Period Definition section).

Figure 6.3
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Example Approval Period Window Figure 6.4 shows an example Approval Period window with a set of
approval periods that begins on September 1, 1997 and ends on the last day of 2000. Each
“Start Date/End Date” row reflects a single approval period (either the 1st to the 15th or the
16th to the last day of each month) within a 24-period annual cycle. For the closed periods, no
more time may be charged to any timesheet without an auditable correction process.

The date displays are shown based on the regional settings of your local hard drive (Control
Panel > Regional Settings).

Figure 6.4
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Objective 3: Customize or maintain an approval period

Since your company’s accounting cycles may or may not fall within standard parameters such
as the 1st and 15th of each month, TimeWizard gives you the flexibility to accommodate such
exceptions. First, set up a standard approval period by following the steps described in Objec-
tive 2, then adjust the standard dates to fit your unique requirements.

Customizing or maintaining an approval period

Figure 6.5

1. Place the cursor on the specific start/end date text box and
enter the date.  TimeWizard automatically enters the slash
marks (“/”) in the date.  Tab or click in the next date text
box to continue entering dates.  (See Figure 6.5)

2. Click “Apply” to save the settings and remain in the dialog
box or “OK” to save the settings and exit the dialog box.

3. Click “Insert” to insert an approval period between
existing start/end dates, or click “Add” to add approval

To customize or maintain an approval period, follow these steps:
periods to the end of all existing start/end dates.

You can refer to the calendar in the upper left of the
window when customizing dates.  Click the double

arrows in the calendar to display another year.
Click the single arrows to display another

month.  (See Figure 6.6)

Figure 6.6

Example TimeWizard customers who use weekly approval periods (i.e., either 26 or 52 Period) may
have to create a custom period so that the last period of the calendar year ends on December
31—regrardless of how many days the period ends up containing.
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You cannot edit a period’s start date or end date after a timesheet transaction has been made
for the period.

Exercise: You can change the approval period of March 1, 1997–March 15, 1997 to two single-week
periods by following these steps:

1. Place the cursor on the March 15, 1997 text box immediately before the “15.”
2. Type “08” to change the date to March 8, 1997.
3. Press the Tab key to move the cursor to the next row.
4. Click on the Insert command button to insert a new Start Date/End Date row

between the March 8, 1997 end date and the cursor to account for the second single-
week period.

5. Place the cursor on the undefined Start Date text box (“00/00/00”).
6. Type “030997” to enter the date March 9, 1997.
7. Place the cursor on the undefined End Date text box (“00/00/00”).
8. Type “031597” to enter the date March 15, 1997.
The approval period customization does not break the continuing flow from end dates to start
dates. In fact, TimeWizard does not allow gaps between end dates and start dates.

If you manually enter an approval period that has gaps or inconsistencies—such as an end
date prior to its start date—TimeWizard returns an error message when you attempt to save
the approval periods.

Objective 4: Delete approval periods

If you create approval periods too far in advance (for example, you selected the wrong year in
the End Date field), you can delete future approval periods from the Start Date/End Date
table—as long as no timesheet transactions exist in the periods you want to delete. Simply,
highlight the periods you want to delete and click on the Delete command button.

You cannot delete the approval period for the current period or for a closed period.
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Objective 5: Close-Out approval periods

When an approval period is closed in TimeWizard, no more time may be entered or edited for
any dates within that period, unless an auditable correction process is used. When you begin
to close-out a period, TimeWizard checks whether all required timesheet approvals are in
place. If all timesheet approvals have been made for the timesheets in the period, the period
will close.

If any required timesheet approvals are missing, a window will open that enables you, as an
Administrator, to override the need for additional approvals. To complete the close-out of the
selected period, you must enter a reason for the override.

Closing-out approvals is an irreversable process.

A closed period remains in the TimeWizard system, allowing you to make Historical Correc-
tions to it, if you have the permission to do so. Historical Corrections modify the timesheet,
but the TimeWizard database maintains the original data and the reason for the correction, as
well as the corrective data. Closed periods can be deleted through the Purge process (see
Chapter 2: Working with the Database).

Closing-out an approval period

To close-out an approval period, follow these steps:

1. Select the Start Date/End Date row for the period you want to close-out.

2. Click “Close-Out.”

3. TimeWizard automatically closes-out the selected period or displays a closed period override window.

4. To close-out the period and override missing approvals, enter a standard or user-defined reason and
specify “Yes” in the override window.
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Summary

Now that you have learned how to set up standard approval periods in the TimeWizard
system (or to customize approval periods to accommodate your company’s nonstandard ac-
counting cycles), your next step in the approval process is to define an approval hierarchy. This
hierarchy of departments and subgroups determines who can approve timesheets in your
company.
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7C H A P T E R

Working in Your Employees’
Timesheets

If you have the appropriate department owner permissions, you can view and edit the timesheets
of employees in departments you own. TimeWizard requires you to leave a note explaining
your reason for editing an employee’s timesheet.

Objectives

1. View an employee’s timesheet

2. Make an employee edit (and leave an employee edit note)
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To view an employee’s timesheet, follow these steps:

1. In the Timesheet Status area, click on the View drop-down
box to view the list of departments you own.

2. Select the department that contains the timesheets you want
to view.

3. The timesheet of the first employee in that department
appears in the Timesheet drop-down box.

4. To view a timesheet of another employee in the selected
department, click on the Timesheet drop-down box. Select
the employee who owns the timesheet you want to view.

5. Confirm that you are viewing the timesheet in the correct
approval period. To view a timesheet for the selected
employee in another period, select the desired period ending
date from the Period End drop-down list.

Viewing an employee’s timesheet

Figure 7.1

Objective 1: View an employee’s timesheet

If you are designated as a department owner, you can view timesheets of employees in the
department you own.
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Objective 2: Make an employee edit (and leave an employee edit note)

If you have the appropriate department owner permission, you can edit the unapproved
timesheets of employees in a department you own. TimeWizard requires users to note a rea-
son for employee edits, i.e., edits of time or detail code values on another employee’s timesheet.
When viewing another employee’s timesheet, the timesheet is locked into read-only mode
until you leave an employee edit note. However, you may add, delete, close, or open an
assignment on the timesheet without leaving a note.

The employee edit note is saved to the database and can be viewed in the timesheet transac-
tion note window. In the client/server timesheet, a shaded timesheet cell indicates that an
employee edit note (or other transaction note) exists. In the TimeWizard.enterprise timesheet,
a Note Pad icon        in the transaction cell indicates that an employee edit note (or other
transaction note) exists. For additional information concerning timesheet notes, see the
TimeWizard User’s Guide or the TimeWizard.enterprise User’s Guide.

An employee edit note will replace a previous transaction note in the transaction note win-
dow. However, each note is preserved in the database.
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1. Confirm that you are viewing the timesheet of the
correct employee in the correct approval period.
Follow the steps in Objective 1, as needed.

2. Click the Employee Edit icon        (located to the
right of the View drop-down box) to open the
Notes - Employee Edit window.

3. Click on the Text ID drop-down box and select a
standard or user-defined note. The standard audit
notes have pre-defined text. If you selected “User
Defined,” compose an original note in the text

Figure  7.2

Making an employee edit (and leaving an employee edit note)

box.

4. When you have selected or composed the
appropriate note, click “OK” to exit the dialog
box and gain edit access to the employee
timesheet. In the client/server timesheet, a
shaded timesheet cell indicates the employee
edit note. In the TimeWizard.enterprise
timesheet, a Note Pad icon      indicates the
employee edit note.

To make an employee edit, follow these steps:

Summary

In this chapter you have learned how to enter the timesheets of your departments’ employees
and make modifications, as necessary.
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8C H A P T E R

Approving and Rejecting Timesheets
for Departments

In the department-oriented approval process, a department manager is assigned approval
authority for time submitted by employees in a specific department. A department owner is a
manager who has permission to access timesheets of employees in the designated department.
Some—but not necessarily all—department owners also have the departmental permission to
approve and reject timesheets.

You define a department hierarchy in the TimeWizard Departments area and set the number
of approvals required for employees in each department or approval unit (see Chapter 10,
“Setting Departmental Approval Definitions”). The department hierarchy or department tree
shows which departments “own” which other departments or approvals units.

The first level of the approval process is always the submittal of all time entries on an employee’s
timesheet for a particular period. If the employee has the Submit Timesheet preference set-
ting, then the employee submits the timesheet for approval (see Chapter 16, “Setting Up
Preferences”). If the employee does not have the preference, then the employee’s department
owner performs the submittal.

If one level of approval is required for the employee’s department, then the submittal will fully
approve the timesheet. If two levels of approval are required, then, following the submittal,
one more approval will fully approve the timesheet. If additional levels of approval are re-
quired, then the timesheet must be approved at successively higher department levels to be-
come fully approved.

If a department approver rejects the submitted hours or clears (i.e., deletes) an approval, the
approval process begins again. The timesheet owner or department owner makes any needed
corrections in the timesheet and resubmits it.

The Approval Status designation in the upper right of the timesheet displays the status of the
timesheet at each level of the approval process. Table 8.1 explains each designation. (If you use
the integrated approvals process, you can find additional information about the timesheet
approval status in Table 9.2 of Chapter 9.)
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Table 8.1: Timesheet Approval Status
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A timesheet with zero hours entered for a period will display in the Department Approvals
window and require approval if an entry has been saved to an associated Special Amount or
User field.

When timesheet hours are approved or rejected, the approval statement or rejection statement
can be automatically e-mailed to the affected timesheet owner. To send such e-mail notifica-
tion, the department approver must have the corresponding preferences Send E-Mail on Ap-
prove and Send E-Mail on Reject set in the approver’s Preference Profile (see Chapter 16,
“Setting Up Preferences”).

E-mail notification also requires specific information to be entered in the timesheet owner’s
and department approver’s Employee Detail windows. A user of the client/server timesheet
must have the user’s e-mail address (preferably a fully-qualified Internet e-mail address) in the
Email Login text box of the Employee Detail window. A user of the TimeWizard.enterprise
timesheet must have the user’s fully-qualified Internet e-mail address in the Domain text box
of the Employee Detail window. See Chapter 11, “Working with Employees,” for more infor-
mation about the Employee Detail window.

This chapter describes using the Department approvals window from the client/server timesheet.
To use the Department Approvals window from the TimeWizard.enterprise timesheet, see the
TimeWizard.enterprise User’s Guide.
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TimeWizard enables department owners with appropriate permission or approval authority,
who are using the client/server timesheet, to do the following for timesheets in their depart-
ment or sub-department:

• Display timesheets with pending approvals
• Approve or reject timesheets for entire departments or for specific employees
• Collect timesheets regardless of their approval status
• Take ownership of other departments or sub-departments
• Clear timesheet approvals for entire departments and sub-departments or for spe-

cific employees
• Check timesheet approval status for entire departments or for specific employees

Objectives:

1. Navigate the Department Approvals window
2. Check the Approvals Inbox for pending approvals
3. Show approval status for a department
4. Show approval history for an employee timesheet
5. Approve or reject timesheets for a department
6. Approve or reject timesheets for a single employee
7. Collect Timesheets
8. Take ownership of a department
9. Release ownership of a department
10. Clear approvals for a department
11. Clear approvals for a department and all sub-departments
12. Clear approval for a single employee

Objective 1: Navigate the Department Approvals window

The Department Approvals window displays your company’s departmental hierarchy for
timesheet approvals and all associated timesheets.
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Opening the Department Approvals window

Figure 8.1

To open the Department Approvals window, follow
either of these steps:

1. Click on the Department Approvals icon        on the
timesheet toolbar.

2. Select Tools > Department Approvals from the main menu.

In the Department Approvals window in Figure 8.2, we have selected the Systems Engineer-
ing Department in the top left frame, which requires the timesheet submit plus two approvals
(for a total of three approvals). In the top right frame, all employee timesheets associated with
the selected department are displayed. When you select an employee, his or her assignment
and hours charged are displayed in the lower frames.

Figure  8.2
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To expand or collapse the department hierarchy in the upper left frame, right click on a selected
department and select Expand from the drop-down menu. Or click on the “+” or “-” symbols
located to the left of the selected department name.

Objective 2: Check the Approvals Inbox for pending approvals

TimeWizard enables you to display a list of timesheets with pending approvals, grouped by
approval period and approving department. This enables you to find the timesheets with
pending approvals quickly and approve or reject them as needed.

To check the Approvals Inbox for pending approvals, follow
these steps:

1. In the Department Approvals window, select Department > Open
Inbox to open the Pending Timesheet Approvals dialog box.

2. TimeWizard displays timesheets with pending approvals grouped by
approval period and approving department.

3. To approve or reject the timesheets with pending approvals, click on
the Period End drop-down menu to select the appropriate period
ending date. Then in the top left box, select the department that
contains the timesheets you wish to approve or reject.

Figure 8.3Checking the Approvals Inbox for pending approvals

Figure 8.3
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1. In the Department Approvals window, click on the
Period End drop-down menu to select the
appropriate period ending date.

2. In the upper left frame, select the department that
contains the timesheets for which you want to
show approval history. If the department contains
subgroups or approval units, continue to open the
departmental hierarchy until you have selected
the appropriate departmental group.

Figure  8.4

Showing approval status for a department

When you select the department in the
upper left frame, all employees in
upper right frame are selected
automatically.

3. Right-click on the appropriate department and
select Show Approval Status from the drop-
down menu (Department > Show Approval
Status) to open the Approve Status dialog box
for the selected department.

To show approval status for a department, follow these steps:

Objective 3: Show approval status for a department

For quick reference of where all of a department’s timesheets are in the approval process,
TimeWizard enables you to show timesheet approval status for the department en masse.

When a department owner clears approvals (i.e., deletes approvals), the record in the Approve
Status window displays “Reset” in the Status field.
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1. In the Department Approvals window, click on the
Period End drop-down menu to select the
appropriate period ending date.

2. In the upper left frame, select the department that
contains the timesheets for which you want to
show approval history. If the department contains
subgroups or approval units, continue to open the
departmental hierarchy until you have selected
the appropriate departmental group.

Figure 8.5

Showing approval history for an employee timesheet

3. In the upper right frame, select the employee
(within the selected department) who owns
the timesheet for which you want to show
approval history.

4. Right-click on the employee and select Show
Approval History from the drop-down menu
(Employees > Show Approval History) to open
the Approve History dialog box for the
selected timesheet.

To show approval history for an employee timesheet, follow these steps:

Objective 4: Show approval history for an employee timesheet

For quick reference of where a specific employee timesheet is in the approval process,
TimeWizard enables you to show the approval history of the selected timesheet.

You may only show approval history for an employee timesheet if the timesheet is pending at
your approval level.

When a department owner clears approvals (i.e., deletes approvals), the record in the Approve
History window displays “Reset” in the Action field.
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Approving or rejecting timesheets for a department

To approve or reject timesheets for a department, follow these steps:

1. In the Department Approvals window, click on the Period End
drop-down menu to select the appropriate period ending
date.

2. In the upper left frame, select the department that contains
the timesheets you wish to approve or reject. If the depart-
ment contains subgroups or approval units, continue to open
the departmental hierarchy until you have selected the
appropriate departmental group.

When you select the department in the upper left
frame, all employees in upper right frame are selected
automatically.

3. Right-click on the appropriate department and select Approve
or Reject from the drop-down menu to approve or reject all
timesheets associated with the selected department.

4. If you selected Approve, TimeWizard automatically approves
all timesheets associated with the selected department and
removes them from the employee list in the upper right frame

(unless “Show all employees” is checked). If this is the
final approval, the approval process is complete, and the
timesheet owner is so notified via email (see introduction
of this chapter for setup information). If higher approvals
are required, the process continues to the next level.

5. If you selected Reject, TimeWizard opens a dialog box
that requires you to specify a reason for the rejection.
Select a standard note or enter an original note in the
text box.

6. Click OK to continue. TimeWizard automatically rejects
all timesheets associated with the selected department
and removes them from the employee list in the upper
right frame (unless “Show all employees” is checked).
The rejected timesheet is returned to the timesheet
owner for correction and re-submittal. The process then
starts over.

Figure 8.7Figure 8.6

Objective 5: Approve or reject timesheets for a department

TimeWizard enables you to approve or reject the timesheets for a department en masse. Be-
fore proceeding with this function, however, be sure that you have reviewed each timesheet for
accuracy.
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To select multiple employees in sequence: 1. Click on the top employee. 2. Hold down the
Shift key. 3. Click on the bottom employee.

Approving or rejecting timesheets for a single employee

1. In the Department Approvals window, click on the Period
End drop-down menu to select the appropriate period
ending date.

2. In the upper left frame, select the department that contains
the timesheets you wish to approve or reject. If the
department contains subgroups or approval units, continue
to open the departmental hierarchy until you have selected
the appropriate departmental group.

3. In the upper right frame, select the employee (within the
selected department) who owns the timesheet you wish to
approve or reject.

4. In the lower left frame, select the assignment for which you
want to review transaction hours. The transaction hours
associated with the selected assignment are populated in
the lower right frame.

5. Right-click on the employee and select Approve or Reject
from the drop-down menu to approve or reject the selected
timesheet based on the accuracy of the assignment data.

6. If you selected Approve, TimeWizard automatically approves

the timesheet and removes it from the employee list in
the upper right frame (unless “Show all employees” is
checked). If this is the final approval, the approval process
is complete, and the timesheet owner is so notified via
email (see introduction of this chapter for setup
information). If higher approvals are required, the process
continues to the next level.

7. If you selected Reject, TimeWizard opens a dialog box
that requires you to specify a reason for the rejection.
Select a standard note or enter an original note in the
text box.

8. Click OK to continue. TimeWizard automatically rejects
the timesheet and removes it from the employee list in
the upper right frame (unless “Show all employees” is
checked). The rejected timesheet is returned to the
timesheet owner for correction and re-submittal. The
process then starts over.

Figure 8.9Figure 8.8

To approve or reject timesheets for a single employee, follow these steps:

Objective 6: Approve or reject timesheets for a single employee

TimeWizard enables you to select each employee’s timesheet and approve or reject it indepen-
dently of the other timesheets in the same department.
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To select multiple employees not in sequence: 1. Click on one employee. 2. Hold down the
Control key. 3. Click on an additional employee. 4. Continue to hold down the Control key
and click on additional employees as needed

Example In the example TimeWizard Reject Timesheet dialog box shown in Figure 8.10, the timesheet
was rejected because of unauthorized overtime. Once the timesheet owner corrects the trans-
action, the timesheet may be resubmitted and the approval process may begin again.

Figure 8.10

Objective 7: Collect Timesheets

TimeWizard enables you to forcibly collect timesheets from any level of department that you
own. In fact, even if an employee has not yet submitted his or her timesheet or if any required
lower-level approval has not yet been completed, you can take ownership of that approval
level and forcibly collect the timesheets.

You cannot collect timesheets for a future period.
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Figure 8.13

Collecting timesheets

Figure 8.12

To collect timesheets, follow these steps:

1. In the Department Approvals window, click on the
Period End drop-down menu to select the appropriate
period ending date.

2. In the upper left frame, select the department that
contains the timesheets you wish to approve or reject. If
the department contains subgroups or approval units,
continue to open the departmental hierarchy until you
have selected the appropriate departmental group.

If you need to collect timesheets at a lower approval level,
you must first take ownership of that level and
then collect the timesheets. See Objective 6.

3. Right-click on the appropriate
department and select Collect Timesheets from

Figure 8.11

the drop-down menu (Department > Collect Timesheets) to
open the Collect Timesheets Warning dialog box (Figure
8.11).

4. Click “Yes” to open the Override dialog box, in which you
must provide a reason for this action.

5. Either select a standard note or enter an original note in the
text box at the bottom of the Override dialog box (Figure
8.12).

6. Click OK to continue.

7. TimeWizard displays a confirmation dialog box with the
number of timesheets collected (Figure 8.13). Click OK to
return to the Department Approvals window.
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Objective 8: Take ownership of a department

TimeWizard enables you to take temporary ownership of lower-level departments for the
purpose of collecting timesheets or approving at that level in the absence of the department
owner.

3. Right-click on the appropriate department and select Take
Ownership from the drop-down menu (Department > Take
Ownership).

When you leave the Approvals window, TimeWizard
automatically releases ownership of any departments
for which you have taken ownership.

4. TimeWizard immediately grants you all approval permissions
of a department owner for the selected department.

Taking ownership of a department

1. In the Department Approvals window, click on the
Period End drop-down menu to select the
appropriate period ending date.

2. In the upper left frame, select the department
that contains the timesheets for which you want
to take ownership. If the department contains
subgroups or approval units, continue to open the
departmental hierarchy until you have selected
the appropriate departmental group.

To take ownership of a department, follow these steps:

3. Right-click on the appropriate department and select Release
Ownership from the drop-down menu (Department > Release
Ownership).

When you leave the Approvals window, TimeWizard
automatically releases ownership of any departments
for which you have taken ownership.

4. TimeWizard immediately returns ownership of the selected
department to the original owner. You no longer have
approval permissions of a department owner for the selected
department.

Releasing ownership of a department

1. In the Department Approvals window, click on the
Period End drop-down menu to select the
appropriate period ending date.

2. In the upper left frame, select the department
that contains the timesheets for which you want
to release ownership. If the department contains
subgroups or approval units, continue to open the
departmental hierarchy until you have selected
the appropriate departmental group.

To release ownership of a department, follow these steps:

Objective 9: Release ownership of a department

TimeWizard enables you to release ownership of any departments for which you have taken
ownership.

In addition, your temporary ownership is released automatically when you exit the Depart-
ments window.
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1. In the Department Approvals window, click on
the Period End drop-down menu to select the
appropriate period ending date.

2. Click the “Show all employees” box to specify
(yes or no) to display all the employees in your
department, those with pending and approved
timesheets alike.

3. In the upper left frame, select the department
that contains the timesheets for which you
want to clear approvals. If the department
contains subgroups or approval units, continue

Figure 8.14

Clearing approvals for a department

to open the departmental hierarchy until you have
selected the appropriate departmental group.

When you select the department in the
upper left frame, all employees in the
upper right frame are selected automati-
cally.

4. Right-click on the appropriate
department and select Clear This Department
Approvals from the drop-down menu (Depart-
ments > Clear This Department Approvals) to
clear all approvals for the selected department.

To clear approvals for a department, follow these steps:

Objective 10:Clear approvals for a department

TimeWizard enables you to clear timesheet approvals for a department en masse. This func-
tion does not allow you to clear an individual approval, rather it clears all approvals from the
initial submit to the highest-level approval.
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Objective 11:Clear approvals for a department and all sub-departments

TimeWizard enables you to clear timesheet approvals for a department and all associated sub-
departments en masse. This function does not allow you to clear an individual approval,
rather it clears all approvals from the initial submit to the highest-level approval.

1. In the Department Approvals window, click on
the Period End drop-down menu to select the
appropriate period ending date.

2. Click the “Show all employees” box to specify
(yes or no) to display all the employees in your
department, those with pending and approved
timesheets alike.

3. In the upper left frame, select the department
that contains the timesheets for which you
want to clear approvals. For this function, you
do not need to select specific subgroups or
approval units.

Figure 8.15

Clearing approvals for a department and all sub-departments

When you select the department in the
upper left frame, all employees in upper
right frame are selected automatically.

4. Right-click on the appropriate department and
select Clear This and all Sub-Department
Approvals from the drop-down menu
(Departments > Clear This and all Sub-
Department Approvals) to clear all approvals for
the selected department and associated sub-
departments.

To clear approvals for a department and all sub-departments, follow these steps:
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To clear approval for a single employee, follow these
steps:

1. In the Department Approvals window, click on the Period End
drop-down menu to select the appropriate period ending date.

2. Click the “Show all employees” box to specify (yes or no) to
display all the employees in your department, those with pending
and approved timesheets alike.

3. In the upper left frame, select the department that contains the
timesheets for which you want to clear approvals. If the
department contains subgroups or approval units, continue to
open the departmental hierarchy until you have selected the
appropriate departmental group.

4. In the upper right frame, select the employee (within the selected
department) who owns the timesheet for which you want to
clear approvals.

Figure 8.16

Clearing approval for a single employee

5. Right-click on the employee and select Clear
Approvals from the drop-down menu to clear
all approvals associated with the selected
timesheet.

Objective 12:Clear approval for a single employee

TimeWizard enables you to select each employee’s timesheet and clear approvals indepen-
dently of the other timesheets in the same department. This function does not allow you to
clear an individual approval, rather it clears all approvals from the initial submit to the high-
est-level approval.
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Summary

In this chapter, you have learned how to participate in your company’s department-oriented
approval process by approving or rejecting submitted timesheets in departments that you
own.
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Approving and Rejecting Timesheet
Assignments

In the integrated approvals process, department approvals are followed by activity approvals.
A project manager is assigned approval authority for time submitted for a specific activity or
activities. The activity approver, called an “activity owner,” can approve or reject time for
those “owned” activities without having approval authority for all of the time submitted for
an employee. Unlike a department approver, an activity owner can approve time for em-
ployee assignments without owning the employee’s department. If different assignments on
one timesheet are owned by different activity owners, each activity owner will need to per-
form an approval or rejection.

Once a timesheet has received all required department approvals, it becomes available to the
authorized activity owners for approval or rejection of activities or assignments. Only one
approval is required for each employee assignment per period. When every assignment on a
timesheet has been approved, the timesheet is fully approved for the period, and no other
level of approval is required.

If an activity owner rejects the submitted hours or clears (i.e., resets) an approval, the ap-
proval process requires additional stages. The rejection or clearing action unlocks the timesheet
so that the employee may correct the timesheet data. After the timesheet data has been
modified, it must be resubmitted. Then the entire approvals process, beginning with depart-
ment approvals, begins again.
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If an activity approval is cleared or hours are rejected, but no modification is made to the
timesheet data, the timesheet must still be resubmitted. In this case, the existing department
approvals remain in place and activity approvals can continue.

After a timesheet has been submitted, an assignment status displays in the Status column at
the left of the timesheet assignment rows to show the status of each assignment at each stage of
the process. Table 9.1 explains each assignment approval status designation.

Table 9.1: Assignment Approval Status

The Approval Status designation in the upper right of the timesheet displays the status of the
timesheet as a whole. Table 9.2 explains each timesheet approval status designation.
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Table 9.2: Timesheet Approval Status

An assignment row with zero hours entered for a period will display in the Activity Approvals
window and will require approval if an entry has been saved to an associated Special Amount
or User field.

When timesheet hours are approved or rejected, the approval statement or rejection statement
can be automatically e-mailed to the affected timesheet owner. To send such e-mail notifica-
tion, the activity owner must have the corresponding preferences Send E-Mail on Approve
and Send E-Mail on Reject set in the activity owner’s Preference Profile (see Chapter 16,
“Setting Up Preferences”).

E-mail notification also requires specific information to be entered in the timesheet owner’s
and activity owner’s Employee Detail windows. A user of the client/server timesheet must
have the user’s e-mail address (preferably a fully-qualified Internet e-mail address) in the Email
Login text box of the Employee Detail window. A user of the TimeWizard.enterprise timesheet
must have the user’s fully-qualified Internet e-mail address in the Domain text box of the

lavorppAteehsemiT
sutatS

noitanalpxE

devorppanU

rolavorpparofdettimbusneebtonsahdoirepdetcelesehtrofteehsemitehT
ta,dettimbusneebsahteehsemitehtfI.lavorpparofdettimbuserebtsum

teser,.e.i(deraelcneebsahlavorppaytivitcarolavorppatnemtrapedenotsael
.dekcolnusiteehsemitehtdna,)"devorppanU"ot

gnidneP
tontublavorpparofdettimbusneebsahdoirepdetcelesehtrofteehsemitehT

.devorppaylluftey

devorppA
siteehsemitehtdna,devorppaneebevahteehsemitehtnostnemngissallA

.doirepdetcelesehtrofdevorppaylluf

detcejeR

tnemtrapedaybdetcejerneebsahdoirepdetcelesehtrofteehsemitehT)1
neebevahdoirepdetcelesehtrofstnemngissaeromroeno)2rorevorppa

ebtsumdnadekcolnusiteehsemitehT.renwoytivitcanaybdetcejer
eritneeht,lattimbuserehterofebdeifidomsiatadteehsemitfI.dettimbuser

.niaganigeblliwssecorpslavorppa



TimeWizard

Section Three • Defining the Approval Process126

Employee Detail window. See Chapter 11, “Working with Employees,” for more information
about the Employee Detail window.

This chapter describes using the Activity Approvals window from the client/server timesheet.
To use the Activity Approvals window from the TimeWizard.enterprise timesheet, see the
TimeWizard.enterprise User’s Guide.

TimeWizard enables project managers with activity approval authority to perform the follow-
ing functions:

• Display a list of activities that are available for approval
• Approve or reject submissions for entire activities, for specific resource assignments,

or for specific employee assignments
• Clear approvals (i.e., delete approvals) for entire activities, for specific resource as-

signments, or for specific employee assignments
• Check approval status for entire activities or for specific employee assignments

Objectives:

1. Navigate the Activity Approvals window
2. Display activities available for approval
3. Show approval status of an activity
4. Show approval history of a single employee assignment
5. Approve or reject submissions for entire activities
6. Approve or reject submissions for specific resource assignments
7. Approve or reject submissions for specific employee assignments
8. Clear approvals for an activity
9. Clear approval for a single resource assignment
10. Clear approval for a single employee assignment



TimeWizard

127Chapter Nine •  Approving and Rejecting Timesheets Assignments

To open the Activity Approvals window, follow either of
these steps:

1. Click on the Activity Approvals icon          on the timesheet
toolbar.

2. Select Tools > Activity Approvals from the main menu.

Figure 9.1

Opening the Activity Approvals window

Objective 1: Navigate the Activity Approvals window

The Activity Approvals window displays your company’s project hierarchy for activity ap-
provals and all associated resource assignments.

In the Activity Approvals window in Figure 9.2:

• The activity “TW3.0 Development, 11, Migration” in the upper left frame has two
associated resource assignments in the upper right frame.

• The “SysEng” resource assignment in the upper right frame has two associated em-
ployee assignments in the lower left frame.

• The employee assignment for Bruce Gibson in the lower left frame has 12 hours
charged to it in the selected period, as shown in the lower right frame.
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Figure 9.2

To expand or collapse the activity hierarchy in the upper left frame, right-click on a selected
activity and select Expand from the pop-up menu or click on the “+” or “-” symbols located to
the left of the selected activity name.
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Displaying pending activity approvals

To display pending activity approvals,
follow these steps:

1. In the Activity Approvals window, select Activity
> Open Inbox from the main menu to open the
Pending Activity Approvals dialog box.

2. TimeWizard displays activities available for
activity approval, grouped by period ending date.

3. To proceed with the approvals process, click on
the Period End drop-down box and select the
appropriate period ending date.

Figure 9.3

Objective 2: Display activities available for approval

TimeWizard enables you to display a list of activities available for approval, grouped by period
ending date. An activity will not display until one or more of its associated employee assign-
ments have received all required department approvals. This display enables you to find pend-
ing activity approvals quickly, and then proceed with approvals or rejections.
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Showing approval status for an activity

To show approval status for an activity, follow these steps:

1. In the Activity Approvals window, click on the Period End
drop-down box and select the appropriate period ending
date.

2. In the top left frame, select the activity that contains the
appropriate resource assignment approvals. If the activity
contains lower-level fields, continue to open the project
hierarchy until you have selected the appropriate activity.

When you select the activity in the left
frame, all resource assignments in the right
frame are selected automatically.

3. Right-click on the appropriate activity and select
Show Approval Status from the pop-up menu (or
select Activity > Show Approval Status from the main
menu) to open the Approve Status window for the
selected activity.

Figure 9.4

Objective 3: Show approval status of an activity

The Show Approval Status feature enables you to view the assignment approval status of
submitted employee assignments associated with a specified activity, for a specified period, en
masse.

When approvals have been cleared (i.e., deleted), the record in the Approve Status window
displays “Reset” in the appropriate status field.
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 Showing approval status for a single employee assignment

To show approval status for an employee assignment, follow these steps:

1. In the Activity Approvals window, click on the Period End drop-
down box to select the appropriate period ending date.

2. In the upper left frame, select the activity that contains the
resource assignment that contains the employee assignment
for which you want to show the approval history. If the activity
contains lower-level fields, continue to open the project
hierarchy until you have selected the appropriate activity.

3. In the upper right frame, select the resource assignment that
contains the employee assignment for which you want to
show the approval history.

When you select the resource assignment in the right frame, all
associated employee assignments in the lower left frame are

selected automatically.

4. In the lower left frame, right-click on
the appropriate employee assignment and select
Show Approval History from the pop-up menu (or

select Employee > Show Approval History from the main
menu) to open the Approve History window for the
selected employee assignment.

Objective 4: Show approval history of a single employee assignment

TimeWizard enables you to show the assignment approval history for a specified employee
assignment.

Figure 9.5

When approvals have been cleared (i.e., deleted), the record in the Approve History window
displays “Reset” in the appropriate action field.
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Objective 5: Approve or reject submissions for entire activities

TimeWizard enables you to approve or reject the submissions for an activity en masse. When
you approve or reject an activity, all associated resource assignments (and therefore employee
assignments) are approved or rejected automatically. Before proceeding with this function,
you may want to review resource assignments and employee assignments for accuracy.

To approve or reject submissions for entire activities, follow these steps:

4. If you selected Approve, TimeWizard automatically
approves all resource assignments associated with the
selected activity and removes them from the resource
assignment list. You may approve or reject another
submission or close the window.

5. If you selected Reject, TimeWizard opens a dialog
box that requires you to specify a reason for the
rejection. Select a standard note or enter an original
note in the text box. Click OK to continue.
TimeWizard automatically rejects all resource
assignments associated with the selected activity and
removes them from the resource assignment list.

Figure 9.7

Approving or rejecting submissions for entire activities

1. In the Activity Approvals window, click on the Period End
drop-down box and select the appropriate period ending
date.

2. In the upper left frame, select the activity that contains the
resource assignments you wish to approve or reject. If the
activity contains lower-level fields, continue to open the
project hierarchy until you have selected the appropriate
activity.

When you select the activity in the upper left frame,
all resource assignments in the upper right frame are
selected automatically.

3. Right-click on the appropriate activity and select Approve or
Reject from the pop-up menu to approve or reject all
associated resource assignments.

Figure 9.6
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Objective 6: Approve or reject submissions for specific resource assignments

TimeWizard enables you to select each resource assignment and approve or reject it indepen-
dently of the other resource assignments associated with the same activity. When you approve
or reject a resource assignment, all associated employee assignments are approved or rejected
automatically. Before proceeding with this function, you may want to review each associated
employee assignment for accuracy.

To select multiple resource assignments listed in sequence:

1. Click on the top resource assignment you want to select.
2. Hold down the Shift key and click on the bottom resource assignment you want to

select.

To select multiple resource assignments not listed in sequence:

1. Click on one resource assignment you want to select.
2. Hold down the Control key and click on an additional resource assignment you want

to select.
3. Continue to hold down the Control key and click on additional resource assignments

as needed.
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Approving or rejecting submissions for specific resource assignments

1. In the Activity Approvals window, click on the Period End
drop-down box to select the appropriate period ending
date.

2. In the upper left frame, select the activity that contains the
resource assignments you wish to approve or reject. If the
activity contains lower-level fields, continue to open the
project hierarchy until you have selected the appropriate
activity.

3. In the upper right frame, right-click on the appropriate
resource assignment, and select Approve or Reject from the
pop-up menu to approve or reject the resource assignment.

4. If you selected Approve, TimeWizard automatically
approves the resource assignment and removes it from the
resource assignment list. You may approve or reject another
submission or close the window.

5. If you selected Reject, TimeWizard opens a dialog box that
requires you to specify a reason for the rejection. Select a
standard note or enter an original note in the text box. Click
OK to continue. TimeWizard automatically rejects the
resource assignment and removes it from the resource
assignment list.

Figure 9.9Figure 9.8

To approve or reject submissions for specific resource assignments, follow these steps:
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Objective 7: Approve or reject submissions for specific employee assignments

TimeWizard enables you to select each employee assignment and approve or reject it indepen-
dently of the other employee assignments associated with the same resource assignment.

Approving or rejecting submissions for specific resource assignments

To approve or reject submissions for specific employee assignments, follow these steps:

1. In the Activity Approvals window, click on the Period End
drop-down box and select the appropriate period ending
date.

2. In the upper left frame, select the activity that contains the
resource assignments that contain the employee assignments
you wish to approve or reject. If the activity contains lower-
level fields, continue to open the project hierarchy until you
have selected the appropriate activity.

When you select the activity in the left frame, all
resource assignments in the right frame are selected
automatically.

3. In the upper right frame, select the resource assignment that
contains the employee assignments you wish to approve or
reject.

When you select the resource assignment in the right
frame, all associated employee assignments in the
lower left frame are selected automatically.

4. In the lower left frame, right-click on the appropriate
employee assignment and select Approve or Reject
from the pop-up menu to approve or reject the
resource assignment.

5. If you selected Approve, TimeWizard automatically
approves the employee assignment and removes it
from the employee assignment list. You may approve
or reject another submission or close the window.

6. If you selected Reject, TimeWizard opens a dialog box
that requires you to specify a reason for the rejection.
Select a standard note or enter an original note in the
text box. Click OK to continue. TimeWizard
automatically rejects the employee assignment and
removes it from the employee assignment list.

Figure  9.10 Figure 9.11
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To select multiple employee assignments listed in sequence:

1. Click on the top employee assignment you want to select.
2. Hold down the Shift key and click on the bottom employee assignment you want to

select.

To select multiple employee assignments not listed in sequence:

1. Click on one employee assignment you want to select.
2. Hold down the Control key and click on an additional employee assignment.
3. Continue to hold down the Control key and click on additional employee assign-

ments as needed.

Example In the TimeWizard Reject Timesheet dialog box shown in Figure 9.12, the employee assign-
ment was rejected because of unauthorized use of a project code. Once the employee corrects
the transaction and resubmits the timesheet, the employee assignment is placed in “Pending”
status again. Department approvals must be completed again before the activity approval
process may continue.

Figure 9.12
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Objective 8: Clear approvals for an activity

If you have the Clear Approvals permission, you can reset approvals or rejections for an activ-
ity en masse. When you clear approvals for an activity, all approvals for associated resource
assignments (and, therefore, employee assignments) are deleted automatically. An activity
owner cannot clear the assignment status “Pending.”

Department owners with the Clear Approvals permission may clear the assignment status
“Pending,” as well as the timesheet approval status “Pending,” in the department approvals
Clear Approvals window.

To clear approvals for an activity, follow these
steps:

1. In the Activity Approvals window, click on the
Period End drop-down box and select the
appropriate period ending date.

2. In the upper left frame, select the activity that
contains the resource assignment approvals you
wish to clear. If the activity contains lower-level
fields, continue to open the project hierarchy until
you have selected the appropriate activity.

When you select the activity in the upper
left frame, all resource assignments in the
upper right frame are selected automati-
cally.

Clearing approvals for an activity

Figure 9.13

3. Right-click on the appropriate activity and select
Clear Approvals from the pop-up menu to clear
approvals for all associated resource assignments
and employee assignments.
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Objective 9: Clear approval for a single resource assignment

If you have the Clear Approvals permission, you can select a resource assignment and reset all
associated approvals (or rejections) for it independently of the other resource assignments
associated with the same activity. When you clear approvals for a resource assignment, all
approvals for associated employee assignments are deleted automatically. An activity owner
cannot clear the assignment status “Pending.”

Department owners with the Clear Approvals permission may clear the assignment status
“Pending,” as well as the timesheet approval status “Pending,” in the department approvals
Clear Approvals window.

To clear approvals for a resource assignment, follow these
steps:

1. In the Activity Approvals window, click on the Period End drop-
down box and select the appropriate period ending date.

2. In the upper left frame, select the activity that contains the
resource assignment approvals you wish to clear. If the activity
contains lower-level fields, continue to open the project hierarchy
until you have selected the appropriate activity.

3. In the upper right frame, select the resource assignment that
contains the approvals you wish to clear.

When you select the resource assignment in the upper
right frame, all employee assignments in the lower left
frame are selected automatically.

Clearing approval for a single resource assignment

Figure 9.14

4. Right-click on the resource assignment and select Clear
Approvals from the pop-up menu to clear the
approvals associated with the selected resource
assignment.
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Objective 10: Clear approval for a single employee assignment

If you have the Clear Approvals permission, you can select an employee assignment and reset
all associated approvals (or rejections) for it independently of the other employee assignments
associated with the same resource assignment. An activity owner cannot clear the assignment
status “Pending.”

Department owners with the Clear Approvals permission may clear the assignment status
“Pending,” as well as the timesheet approval status “Pending,” in the department approvals
Clear Approvals window.
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Clearing approval for a single employee assignment

To clear approvals for an employee assignment, follow these steps:

1. In the Activity Approvals window, click on the Period End
drop-down box and select the appropriate period ending
date.

2. In the upper left frame, select the activity that contains the
resource assignment that contains the employee assignment
approvals you wish to clear. If the activity contains lower-level
fields, continue to open the project hierarchy until you have
selected the appropriate activity.

3. In the upper right frame, select the resource assignment
that contains the employee assignment approvals you
wish to clear.

4. In the lower left frame, right-click on the appropriate
employee assignment and select Clear Approvals from
the pop-up menu to clear the approvals for the selected
employee assignment.

Figure 9.15

Summary

In this chapter, you have learned how to participate in the activity approvals portion of the
integrated approvals process by approving or rejecting submitted timesheet data for activities
you own.



4
S E C T I O N  F O U R

Managing Resources

Introduction to Managing Resources in TimeWizard

In the Introduction to this manual, we recalled seventh grade English and the six
types of questions—who, what, when, where why and how. The answers to the

question “Who is working?” lies in the TimeWizard Employees section, which en-
ables you to add and manage the resources who are able to make time entries in the
TimeWizard system. For each resource, you complete an employee record that en-
compasses everything TimeWizard needs to know about that user. This includes not
only standard data such as name and employee number but also TimeWizard-specific
data such as departmental ownership settings and resource code designations.

This section includes the following

Chapter Ten: Setting Departmental Approval Definitions
Chapter Eleven: Working with Employees
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10C H A P T E R

Setting Departmental Approval
Definitions

In Chapter 5, we discussed the different types of approval process and the implications of
each. In Chapter 6, you learned how to set up standard or customized approval periods so that
your company’s employees can enter time within those periods. In this chapter, we discuss the
final step of setting up the department portion of the approval process. You do this by estab-
lishing an approval hierarchy of departments, subgroups, and associated employees. Table
10.1 explains the role of each member of the approval hierarchy.

If you choose the integrated approvals process, you will also need to map out who approves
which assignment time entries. You will set activity approvers for this purpose in the Activity
Approval Pools area (see Chapter 18, “Creating Activity Approval Pools”).
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Objectives

When you have finished this chapter, you should be able to do the following:

1. Navigate the Departments window
2. Create an approval hierarchy
3. Place employees in the appropriate departments and subgroups
4. Edit departments and subgroups in an approval hierarchy
5. Delete departments and employees from an approval hierarchy
6. Cut and paste departments and employees
7. Maintain employees in the Departments window

Table 10.1: Approval Hierarchy Members
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Objective 1: Navigate the Departments window

The Departments window enables you to define departments in the TimeWizard system and
to establish a hierarchy of approvals. You can then assign employees to the appropriate depart-
ments.

Objective 2: Create an approval hierarchy

An approval hierarchy is like an organizational chart that illustrates who works for whom in
your company. For example, your highest level of the hierarchy could be called “Executive
Office,” followed by the primary departments of your company (such as Business Develop-
ment, Information Technology, and Payroll). Each primary department may include several
subgroups (such as Administration, Consulting, and Help Desk). If a subgroup is large, you
can divide it into approval units, the lowest possible level of the approval hierarchy.

If your organization wants to use the activity approval portion of the integrated approvals
process, but chooses not to use the department approval portion, set the number of approvals
for each department to “1.” When a timesheet is submitted for approval, the submittal acts as
the first departmental approval. If only one department approval is required, the submittal
makes the timesheet accessible to activity approvers.

Opening the Departments window

Figure 10.1

1. Select Tools > Departments from the TimeWizard
Administrator main menu.

2. Click on the Departments icon on the TimeWizard
Administrator toolbar.

To open the Departments window, follow either of
these steps:
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Creating an approval hierarchy

To create an approval hierarchy, follow these steps:

1. Right-click on the default department entitled “Begin
Department Hierarchy Here” to access the Departments
tools menu. Select “Edit”and rename the default
department as appropriate (i.e., your company’s highest
level department).

2. Right-click on the default department to access the
Departments tools menu.

3. Select “Add” to open the Department dialog box.

4. For the new department, enter the appropriate
information, such as department name and number of
department approvals required. The first approval is the
submittal of the timesheet.

Figure 10.3

5. To add additional departments, repeat step 2-4.

6. To add subgroups that are approved by a particular
department, right-click on the specific department and
repeat step 3. Enter the appropriate information in the
dialog box.

7. To designate a subgroup as an approval unit, click on
the “Approval Unit Only” checkbox in the dialog box.

8. Click “Apply” to save the settings and keep the dialog
box open, or click “OK” to save the settings and close
it.

Figure 10.2

A drum-shaped icon appears to the left of each department or subgroup in the Departments
window (see Figure 10.2). Approval units will have an icon that shows a smaller drum beside
the larger one, indicating a “parent-child” relationship.

To open or collapse the approval hierarchy, either click on the plus (+) or minus (-) symbols to
the left of each department or double-click on the department.
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Objective 3: Place employees in the appropriate departments and subgroups

When you place employees into a specific department or subgroup, they are bound by the
approval settings of the department or subgroup. Just as the department approval hierarchy
reflects the departmental structure of your company, the employee placements reflect the day-
to-day organization of your company’s resources.

Placing employees in the appropriate departments and subgroups

To place employees in the appropriate departments and subgroups, follow these steps:

1. Click on the default department (the highest level
department). All employees already in the TimeWizard
system are displayed in the right frame of the
Departments window.

Figure 10.4

2. Click and hold on the employee you want to place in
another department or subgroup.

3. Drag the selected employee from the default depart-
ment onto the appropriate department or subgroup.
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Objective 4: Edit departments and subgroups in an approval hierarchy

TimeWizard enables you to edit departments and subgroups in the approval hierarchy at any
time.

Objective 5: Delete departments and employees from an approval hierarchy

You can only delete lowest-level departments or subgroups (i.e., ones that have no child sub-
group beneath it) that contain no employees. To delete a department that has subgroups as
well as employees, you first must move its position in the approval hierarchy (to a lowest-level
position) and move all of its employee members to a new location.

You cannot delete an employee who has timesheet transactions in any period (open or closed).

Editing departments and subgroups in an approval hierarchy

Figure 10.5

1. Right click on the department or subgroup you want to edit.

2. Select Edit from the drop-down menu to open the Department
dialog box.

3. Edit the settings as necessary.

You cannot edit the Department Code.

4. Click Apply to save the settings and remain in the dialog box or OK
to save the settings and return to the Departments window.

To edit departments and subgroups, follow these steps:

Deleting Departments and Employees from an Approval Hierarchy

To delete departments and employees from an approval hierarchy, follow these steps:

1. Right click on the subject of your choice.

2. Select Delete from the drop-down menu.

3. In the Delete dialog box, click Yes to delete
the department or employee.

Figure 10.6 Figure 10.7
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Objective 6: Cut and paste departments and employees

You can cut departments and paste them into a new position in the approval hierarchy (e.g., as
a subgroup to another department), and you can cut employees and paste them into a new
department or subgroup.

You also can click and drag departments and employees for the same results as cutting and
pasting.

To select multiple employees in sequence: 1. Click on the top employee. 2. Hold down the
Shift key. 3. Click on the bottom employee.

To select multiple employees not in sequence: 1. Click on one employee. 2. Hold down the
Control key. 3. Click on an additional employee. 4. Continue to hold down the Control key
and click on additional employees as needed.

Cutting and pasting departments and employees

To cut and paste departments and employees, follow these steps:

1. Right click on the subject of your choice.

2. Select Cut from the drop-down menu.

3. Right-click on the appropriate destination.

4. Select “Paste Employees” or “Paste Department”
as appropriate.

Figure 10.8 Figure 10.9
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Summary

By creating a hierarchy of departments, you continue the definition of the approval process
for your company. You will assign departmental approval authority to specific employees in
Chapter 11, “Working with Employees.” If you choose the integrated approvals process, you
will set activity approvers in Chapter 18, “Creating Activity Approval Pools.”

Objective 7: Maintain employees in the Departments window

For convenient management of your company’s employees and departments, TimeWizard
enables you to access certain dialog boxes associated with the TimeWizard Employees window
by right-clicking on any listed employee. These dialog boxes include:

• The Employee Detail dialog box
• The Departments Owned dialog box
• The Resource Codes dialog box.

For complete instructions on using these TimeWizard dialog boxes and associated functions,
see Chapter 11, “Working with Employees.”

Figure 10.10
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11C H A P T E R

Working with Employees

The Employees section is your one-stop section for setting up and maintaining your resources
in the TimeWizard system. In this chapter, we will discuss how to create, access, and maintain
new employee records; set department-level permissions; and assign resource settings to indi-
vidual employees.

In other areas of TimeWizard—e.g., Business Rules, Activities and Assignments, and Re-
ports—you can specify security parameters that further govern the actions of each specific
resource.

Objectives

1. Navigate the Employees window
2. Use the Employees Quickfilter
3. Add a new employee
4. Assign department ownership for an employee
5. Assign department permissions for an employee
6. Assign a resource code to an employee
7. Assign employee passwords
8. Maintain employee security records
9. Delete an employee
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Objective 1: Navigate the Employees window

From the Employees window, you establish and maintain a list of all resources in the TimeWizard
system. At the top of this window is the Employees Quickfilter (see Objective 2). The main
body contains data that is pulled from each employee’s security record. Table 11.1 explains
each Employee Toolbar icon. Table 11.2 explains icon used in the Employees window.

To open the Employees window, follow either of these
steps:

Figure 11.1

Navigating the Employees Window

1. Click on the Employees icon.

2. Select Tools > Employees from the TimeWizard main menu.

Table 11.1: Employee Toolbar Icons
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Table 11.2: Employees Window

Example Figure 11.2 shows an example TimeWizard Employees window. In this example, we selected
<All> for each Quickfilter field to retrieve all employees in the TimeWizard system.

Figure 11.2
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Objective 2: Use the Employees Quickfilter

Once you have entered employees into the TimeWizard system, you can retrieve them quickly
using the Employees Quickfilter located at the top of the Employees window. Rather than
having to scroll through an entire listing of your company’s employees, you can use the quickfilter
to list only the employees with whom you want to work.

The fields listed across the top are those specified as quickfilter fields in your Employees
Custom Field definitions. The drop-down box below each field contains all possible values
associated with the field.

To use the employee quickfilter, follow these steps:

1. Click on the scroll arrow in each quickfilter field and select your
desired filtering parameters.

2. Click “Retrieve” (Employees > Quickfilter > Retrieve).

Figure 11.3

Using the employee quickfilter

3. All employees that fall within your selected filtering
parameters appear in the Employees window.

To view all employees, select <All> for each quickfilter field. Or you can type the first charac-
ters of a value in a Quickfilter field; as you type, TimeWizard searches ahead for a match.

Objective 3: Add a new employee

Once employees are active in the TimeWizard system, they have timesheets available to them
to which assignments can be added and time charged.  Through the Employee Detail dialog
box, you can create new employee records and access and maintain existing employee records.
Table 11.3 gives a detailed explanation of each item of the Employee Detail dialog box. You
have the option of adding employees into TimeWizard using three different methods:

• Direct entry into the Employee Detail dialog box from the Employees window (dis-
cussed here)
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To add a new employee, follow these steps:

1. Click on the Add Employee icon         (Employee > Add
Employee) to open the Employee Detail dialog box.

2. Enter employee information and security parameters.
(See detailed explanations of each text box, below.)

3. Click “Apply” to save the settings and remain in the

Adding a new employee

Employee Detail dialog box, or click “OK” to
save the settings and exit the dialog box.

• Direct entry into the Employee Detail dialog box from the Departments window
(see chapter 10)

• Automated entry through a Table Retrieval (see chapter 25)

The bottom of the Employee Detail dialog box contains text boxes for entering each of the
user-defined fields that were defined in Chapter 3: Defining Custom Fields.

Once in the Employee Detail dialog box, you can click “Add” (in the upper right corner) to
add a new employee (rather than opening a new Employee Detail dialog box from the main
Employees Window). When you open a new Employee Detail dialog box in this manner,
TimeWizard continues to display several of the employee data selections. This is especially
convenient for adding several similar employees in succession.

Figure 11.4
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Table 11.3: Employee Detail (continued on page 157)
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Table 11.3: Employee Detail (continued from page 156)
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Objective 4: Assign department ownership for an employee

A department owner has the ability to view timesheets for employees in any departments
owned. In the Departments Owned By dialog box, you can manage the department owner’s
access and control over the timesheets in each owned department.

You can assign direct ownership of departments from any level of the department hierarchy.
“Directly owned” departments are the departments listed in the department owner’s Depart-
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 Assigning department ownership for an employee (continued on page 159)

To assign department ownership for an employee, follow these steps:

Assigning department ownership is not part of the initial
employee record setup. When you have completed an
employee record for a new employee, you must save the
settings by clicking on Apply before the Ownership
command button becomes available.

1. In the Employees window, double-click on an employee to
open the Employee Detail window.

2. Click “Ownership” to open the Departments Owned By dialog
box.

In the Departments Owned By dialog box, all
departments entered into the TimeWizard system
(see Chapter 4: Assigning Code Values) are listed on
the left. All departments directly owned by the
employee are listed on the right.

3. Select the department to be owned from the
Department List text box (at left).

Figure 11.5

ments Owned text box. “Indirectly owned” departments are the departments that are subor-
dinate to a directly owned department in the department hierarchy and have not been as-
signed in the Departments Owned text box. Both directly and indirectly owned departments
display in the department owner’s View drop-down list on the timesheet. A department owner
has the same department permissions with an indirectly owned department as with the higher-
level directly owned department.

Usually, you assign direct ownership of all departments that the department owner regularly
approves, whether the departments are lower-level or higher-level departments. By allowing a
department owner to display indirectly owned departments in the approvals area, you can
enable a department owner of a higher-level department to act as the direct owner of a lower-
level department, e.g., in that owner’s absence. See Objective 5 for further information on
indirectly owned departments.
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Objective 5: Assign department permissions for an employee

The right side of the Departments Owned By dialog box contains permission settings that
manage the department owner’s access and control over the timesheets in his or her depart-
ment.

A department owner can have different permissions for each owned department.

If you use the department approvals process, you may enable approvers who use
TimeWizard.enterprise to display their indirectly owned departments in the approvals area.
The TimeWizard client/server approvals area uses a different procedure, which is explained in
Chapter 8, “Approving and Rejecting Timesheets for Departments.”

You can enable TimeWizard.enterprise department approvers to approve timesheets in a De-
partment Summary view by assigning the Group Approve permission. Department approvers
without this permission perform approvals in the more detailed Timesheet Summary view.
Group approvers may use either view. For more information, see the TimeWizard.enterprise
User’s Guide.

4. Click on the “>” to move the selected department to the
Departments Owned text box (on the right). You also can
double-click on the selected department to move it over.

To correct or change a department assignment, select the
incorrect entry and click on the “<” to move it back to the

Department List box. You also can double-click on the
incorrect entry to move it back.

5. Click “Apply” to save the settings and remain in the
dialog box, or click “OK” to save the settings and exit
the dialog box.

 Assigning department ownership for an employee (continued from page 158)
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Table 11.4:  Departmental Options (Timesheet Functions)

Assigning department permissions for an employee

To assign department permissions for an employee,
follow these steps:

1. Specify whether the employee can display indirectly owned
departments in the TimeWizard.enterprise Department
Approvals area.

2. Indicate (Yes or No) whether the employee can approve
and reject timesheets for the department owned.

3. Indicate (Yes or No) whether the employee is the primary
approver—if not, then the employee is a “backup”
approver—of the timesheets for the department owned.
This designation can be included in TimeWizard reports.

4. Indicate (Yes or No) whether the employee can “group
approve” in the TimeWizard.enterprise Department
Summary view. If not, the employee can perform approvals
only in the Timesheet Summary view.

5. Indicate whether the employee has read-only or edit
timesheet access capabilities on the timesheets for the
department owned. In other words, can the department
owner only look at the timesheets (read-only) or actually
make changes to the timesheets (edit)? Making edits
requires leaving a note in TimeWizard.

6. Indicate (Yes or No) whether the employee is allowed to
perform timesheet functions for everyone in the depart-
ment owned. Table 11.4 gives a detailed explanation of
timesheet functions. Timesheet functions include the

Figure 11.6

following permissions:

• Add Assignments
• Delete Assignments
• Close Assignments
• Open Assignments
• Historical Corrections
• Edit ETCs

7. Click “Apply” to save the settings and remain in the
dialog box, or click “OK” to save the settings and exit the
dialog box.
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Objective 6: Assign a resource code to an employee

If you chose to use resource codes, you can assign resource code values to individual employ-
ees. These values represent specific skills offered by the employee, such as programming, ac-
counting, and editing.

Assigning resource codes is not part of the initial employee record setup. When you have
completed an employee record for a new employee, you must save the settings by clicking
Apply before the Resource Codes command button becomes available.
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Table 8.4: Departmental Options (Timesheet Functions)
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Assigning a resource code to an employee

To assign a resource code to an employee, follow these steps:

1. In the Employees window, double-click on an employee to
open the Employee Detail window.

2. Click “Resource Codes” to open the Resource Codes For
dialog box.

In the Resource Codes For dialog box, all resource codes
entered into the TimeWizard system (see Chapter 4:
Defining Custom Fields) are listed on the left. All resource
codes assigned to the employee are listed on the right.

3. Select the resource to be owned from the Resource Codes
List box (on the left).

4. Click on the “>” to move the selected resource code
to the Assigned Resource Codes box (on the right).
You also can double-click on the selected resource to
move it over.

To correct or change a resource assignment, select the
incorrect entry and click on the “<” to move it back to
the Resource Codes List box. You also can double-click
on the incorrect entry to move it back.

5. Click “Apply” to save the settings and remain in the
dialog box, or click “OK” to save the settings and exit
the dialog box.

Figure 11.7
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Objective 7: Assign employee passwords

The Password command button in the Employee Detail window opens the Change Password
For dialog box and enables you to enter the employee’s password, which is used in conjunction
with the Login ID to gain entry into the TimeWizard system. It must be at least six characters
in length, with the maximum length being 20 characters. Warning: Do not use uppercase for
the password and do not begin or end the password with the letter “a”! Once entered, the
password appears as asterisks to ensure privacy.

Assigning employee passwords

To assign employee passwords, follow these steps:

1. Type the new password in the Enter New Password text box.
Remember: Do not use uppercase for the password.

2. Type the new password once again in the Confirm New
Password text box.

Figure 11.8

3. Click “OK” to save the settings and exit the dialog
box.

If you do not enter a password when adding a new employee, the password default setting is
“password.” If you wish, you can let the default password apply and allow employees to change
their own passwords the first time they login.

If an employee forgets his or her password, you (as TimeWizard Administrator) can open the
default window for the employee, click on the Password command button, and follow the
steps outlined above to enter a new password. However, you cannot find out what the old
password was.



TimeWizard

Section Four • Managing Resources164

Summary

In this chapter, you have learned how to add employees to your TimeWizard system and setup
security records for those employees. These records give you the ability to exercise precise
control over who is permitted to use the various functions in TimeWizard.

Objective 8: Maintain employee security records

In the event an employee changes employment status (e.g., from contract or part-time to
fulltime), you can change the employee ID within his or her employee record. The new
employee ID must be unique. TimeWizard retains the original employee ID in historical
data. In addition, you can make other corrections to an employee’s security record as neces-
sary.

Maintaining Employee Security Records

To maintain employee security records, follow these steps:

1. From the Employees window, select the employee whose record you wish to edit.

2. Click on the Edit Employee icon          or double-click on the employee to open the Employee Detail
window.

3. Make any necessary changes to the record.

4. Click “Apply” to save the settings and remain in the window, or click “OK” to save the settings and exit
the window.

Objective 9: Delete an employee

You cannot delete an employee who has timesheet transactions existing in any period (open or
closed). The only way to delete such an employee is to first archive any period in which time
has been entered for the employee (such periods must be closed) and then delete any assign-
ments associated with the employee.

Deleting an employee

To delete an employee, follow these steps:
1. From the Employees window, select the employee you want to delete.

2. Click the Delete Employee icon          (Employee > Delete Employee) to open the Delete Employee
dialog box.

3. TimeWizard displays a  prompt, “Are you sure you want to delete this employee?” Click “Yes” to
delete the record.



5
S E C T I O N   F I V E

Managing Projects
in TimeWizard

The implied prerequisite to needing a labor tracking system is, well, labor. And
by definition, labor includes workers and activities—the two key ingredients to

this section. TimeWizard’s basic project management capabilities enable you to setup
activities and then assign resources to them. TimeWizard defines an “activity” as a task
or project and an “assignment” as the link between a resource (employee) and an
activity. When you assign an employee to an activity, you authorize that employee to
enter or charge time to a project or task on his or her timesheet.

This section includes

Introduction to Project Management in TimeWizard
Chapter 12: Working with Activities
Chapter 13: Working with Resource Assignments
Chapter 14: Working with Employee Assignments





167

The Activities and Assignments area enables you to create, maintain, and control access to
activities in your TimeWizard system. For any activity listed in the Activities and Assignments
window, you can add resource assignments, view employees available for assignment, assign
employees to an activity, and maintain existing assignments. Table I.1 gives a detailed explana-
tion of each section of the Activities and Assignments window (displayed in Figure I.1). Table
I.2 explains each toolbar icon in the Activities and Assignments window.

You also have the choice of managing projects in a project management system (e.g., Microsoft
Project 98, Primavera P3, or Business Engine) and then sharing project-related data with
TimeWizard through one of its ProjectLink interfaces. For more information, Section 7:
Sharing TimeWizard Data with Other Systems.

There are two assignment types in TimeWizard:

• A resource assignment is the association of a resource code and an activity.
• An employee assignment is the association of an activity, a resource code, and

an employee.

Introduction to Project Management
in TimeWizard
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Before we go any further—just to be certain that you understand the difference between
TimeWizard assignment types—we are going to play a game that you probably haven’t seen
since kindergarten: “Match the Worker to the Job.” On the top there are the following work-
ers: a postal worker, a waiter, a farmer, and a group of office workers. On the bottom there are
the following jobs: serving a bottle of wine, attending an office meeting, delivering mail, and
feeding a pig. The object of the game is to match the right worker to the right job.

In this exercise, the specific professional abilities—such as those represented by a postal worker,
a waiter, or a farmer—are resource types. Some of the jobs or activities—such as farming,
waiting tables, or delivering mail—can only be done by certain resource types. When you
match a specific resource type to a specific activity, you have created a resource assignment.
Only employees who have the appropriate resource codes may be assigned to resource assign-
ments.

Other activities—such as attending an office meeting—can be done by any worker. When
you match any resource type to a specific activity, you have created an <unclassified> resource
assignment. Any employee—regardless of what resource codes they have—may be assigned to
<unclassified> resource assignments.

Finally, when you put an individual employee—whether that is Joe the postal worker, Bob the
farmer, or Mary the office employee—to work on a resource or  <unclassified> assignment,
you have created an employee assignment.
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Figure I.1

Table I.1: Activities and Assignments Window Area

Section Five • Introduction to Project Management in TimeWizard
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Table I.2: Activities and Assignments Window Toolbar Icons
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Working with Activities

The Activities and Assignments area—which also includes the Activity Detail dialog box—
enables you to  create, maintain, and control access to  activities in your TimeWizard system.
In the next chapter, you will learn how to assign employees to activities so that they can charge
time to a project or task on their timesheets. Remember: TimeWizard defines an “activity” as
a task or project and an “assignment” as the link between a resource (employee) and an activ-
ity.

Objectives

1. Navigate the Activities and Assignments window
2. Use the Activities Quickfilter
3. Add a new activity
4. Define a new activity value
5. Edit an existing activity
6. Delete an existing activity
7. Close an existing activity
8. Open an existing activity

12C H A P T E R
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Objective 1: Navigate the Activities and Assignments window

From the Activities and Assignments window, you can create and maintain all TimeWizard
activities and assignments. Table 12.1 defines each icon used in this chapter.

Navigating the Activities and Assignments Window

To open the Activities and Assignments window,
follow either of these steps:

1. Click on the Activities and Assignments icon.

2. Select Tools > Activities and Assignments from the
TimeWizard main menu.

Figure 12.1

Objective 2: Use the Activities Quickfilter

Once you have entered activities into the TimeWizard system, you can retrieve them quickly
using the Activities Quickfilter located at the top of the Activities and Assignments window.
Rather than having to scroll through an entire listing of your company’s activities, you can use
the quickfilter to narrow the list of activities with which you want to work.

The fields listed across the top are those specified as quickfilter fields in your Activities Cus-
tom Field definitions. The drop-down box below each field contains all possible values associ-
ated with the field.

By selecting values for one or more quickfilter fields, you can reduce the number of activities
retrieved from the TimeWizard database. This can be a benefit for performance and for ease of
use.
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Table 12.1: Retrieved Activities Area Icons

Using the activity quickfilter

To use the activity quickfilter, follow these steps:

1. Click on the scroll arrow in each quickfilter field and
select your desired filtering parameters. Note: To view
all activities, select <All> for each quickfilter field.

2. Click on the “Retrieve” command button (Activities >
Quickfilter > Retrieve).

Figure 12.2

3. All activities that fall within your selected filtering
parameters appear in the activity quickfilter window.

To view all activities, select <All> for each quickfilter field. Or you can type the first characters
of a value in a Quickfilter field; as you type, TimeWizard searches ahead for a match.
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Objective 3. Add a new activity

From the Activity Detail dialog box, you can combine the activity code values you created in
Chapter 4 to create new activities in your TimeWizard system. Each activity must be a unique
combination of activity code values. The Activity Detail dialog box consists of four sections:
key activity field information, non-key activity field information, project management infor-
mation, and last update information. Table 9.2 explains these sections in detail.

You have the option of adding activities into TimeWizard using three different methods:

• Direct entry into the Activity Detail dialog box from the Activities and Assignments
window (discussed here)

• Automated entry through a ProjectLink (see Section 7)
• Automated entry through a Table Retrieval (see Section 7)

Once in the Activity Detail dialog box, you can click “Add” (in the lower left corner) to add a
new activity (rather than opening a new Activity Detail dialog box from the Activities and
Assignments window). When you open a new Activity Detail dialog box in this manner,
TimeWizard continues to display several of the activity data selections. This is especially con-
venient for adding several similar activities in succession.
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Example       Figure 12.3 shows an example Activity Detail window in which we created an activity d e -
scribed as “Standards/Guideline/HR Reviews.” The fields available in the Activity Detail win-
dow are determined by the custom field settings you defined in Chapter 3: Defining Custom
Fields. This example activity has the following key field values:

• Project: BOP-AD-99-Develop
• Scenario: 99-Prod
• Task: 1

To Add a new activity, follow these step

1. Click on the Add Activity icon to open the Activity
Detail window (Activity > Add Activity).

2. Enter the appropriate information requested for each
section of the Activity Detail window. (See “The

Figure 12.3

Activity Detail Window,” this chapter, for detailed
explanations.)

3. Click “Apply” to save the settings but remain in the
Activity detail window, or click “OK” to save the
settings and close the Activity Detail window.

Adding an activity
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Table 12.2: Activity Detail Area (continued on page 177)

liateDytivitcA noitanalpxE

)lanretnI(DIytivitcA .ytivitcahcaerofyllacitamotuasretnedraziWemiTtahtreifitnedilanretninasisihT

)deilppus-resU(DIytivitcA .ytivitcahcaerofretneuoytahtreifitnedinasisihT

epyTytivitcA

,)evaeL-HO(evaeldaehrevo,detaler-tcejorpsiytivitcaehtrehtehwseificepssihT
.)esnepxE-HO(esnepxenaro,)rehtO-HO(daehrevorehto,)kaerB-HO(kaerbdaehrevo

fotnuomanatpeccastnemngissaevael,teehsemit)OIC(tuO-kcolC/nI-kcolCehtnI
kaerbotdeggolemiT.steehsemitOIC-nonniodyehtsa,yadfosemitfodaetsniemit
deddaebnacstnemngissaesnepxE.slatotdoireproyliadnidetnuoctonsistnemngissa

.steehsesnepxeotylno

sutatSytivitcAsl
lla,desolcsiytivitcananehW.desolcroneposiytivitcaehtrehtehwseificepssihT

.desolcoslaerastnemngissadetaicossa

ytiroirPytivitcA
rebmunrewolA.ytivitcaehtfoecnatropmifolevelehtknarotuoyselbanesihT

.)eurtsietisoppoehthcihwrof,tcejorPtfosorciMnitpecxe(ytiroirprehgihasetangised

sdleiFyeKdenifeD-resU
tnawuoytahtnoitamrofnidetaler-ytivitcafoseirogetaclarenegehteraesehT

-resuelpmaxeehT.)sdleiFmotsuCgninifeD:3retpahCees(erutpacotdraziWemiT
.tnemtrapeddna,ksat,tcejorp,oiranecsera3.9erugiFninwohssdleifyekdenifed

noitpircseDytivitcA .teehsemitehtnoraeppalliwtisaytivitcaehtfonoitpircsedehtsisihT



TimeWizard

177Chapter Twelve • Working with Activities

Table 12.2: Activity Detail Area (continued from page 178)
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Objective 4: Define a new activity value

In the event you are attempting to create a new activity but a necessary activity value is not yet
in your TimeWizard system, you can create such a value on the fly. TimeWizard provides a
link from the Activity Details dialog box to the Code Values window, which enables you to
add a new value for a key field. You can then return to the Activity Details dialog box and
finish creating the new activity.

To define a new activity value, follow these
steps:

1. Type the new value in the appropriate key
field text box.

2. As soon as you enter and apply a new
project name (by either clicking “Apply” or
clicking on any other text box in the Activity
Detail window), TimeWizard opens a dialog
box asking if you wish to add the value.

3. Click “OK” to open the Code Values
window, with your new value entered (see
Chapter 5: Assigning Code Values).

4. Click “OK” to save the Code Values
window information and return to the
Activity Detail window.

Figure 12.4.2

Defining a new activity value

Figure 12.4.1
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You can bypass the Code Value Editor by checking the “Do not display Code Value Editor”
option in the TimeWizard dialog box. TimeWizard will automatically add the new value for
you.

Example: In the example shown in Figures 12.4.1 and 12.4.2, we are adding a new value “BOP-AD-99-
General 2” to the Project field. When we return to the Activity Detail window, we can use the
newly added value to create a new activity.

Objective 5: Edit an existing activity

You can edit existing activities by modifying the data listed in the Activity Detail window. To
maintain the relationships and integrity of the TimeWizard database, you cannot modify the
key fields in activity records. If you need to change these fields, you must first delete the
activity (or close it if hours exist) and then re-add it with the new fields.

To Edit an Activity, Follow these steps

1. Click on an activity listed in the Activities and Assign-
ments window.

2. Click on Activity > Edit Activity (or double-click on the
activity) to open the Activity Detail window for the
selected activity.

3. Modify existing information as needed.

4. Click “Apply” to save the settings and remain in the
Activity Detail window, or “OK” to save the settings
and exit the Activity Detail window.

Editing an activity

Objective 6: Delete an existing activity

To maintain the relationships and integrity of the TimeWizard database, you cannot delete an
activity if you have assignments (open or closed) to it in any period (see Figure 12.6.2). For
more information on the Archive and Purge functions (which allow you to save and then
delete unneeded data) see Chapter 2: Working with the TimeWizard Database.

You can instruct TimeWizard to proceed without displaying the Delete Activity confirmation
dialog box by specifying “Do not ask this question again.”
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To Delete an Activity, follow these steps:

1. Click on an activity.

2. Click on the Delete Activity icon (Activity > Delete Activity).

3. TimeWizard displays a prompt, “Delete selected activity?”

Deleting an activity

Figure 12.5.2

Click “OK” to delete the activity (see Figure 9.5.1). If
transactions exist for the activity, TimeWizard displays a dialog
box stating that you cannot delete the activity (see Figure
12.5.2).

Figure 12.5.1

Objective 7: Close an existing activity

Once an activity is closed, employees cannot enter hours for any assignments associated with
it on their timesheets. Any time already entered on the timesheet will stay as is, but TimeWizard
will lock out any further transactions associated with those assignments and any additional
assignments to that activity. When you close an activity, you are saying that all work must stop
for all associated assignments.

To close an existing activity, follow these steps:

1. Click on an activity.

2. Click on the Close Activity icon (Activity > Close Activity) to
close the selected activity.

3. TimeWizard displays a  prompt, “Close activity and all
associated assignments?” Click “OK” to close the activity.

Closing an existing activity

Figure 12.6
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Objective 8: Open an existing activity

When opening an activity, associated assignments can be opened automatically at the same
time, and then new assignments and subsequently time entries can be associated with it.

When you open an activity, you can instruct TimeWizard to open all associated activities at
the same time by specifying “Open all associated assignments” in the Open selected activities
confirmation dialog box.

To open an existing activity, follow these steps:

1. Click on an activity.

2. Click on the Open Activity icon (Activity > Open Activity) to
open the selected activity.

3. TimeWizard displays a  prompt, “Open selected activities?”
Click “Yes” to open the activity.

Opening an activity

Figure 12.7

You can select multiple activities to assign to a resource assignment.

To select multiple activities in sequence: 1. Click on the top activity. 2. Hold down the Shift
key. 3. Click on the bottom activity.

To select multiple activities not in sequence: 1. Click on one activity. 2. Hold down the
Control key. 3. Click on an additional activity. 4. Continue to hold down the Control key and
click on additional activities as needed.

Summary

In this chapter, you learned how to  create, maintain, and control access to  activities in your
TimeWizard system. In the next chapter, you will learn how to assign employees to activities
so that they can charge time to a project or task on their timesheets.
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Working with Resource Assignments

In Chapter 4, you specified resource code values to allow you to categorize your employees
by specific talent designations. Later, in Chapter 11, you assigned these resource code
values to specific employees. In this chapter, you create resource assignments, which is the
association of a resource and an activity. Only employees who have the appropriate resource
codes may be assigned to resource assignments. However, <unclassified> resource assign-
ments are available to any employee not already assigned to the activity.

One employee may have multiple resource codes, and therefore can be assigned to multiple
resource (as well as <unclassified> resource) assignments. Any employee—regardless of
what resource codes they have—may be assigned to <unclassified> resource assignments.

For instructions on adding activities to TimeWizard, see Chapter 12: Working with Activi-
ties.

Objectives

1. Navigate the Assignments area of the Activities and Assignments window
2. Add resource assignments
3. Edit an existing resource assignment
4. Delete an existing resource assignment
5. Close a resource assignment
6. Open a resource assignment
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Objective 1: Navigate the Assignments area of the Activities and Assignments window

From the Assignments area of the Activities and Assignments window (Figure 10.1), you
can create and maintain resource and employee assignments for all TimeWizard activities.
This area is divided into three sections (from left to right): the Resource Assignments
section, the Assigned Employees section, and the Available Employees section. For a de-
tailed explanation of each section of the Assignments area of the Activities and Assignments
window, refer to Table I.1 in the Introduction of this section. Table 10.1 defines each icon
used in this chapter.

Figure 10.1

Table: 10.1: Resource Assignments Icons
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Objective 2: Add resource assignments

For any activity listed in the Activities and Assignments window, you can add resource
assignments that stipulate which employees can be assigned to the activity.

Adding resource assignments

To Add resource assignments, follow these steps

1. In the activities quickfilter, click on a listed activity.

2. In the Assignment menu, select Add Resource Assignment to
open the Resource Assignment dialog box.

3. Select a resource code from the list to add a resource
assignment for the activity.

Figure 10.2

Example        The Resource Assignments section of the Assignments area (left) in Figure 10.1 contains the
default <unclassified> resource assignment as well as five additional resource assignments
that we selected from the Resource Assignment dialog box. In addition, we closed two of the
resource assignments so that all related employee assignments are closed and no additional
employees may be assigned to them.

4. Click OK to save the setting and return to
the Activity and Assignments window.

Adding a resource assignment to an
activity does not assign an
employee to the activity. It merely
specifies the resource codes
available for the employee
assignment.
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Objective 3: Edit an existing resource assignment

You can edit existing resource assignments by modifying the data listed in the Resource
Assignment Detail dialog box. To maintain the relationships and integrity of the TimeWizard
database, you cannot modify the key field (resource) in assignment records. If you need to
change this field, you must delete the assignment and then add it with the new resource.
Table 10.2 defines each area of the Resource Assignment Detail dialog box.

Editing a resource assignment

To edit an existing resource assignment, follow these steps

1. Click on a resource assignment.

2. Click on Assignment > Edit Resource Assignment to open the
Resource Assignment Detail window.

3. Alter the information as needed.

4. Click “Apply” to save the settings but remain in
the Resource Assignment Detail window, or click
“OK” to save the settings and close the Resource
Assignment Detail window.

Figure 10.3

Example Figure 10.3 shows an example Resource Assignment Detail dialog box in which we created
a resource assignment named SysEng for the selected activity. Any employee assigned to the
SysEng resource assignment for the selected activity must be associated with the SysEng
resource code.
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Table: 10.2: Resource Assignment Detail Area
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Objective 4: Delete an existing resource assignment

To maintain the relationships and integrity of the TimeWizard database, you cannot delete a
resource assignment if there is any time entered for it in any period (open or closed). For
more information on the Archive and Purge functions (which allow you to save and then
delete unneeded data) see Chapter 2: Working with the TimeWizard Database.

You can instruct TimeWizard to procede without displaying the Delete Assignment confir-
mation dialog box by specifying “Do not ask this question again.”

To delete an existing resource assignment, follow these
steps

1. Click on a resource assignment.

2. Select Assignment > Delete Resource Assignment to delete
the selected assignment.

3. TimeWizard displays a prompt, “Are you sure you want to
delete the selected assignment?” Click “OK” to delete the
assignment.

Deleting a resource assignment

Figure 10.4

Objective 5: Close a resource assignment

Once a resource assignment is closed, all associated employee assignments are also closed
(i.e., the assigned employee cannot enter hours for it on the timesheet). Any time already
entered on the timesheet for that resource assignment will stay as is, but TimeWizard will
lock out any further transactions associated with that assignment.

You can instruct TimeWizard to proceed without displaying the Close Resource Assignment
confirmation dialog box by specifying “Do not ask this question again.”

When closing a resource assignment, Actual Finish is calculated based on latest transaction.
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To close a resource assignment, follow these steps

1. Click on a resource assignment.

2. Select Assignment > Close Resource Assignment to close the
selected assignment.

3. TimeWizard displays a  prompt, “Are you sure you want to
close the selected assignment?” Click “OK” to close the
assignment.

Closing a resource assignment

Figure 10.5

Objective 6: Open a resource assignment

When opening a resource assignment, associated employee assignments can be opened
automatically at the same time, and then new employee assignments and subsequently time
entries can be associated with it.

When you open a resource assignment, you can instruct TimeWizard to open all associated
employee assignments at the same time by specifying “Open all associated assignments” in
the Open selected activities confirmation dialog box.

When opening a resource assignment, Actual Finish is cleared.

To open a resource assignment, follow these steps

1. Click on a resource assignment.

2. Select Assignment > Open Resource Assignment to open the
selected assignment.

3. TimeWizard displays a  prompt, “Are you sure you want to
open the selected assignment?” Click “OK” to open the
assignment.

Opening a resource assignment

Figure 10.6
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Summary

In this chapter, you have learned how to make resource and <unclassified> resource assign-
ments to the activities in your TimeWizard system. Your next step is to make employee
assignments based on the resource code criteria—thereby authorizing your company’s em-
ployees to work on specific projects and charge time against those projects on their timesheets.
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Working with Employee Assignments

From the the Assigned Employees section and the Available Employees section of the Activi-
ties and Assignments window, you can create and maintain employee assignments. In this
process, employees are assigned to a resource or <unclassified> resource assignment (employee-
specific) for a selected activity.

Only employees who have the proper resource codes are available for resource assignments.
However, any employee not already assigned to a selected activity is available for <unclassi-
fied> resource assignments (i.e., employee-specific assignments). Table 14.1 defines each icon
used in this chapter.

Objectives

1. Assign available employees to a resource assignment
2. View assigned employees
3. Edit an existing employee assignment
4. Delete an existing employee assignment
5. Close an existing employee assignment
6. Open an existing employee assignment
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Objective 1: Assign available employees to a resource assignment

An available employee is defined as one who is not already assigned to the selected  resource
assignment. The list of available employees will vary depending on the resource code require-
ments of the resource assignment. For example, if the resource assignment is “SysEng,” only
employees who have the “SysEng” resource code will be listed. However, if the resource assign-
ment is <unclassified>, all available employees will be listed, regardless of which resource codes
they have. Multiple employees may be assigned to the same activity, and any given employee
may be assigned to multiple activities.

You can view employees by either name or employee ID by changing the display order (As-
signment > Display Order > By Name/By Employee ID). To do so, click on the data column
header you prefer in the Available Employees area.

Table: 14.1: Employee Assignments Icons
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Assigning available employees to a resource assignment

To assign available employees to an activity, follow These
steps:

1. In the Retrieved Activities area, click on a listed activity.

2. In the Resource Assignments area (left), select either <unclassified>
or a specific resource assignment.

3. In accordance with your selections, all employees available for
assignment are listed in the Available Employees box (right).

4. Click on an available employee.

5. Drag and drop the available employee from the Available
Employees box (right) to the Assigned Employees box (center). Or
click on the Add Assignment icon (Assignment > Add Assign-
ment).

Figure 14.1

You can select multiple employees to assign to a resource assignment.

To select multiple employees in sequence: 1. Click on the top employee. 2. Hold down the
Shift key. 3. Click on the bottom employee.

To select multiple employee not in sequence: 1. Click on one employee. 2. Hold down the
Control key. 3. Click on an additional employee. 4. Continue to hold down the Control key
and click on additional employees as needed.



TimeWizard

Section Five • Managing Projects in TimeWizard194

Viewing assigned employees

To view assigned employees, follow these steps

1. Click on a listed activity.

2. Click on an associated resource assignment.

3. Check the Show Assigned Employees box at the bottom of the
Activities and Assignments window.

4. All employees assigned to the selected activity are listed in the
Assigned Employees box at right.

Figure 14.2

Objective 2: View assigned employees

The Assigned Employees box (center) lists all employees assigned to specified resource assign-
ment for the selected activity.

You can view employees by either name or employee ID by changing the display order. To do
so, click on the data column header you prefer in the Assigned Employees area.
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Editing an employee assignment

To edit an existing employee assignment follow these steps:

1. Click on an assigned employee.

2. Click on Assignment > Edit Assignment to open the Employee
Assignment Detail window.(Or double-click on the employee.)

3. Alter the information as needed.

4. Click “Apply” to save the settings but remain in the
Employee Assignment Detail window, or click “OK”
to save the settings and close the Employee
Assignment Detail window.

Figure 14.3

Objective 3: Edit an existing employee assignment

In the Employee Assignment Detail dialog box, you can edit the information associated with
one of the employees assigned to an activity. The Employee Assignment Detail window con-
sists of four sections: activity information, employee and assignment information, project
management information, and last update information. Table 14.2 explains these sections in
detail.

To maintain the relationships and integrity of the TimeWizard database, you cannot modify
the key field (employee/resource) in assignment records. If you need to change this field, you
must delete the assignment and then add it with the new employee/resource.

Example         Figure 14.3 shows an example Employee Assignment Detail dialog box in which we assigned
employee Mike T. Williams to an <unclassified> resource assignment for the activity described
as “software development - customer support.”
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Table: 14.2: Employee Assignment Detail Area
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Objective 4: Delete an existing employee assignment

To maintain the relationships and integrity of the TimeWizard database, you cannot delete an
assignment if there is any time entered for it in any period (open or closed).

To delete an existing employee assignment

1. Click on an assigned employee.

2. Click on the Delete Assignment icon (Assignment > Delete
Assignment) to delete the selected assignment.

3. TimeWizard displays a prompt, “Are you sure you want to
delete the selected assignment?” Click “OK” to delete the
assignment.

Deleting an employee assignment

Figure 14.4

Objective 5: Close an existing employee assignment

Once an assignment is closed, the employee cannot enter hours for it on the timesheet. Any
time entered on the timesheet will stay as is, but TimeWizard will lock out any further trans-
actions associated with that assignment.

When you close an assignment, the Actual Finish is calculated based on the last transaction.

To close an existing employee assignment, follow these steps

1. Click on an assigned employee.

2. Click on the Close Assignment icon (Assignment > Close Assignment)
to close the selected assignment.

3. TimeWizard displays a  prompt, “Are you sure you want to close the
selected assignment?” Click “OK” to close the assignment.

Closing an employee assignment

Figure 14.5
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Objective 6: Open an existing employee assignment

Once an assignment is opened, it reappears on the timesheet, and work may continue for that
employee on that task or project.

When you open an assignment, the Actual Finish is cleared.

To open an existing employee assignment, follow these steps

1. Click on an assigned employee.

2. Click on the Open Assignment icon (Assignment > Open Assignment)
to open the selected assignment.

3. TimeWizard displays a  prompt, “Are you sure you want to open the
selected assignment?” Click “OK” to open the assignment.

Opening an employee assignment

Figure 14.6

Summary

In this chapter, you have learned how make employee assignments to the resource assignments
for the activities in your TimeWizard system. In so doing, you authorize your company’s
employees to work on specific projects and charge time against those projects on their timesheets.



6
S E C T I O N  S I X

Applying Your Business
Rules to TimeWizard

Playing by the Rules

You can play just about any game without regard to the rules—from tennis to
chess to Candyland—but you just don’t get the same outcome of the game.

TimeWizard is much the same. Through previous chapters, you have already setup
the system so that your employees can charge time against projects on their timesheets.
You could say that you have setup the playing board and all the pieces. By applying
rules to the game—or rather your company’s time accounting process—you improve
the outcome and ultimate impact the software will have on your company.

TimeWizard’s business rules enable you to determine what each user can or cannot do
within the system. For example, you can control where users can go in the system,
setup standard work days for different employee types (e.g., full-time or part-time),
grant or deny employee access to the activities in TimeWizard, specify what types of
time employees can charge on their timesheets (e.g., overtime, shift codes, and pay
codes), and decide who has access to certain levels of business reports.
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This section includes

Introduction to Section 6
Chapter 15: Setting Permissions
Chapter 16: Setting Up Preferences
Chapter 17: Creating Access Lists
Chapter 18: Creating Activity Approval Pools
Chapter 19: Setting Up Detail Code Rules
Chapter 20: Defining Timesheet Rules
Chapter 21: Standard Text Editor
Chapter 22: Setting Report Category Profiles
Chapter 23: Setting Up Reports
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Introduction

This introduction to applying your business rules to TimeWizard explains the principles that
are the same throughout all of the business rules categories. By understanding these common-
alities up front, you will find it easier to grasp the specific areas in which the categories differ.

TimeWizard has eight categories that enable you to set up the following business rules: Per-
missions, Preferences, Access Lists, Activity Approval Pools, Detail Code Rules, the Standard
Text Editor, Report Categories, and Timesheet Rules. Table I.1 explains each business rule
category. When you define a business rule, you create a rules profile group. Then, when you
assign TimeWizard users to specific rules profile groups, they are—as members of that group—
bound by its permissions and restrictions.

Table I.1: Business Rules Categories
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Objectives

When you have finished this introduction, you should be able to do the following:

1. Understand Employee and Activity Grouping Methods
2. Understand who Available Members are
3. Use the Quickfilter

Objective 1: Understand Employee and Activity Grouping Methods

One of the necessary steps in creating many of the business rules in TimeWizard is to group
together employees and/or activities. By grouping, you are specifying which employees or
activities should be treated alike for the specific rule you are creating. In short, you are saying
how you want to group your employees or activities for the purpose of assigning them—as
members—to specific rules.

The definition of “members” is controlled by your selections in the Employee and Activity
Members Grouped By drop-down boxes, located at the bottom of each Business Rules cat-

Table I.2: Employee Grouping Methods
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egory window and in the Activity Groups dialog boxes. Each grouping method controls how
your information is categorized and displayed in the selected category window; consequently,
you may choose only one method of employee or activity grouping for each category. Chang-
ing the method of grouping employees or activities for a specific profile or activity group will
remove all existing assignments for that profile or group.

The Employee Members Grouped By menu (located in most Business Rules category win-
dows) groups employees based on any of the three key employee fields. The Activity Members
Grouped By menu (located in the Activity Groups dialog boxes for the Access Lists and
Activity Approval Pools business rules categories) groups employees based on any of the four
custom key activity fields. In addition, for most of the grouping methods (employee or activ-
ity) you can select a custom list. Table I.2 explains the TimeWizard employee grouping meth-
ods.

Objective 2: Understand who Available Members are

From within the Permissions, Preferences, Detail Codes, and Report Categories business rules
categories, an available member may belong only to a single rules profile group, as that set of
rules governs all actions by that member. For these business rules categories, the term “avail-
able members” is defined as those members not previously assigned to another profile group
from within any same Business Rules category.

The same restriction does not apply to the Access Lists and Activity Approval Pools business
rules categories. An employee may belong to multiple access lists and activity approval pools.
For these busines rules categories, the term “available members” is defined as those members
not previously assigned to the same access list or activity approval pool.
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Objective 3: Use the Quickfilter

Once you have entered employees and activities into the TimeWizard system, you can retrieve
them quickly using the quickfilter located in each Business Rules category window. Rather
than having to scroll through entire listings of your company’s employees and activities, you
can use the quickfilter to narrow the list with which you want to work.

The fields listed across the top are those specified as quickfilter fields in your Custom Field
definitions. The drop-down box below each field contains all possible values associated with
the field.

By selecting values for one or more quickfilter fields, you can reduce the number of activities
or employees retrieved from the TimeWizard database. This can be a benefit for performance
and for ease of use.

Summary

In this introduction, you have been introduced to the basic concepts and functional common-
alities of the TimeWizard Business Rules categories. In the following chapters, you learn the
specific steps needed to define each rule for your TimeWizard system.

Using the quickfilter

To use the quickfilter, follow these steps:

1. Click on the scroll arrow in each quickfilter field and select your
desired filtering parameters. Note: To view all activities or
employees, select <All> for each quickfilter field.

2. Click “Retrieve.”

3. All activities or employees that fall within your
selected filtering parameters appear in the
appropriate window.

Figure I.1
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Setting Permissions

The Permissions business rules category enables you to control user access throughout the
system. Simply put, users must have your permission to access certain functions in TimeWizard.
You control access to TimeWizard users by setting up permissions profile groups and assign-
ing employee members to appropriate groups.

After reviewing all of the individual permissions (as shown in Figure 15.2 and defined in
Tables 15.2-4), decide how many different sets of rules are needed for permissions. For ex-
ample, you may have a default list of permissions for most employees, a different set of per-
missions for managers, and an additional one or two sets for different levels of TimeWizard
Administrators. These sets of rules are called profiles.

In addition, think about how you want to group employees for the purpose of assigning them
to these sets of rules. Do all employees—without exception—have the same set of permissions
based on the department to which they belong? Or is the grouping based on what type of
employee they are (e.g., regular employee vs. contractor)? Or if grouping does not fit your
organization, you can use custom lists.

Objectives

When you have finished this chapter, you should be able to do the following:

1. Navigate the Permissions area
2. Define a permissions profile
3. Assign members to a permissions profile
4. Edit a permissions profile
5. Delete a permissions profile
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Objective 1: Navigate the Permissions area

From the Permissions area, you can create and maintain all TimeWizard permissions profiles.
Table 15.1 defines each toolbar icon used in this chapter.

Table 15.1: Permission Icons

Figure 15.1

Navigating the Permissions area

To open the Permissions area, follow either
of these steps

1. Click on the Permissions icon.

2. Select Tools > Business Rules > Permissions from
the TimeWizard main menu.

Objective 2: Define a permissions profile

The Permissions Profile categories in the Permissions Profile dialog box refer to typical levels
of TimeWizard users. Any profile that you create is not limited to a single category. In other
words, you can pick and choose among all of the permission selections to create a unique
profile. Tables 15.2-4 explain all of the selections available in the Permissions Profile dialog
box.
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The Default permissions profile contains all employees who do not belong to any other pro-
file. You cannot delete the default profile. You create new permission profiles so that groups of
employees are governed by different permission rules.

Defining a permissions profile

To define a permissions profile, follow either of these steps

1. Open the Permissions window (Tools > Business Rules >
Permissions).

2. Click the Add Profile icon to open the Permissions Profile dialog
box (Profile > Add Profile).

3. Type the name and description of the profile in the text boxes.

4. Check every permission box appropriate to the
profile. (See Tables 15.2-4 for detailed explanations.)

5. Click “Apply” to save the settings but remain in the
dialog box, or click “OK” to save the settings and
close the dialog box.

Figure 15.2

Example      Figure 15.2 shows an example Permissions Profile dialog box in which we created a new
permissions profile group named “Timesheet Manager.” In this example, the permissions
profile group members (who will be managers of TimeWizard timesheets) have a variety of
permissions selected from each permissions level to enable them to manage timesheets effec-
tively.
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Table 15.2: Timesheet Permissions

Table 15.3: Advanced Permissions
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Table 15.4: Administrator Permissions
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Objective 3: Assign members to a permissions profile

When you assign TimeWizard users to specific permissions profile groups, they are—as mem-
bers of that group—bound by its permissions and restrictions. All members start out in the
<default> permission profile. Create all the additional permissions profiles you need. Then
decide how to group employees (i.e., by department, salary, employee code, or custom lists).
As you select a profile on the left, you see the current members of that profile on the right.
Move the members on the right (from the <default> group) into the appropriate profile on
the left.

Assigning members to a permissions profile

To assign members to a permissions profile, follow either of these steps
Figure 15.3

1. Open the Permissions window (Tools > Business Rules >
Permissions).

2. Choose an employee grouping method (see “Employees
Grouping Methods,” this chapter).

3. To view all available members, select “<Default>” in the
Permissions Profile window (the members listed are “members”

of the “profile group” named “<Default>”).

The <default> profile can be modified but
never deleted.

4. Drag and drop each appropriate
employee from the list in the Members box to the
appropriate profile in the Permission Profiles box.
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In the members box, you can sort the display lists by clicking on the Employee ID tab and the
Employee Name tab.

In addition, you can multiple select members by using the shift or control keys on your
keyboard.

To edit a permissions profile, follow these steps:

1. Select a Permissions Profile.

2. Click the Edit Profile icon to open the Permissions Profile dialog box (Profile > Edit Profile).

3. Modify the profile information as desired.

4. Click “Apply” to save the settings but remain in the dialog box, or click “OK” to save the settings and close the dialog box.

Editing a permissions profile

Objective 4: Edit a permissions profile

When you edit a permissions profile, you automatically change the permission settings for all
of its members.

To delete a permissions profile, follow these steps

1. Select the desired profile.

2. Click the Delete Profile icon (Profile > Delete Profile). Members of deleted
profiles

Deleting a permissions profile

Figure 15.4

Objective 5: Delete a permissions profile

When you delete a permissions profile, its members return to the <Default> group. You
cannot delete the <Default> profile, because its members are those not belonging to any other
group.
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Summary

In this chapter, you have learned how to control access to TimeWizard users by setting up
permissions profile groups and assigning members to appropriate groups.
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16C H A P T E R

Setting Up Preferences

You can create preference business rules groups to define standard work days, work weeks, and
other timesheet and project management settings for your company’s employees. You then
assign members to these groups. You can create as many preference profiles groups as needed,
but each employee may be assigned to only one—e.g., one employee may have a standard
work day of four hours, while another may have a standard work day of eight hours.)

Objectives

When you have finished this chapter, you should be able to do the following:

1. Navigate the Preferences area
2. Define a preferences profile
3. Assign members to a preferences profile
4. Edit a preferences profile
5. Delete a preferences profile
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Objective 1: Navigate the Preferences area

From the Preferences area, you can create and maintain all TimeWizard Preference profiles
and manage the memberships to each. Table 16.1 defines each toolbar icon used in this chap-
ter.

To open the Preferences area, follow either of these
steps:

1. Click on the Preferences icon.

2. Select Tools > Business Rules > Preferences from the
TimeWizard main menu.

Figure 16.1

Navigating the Permissions area

Table 16.1: Preferences Icons
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Objective 2: Define a preferences profile

The Default preferences profile contains all employees who do not belong to any other pro-
file. You can rename—but not delete—the default profile. You create new preferences profiles
so that groups of employees are governed by different preference rules. Tables 16.2-5 explain
all of the selections available in the Preferences Profile dilaog box.

The Timer Logoff (minutes) is a unique client/server feature that serves as additional system
security. This feature can guard against two potential problems:

1. Possible access to information and permissions that otherwise would be restricted.
This could occur when employees who are logged on to TimeWizard leave it run-
ning and leave their workstations unattended for a period of time.

2. Resource overload. This could occur (depending on your DBMS server licensing and
setup) if many users are logged on to TimeWizard and are, therefore, connected to
the TimeWizard database.

Defining a preferences profile

To define a preferences profile, follow these steps:

1. Open the Assign Preferences window (Tools > Business Rules >
Preferences).

2. Click on the Add Preferences icon to open the “Preferences
Profile” dialog box (Profile > Add Profile).

3. Type the profile name and description in the text boxes.

4. Specify profile settings (see Tables 16.2-5).

5. Click “Apply” to save the setting but remain in the
dialog box, or click “OK” to save the setting and
close the dialog box.

Figure 16.2
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Table 16.2: Logon/Logoff Preferences

Table 16.3: Email Preferences
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Table 16.4: Timesheet Editing Preferences
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Objective 3: Assign members to a preferences profile

When you assign TimeWizard users to specific preferences profile groups, they are—as mem-
bers of that group—bound by its preferences and restrictions. All members start out in the
<default> preferences profile. Create all the additional preferences profiles you need. Then
decide how to group employees (i.e., by department, salary, employee code, or custom lists).
As you select a profile on the left, you see the current members of that profile on the right.
Move the members on the right (from the <default> group) into the appropriate profile on
the left.

In the members box, you can sort the display lists by clicking on the Employee ID tab and the
Employee Name tab.

In addition, you can multiple select members by using the shift or control keys on your keyboard.

Table 16.5: Timesheet Display Preferences
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Assigning members to a preferences profile

To assign members to a preferences profile, follow these steps:

1. Choose an employee grouping method (see “Employee
Grouping Methods,” this chapter).

2. Select “<Default>” in the Preferences Profile window to view all
available members (the members listed are “members” of the
“profile group” named “<Default>”).

3. Drag and drop each appropriate employee from the
list in the Members box to the appropriate profile in
the Preferences Profiles box.

Figure 16.3

Example In Figure 16.2, we created a new Preferences profile named “Short Workday” for employees
who have a shorter workday and work week. According to the set rules of this example profile
(among other preferences), a typical workweek for its members—the employees listed in Fig-
ure 16.3—consists of a 7-hour work day and a 35-hour standard work week.
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Objective 4: Edit a preferences profile

When you edit a preferences profile, you automatically change the preference settings for all
of its members.

Objective 5: Delete a preferences profile

When you delete a preferences profile, its members return to the <Default> group. You
cannot delete the <Default> profile.

Summary

In this chapter, you have learned how to create preference profile groups—to define standard
work days, work weeks, and other timesheet and project management settings for your
company’s employees—and then assign members to these profiles.

To edit a preferences profile, follow these steps:

1. In the Preferences window, select a preference profile from the Preference Profiles box.

2. Click the Edit Profile icon or double-click on the profile to open the Preferences Profile dialog box (Profile > Edit Profile) for
the selected profile.

2. Edit the profile information.

3. Click “Apply” to save the settings but remain in the dialog box, or click “OK” to save the settings and close the dialog box.

Editing a preferences profile

To delete a preferences profile, follow these steps:

1. Select the desired profile.

2. Click the Delete Profile icon (Profile > Delete Profile). Members of deleted
profiles return to the <Default> group. (Remember: You cannot delete the
<Default> profile.)

Figure 16.4

Deleting a preferences profile
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Creating Access Lists

Assigning an access list to an activity enables you to have greater control over the way assign-
ments to an activity are made. By creating access lists, you limit the list of employees who have
“access” to a specific activity. In other words, an access list specifies which TimeWizard users
can be assigned to a particular activity.

Your work with access lists follows a three-step process:

1. Define activity groups (in the Activity Groups dialog box).
2. Assign activities to the activity groups (in the Activity Groups dialog box).
3. Assign members to the activity groups (in the Activity Groups dialog box), thus

defining an access list.

Objectives

1. Navigate the Access Lists area
2. Define an activity group
3. Assign available activity members to an activity group
4. Assign available employee members to an activity group
5. Edit an activity group
6. Delete an activity group
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Objective 1: Navigate the Access Lists area

From the Access Lists area, you can create and maintain all TimeWizard Access Lists. Table
17.1 defines each toolbar icon used in this chapter.

To open the Access Lists area, follow either
of these steps:

1. Click on the Access Lists icon.

2. Select Tools > Business Rules > Access Lists from
the TimeWizard main menu.

Figure 17.1

Navigating the Access Lists area

Table 17.1: Access Lists Icons
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Objective 2: Define an activity group

The first step in creating access lists is to create groups of activities—activity groups—to
which you will later grant access to selected employee members. In this objective, you create
and name the group to which you will assign activity members.

Defining an activity group

To define an activity group, follow these
steps:

1. Click the Add Activity Group icon to open
the Activity Groups dialog box (Activity
Group > Add Group) (see Figure 9.8).

2. Type the activity group name and descrip-
tion in the text boxes.

3. Click “Apply” to save the settings but
remain in the dialog box, or click “OK” to
save the settings and close the dialog box.

Once you click on Apply, the
retrieve button is enabled so you
can assign activity members.

Figure 17.2

Example        Figure 17.2 shows an example Activity Groups dialog box in which we are adding a new
   activity group named “Software Development.”
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Objective 3: Assign available activity members to an activity group

Once you have defined an activity group, the next step is to assign individual activities—
activity members—associated with the larger activity group. Available activities are those ac-
tivities not assigned to another activity group. All activity members start out in the <Core
Group> activity group. Create all the additional activity groups you need. Then decide how to
group activities—i.e., by any of the four custom key Activity fields you defined previously or
by custom lists. As you select an activity group on the left, you see the current activity mem-
bers of that activity group on the right. Move the members on the right (from the <Core
Group>) into the appropriate activity group on the left.

Example Figure 17.3 shows an example Activity Groups window in which we have assigned  three
activity member—SWDV/AT/ANYL, SWDV/CS/ANYL, and SWDV/MN/ANYL—to the
activity group named “Software Development. In this example, we chose to group activity
members by custom lists.

Assigning available activities to an activity group

To assign available activities to an activity
group, follow these steps:

1. In the Access Lists window, click the tab of the activity
group to which you want to assign activities.

2. Click the Edit Activity Group icon (or double-click on
the appropriate activity group tab) to open the
Activity Groups dialog box.

3. Specify an activity member grouping method.

4. Specify your quickfilter parameters (see “Using the
Quickfilter,” this chapter).

5. Click “Retrieve” to display available activities in the
Members box (the activities listed are “members” of
the <Core Group>).

6. Drag and drop available <Core Group> activity
members from the Members box onto a desired
activity in the Activity Groups box.

7. Click “OK” to return to the Access Lists window.
Figure 17.3
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To edit the activity membership for an activity group, move the appropriate activities from the
membership area on the right back to the <Core Group> activity group on the left.

In the Activity Members box, you can sort the display lists by clicking on the Activity fields
tabs.

In addition, you can multiple select activity members by using the shift or control keys on
your keyboard.

Objective 4: Assign available employee members to an activity group

When you assign available employee members to an activity group, you allow them to create
assignments for any of the activities in the activity group. Employees who are not assigned to
the activity group do not have access to those activities.

Available employees are those who are not already assigned to the selected activity group. A
single employee may be assigned access to multiple activity groups.  Create all the additional
activity groups you need. Then decide how to group employees. As you select an activity
group from the tabs at the top of the Access Lists window, you can see available employees on
the right. Move the appropriate employees on the right into the membership area on the left.

To edit the employee membership for an activity group access list, move the appropriate
employees from the membership area on the left back to the available employees area on the
right.

In the Activity Members box, you can sort the display lists by clicking on the Activity fields
tabs.

In addition, you can multiple select activity members by using the shift or control keys on
your keyboard.
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Example Figure 17.4 shows an example activity group access list. From the list of available employees
on the right, we assigned seven employees access to the activity group “Software Develop-
ment.” In this example, we chose to group activity members by custom lists.

Another example could be to group employees by department and then assign SE to the
Software Development tasks access list.

Assigning available employee members to an activity group

To assign members to an activity group, follow these steps:

1. In the Access Lists window, click the tab of the activity group
to which you want to assign employees.

2. Specify an employee grouping method (see “Employees
Grouping Methods,” this chapter).

3. Specify your quickfilter parameters (see “Using the
Quickfilter,” this chapter).

4. Click “Retrieve” to display available employees.

5. Drag and drop each appropriate employee from the
Available Employees box to the Access List Members box.

To reverse the Access List assignment, simply drag and
drop the employee from the Acces List Members box
back to the Available Employees box.

Figure 17.4
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Objective 5: Edit an activity group

The Edit Activity Group dialog box enables you to rename and change the description for an
existing activity group.

Editing an activity group

To edit an activity group, follow these steps:

1. In the Access Lists window, click the tab of the activity group to
which you want to make corrections.

2. Click the Edit Activity Group icon to open the Activity Groups
dialog box (Activity Group > Edit Group).

3. Click “Retrieve” to display available activities.

4. In the Activity Groups box, double-click on the activitiy group

you want to edit to open the Edit Activity Group
dialog box.

5. Edit the activity group information (i.e., name or
description) as necessary.

6. Click “OK” to save the changes and return to the
Activity Groups dialog box.

Figure 17.5
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Objective 6: Delete an activity group

When you delete an activity group, its activity members return to the <Core Group>, and its
employee members return to the Available Employees box for other activity groups.

Activities belonging to the deleted activity groups return to the <Core> group. Consequently,
employees belonging to the deleted activity groups return to the available employees list.

Summary

In this chapter you have learned to create groups of activities and then assign employee mem-
bers to those groups. In so doing, you allow those employees to create assignments for the
activities in the activity groups.

To delete an activity group, follow these steps:

1. In the Access Lists window, click the tab of the activity group that
you want to delete.

2. Click the Delete Activity Group icon (Profile > Delete activity
group).

3. TimeWizard displays a confirmation window: “Delete current
activity group?” Click “OK” to delete the activity group.

Figure 17.6

Deleting an Activity Group
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Creating Activity Approval Pools

If you chose integrated approvals as your approval process, you need to set up activity approval
pools. Creating activity approval pools enables you to specify who can approve time charged
to specific activities. An activity approver, who is called an activity owner, is usually a project
team leader who is authorized to approve time for a particular project’s activities. An activity
owner does not need to be a department owner to approve time for employee assignments.

Your work with project approval pools follows a three-step process:

1. Define activity groups (in the Activity Groups dialog box).
2. Assign activity members to the activity groups (in the Activity Groups dialog box).
3. Assign employee members to the activity groups (in the Activity Approval Pools

window), thus defining an activity approval pool.

Objectives

1. Navigate the Activity Approval Pools area
2. Define an activity group
3. Assign available activity members to an activity group
4. Assign available employee members to an activity approval pool
5. Edit an activity group
6. Delete an activity group
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Objective 1: Navigate the Activity Approval Pools area

From the Activity Approval Pools area, you can create and maintain all TimeWizard activity
approval pool activity groups. Table 18.1 defines each toolbar icon used in this chapter.

To open the Activity Approval Pools area, follow
either of these steps:

1. Click on the Activity Approval Pools icon.

2. Select Tools > Business Rules > Activity Approval Pools from
the TimeWizard main menu.

Figure 18.1

Navigating the Activity Approval Pools area

Table 18.1: Activity Approval Pools Icons
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Objective 2: Define an activity group

The first step in creating an activity approval pool is to create an activity group. In this objec-
tive, you add and name the group. In Objective 3, you assign activities (activity members) to
the group. Finally, in Objective 4, you assign employee members to the group. These em-
ployee members are activity owners, who have the authority to approve time for all employee
assignments associated with the group’s activity members.

Defining an activity group

To define an activity group, follow these
steps:

1. After opening the Activity Approval Pools
window, click the Add Activity Group icon or
select Activity Group > Add Activity Group
from the main menu to open the Activity
Groups dialog box.

2. Type the profile name and description in the
text boxes at the top of the dialog box.

3. Click “Apply” to save the settings but remain
in the dialog box, or click “OK” to save the
settings and return to the Activity Approval
Pools window. If you remain in the dialog box,
continue with Objective 3, step 3, to assign
activity members.

Once you click on Apply, the Add
button in the dialog box is enabled,
and you can add additional activity
groups without exiting. Figure 18.2
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Objective 3: Assign available activity members to an activity group

Once you have defined an activity group, the next step is to assign individual activities—
activity members—associated with the larger activity group. Available activities are those ac-
tivities not assigned to another activity group. All activities start out in the <Core Group>
activity group. Define all the additional activity groups you need (see Objective 2). Then
decide how to group activities—i.e., by any of the key activity fields you defined previously in
the Custom Fields area (from activity field 1 through field 4). As you select an activity group
on the left of the Activity Groups dialog box, you see the current activity members of that
activity group on the right. When the <Core Group> is selected, you can move available
activities on the right into the appropriate activity group on the left.

Example Figure 18.3 shows an example Activity Groups window in which we have assigned one activ-
ity member to the activity group named “eCommerce.” In this example, we chose to group
activity members by Project.

To assign available activity members to an
activity group, follow these steps:

1. In the Activity Approval Pools window, click on
the activity group to which you want to assign
activities.

2. Click the Edit Activity Group icon or select Activity
Groups > Edit Activity Group from the menu to
open the Activity Groups dialog box.

3. Specify activity grouping method in the Activity
Members Grouped By drop-down box (see the
introduction of this chapter).

You must use the same grouping method
for each activity group in the Activity
Approval Pools area.

4. With <Core Group> selected on the left, drag and
drop available <Core Group> activities from the
Activity Members box on the right onto the
desired activity group on the left.

5. Click “Apply” to save your assignments and
remain in the dialog box or click “OK” to save
and exit the Activity Groups box.

Figure 18.3

Assigning available activity members to an activity group

6. While the Activity Groups dialog box is open, click on any activity
group on the left to view its assigned members on the right.
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You can multiple-select activity members by holding down the Shift key and clicking on the
top and bottom rows of the series you want to select or by holding down the Control key and
clicking on each row you want.

Objective 4: Assign available employee members to an activity approval pool

When you assign available employee members to an activity group, you grant approval au-
thority for all employee assignments associated with the activities in the activity group. Other
employees, who are not assigned to the activity group, do not have approval authority over
those activities. An activity group may have more than one approval pool member; however,
only one member’s approval will be required for that group of activities. Additional pool
members are for backup purposes.

Available employees are those who are not already assigned to the selected activity group. A
single employee may be assigned to multiple activity groups.  Define all the additional activity
groups you need. As you select an activity group in the upper frame of the Activity Approval
Pools window, you can see available employees in the lower right frame. Move the appropriate
employees from the right into the Approval Pool Members area in the lower left frame.

You must assign activity members to an activity group before assigning employee members to
the associated activity approval pool.

To edit the employee membership for an activity group, move the appropriate employees
from the membership area (on the left) back to the available employees area on the right.

Example Figure 18.4 shows an example activity approval pool. From the list of available employees on
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the right, we assigned two employees approval authority over the activities in the activity
group “B2B.”

In the Approval Pool Members box and the Available Employees box, you can sort the display
lists by clicking on the Employee ID or Employee Name Column headings.

To assign available employee members to an activity approval pool, follow these steps:

1. In the Activity Approval Pools window, click on the activity
group to which you want to assign employees.

2. Specify your quickfilter parameters (see “Using the Quickfilter,”
in the introduction of this section). If you choose any parameters
other than <All>, click “Retrieve” to display the filtered list of
employees.

3. Drag and drop each appropriate employee from the
Available Employees box to the Approval Pool
Members box.

To reverse the activity approval pool
assignment, simply drag and drop the
employee from the Approval Pool Members
box back to the Available Employees box.

Figure 18.4

Assigning available employee members to an activity approval pool
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In addition, you can multiple-select activity members by holding down the Shift key and
clicking on the top and bottom rows of the series you want to select or by holding down the
Control key and clicking on each row you want.

Objective 5: Edit an activity group

The Activity Groups dialog box enables you to rename and change the description for an
existing activity group. You can change the membership of an activity group in the same
dialog box.

Editing an activity group

To edit an activity group, follow these steps:

1. In the Activity Approval Pools window, click on the Edit Activity
Group icon to open the Activity Groups dialog box (Activity
Groups > Edit Activity Group).

2. In the Activity Groups dialog box, click on the activity group you
want to edit.

3. To edit the group name or description, make the desired
change in the text boxes in the top frame.

4. To edit the activity membership of the group, drag
the appropriate activities from the membership
frame on the right to the <Core Group> activity
group on the left. Activities moved to the
<CoreGroup> are available to be assigned.

5. Click “Apply” to save the settings but remain in the
dialog box, or click “OK” to save the settings and
close the dialog box.
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To delete an activity group, follow these steps:

1. In the Activity Approval Pools window, click on the activity group
that you want to delete.

2. Click on the Delete Activity Group icon (Activity Groups > Delete
Activity Group).

3. TimeWizard displays a confirmation window: “Delete current
activity group?” Click “OK” to delete the activity group. Figure 18.6

Deleting an activity group

Objective 6: Delete an activity group

When you delete an activity group, its activity members return to the <Core Group>, and its
employee members return to the Available Employees frame to be available for other activity
groups. Deleting an activity group deletes the corresponding activity approval pool.

Summary

In this chapter, you have learned to create activity approval pools that assign approval author-
ity over specific activities to specific employees.
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Setting Up Detail Code Rules

The detail code fields and detail code values that you entered previously enable employees to
associate different types of data with specific timesheet transaction entries. For example, if
your company’s Payroll managers need TimeWizard to capture pay code information, you
would set up a detail code custom field entitled “Pay Codes.”  For TimeWizard to capture
specific information within this custom field category, you would add specific pay code val-
ues, such as “regular time” or “overtime.” 

Creating detail code business rules enables you to restrict TimeWizard users to specific sets of
Detail Code values for their timesheet transactions. To further enhance those restrictions, you
can associate the detail code business rules with activity groups so that employees’ access to
detail codes is based on the activity to which they are assigned. For example, just because the
pay code value “overtime” exists does not mean that every employee is allowed to charge
overtime to a timesheet. TimeWizard enables you to specify that only a certain group of
employees working on a certain activity can charge overtime to their timesheets (for that
activity only).

If you want the same “rules” to apply to employees for all activities, then you can skip objec-
tives 2-5, because all activities would be in the “core” activity group. Later, to create exceptions
to this setup, you may create new activity groups and associate new detail code profiles with
each group.

Objectives

1. Navigate the Detail Codes area
2. Define an activity group
3. Assign available activity members to an activity group
4. Edit an activity group
5. Delete an activity group
6. Define detail code profiles for an activity group
7. Assign employee members to detail code profiles
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To open the Detail Codes area, follow either of
these steps:

1. Click on the Detail Codes icon.

2. Select Tools > Business Rules > Detail Codes from the
TimeWizard main menu.

Figure 19.1

Navigating the Detail Codes area

8. Edit a detail code profile
9. Delete a detail code profile

Objective 1: Navigate the Detail Codes area

The Rules for Detail Code drop-down box at the top of the Detail Code Rules window
contains the detail code fields.

From the Detail Code Rules area, you can create and maintain all TimeWizard detail code
activity groups and detail code profiles. Table 19.1 defines each toolbar icon used in this
chapter.

Table 19.1: Detail Codes Icons
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Defining an activity group

To define an activity group, follow these
steps:

1. Click on the Detail Codes icon to open the
Detail Code Rules window.

2. Click on the Rules for Detail Code drop-down
box (Figure 19.2) to select the Detail Code
field for which you want to create a profile
group. Scroll through the drop-down list to
make the selection, e.g., “Cost Type.”

3. Click the Add Activity Group icon to open
the Activity Groups dialog box (Activity Group
> Add Group).

4. In the Activity Groups dialog box, type the
profile name and description in the text
boxes (Figure 19-3).

5. Click “Apply” to save the new settings and
keep the dialog box open, or click “OK” to
save the settings and close it.

Once you click on Apply, the Retrieve
button is enabled so you can assign

activity members to the newly-created activity
group(s).

Figure 19.2

Objective 2: Define an activity group

The first step in creating detail code rules is to create activity groups for which you will later
create detail profiles and assign selected employee members. In this objective, you create and
name the activity group to which you will assign activity members.

Figure 19.3

If you want the same “rules” for all activities, then you can skip objectives 2-5, because all
activities would be in the “core” activity group.

Example       Figure 19.3 shows an example Activity Groups dialog box in which we have added a new activity
group named “Software Development” for the detail code “Cost Type.”
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Objective 3: Assign available activity members to an activity group

Once you have defined an activity group, the next step is to assign individual activities—
activity members—which will populate the activity group(s). Available activities are those
which have not already been assigned to another activity group. All activity members start out
in the <Core Group> activity group. Once you have created all the activity groups you need,
you must decide how to group the activities themselves—i.e., by any of the four custom key
Activity fields you defined previously, or by custom lists. As you select a newly-created activity
group on the lower left of the Detail Code Rules window, you will see the activity members
already a part of that activity group on the right. Click on the <Core Group> on the left to
display the available activities on the right.  Next, click on and drag the desired activity mem-
bers on the right into the appropriate activity group on the left.

Changing the method of grouping activity members for activity groups will remove all exist-
ing assignments of activity members to activity groups (see Section 6 Introduction, Objective
1, “Understand Employee and Activity Grouping Methods” for details).

Assigning available activity members to an activity group

To assign available activities to an activity
group, follow these steps:

Once you have created an activity group, the
next step is to assign individual activities to that
activity group.

1. In the upper left list of the Detail Code Rules
window, highlight the activity group to which
you want to assign activities .

2. Click the Edit Activity Group icon to open the
Activity Groups dialog box (Figure 19.4).

3. At the bottom of the dialog box, specify an
activity grouping method.

4. Specify your quickfilter parameters (see Section
6, Objective 3, “Use the Quickfilter” for details).

5. Click “Retrieve” to display available activities in
the Members box (the activities listed are
“members” of the <Core Group>).

6. Drag and drop available activity members from
the Members box onto a desired activity in the
Activity Groups box.

Figure 19.4

7. Click “Apply” to save the new settings and keep the dialog box
open, or click “OK” to save the settings and return to the Detail
Code Rules window.
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To remove an activity member from an activity group, highlight the activity group and move
the appropriate activity from the membership frame on the right back onto the <Core Group>
activity group on the left.

In the Activity Members frame, you can sort the display lists by clicking on the Activity field
column headings.

In addition, you can simultaneously select multiple activity members by using the shift or
control keys on your keyboard.

Example Figure 19.4 shows an example Activity Groups dialog box in which we have assigned  three
activity members to the activity group named “Software Development.” In this example, we
chose to group activity members by custom lists.

Objective 4: Edit an activity group

The Edit Activity Group dialog box enables you to rename and change the description for an
existing activity group.

To edit an activity group, follow these steps:

1. In the Detail Code Rules window, click on the activity group to which you want to make corrections.

2. Click the Edit Activity Group icon to open the Activity Groups dialog box ( or, Activity Group > Edit Group).

3. Click “Retrieve” to display available activities.

4. In the Activity Groups box, double-click on the activitiy group you want to edit to open the Edit Activity Group dialog box.

5. Edit the activity group information (i.e., name or description) as necessary.

6. Click “OK” to save the changes and return to the Activity Groups dialog box.

7. Click “Apply” to save the settings and remain in the dialog box, or click “OK” to save the settings and close the dialog box.

Editing an Activity Group
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Deleting an activity group

To delete an activity group, follow these steps:

1. In the Detail Code Rules window, click on the activity group that you
want to delete.

2. Click the Delete Activity Group icon (Activity Groups > Delete Activity
Group).

3. TimeWizard displays a confirmation window: “Delete current activity
group?” Click “OK” to delete the activity group.

Activities belonging to the deleted activity groups return to the <Core
Group>. Consequently, employees belonging to the deleted activities
return to the available employees list.

Figure 19.5

Objective 5: Delete an activity group

When you delete an activity group, its activity members return to the <Core Group> of
activity members available for (re-)assignment to other activity groups, and its employee mem-
bers return to the available employee members list.
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To define detail code profiles for an activity group, follow these steps:

1. In the Detail Code Rules window, click on the activity group for
which you want to create detail code profiles.

2. Click the Add Profile icon to open the Codes Profile dialog box
(Profile > Add Profile).

3. Type the profile name and description in the text boxes.

4. Select the appropriate permissions. You must
specify one default setting for one permission for
the entry of positive timesheet hours.  If your
company uses negative hours, see note below.

5. Click “Apply” to save the settings and remain in
the dialog box, or click “OK” to save the settings
and close the dialog box.

Figure 19.6

Defining detail code profiles for an activity group

Objective 6: Define detail code profiles for an activity group

Now that you have created activity groups and assigned specific activities to them, you must
create detail code profiles for each activity group and then assign employee members to those
profiles. These detail code profiles will determine how employees charge time upon being
assigned to an activity; the codes include such information as Cost Type, Pay Code and Billing
Type.  Information about the values used to create detail code profiles can be found in Chap-
ter 4, Objective 3, “Assign available activity members to an activity group.”

If your company uses negative hours (e.g., for sick leave), you must select one default setting
for the set of negative permitted code values, as well as one default setting for the positive
permitted code values.
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When you select an activity group from the list at the top of the Detail Code Rules window,

Objective 7: Assign employee members to detail code profiles

When you assign available employee members to detail code profiles, you allow them to
charge the specified detail code values to assignments of activities in the activity group with
which the profile is associated.

“Available” employees are those who are not assigned to a given detail code profile for an
activity group. A single employee may only be assigned to one detail code profile per activity
group; however, that employee may belong to other profiles for other activity groups. The
general procedure is to first create all necessary activity groups, assign activities to them, asso-
ciate detail code profiles with activity groups, and assign employees to those profiles.

move the appropriate employee from the Members frame on the right back to the <default>
profile on the right.

In the employee members frame, you can sort the display lists by clicking on the Members
field column headings.  In addition, you can simultaneously select multiple employees by
using the shift or control keys on your keyboard.

the <default> profile in the lower left will be highlighted, and you will see available employees
in the Members list below and to the right. Click on and drag the appropriate employees on
the right into the appropriate profile on the left.

To remove an employee member from an activity group profile, highlight the profile and

Changing the method of grouping employee members for detail code profiles will remove all
existing assignments of employeess to detail code profiles (see Section 6 Introduction, Objec-
tive 1, “Understand Employee and Activity Grouping Methods” for more information).
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1. Click on the Detail Codes icon to open the Detail
Code Rules window.

2. Click on the Rules for Detail Code drop-down box and
select the Detail Code field that contains the profile to
which you want to assign members. Scroll through
the drop-down list to make the selection.

3. Click on the activity group that contains the profile to
which you want to assign members.

4. At the bottom of the window, specify an employee
grouping method.

Figure 19.7

Assigning employee members to detail code profiles

5. Specify your quickfilter parameters (see Section 6,
Objective 3,“Use the Quickfilter”).

To assign employee members to detail code profiles, follow these steps:

6. Click “Retrieve” to display available employees. The
available employees are members of the <default>
profile.

7. Drag and drop each appropriate employee from the
Members frame in the lower right to the appropriate
profile in the lower left Profiles frame.

To reverse the profile assignment, simply
drag and drop the employee from the profile
Members box back to the <default> profile.
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Objective 8: Edit a detail code profile

When you edit a detail code profile, you automatically change the settings for all of its mem-
bers.

To edit a detail code profile, follow these steps:

1. Click on the Detail Codes icon to open the Detail Code Rules window.

2. Click on the Rules for Detail Code drop-down box and select the Detail Code field that contains the profile you want to
edit. Scroll through the drop-down list to make the selection.

3. Click on the activity group that contains the profile you want to edit.

4. Specify your quickfilter parameters (see Section 6, Objective 3, “Use the Quickfilter”).

5. Click “Retrieve” to display the profiles.

6. Select the code profile you want to edit.

7. Click the Edit Profile icon to open the Codes Profile dialog box (Profile > Edit Profile).

8. Modify the profile information as desired.

9. Click “Apply” to save the settings and remain in the dialog box, or click “OK” to save the settings and close the dialog box.

Editing a detail code profile

Example In Figure 19.6, we defined a codes profile named “Contract Employees.” In Figure 19.7, we
assigned employee members to that Contract Employees profile. In this example, the mem-
bers of the Contract Employees profile are only permitted to charge time for holiday, over-
time, regular time, and sick leave when they work on the activities in the Software Develop-
ment activity group.
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Objective 9: Delete a detail code profile

When you delete a detail code profile, its members return to the <default> profile. You cannot
delete the <default> profile, because its members do not belong to another group.

To delete a detail code profile, follow these steps:

1. Click on the Detail Codes icon to open the Detail Code
Rules window.

2. Click on the Rules for Detail Code drop-down box and
select the Detail Code field that contains the profile you
want to delete. Scroll through the drop-down list to
make the selection.

3. Click on the  activity group that contains the profile you
want to delete.

4. Specify your quickfilter parameters (see Section 6,
Objective 3, “Use the Quickfilter”).

5. Click “Retrieve” to display the profiles.

6. Select the code profile you want to delete.

7. Click the Delete Profile icon (Profile > Delete Profile).

Deleting a detail code profile

8. TimeWizard displays a confirmation window:
“Delete the selected profile?” Click “OK” to delete
the profile.

Figure 19.8
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Summary

In this chapter, you have seen how to define activity groups and how to assign activities to
them.  You have also seen how to associate detail code profiles with activity groups and how to
populate those profiles with employees. You have learned that the creation of detail code
profiles allows you to restrict TimeWizard users to specific sets of Detail Code values for their
timesheet transactions.
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Defining Timesheet Rules

Defining timesheet rules enables you to apply your organization’s time accounting rules to the
timesheet data that employees submit for approval. Timesheet rules allow you to enforce
restrictions on the amounts of time submitted and the amounts of time associated with desig-
nated detail code values. Because timesheets that reach approvers are in compliance with the
defined timesheet rules, the approval process is quicker and easier, and the data shared with
other systems is more accurate.

When you define a timesheet rule, you first create the rule, and you then apply the rule to
employees by assigning it to preference profile groupings. You can define multiple timesheet
rules and determine when and how each will be applied. For each rule, you determine the
affected days or date range, the affected activities or detail code values, and whether a timesheet
owner who violates the rule is prevented from submitting the timesheet or merely receives a
warning.

For example, you can make a timesheet rule that employees in one preference profile cannot
submit more than 90 hours for a two-week period. For another preference profile, you can
make a rule that hours cannot be submitted as overtime until 40 hours have been submitted as
regular hours for a week. Another rule might apply to specific holiday dates, such as 12/25/01,
and either require submitted hours to be logged to a holiday activity or prevent submission of
project-related hours. If your employees are instructed to account on their timesheets for all
weekly totals less than 40 (e.g., leave without pay), you can have TimeWizard enforce a rule
that total hours must be greater than or equal to 40.
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Objectives

1. Add a timesheet rule for an operator type and hours total
2. Define the range
3. Define the classification
4. Define the severity and compose error message text
5. Assign a timesheet rule to a preference profile
6. Edit a timesheet rule
7. Delete a timesheet rule

Objective 1: Add a timesheet rule for an operator type and hours total

You start the process of defining a timesheet rule by adding a name for the rule in the Define
Timesheet Rules window, selecting an operator type, and entering the total number of hours
on which the rule will be based. For example, if you want a rule that regular weekly hours
must not exceed 40, then you can name a rule “Regular Hours,” select the operator “Must be
less than or equal to (<=),” and enter the total hours “40.00” as in Figure 20.1.

You may select any of the following operator types:

•   must be equal to (=)
•   must not be equal to (<>)
•   must be greater than (>)
•   must be greater than or equal to (>=)
•   must be less than (<)
•   must be less than or equal to (<=)
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Adding a timesheet rule, operator type, and hours total

To add a timesheet rule, follow these steps:

1. Open the Define Timesheet Rules window through the Tools
main menu (Tools > Business Rules > Define Timesheet Rules
... ).

2. Click on the Add command button in the upper right to open
the Add New Rule window.

3. Enter the desired Timesheet Rule name in the Rule Name text
box. Click on the OK button to save the rule name and return
to the Define Timesheet Rules window. The newly saved rule

name will display in the Rule List in the left of the
window and in the Rule Name text box in the upper
center.

4. Click on the drop-down box below the Rule Name
text box and select an operator for the rule.

5. Enter the total number of hours for the rule in the
text box to the right of the operator drop-down box.

6. Follow the steps in Objective 2 to continue defining
the rule.

Objective 2: Define the range

The range designates the interval of time in days or dates to which the timesheet rule will
apply. Table 20.1 explains the interval types you can select. The selection of some interval
types entails additional steps to define the range.

Figure 20.1
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Table 20.1: Interval types
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Defining the range (continued on page 251)

1. In the Define Timesheet Rules window, see that the Rule Name
text box displays the desired rule.

2. In the Range tab page, click on the Interval drop-down box and
select the interval type from the list.

3. If you selected “Every day” or “Period rule,” follow
the steps in Objective 3 to continue defining the
rule. If you selected another interval type, continue
with the steps of Objective 2.

Figure 20.2

To define the range, follow these steps:
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Defining the range (continued from page 250)

4. If you selected “Day of week list,” boxes labeled “Select
Weekdays” and “Weekday List” display on the Range tab page
(Figure 20.2). Highlight the desired day in the Select Weekdays
box and click on the right-arrow (>) command button to move
your selection to the Weekday List box or double-click on the
day to display it in the list. Repeat until all desired days display in
the Weekday List box. Click on the left-arrow (<) button to
move a highlighted day from the Weekday List box to the Select
Weekdays box.

5. If you selected “Day of week range,” boxes labeled “From”
and “To” display on the Range tab page. Click on the “From”
drop-down box and select the first day of the range from the
list. Click on the “To” drop-down box and select the last day of
the range from the list.

6. If you selected “Date list,” a calendar and a box labeled “List of
Dates” display on the Range tab page (Figure 20.3). In the
calendar, click on the double arrows to select another year and
click on the single arrows to select another month. Click on the
desired date and then click on the right-arrow (>) command

button to display your selection in the List of Dates
box or double-click the date to display it in the list.
Repeat until all desired dates display in the List of
Dates box. Click on the left-arrow (<) button to
delete a highlighted date from the list.

7. If you selected “Date range,” a calendar and boxes
labeled “From Date” and “To Date” display on the
Range tab page. In the calendar, click on the double
arrows to select another year and click on the single
arrows to select another month. Click on the desired
date to begin the range, and click on the upper
right-arrow (>) command button next to the “From
Date” box. Click on the desired date to end the
range, and click on the lower right-arrow button
next to the “To Date” box.

8. Follow the steps in Objective 3 to continue defining
the rule.

Figure 20.3
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Table 20.2: Classifications

Objective 3: Define the classification

The classification designates the activities or detail code values to which the timesheet rule will
apply. Table 20.2 explains the classifications you can select. The selection of some classifica-
tions entails additional steps to define the activities or detail code values on which the timesheet
rule will be based.
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To define the classification, follow these steps:

an activity item in the Act Key List box and click on
the right-arrow (>) command button to move your
selection to the Act Key Selected box. Repeat until
all desired items display in the Act Key Selected box.
You can click the double right-arrow (>>) button to
select and move all the items. Click on the left-
arrow (<) button to delete a highlighted item from
the Act Key Selected box or click on the double left-
arrow (<<) button to delete all the items.

Defining the classification (continued on page 254)

1. In the Define Timesheet Rules window, see that the Rule Name
text box displays the desired rule.

2. In the Classification tab page, click on the “Process Rule for”
drop-down box and select the classification from the list.

3. If you selected “All hours” or “All project-related activities,”
follow the steps in Objective 4 to continue defining the rule. If
you selected another classification, continue with the steps of
Objective 3.

4. If you selected an activity field name, boxes labeled “Act Key
List” and “Act Key Selected” will display (Figure 20.4). Highlight

Figure 20.4
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Defining the classification (continued from page 253)

5.  If you selected a detail code field name, boxes labeled “Detail
Code List” and “Must charge to these codes” will display.
Highlight a detail code value in the Detail Code List box and
click on the right-arrow (>) command button to move your
selection to the Must charge to these codes box. Repeat until all
desired code values display in the Must charge to these codes
box. Use the horizontal scroll bars as needed. To delete the
values from the Must charge to these codes box, click on the
Clear button in the upper right of the tab page.

6. If you selected a detail code field name, but you did not select a
detail code with condition, you can select “Enforce rule only
when hours have been logged” to prevent the rule from being
applied when no hours have been entered in the defined range
(see Figure 20.5 above and the example below).

7. If you selected a detail code field name with condition, boxes
labeled “Detail Code List,” “Must charge to these codes,” and
“Before these codes” will display. Highlight a detail code value

in the Detail Code List box and click on the upper
right-arrow (>) command button to move your
selection to the Must charge to these codes box.
Repeat until all desired code values display in the
Must charge to these codes box. To move a code
value to the Before these codes box, highlight the
value in the Detail Code List box and click on the
lower right-arrow button. Repeat until all desired
code values display in the Before these codes box.
Use the horizontal scroll bars as needed. To delete
the values from the Must charge to these codes or
Before these codes boxes, click on the Clear button
in the upper right of the tab page.

8. Follow the steps in Objective 4 to continue defining
the rule.

Figure 20.5

Example

Suppose you define a rule that employees must log at least four hours when they apply a detail
code for overtime to weekend hours. Select the “Enforce rule only when hours have been
logged” checkbox to prevent the timesheet rule from invalidating timesheets that have no
hours logged for the weekend.
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Objective 4: Define the severity and compose error message text

The severity level of the timesheet rule determines whether a timesheet that violates the rule
can be submitted for approval. If you want to require timesheets that violate the rule to be
corrected before submittal, choose the “Error” level. If you want the timesheet owner to re-
ceive a warning but have the option of submitting an uncorrected timesheet, choose the
“Warning” level instead.

Regardless of the severity level you select, when the timesheet owner attempts to submit a
timesheet that violates a rule, your custom error message displays with the dates of the timesheet
columns that contain the violations. If the timesheet owner does not have the permission to
submit timesheets, the department owner who performs the submittal will receive the mes-
sage. You are required to enter a message before you can complete the definition of a timesheet
rule.

A property setting enables you to use a different error message specifically for violations of
timesheet rules for leave balances. By applying this property setting, the alternative message
displays when an employee exceeds a leave balance and attempts to submit the timesheet. If
the employee violates a timesheet rule other than a leave balance rule, the message entered in
the Define Timesheet Rules window displays.

The alternative message text is “Leave Balance Exceeded.” You may edit this text to create a
custom message for leave balance violations. See the TimeWizard Installation Guide to learn to
change the property setting and to create an alternative message.
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To define severity, follow these steps:

alternative property setting, for all violations except
excessive leave balances.

4. Click the Apply command button at the bottom of
the window to save all aspects of your timesheet
rule and remain in the window. Click the OK button
to save all aspects of your timesheet rule and exit
the window.

Defining severity and composing error message text

1. In the Define Timesheet Rules window, see that the Rule Name
text box displays the desired rule.

2. In the Severity tab page, click on the “Process Rule as” drop-
down box and select the severity from the list. If a timesheet
violates a rule processed as “Error,” the timesheet cannot be
submitted until corrected.

3. In the Error Message text box, enter the message text you want
displayed for all timesheet rule violations, or, if you use the

Figure 20.6
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To assign a timesheet rule, follow these steps:

4. Repeat step 3 until all the rules you want to assign
to the profile display in the Assigned Rules text box.

5. To delete a rule from the Assigned Rules box,
highlight the rule and click on the left-arrow (<)
button.

6. Click on the Apply command button at the bottom
of the window to save your assignments and remain
in the window. Click on the OK button to save your
assignments and return to the Preference Profile
window.

Assigning a timesheet rule

1. In the Preferences area, open the desired Preference Profile
detail window (see Chapter 16).

2. Click on the “Assign Rules ... “ command button in the lower
right to open the Timesheet Rules window (Figure 20.7).

3. In the Timesheet Rules text box in the left side of the window,
highlight the name of the rule you want to assign. Click on the
right-arrow (>) command button to move the selected rule to
the Assigned Rules text box on the right side of the window.

The rule will apply to all members of the preference
profile.

Figure 20.7

Objective 5: Assign a timesheet rule to a preference profile

Before a timesheet rule can be applied to a timesheet, the rule must be assigned to the em-
ployee. TimeWizard enables you to assign timesheet rules to selected groups of employees by
assigning the rules to preference profiles in the Preferences area of TimeWizard Administrator.
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Summary

You have learned to create timesheet rules so that timesheet data is more accurate. You have
also learned to assign different timesheet rules to different groups of employees.

To edit a timesheet rule, follow these steps:

1. In the Define Timesheet Rules window, highlight the name of the desired rule in the Rule List box
on the left side of the window to display the name in the Rule Name text box in the upper center
(Figure 20.1).

2. To edit a rule name, make the edit in the Rule Name box rather than the Rule List box.

3. Change the entries in the desired input text boxes or drop-down boxes.

To make an edit on a Classification tab page that displays a Clear command button in
the upper right, first click on the Clear button.

4. Click on the Apply command button to save your edits and remain in the window or click on the
OK button to save your edits and exit.

Editing a timesheet rule

To delete a timesheet rule, follow these steps:

1. In the Define Timesheet Rules window, highlight the name of the desired rule in the Rule List box
on the left side of the window to display the name in the Rule Name text box in the upper center
(Figure 20.1).

2. Click on the Delete command button in the upper right of the window.

3. A prompt box, which includes the rule name, opens to ask if you want to delete that rule. Click
on the OK button in the box to confirm the deletion or click on the Cancel button to stop the
deletion.

4. If you deleted the rule, it is deleted from both the Define Timesheet Rules window and the
Preference Profile Timesheet Rules window.

5. Click on the “X” control on the right side of the window title bar or click on the Cancel button at
the bottom of the window to exit the window.

Deleting a timesheet rule

Objective 6: Edit a timesheet rule

Objective 7: Delete a timesheet rule
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Standard Text Editor

TimeWizard’s communication system consists of several types of notes that can be attached to
a variety of transactions. Some notes—such as a timesheet transaction note or a timesheet
summary—are composed voluntarily by the timesheet owner. Other notes—such as an em-
ployee edit note or an approval statement—are required for auditing purposes.

Rather than requiring all TimeWizard users to write their own notes (which may not commu-
nicate effectively), you can use the Standard Text Editor to compose standard notes that users
can select for multiple timesheet functions. Users then will have the option of choosing a
standard note or composing an original note.

For convenience, one default standard text note comes predefined for each standard text
category. You can edit these notes to reflect the wording you desire and add additional notes
for each standard text category.

Objectives

1. Navigate the Standard Text Editor Area
2. Compose Standard Notes
3. Edit Standard Notes
4. Deleting Standard Notes
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Objective 1: Navigate the Standard Text Editor area

From the Standard Text Editor area, you can compose standard notes that users can select for
multiple timesheet functions.

To open the Standard Text Editor area,
follow either of these steps:

1. Click on the Standard Text Editor icon.

2. Select Tools > Business Rules > Standard Text
Editor from the TimeWizard main menu.

Figure 21.1

Navigating the Standard Text Editor area

Table 21.1: Standard Text Categories
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Objective 2: Compose standard notes

The standard text categories cover all functions of the timesheet for which users may desire or
be required to leave notes. You can compose and save multiple notes for each standard text
category—except for the Approval Statement category, which allows for only one note. Table
21.1 explains each standard note category.

Composing standard notes

To compose standard notes, follow these steps:

1. Select Standard Text Editor from the Tools menu (Tools >
Business Rules > Standard Text Editor) to open the Standard Text
Editor window.

2. Select the Standard Text Category for which you want to
compose a standard note.

3. Click “Add” to add an empty text box in the Text ID box.

4. Enter the name of the standard note in the text box.

5. Click in the Text box (at right) and compose the
standard text for the selected note.

6. Click “Apply” to make the settings but remain in
the dialog box, or click “OK” to save the settings
and close the dialog box.

Figure 21.2

Example       In the example Standard Text Window shown in Figure 21.2, we added a new note entitled
“Summary Note” to the Timesheet Summary Standard Text Category. We then composed the
text for the new note in the Text box. Now that this note exists in the TimeWizard system,
timesheet users can select this note as their timesheet summary, rather than having to type a
new note (which may not communicate as effectively).
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Objective 3: Edit Standard Notes

TimeWizard enables you to edit the text in an existing standard note at any time. Once you
apply the change, TimeWizard users making new selections will see the new text when they
place that standard note. Notes already saved to the database remain unchanged.

To edit standard notes, follow these steps:

1. Select Standard Text Editor from the Tools menu (Tools > Business Rules > Standard Text Editor) to
open the Standard Text Editor window.

2. Select the Standard Text Category that contains the note you want to edit.

3. In the Text ID box, select the note that you want to edit.

4. In the Text box, make any necessary changes to the text.

5. Click “Apply” to save the settings but remain in the dialog box, or click “OK” to save the settings
and close the dialog box.

Editing Standard Notes

To delete standard notes, follow these steps:

1. Select Standard Text Editor from the Tools menu (Tools > Business Rules > Standard Text Editor) to
open the Standard Text Editor window.

2. Select the Standard Text Category that contains the note you want to delete.

3. In the Text ID box, select the note that you want to delete.

4. Click “Delete.”

5. Click “Apply” to save the settings but remain in the dialog box, or click “OK” to save the settings
and close the dialog box.

Deleting standard notes

Objective 4: Delete standard notes

TimeWizard enables you to delete unused standard notes. When you delete a standard note,
it will no longer be available to TimeWizard users.

Summary

In this chapter, you have learned to compose standard notes in the system so that communi-
cation between TimeWizard users remains convenient and consistent.
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Setting Up Clock-In/Clock-Out Use

Clock-In/Clock-Out (CIO) timesheets record start and stop times of an employee’s work for
each assignment during the day. A time cell displays the time of day instead of the amount of
hours worked. The Daily Total and Period Total cells display amounts of hours in the usual
way.

Clock-In/Clock-Out users

You can designate some or all TimeWizard.enterprise users as CIO users. CIO users automati-
cally receive the Clock-In/Clock-Out timesheet when they open their timesheets.

Time formats

CIO timesheets can display time in AM/PM format or in 24-hour format. “01:00PM” is an
example of AM/PM format; the same time would display as “13:00” in 24-hour format. The
selected time format applies globally to all CIO users in your TimeWizard database. To change
the property setting to 24-hour format from the default AM/Pm format, refer to the TimeWizard
Installation Guide.

Leave and break activities

Leave activities, such as Vacation Leave or Sick Leave, can be set for entry of an amount of
hours, rather than start and stop times, by defining their activity type as OH-Leave in the
Activity Detail window. Activities such as Lunch or Break Time can be set so that they do not
add time to daily and period totals by defining their activity type as OH-Break. See Chapter
12, “Working with Activities,” for information on creating activities.
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TimeWizard

When a CIO timesheet is submitted for approval, TimeWizard does not check the timesheet
data for adherence to the Timesheet Rules set in the Define Timesheet Rules window and
assigned to preference profiles. Restrictions can be enforced through the balance settings for
OH-Leave assignments and through the approval process. DataBridge scripts can prevent the
export of certain kinds of invalid data.

To learn to use the CIO timesheet, see Chapter 5, “Clocking In and Out,” in the
TimeWizard.enterprise User’s Guide.

Objectives

1. Set up Clock-In/Clock-Out timesheets
2. Set Detail Codes for different types of users
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Objective 1: Set up Clock-In/Clock-Out timesheets

Employees who are designated as CIO users can clock in and out of the same assignment
many times during a day by adding multiple detail code rows to the assignment.

Once you have completed the setup for CIO timesheets, the first detail field of each assign-
ment will automatically display a sequence number (positive integers such as 1, 2, or 3). Any
other detail code fields will display your default detail code values and will be read-only fields.

Setting up Clock-In/Clock-Out timesheets

To set up Clock-In/Clock-Out timesheets, follow these steps:

1. To set the first detail code field for CIO sequence numbers,
consult the TimeWizard Installation Guide and set the
appropriate property setting to “Y.”

2. To assign the CIO timesheet to an employee, select CIO User
in the Employee Detail window for the employee (Employees
> Employee Detail). (Figure 22.1).

3.  In the Custom Fields area, define the first Detail Code field for
the CIO sequence number (Tools > Custom Fields > Detail
Codes). Enter a Caption and the maximum length (number
of digits) of the sequence number, and click “OK.”

Figure 27.1

4.   In the Code Values area, assign positive integers in
sequence to the first Detail Code field (Tools > Code
Values > Detail Codes), from “1” to the maximum
times an employee can use an assignment in one day.

      For each number, click “Add” and enter the number in
the blank Name box. After entering all the numbers,
click “OK.”

5.   To complete the setup, continue with the steps on the
next page to make and assign Detail Code Rules for
CIO users.
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TimeWizard

Completing the Clock-In/Clock-Out setup

To complete the Clock-In/Clock-Out setup, follow these steps:

1. In the Detail Codes area (Tools > Business Rules > Detail Codes),
define new activity groups, if needed, in the Activity Groups
dialog box, and save the new settings.

2. Assign activities to activity groups, as needed, and save the new
settings. Do not change the Activity Members Grouped By
selection unless you want to remove all exisitng activity
assignments.

3. In the Codes Profile dialog box (Figure 22.2), define a detail
code profile for each activity group that CIO users may access.
Select the Permitted box of each sequence number. Do not
permit any other code values for the first detail code field.

4. Select the code value “1” as the positive default.

5. If CIO users may use detail code fields other than
the first field, select the permitted code values for
those fields. If any associated transactions will be
negative, select the corresponding Negative Values
box(es) and one negative default.

6. Save the Codes Profile settings.

7. Assign CIO users to the appropriate detail code
profiles, defined in step 3 above. Do not change the
Employee Members Grouped By selection unless
you want to remove all existing employee
assignments. Close the Detail Code Rules window.

Figure 22.2
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Objective 2: Set Detail Codes for different types of users

You can have the first detail code field show different sets of codes to different types of users.
Non-CIO users need not see the sequence numbers described in Objective 1.

Setting Detail Codes for different types of users

To set detail codes for different types of users, follow these steps:

1. In the Code Values area, assign code values for non-CIO users
to the first detail code field (Tools > Code Values > Detail
Codes). For each code, click “Add” and enter the code in the
blank Name box. After entering all the codes, click “OK.”

Retain the sequence numbers assigned in Objective 1 (Figure
22.3).

2. In the Codes Profile dialog box of the Detail Codes area (Tools >
Business Rules > Detail Codes > Codes Profile), define a detail
code profile for each activity group that a specific non-CIO user
group may access (Figure 22.2). Select the Permitted box of
each code you added in step 1. Do not permit codes for the first

detail code field that are inappropriate for these
users.

4. Select one code as the positive default or, if the
associated transactions will be negative, select the
corresponding Negative Values boxes and one
negative default. Save the Codes Profile settings.

5. Assign users to the appropriate detail code profiles,
defined in step 2 above. Do not change the
Employee Members Grouped By selection unless
you want to remove all existing employee
assignments. Close the Detail Code Rules window.

Figure 22.3
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TimeWizard
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Setting Up Accrual Hours

Many employees accrue leave hours, such as vacation or sick leave, each payroll period.
TimeWizard can automatically generate the leave accrual for selected activities and employ-
ees. You can schedule leave balances to be updated at the end of each approval period or on a
selected day prior to the end of the period.

Objectives

1. Set up accrual activities
2. Define an accrual profile
3. Assign employees to an accrual profile
4. Schedule balance updates
5. Edit an accrual profile
6. Delete an accrual profile
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TimeWizard

Setting up accrual activities

To set up accrual activities, follow these steps:

1. In the Activities and Assignments area, select Activity > Add
Activity from the menu or click the Add Activity icon to add a
new activity.

2. In the Activities Detail window (Figure 23.1), click the Activity
Type drop-down box and select “OH-Leave” from the list.

3.  Follow the instructions in Chapter 12, Objective 3, “Add a

Figure 23.1

new activity” to complete the setup for the activity.

Remember that each activity must have a unique
combination of key activity values in the top section of
the window.

Objective 1: Set up accrual activities

You can select any activities that are designated as activity type “OH-Leave” to accrue leave
hours. If you add multiple leave activities to the TimeWizard database, you can set up differ-
ent activities to accrue different amounts of hours each approval period. For example, you can
set Vacation Leave to accrue 3.08 hours each period and Sick Leave to accrue 1.54 hours each
period.

Setting up specific activities for different types of leave also enables you to assign different
employees to different accrual profiles. For example, you can choose to assign all employees to
a profile for Sick Leave and only some employees to a profile for Personal Leave.

An accrual profile is set up for an activity rather than a specific employee assignment. When
timesheet balances are updated, the accrual amount is applied to all employee assignments
based on the accrual activity.
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Objective 2: Define an accrual profile

When you define an accrual profile, you specify the amount of hours to accrue to one selected
leave activity in one period. You define a separate accrual profile for each activity that you
want to use for accruals. Employee assignments based on an accrual activity only accrue hours
if the employee is assigned to the accrual profile for that activity.

You can define multiple profiles for one activity if different employees accrue different amounts
of hours for the activity. For example, you can define one vacation profile for entry-level
employees and a second vacation profile for employees with more seniority who accrue more
vacation hours each period. You must give each profile a unique name.

Defining an accrual profile

To define an accrual profile, follow these steps:

1. Click the Accrual hours icon on the toolbar or select Tools  >
Business Rules > Accruals from the menu to open the Accrual
Hours window.

2. Select the activity for the profile in the Activity Groups list in the
top frame. Scroll down in the list as needed.

3. Click the Add Profile icon or select Profile > Add Profile from the
menu to open the Accrual hours dialog box for the selected
activity (Figure 23.2).

4. Type a unique profile name and optional description
in the text boxes. Enter the amount of accrual hours
in the bottom box.

5. Click “OK” to save the profile and close the Accrual
hours dialog box.

6. To define more accrual profiles, repeat steps 2 – 5
above.

Figure 23.2
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TimeWizard

Objective 3: Assign employee members to an accrual profile

You can assign an employee to many accrual profiles, provided that each of the employee’s
profiles is defined for a different accrual activity.

All employees are initially assigned to the <default> profile for each accrual activity. You may
edit the accrual hours amount in the <default> profile or keep its initial setting of zero hours.
When you assign an employee to a profile, you remove the employee from the <default>
profile for that activity. However, the employee remains in the <default> profiles for other
activities until you make assignments for those activities.

Changing the method of grouping employee members for accrual profiles will remove all
existing assignments to accrual profiles. See the Section Six Introduction, Objective 1, “Un-
derstand Employee and Activity Grouping Methods” for more information on grouping meth-
ods.

Assigning employee members to an accrual profile

To assign employees to an accrual profile, follow these steps:

1. In the Accrual Hours window, click the Retrieve button on the
right to display the Accrual Hours Profiles in the lower left
frame.

2. To change the employee grouping method for all accrual
profiles, select a grouping method in the Employee Members
Grouped By drop-down box at the bottom of the window.
Changing the grouping method removes all existing assign-
ments to accrual profiles.

3. Select members in the lower right frame. Drag and drop the

selected members to the appropriate profile in the
lower left.

4. To view assignments to a profile, select the profile in
the lower left. The members of the selected profile
display in the lower right.

5. To change an assignment, drag and drop a member
from the Members frame to the <default> profile.
Select the <default> profile and repeat step 3 if
needed.

Figure 23.3
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Objective 4: Schedule balance updates

You can schedule TimeWizard to update the leave balances at specified times. You accomplish
this by setting up a Custom Application interface in the Interface Controller, setting an Inter-
val Type, and starting the Scheduler.

Setting up a Custom Application for accruals

To set up a Custom Application for accruals, follow these steps:

1. Click the Interface Controller toolbar icon or select Tools >
Interface Controller from the main menu to open the Interface
Controller window.

2. Click the Add Interface icon or select Interface > Add Interface
from the menu to add a new interface row.

3. In the new row, select Custom Application from the Interface
Type drop-down menu.

4. Click the Setup icon or double-click the blank
application name box to open the Enter Application
Name dialog box.

5. Enter the following name for the application:
twaccrual

6. Click “OK” to save the name and close the dialog
box. Continue with the steps on the next page.

Figure 23.4
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Scheduling balance updates

To schedule a balance update, follow these steps:

1. In the Interface Controller window, select the twaccrual
application. Select Interface > Interval from the menu or click
the Interval icon on the toolbar to open the Change Interval
dialog box (Figure 23.5).

3. Select an interval type such as Period ending. If you select
Period ending, the default value of zero in the “Current period
end minus __ day(s)” box schedules the update for the last
day of each period.

4. To schedule the update for a specified number of days before
the end of the period, select Period ending as the interval
type, and edit the number in the “Current period end minus
__ day(s)” box as needed.

5. In the Time box, specify the time of day to update the
balances. Enter the time in the format HH:MM:SS AM or
HH:MM:SS PM.

6. Click “Apply” to view a confirmation of your settings. Click
“OK” to save the settings and close the dialog box.

7. Select Interface > Start Scheduler from the menu or click the
Start Scheduler icon on the toolbar.

8. To stop a scheduled update, select the application row in the
Interface Controller window. Select Interface > Stop Scheduler
from the menu or click the Stop Scheduler icon.

Figure 23.5

To learn more about working with the Interface Controller, see “Introduction to the TimeWizard
Interface Controller” in Section Seven, particularly Objective 3, “Navigate the Interface Con-
troller window” and Objective 7, “Review the Interface Status.”
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Objective 5: Edit an accrual profile

When you edit an accrual profile, your change applies to all members of the profile.

Editing an accrual profile

To edit an accrual profile, follow these steps:

1. Click the Accrual hours icon on the toolbar or select Tools >
Business Rules > Accruals from the menu to open the Accrual
Hours window.

2. Click the Retrieve button on the right side of the window to
display the profiles in the lower left.

3. Select the accrual profile you want to edit. Click the Edit Profile
toolbar icon or select Profile > Edit Profile from the menu to
open the Accrual hours dialog box for the profile.

4. Edit the profile definition as needed.

5. Click “OK” to save your changes and close the dialog
box.

6. To modify member assignments to the profile, see
the steps of Objective 3, “Assign employee
members to an accrual profile.”

7. To change the accrual activity for the profile, delete
the profile and define a new profile. See Objective
6, “Delete an accrual profile.”

Objective 6: Delete an accrual profile

When you delete an accrual profile, its members return to the <default> profile. You cannot
delete the <default> profile.

Deleting an accrual profile

To delete an accrual profile, follow these steps:

1. Click the Accrual hours icon on the toolbar or select Tools >
Business Rules > Accruals from the menu to open the Accrual
Hours window.

2. Click the Retrieve button on the right side of the window to
display the profiles in the lower left.

3. Select the accrual profile you want to delete. Click
the Delete Profile toolbar icon or select Profile >
Delete Profile from the menu.

4. A dialog box displays to confirm that you want to
delete the selected profile. Click “Yes” to delete the
profile or “No” to retain the profile.
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Setting Up the Expense System

The expense system enables you to track employee expenses in relation to TimeWizard assign-
ments. It also provides employees with an easy system for recording and submitting detailed
expense sheets, whether or not the employees use timesheets. Department owners can approve
expense sheets in the Expense Approval area, which uses the same approval hierarchy as de-
partment approvals.

You customize the expense system for your business. Expense types, payment types, and ex-
pense sheet names are all user-defined. Users can produce expense sheets for specific projects,
date ranges, or any other categorization of expenses.

The expense system accommodates all internationally recognized currency types and can be
configured to perform exchange rate calculations.

You can export expense data to external corporate systems through TimeWizard’s DataBridge.
See Chapter 27, “Working with the DataBridge Toolkit,” for information on the DataBridge
feature.

Objectives

1. Set expense permissions
2. Set up optional expense activities
3. Set default currency and exchange rates
4. Set up currency profiles
5. Define expense types
6. Define payment types
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Objective 1: Set expense permissions

Three permission settings govern access to the expense system. Table 24.1 explains each ex-
pense permission.

Table 24.1: Expense Permissions

Setting expense permissions

To set expense permissions, follow these steps:

1. Open the Permissions window (Tools > Business Rules >
Permissions) and click “Retrieve.”

2. To modify an existing permissions profile for all of its employee
members, select the profile and open the Permissions Profile
dialog box (Profile > Edit Profile).

3. From Advanced Permissions, select “Expense System” as
needed. From Administrator Permissions, select “Expense
System Setup” and “Currency” as needed.

4. Click “OK” to save the settings and close the
dialog box. Repeat steps 2 - 4 to modify other
permissions profiles.

5. To apply your changes, close the Permissions
window.

6. To add a new permissions profile or change
employee profile assignments, see Chapter 15,
“Setting Permissions.”
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Objective 2: Set up optional expense activities

An expense sheet user can add any assignment—even a closed assignment—to an expense
sheet, provided that the user is not restricted from adding the assignment by other business
rule settings. The assignment does not need to be on the user’s timesheet to be added to an
expense sheet.

Expense activities

Assignments based on expense activities can only be added to expense sheets; they cannot be
added to timesheets. An expense sheet may contain timesheet assignments, expense assign-
ments, or both. Expense activities are particularly useful for employees who do not use
timesheets, but need to submit expense sheets. For example, salaried or exempt employees
may not be required to submit timesheets but may have travel expenses to record.

To use an expense sheet, an employee must be entered in TimeWizard (Administrator >
Employees) and must be assigned the “Expense System” permission (see Objective 1, “Set
expense permissions”).

Setting up expense activities

To set up expense activities, follow these steps:

1. Open the Activities and Assignments window (Tools >
Activities and Assignments).

2. Open the Activity Detail dialog box (Activity > Add Activity).

3.  Click the Activity Type drop-down box and select “OH-
Expense” from the list.

4. Enter the appropriate information requested for each section
of the dialog box, as needed.

5.   Click “Apply” to save the settings and remain in the
Activity Detail dialog box, or click “OK” to save the
settings and close the dialog box. After clicking
“Apply,” you can click “Add” to add another activity.

6. In the Activities and Assignments window, make one or
more resource assignments based on each new activity.
The resource assignments may use the resource code
“<unclassified>.”

For more information on adding and editing activities and resource assignments, see Chapter
12, “Working with Activities,” and Chapter 13, “Working with Resource Assignments.”
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Objective 3: Set default currency and exchange rates

Currencies

Initially, the US Dollar is designated as the default company currency type in TimeWizard.
You may change which currency type is set as your company default. When you define an
expense type for use in the expense system, you may use your company default or select
another currency type for the expense type.

The box on the next page describes one method of setting the default currency type that will
display in the Expense Type setup window. You may choose to change this company default
currency by running a database script instead. An example of such a script is included later in
this objective.

An expense sheet user may have a different default currency than the company default cur-
rency. You have the option of setting up currency profiles to assign different user default
currencies to different employees or groups of employees. Whether or not an expense sheet
user’s default currency is the same as the company’s, the user may select another currency for
an expense item entry.

If a user selects a currency other than the user’s default for an expense entry, and if TimeWizard
has been set up to perform exchange rate calculations, then the expense sheet will automati-
cally display the amount of the entered expense in both currencies.

If a user enters expense items with different currencies on the same expense sheet, the sheet
will display totals grouped by currency type, rather than displaying one grand total.

Setting the company default currency in the database does not automatically set the currency
type in the <default> currency profile in the Currency window (Administrator > Currency).
See Objective 4, “Set up currency profiles,” for more information.

Exchange rates

Entering exchange rates in TimeWizard is optional. However, if you complete the exchange
rate setup for the currencies your employees use, TimeWizard will perform rate calculations
for you and display the results on expense sheets. You may update the rates as often as you
wish.
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TimeWizard’s database accepts exchange rates up to four decimal places and performs calcu-
lations using four decimal places.

When TimeWizard is set up for exchange rate use, the rates display in the expense entry
window and on the expense sheet. The expense sheets are initially set to round the rate to two
decimal places for display purposes. You can configure the expense entry window and the
expense sheet to display up to four decimal places by changing the setting of the
FRACTIONSIZE property in the TWeb properties file on the TimeWizard Web server.

The box below describes one method of setting exchange rates. You may choose to update the
rates by running a database script, instead. An example of a such a script is included at the end
of this objective.

Setting the default currency and exchange rates

To set the default currency and exchange rates, follow these steps:

1. In the TimeWizard database table named Currency, locate the
currency you want to designate as your company default
currency. In the default_currency column, change the value to
“1” (from “-1”). Only one currency in the column should have
the value “1.”

2. If you want to use exchange rates, note the identification (ID) of
all the currencies you want to use, located in the currency_id
column. You will need these IDs in step 4 below.

3. In the database table named effdate_currency, locate an ID of a
currency you want to use. Modify the value in the

exchange_rate column for that ID row to the
exchange rate you want the system to use for the
currency.

4. Modify the value in the eff_date column for that ID
row to the date you want the new exchange rate to
take effect in the system.

5. Repeat steps 4 and 5 above for each currency you
want the system to use.

6. To complete the set up for exchange rates, on the
TimeWizard Web server, in the TWeb properties file,
set the EXCHANGERATE property to: Yes
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Sample script for updating exchange rates in the database

Running a database script is optional.

For MS SQL Databases:

Run a statement similar to the statement in number 1 below from query analyser in MS SQL
Server.

For Oracle Databases:

1. Run a statement similar to the one below from SQL Plus or SQL Plus worksheet in
Oracle.

update effdate_currency set exchange_rate=0.993,eff_date=’02-Feb-2003'
where currency_id=(select currency_id from currency where name=’Euro’);

2. Next, for Oracle databases only, run the following statement:
commit;

Substitute values for MS SQL and Oracle Databases:

Run the statement(s) again for each currency that has an exchange rate you want to change,
replacing three values for each currency. The three places where you must substitute an appro-
priate value are described below.

exchange_rate= (Exchange rate that you want the system to use)

eff_date= (Date the new exchange rate will be applied in
the system)

name= (Name of the currency to which the new exchange rate
will be applied)

You must type currency names exactly as they appear in the Currency table in the database.
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Sample script for changing the company default currency

Running a database script is optional.

For MS SQL Databases:

Run a statement similar to the statement in number 1 below from query analyser in MS SQL
Server, substituting the appropriate value in the place described below:

name= (Name of the currency which you want to set as the company default)

For Oracle Databases:

1. Run a statement similar to the statement below from SQL Plus or SQL Plus worksheet
in Oracle:

update currency set default_currency=-1;
update currency set default_currency=1 where name=’Euro’;

Before running the statement, substitute the appropriate value in the place described
below:

name= (Name of the currency which you want to set as the company default)

2. Next, for Oracle databases only, run the following statement:
commit;

You must type currency names exactly as they appear in the Currency table in the database.
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Objective 4: Set up currency profiles

You can assign different default currencies to different employees by defining currency profiles
and assigning employees or groups of employees to the profiles. Employees can still choose
other currencies for expense entries.

Employees are initially assigned to the <default> profile. The <default> profile is originally set
to the currency type US Dollar, but you may change this to another currency.

Defining a currency profile

To define a currency profile, follow these steps:

1. Select Tools > Business Rules > Currency from the menu or click
the Currency Profile icon to open the Currency window.

2. Select Profile > Add Profile from the menu or click the Add
Profile icon on the toolbar to open the Currency Profile dialog
box (Figure 24.1).

3. Enter a name and description for the profile in the text boxes.

4. Click the Currency drop-down box and select the
default currency for the profile from the list.

5. Click “OK” to save the settings and close the dialog
box.

6. Continue with the steps on the next page.

Figure 24.1



TimeWizard

287Chapter Twenty-Four • Setting Up the Expense System

Changing the method of grouping employee members will remove any existing assignments
of employees to currency profiles and will return all employees to the <default> profile.

Assigning members to a currency profile

To assign members to a currency profile, follow these steps:

1. In the Currency window (Tools > Business Rules > Currency),
click the Retrieve button on the right to display the list of profiles
in the lower left frame (Figure 24.2).

2. To select a grouping method other than “Custom Lists,” click
the Employee Members Grouped By drop-down box.

3. Select employees or groups of employees from the Members list
in the lower right frame and drag and drop them into the
appropriate profile in the lower left.

4. To remove a member from a profile, select the
profile. The profile’s members display in the lower
right. Select the members you want to remove and
drag and drop them into the <default> profile.

5. To apply your assignments, close the window.

Figure 24.2

For more information on grouping methods, see Objective 1, “Understand Employee and
Activity Grouping Methods,” in the Introduction to Section Six, “Applying Your Business
Rules to TimeWizard.”
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Objective 5: Define expense types

You set up expense categories called expense types in the Expenses area of TimeWizard.enterprise.
You must have the Expense System Setup permission to access the Expense Type setup win-
dow.

An expense type may be a flat amount or an expense rate. Choose “Expense Rate” for expenses
that have a rate per unit, such as mileage (rate per mile) or equipment rental (rate per day).

Defining an expense type

To define an expense type, follow these steps:

1. In your TimeWizard.enterprise Employee Home Page, open
the Expenses menu on the main navigation bar. Select
Expense Setup > Expense Type Setup from the menu.

2. In the Expense Type dialog box, enter the expense name and
description in the text boxes.

3. Click the Amount Type drop-down box and select “Flat
Amount” or “Expense Rate.”

4. If you selected “Expense Rate,” select a currency type for the
rate in the Unit Rate drop-down box and enter a rate in the
box to the left of the currency type.

5. If you selected “Expense Rate,” enter the type of unit in the
Unit Title box.

6. Click “Save” to save the settings.

7. Click “Return” to close the dialog box and return to your
Employee Home Page. Or, to empty the text boxes and restore
the drop-down boxes to their defaults, click “Reset.” Clicking
“Reset” will not delete settings that have been saved.

8. To review or edit a saved expense type, select View/Edit
Existing Expense Type. Select the type from the drop-down
box and click “Retrieve” in the lower left of the dialog box.

9. To delete a saved expense type, select Delete Existing Expense
Type. Select the type from the drop-down box and click
“Delete” in the lower left of the dialog box.

Figure 24.3
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Objective 6: Define payment types

You set up payment types in the Expenses area of TimeWizard.enterprise. You must have the
Expense System Setup permission to access the Payment Type setup window. Typical pay-
ments types are “Employee Paid” (for amounts to be reimbursed to the employee) and “Com-
pany Paid” (for amounts charged to the company).

When you define a payment type, you must set the payment type to add expense entries to the
expense sheet total or to subtract expenses from the total. For example, you can set a payment
type such as “Employee Paid” for expenses to be added to the total. Expense entries to be
subtracted display as negative numbers.

Setting the “Add to Total Expense” option to “No” can result in a negative total on the expense
sheet. If you want to prevent this outcome, set all payment types to “Yes,” which will add the
expense amounts to the total.

If your company issues advances to employees, you may want to set up payment types in the
following manner. Set a payment type to add employee expenditures to the total. Set another
type to subtract the amount of an advance. If the expense sheet total displays a negative
number, then the total shows the unspent amount to be returned to the company. If the total
is a positive number, the total shows the amount to be reimbursed to the employee. A total of
zero means that the employee’s expenditures equaled the advance.

Payment type can be used to indicate payment method (e.g., corporate credit card, personal
credit card, check, or cash) or other information you want to track.
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To learn to prepare expense sheets, see Chapter 10, “Preparing Expense Sheets,” in the
TimeWizard.enterprise User’s Guide.

For information on performing expense sheet approvals, see Chapter 15, “Approving and
Rejecting Expense Sheets,” in the TimeWizard.enterprise User’s Guide.

Defining a payment type

To define a payment type, follow these steps:

1. In your TimeWizard.enterprise Employee Home Page, open
the Expenses menu on the main navigation bar. Select
Expense Setup > Payment Type Setup from the menu.

2. In the Payment Type dialog box, enter the payment name and
description in the text boxes.

3. Select “Yes” to add the amount to the total on an expense
sheet or “No” to subtract the amount from the total.

6. Click “Save” to save the settings.

7. Click “Return” to close the dialog box and return to your
Employee Home Page. Or, to empty the text boxes and restore
the drop-down boxes to their defaults, click “Reset.” Clicking
“Reset” will not delete settings that have been saved.

8. To review or edit a saved payment type, select View/Edit
Existing Payment Type. Select the type name from the drop-
down box and click “Retrieve” in the lower left of the dialog
box.

9.  To delete a saved payment type, select Delete Existing
Payment Type. Select the type name from the drop-down box
and click “Delete” in the lower left of the dialog box.

Figure 24.4
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Setting Report Category Profiles

The Report Categories business rules section enables you to control user access to all TimeWizard
report categories. Simply put, users must have your permission to access certain reports in
TimeWizard. You control access to TimeWizard users by setting up report categories profile
groups and assigning employee members to appropriate groups.

Objectives

When you have finished this chapter, you should be able to do the following

1. Navigate the Report Categories frame
2. Define a reports category profile group
3. Assign members to a reports category profile group
4. Edit a reports category profile group
5. Delete a reports category profile group
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Objective 1: Navigate the Report Categories frame

From the Report Categories area, you can assign and maintain user access to all TimeWizard
report categories.  Table 22.1 defines each toolbar icon used in this chapter.

Objective 2: Define a reports category profile group

The report categories in the Reports Codes Profile dilaog box refer to typical levels of
TimeWizard users. Any profile that you create is not limited to a single report category. In
other words, you can pick and choose among all of the report category selections to create a
unique reports category profile group. Table 22.2 explains all of the pre-defined selections
available in the Reports Codes Profile dialog box. These are the default categories and reports
that come with TimeWizard.

To open the Report Categories frame, follow
either of these steps:

1. Click on the Report Categories icon.

2. Select Tools > Business Rules > Report Categories from
the TimeWizard main menu.

Figure 22.1

Navigating the Report Categories frame

Table 22.1: Report Categories Icons
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Defining a reports category profile group

To define a reports category profile group follow these steps:

1. Open the Report Categories window (Tools > Business Rules >
Report Categories).

2. Click the Add Profile icon to open the Reports Codes Profile
dialog box (Profile > Add Profile).

3. Type the name and description of the reports category profile
group in the text boxes.

4. Check every reports category box appropriate to the
profile group. Table 22.2 lists each report included in
the report categories.

5. Click “Apply” to save the settings but remain in the
dialog box, or click “OK” to save the settings and
close the dialog box.

Figure 22.2

The Default Reports Category Profile contains all employees who do not belong to any other
profile. You can rename—but not delete—the default profile. You create new reports category
profile groups so that groups of employees are governed by different restrictions.

Example Figure 22.2 shows an example Reports Codes Profile dialog box in which a new reports cat-
egory profile group called Timesheet Manager has been created. In this example, the profile
group members have permission to run reports from the following report categories: Depart-
ment Owner, Activity Owner, Timesheet User.
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Table 22.2: Report Categories
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In the members box, you can sort the display lists by clicking on the Employee ID tab and the
Employee Name tab.

Assigning members to a reports category profile group

To assign members to a reports category profile group follow these steps:

1. Open the Report Categories window (Tools > Business Rules >
Report Categories).

2. Choose an employee grouping method (see “Employees
Grouping Methods,” in the Introduction to this section).

3. To view all available members, select “<Default>” in the Report
Categories window (the members listed are “members” of the

“profile group” named “<Default>”). Note that the
<Default> profile can be modified (renamed) but
never deleted.

4. Drag and drop each appropriate employee from the
list in the Members box to the appropriate profile
group in the Reports Category Profile box.

Figure 22.3

Objective 3: Assign members to a reports category profile group

When you assign TimeWizard users to a specific reports category profile group, they are—as
members of that group—bound by its permissions and restrictions.
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To edit a reports category profile group, follow these steps

1. Select a reports category profile group.

2. Click the Edit Profile icon to open the Reports Codes Profile dialog box (Profile > Edit Profile).

3. Modify the profile information as desired.

4. Click “Apply” to save the settings but remain in the dialog box, or click “OK” to save the settings
and close the dialog box.

Editing a reports category profile group

To delete a reports category profile group, follow these steps

1. Select the desired profile group.

2. Click the Delete Profile icon (Profile > Delete Profile). Members of deleted profiles return to the
<Default> profile.

Deleting a reports category profile group

Objective 4: Edit a reports category profile group

When you edit a reports category profile group, you automatically change the permission
settings for all of its members.

Objective 5: Delete a reports category profile group

When you delete a reports category profile group, its members return to the <Default> group.
You cannot delete the <Default> profile, because its members are those not belonging to any
other group.

Summary

In this chapter, you have learned how to control access to TimeWizard reports by creating
report category profile groups and assigning members to appropriate groups.
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Setting Up Reports

TimeWizard provides for a number of pre-installed report categories and reports. In addition,
it allows for customized report categories and reports to be created and added for use within
TimeWizard. In this chapter you learn how to setup custom report categories and reports, and
how to setup the enterprise web configuration.

Refer to the TimeWizard Guide to Reports for additional information on pre-installed report
categories, pre-installed reports, and running reports.

Objectives

1. Define report categories
2. Define reports
3. Set up the enterprise Web Configuration

The reports definition is a simple process. First, you create report categories. Second, you
create new reports and specify whether each is designed to expect parameter input at runtime.
Third, you assign individual report files to each report category. Finally, you assign report
categories to report profiles that enable specified users to have access to those report categories
and reports contained within. See Chapter 22, Setting Report Category Profiles, for informa-
tion on setting up report category business rules.
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Objective 1: Define Report Categories

From the Define Report Categories dialog box, you can create report categories that will later contain
individual report files. For example, a report category named “Resource Utilization” might include
reports such as employee hours by activity, employees by department, or employees who own depart-
ments.

Defining Report Categories

Figure 23.1

To delete a report category, follow these steps:

1. Select the report category you want to delete.

2. Click on the Delete command button.

3. Click OK to save the settings and exit the dialog box, or
Apply to save the changes and remain in the dialog box.

Before deleteing a report category you must first:

1.  Delete all associated reports see Objective 2 for
additional information).

2.  Remove (uncheck) the category from any Report
Category business rules (see Chapter 22, Setting
Report Category Profiles, for additional information.

To add a new category, follow these steps:

1. To open the Define Report Categories dialog box, select
Tools > Reports > Define Categories from the TimeWizard
main menu.

2. Click on the Add command button.

3. Enter the name of the report category in the Category
Name text box.

4. Enter the path to the report category folder in the Path text
box. To enter an existing path, click on the Browse button,
and navigate to and select the report category folder. This
designates the location of the folder that contains the
individual report files.

5. Click OK to save the settings and exit the dialog box, or
Apply to save the changes and remain in the dialog box..
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Objective 2: Define Reports

From the Define Reports dialog box, you can create report or import reports, specify whether
each report is designed to expect parameter input at runtime, and assign reports to appropri-
ate report categories.

For any newly created report category you must first select (check) the category in at least one
Report Category Business Rule Profile to which you belong before it becomes available to
have reports assigned to it. See Chapter 22, Setting Report Category Profiles, for information
on setting up report category business rules.

Defining Reports and Identifying Report Parameter Specifications

Figure 23.2

To delete a report, follow these steps:

1. Select the category that contains the report you want to
delete.

2. Select the report.

3. Click on the Delete command button.

4. Click OK to save the settings and exit the dialog box, or
Apply to save the changes and remain in the dialog box.

The report file is not physically deleted, rather the
reference to it is deleted from the category.

To add a new report, follow these steps:

1. To open the Define Reports dialog box, select Tools >
Reports > Define Reports from the TimeWizard main menu.

2. From the Category drop down menu, select the report
category to which you want to assign reports.

3. To add a new report, click the Add command button.

4. Enter the name of the report in the Report Name text box.
To copy an existing report, click on the Browse button and
select the report file.

5. Enter the description of the report in the Description text
box.

6. Specify whether the report is designed to expect parameter
input at runtime. You select (yes or no) from the following
options: Parameters, Period End, Depart ments Owned,
EmpID. Table 23.1 explains each report option.

7. Click OK to save the settings and exit the dialog box, or Apply to save the changes and remain in the dialog box.
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Table 23.1: TimeWizard Report Definition Options
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Objective 3: Set up the enterprise Web Configuration

The enterprise Web Configuration setup process enables you to run interactive, presentation-
quality reports over the Internet. This is perhaps the most powerful feature of
TimeWizard.enterprise in that it enables you not only to capture valuable business data via the
web but also to analyze and act upon that information while online.
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Setting up the Enterprise Web Configuration

To set up the Enterprise Web Configuration, follow these steps:

1. To open the Enterprise Web Configuration dialog box, select
Tools > Reports > Enterprise Web Configuration from the
TimeWizard main menu.

2. Specify the configuration setting for the following selections:
Version, Publish Path, Webservername, Access Control,

Cleanup Interval, Autostart Cleanup. Table 23.2 explains
each configuration setting. See the TimeWizard
Implementation Guide provided on the installation CD
for further information.

3. Click OK to save the settings and exit the dialog box.

Figure 23.3

Table 23.2:  TimeWizard.enterprise Configuration Settings
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Summary

In this chapter, you learned about how to create and delete customized report categories, add
and delete reports from specified categories, add and delete reports from specified categories,
and how to set up the TimeWizard.enterprise web reporting configuration settings.



7
S E C T I O N  S E V E N

Sharing Information Between
TimeWizard and Other

Corporate Systems

Can We Talk?

In today’s business climate, the need for accurate and timely information is
paramount. Successful companies cannot afford to have isolated departments

duplicating efforts or even competing against one another. Rather, each depart-
ment must be willing and able to share its data so that the company as a whole can
benefit. Corporate applications that contribute to the overall success of a company
must be able to interface with one another to be fully effective.

TimeWizard’s Interface Controller enables you to setup and maintain interfaces
for one- and two-way transfers of data to and from your TimeWizard system. By
allowing TimeWizard and your other corporate systems to communicate with one
another, you ensure that data from one system has the same meaning company
wide. These interfaces keep TimeWizard and your other corporate systems in synch
without redundant data entry. In addition, you can setup TimeWizard to perform
scheduled processes.

The interfaces enable you to use your application of choice for all of your business
efforts. For example, you may prefer to manage your projects and activities in
Microsoft Project 98 and your Human Resources efforts in Peoplesoft. An inter-
face with these systems enables you to populate TimeWizard with the appropriate
project and personnel records. Once the data is approved or updated, TimeWizard
can update you external system, making manual updates unnecessary.
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This section includes the following:

Introduction to the TimeWizard Interface Controller
Chapter 27: Working with the DataBridge
Chapter 28: Working with the Table Retrieval
Chapter 29: Working with Custom Applications
Chapter 30: Working with AutoPopulate
Chapter 31: Working with the Closed Period Override Utility
Chapter 32: Working with the Exception Processor
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Introduction to the TimeWizard
Interface Controller

The Interface Controller enables you to set up and maintain all TimeWizard interfaces, sched-
ule interface intervals, and create re-usable filters and database profiles for use with multiple
interfaces.

Objectives

1. Overview of TimeWizard Interface Types
2. Overview of Running TimeWizard Interfaces
3. Navigate the Interface Controller window
4. Execute TimeWizard Interfaces
5. Browse Interface Log Files
6. Set up the Interface Interval
7. Review the Interface Status
8. Create database profiles
9. Delete database profiles
10. Edit database profiles
11. Filter interface data
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Objective 1: Overview of TimeWizard Interfaces

This introduction briefly describes each type of interface available through the Interface Con-
troller.

TimeWizard also enables you to setup the execution of an interface of your own design. See
Chapter 26: Working with Custom Applications.

The TimeWizard Interface Controller has the following interface types:

ProjectLinks

TimeWizard provides automated links to selected project management systems, allowing two-
way transfer of data: from your project management system to TimeWizard and from
TimeWizard to your project management system.

Each TimeWizard ProjectLink has its own supplement to the TimeWizard Administrator’s
Guide. Refer to the appropriate supplement for detailed usage instructions.

TimeWizard provides links for the following project management systems

• Microsoft Project 98
• Primavera Project Planner (P3)
• Business Engine (ResourceServer and ProjectServer)
The ProjectLinks enable you to create TimeWizard timesheet activities and assignments auto-
matically from your project management system (rather than having to enter them manually).
Employees then can enter time for these assignments on their timesheets. TimeWizard cap-
tures the following project-related data:

• Actual Start/Finish Dates
• Planned Start/Finish Dates
• Early Start/Finish Dates
• Estimate to Complete in Hours
• Original Planned Hours
• Initial Actual Hours
• Actual Hours Accumulated
Once the data is approved, TimeWizard can update your project management system with
this information, making manual updates unnecessary.
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Databridge Toolkit

TimeWizard provides the capability for you to create automated exports to other systems
within your organization—such as Payroll, Accounting, Human Resources, etc.—allowing a
one-way transfer of data from TimeWizard to your selected system.

Table Retrievals

TimeWizard enables you to import and update data from other systems in your company to
your TimeWizard system.

AutoPopulate

TimeWizard enables you to have time entered automatically on timesheets of employees who
are designated as AutoPopulate users.

Close Period: Override

TimeWizard enables you to close the oldest period currently open, even if timesheets in the
period have missing approvals.

Exception Processor

TimeWizard enables you to specify circumstances under which you want to have exception
logs (specifying such conditions as missing timesheets, approvals, or rejected timesheets) sent
via e-mail to specified individuals within your company.

The ProjectLinks are available only if you have purchased the add-on systems.

Objective 2: Overview of Running TimeWizard Interfaces

Introduction to Distributed Computing

Distributed computing allows you to get the most out of your investment in the client/server
architecture. By building distributed applications, you can:

• Centralize business logic on servers.
• Partition application functions between the client and the server, thereby reducing

the client workload.
• Make your applications scalable and easy to maintain.
• Increase application performance by utilizing higher-end server hardware.
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Running the Interfaces from an Application Server

Import and export processes tend to consume substantial computer resources. In the interest
of efficiency, security, and convenience, the TimeWizard data interfaces must be run on an
application server, with the execution initiated and controlled from a TimeWizard Adminis-
trator client workstation.

The Administrator application does not have to be running for the scheduler/interfaces to
run.

Figure I.1 illustrates the TimeWizard Application Environment, which outlines the relation-
ship between the TimeWizard administror/client machines, the TimeWizard.enterprise web
server, the TimeWizard database, and the application server.

Figure I.1

Timesheet 
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(Application files,
Timwiz.ini file,
and Oracle
or MSS SQL client)

TimeWizard
Administrator
Client
(Application files,
Timwiz.ini file,
and Oracle
or MSS SQL client)

TimesWizard.enterprise
Client
(Netscape or Internet Explorer)

Database Server
(TimeWizard Database
and Oracle or MS SQL)

Network installation 
of TimeWizard Client-Server 
includes the following:
IAS and Log files
Interface Applications
Database Setup files
Registration files 
(Timwiz.ini file)

Application  Server

Network Installation
of TimeWizard.enterprise 
includes the following:
NetDynamics Application
TimeWizard.enterprise Application

TimesWizard.enterprise
Client
(Netscape or Internet Explorer)

TimesWizard.enterprise
Client
(Netscape or Internet Explorer)

Timesheet 
Client
(Application files,
Timwiz.ini file,
and Oracle
or MSS SQL client)

Web Server installation 
includes the following
TimeWizard.enterprise files:

Help files
Graphics and images
NetDynamics files
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Setting up the TimeWizard Server Application

The server application is stored and executed on an application server. The server application
also is required to be in run mode at all times. The traffic signal displayed on the application
server’s main window indicates whether the service status is active or inactive. The green light
indicates it is active; the red light indicated it is inactive. In addition you can start or stop the
service manually, if necessary.

You are required to assign a port number for the application/service in the SERVICES file on
the application server. The TimeWizard server application requires a unique port number on
the server machine.

For example, you could assign a port number as follows in the \\WINNT\SYSTEM32\SERVICES
file:

tw_serv 10014/tcp tw_serv
tw_serv 10014/udp

The InterfaceApp.ini file keeps Interface applications information such as Status, Start time,
and Stop time. The file gets created every time when TimeWizard server starts. It has three
sections:

• Interface Application, which keeps status information for Interface applications
based on the control ID, which can be viewed in the Interface Controller.

• Start Time, which keeps date and time stamp when an application has started
based on the control ID.

• Stop Time, which keeps date and time stamp when an application has stopped
execution based on the control ID.

Setting up the TimeWizard Administrator Application

In the TimeWizard Administrator system Hosts file, you are required to declare the TCP/IP
address of the application server where the TimeWizard server application resides.

In addition, you must also identify the HostName and Port number under the [Application
Server] heading in the Timwiz.ini file:

HostName = Dev005
Port = 10014
IP Address = DEV0005
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To open the Interface Controller window, follow
either of these steps:

Navigating the Interface Controller window

1. Click on the Interface Controller icon on the TimeWizard
Administrator toolbar.

2. Select Tools > Interface Controller from the TimeWizard main
menu.

If the application server is not running, the Interface
Controller will not connect and will kick you out.

Figure I.2

Objective 3: Navigate the Interface Controller window

The TimeWizard Interface Controller gives you quick access to manage all of your interfaces
between TimeWizard and your other corporate applications. Table I.1 explains the interface
commands of the Interface Controller window.

Example Figure I.3 shows an Interface Controller window in which we have created a DataBridge,
Table Retrieval, Exception Processor, a ProjectLink Retrieval, and a close period override. For
each interface, we have specified appropriate intervals.

Figure I.3
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Table I.1: Interface Controller Commands
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To execute TimeWizard interfaces, follow these
steps:

Executing TimeWizard interfaces

1. In the Interface Type column of the Interface Controller
window, select the interface you want to run.

2. To execute the selected interface, click the Execute Now
icon or select Interface > Execute Now from the main
menu.

3. To stop an interface during execution, click the Stop
Interface icon or select Interface > Stop Interface from the
main menu.

Figure I.4

Objective 4: Execute TimeWizard Interfaces

The execute interface command runs the selected interface in accordance to your setup and
scheduling parameters.



TimeWizard

313Introduction • Introduction to the TimeWizard Interface Controller

To execute browse interface log files, follow these
steps:

Browsing interface log files

1. In the Interface Type column of the Interface Controller
window, select the appropriate interface.

2. To browse log files for the selected interface, click the
Browse Log Files icon (Place Icon I.6 here.) or select Interface
> Browse Log Files from the main menu.

Figure I.5

Objective 5: Browse Interface Log Files

The Interface Status dialog box displays the ID, start and stop times, and current status (run-
ning or idle) of each TimeWizard interface you have created in the Interface Controller.



TimeWizard

Section Seven • Sharing Information Between TimeWizard and Other Corporate Systems314

Setting Up the Interface Interval

To set up the interface interval, follow these steps:

1. To open the “Change Interval” dialog box, click on the Interval
icon,         select Interface > Interval from the main menu, or
double-click on the interval field.

2. In the Interval Type area, click on the check boxes to select or
deselect the intervals. Your interval options are hourly, daily,
weekly, monthly, or sequenced. Table I.2 explains these options.

3. Use the appropriate drop-down boxes to select the correspond-
ing interval specifications (e.g., specific day and time). For a
sequenced interval, click on the interface drop-down box and
select from the list of existing interfaces.

4. Click Apply to save the settings and remain in the
Change Interval dialog box, or click OK to save the
settings and exit the dialog box.

5.             Click the Start Scheduler icon or  select
Interface > Start Scheduler from the main menu.

6. To stop a scheduled interface interval, click the Stop
Scheduler icon or select Interface > Stop Scheduler
from the main menu.

Figure I.6

Objective 6: Set up the Interface Interval

Setting up the interface interval enables you to run interfaces at scheduled times. In addition,
you can sequence two or more interfaces to run in a specified order at specified times. Once
you have set up an interface interval, click the Start Scheduler icon (Interface > Start Sched-
uler) to activate the TimeWizard scheduler. The scheduler then runs continually in the back-
ground and executes all scheduled intervals.

When you run sequenced interfaces, each interface must run successfully before the next
interface will run. In other words, if one interface in a sequence fails, the sequence stops and
no subsequent interfaces run.
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Objective 7: Review the Interface Status

The Interface Status dialog box displays the ID, start and stop times, and current status (run-
ning or idle) of each TimeWizard interface you have created in the Interface Controller.

Table I.2: Interval Options

Reviewing the interface status

To review the interface status, follow these steps:
Figure I.6

2. In the Interface Status dialog box, review the data
and verify the status of each interface.

1. To open the Interface Status dialog box, click on the Interface
Status icon         or select  Interface > Interface Status from the
main menu.
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Objective 8: Create Database Profiles

By creating database profiles, you add the flexibility to re-use connectivity information across
interfaces—without the effort of having to redefine it each time. The same database profiles
can be used for Table Retrieval, DataBridge, and ProjectLink interfaces.

The Database Profile command button (which opens the the Select Database Profile dialog
box) is located wherever you are required to select a database profile for Table Retrieval,
DataBridge, and ProjectLink interfaces. From the Select Database Profile dialog box, you can
access the Database Profile Setup dialog box.

Creating Database Profiles

To create database profiles, follow these steps:
Figure I.8

4. Click the Test command button to verify your data.
TimeWizard attempts to connect to the specified
database.

5. Click OK to save the settings and exit the Database
Profile Setup dialog box.

1. Click the Database Profile command button to open the
Select Database Profile dialog box.

2. Click the New command button to open the Database
Profile Setup dialog box.

3. Enter the appropriate setup information in the data fields.
Table I.3 explains each database profile setup selection.
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Objective 9: Edit Database Profiles

TimeWizard enables you to edit and maintain your database profiles so that you can ensure
ease of connectivity to your external systems.

Table I.3: Database Profile Selections

Editing Database Profiles

To edit database profiles, follow these steps:

1. In the Select Database Profile dialog box, click on a profile to select it.

2. Click the Edit command button to open the Database Profile Setup dialog box for the selected profile.

3. Edit the appropriate setup information in the data fields. Table I.2 explains each database profile setup selection.

4. Click the Test command button to verify your data. TimeWizard attempts to connect to the specified database.

5. Click OK to save the settings and exit the Database Profile Setup dialog box.
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Objective 10: Delete Database Profiles

TimeWizard enables you to delete database profiles that you no longer require.

Objective 11: Filter interface data

TimeWizard enables you to specify a filter to further define which records are processed.
Specifically, the filter function allows you to build a test expression that then is applied to the
inport and export fields. This limits the records being processed to those that meet the condi-
tions of the expression.

The Filter command button (which opens the the Select Filters dialog box) is located wher-
ever you are able to filter data for Table Retrieval, DataBridge, and ProjectLink interfaces.
From the Select Filters dialog box, you can access the Filters dialog box.

To delete database profiles, follow these steps:
1. In the Select Database Profile dialog box, click on a profile to select it.

2. Click the Delete command button to delete the selected profile.

3. Click OK to save the settings and exit the Database Profile Setup dialog box.

Deleting Database Profiles

Filtering interface data (continued on page 291)

Figure I.9To filter the interface data, follow these steps:

2. Click on the Expression drop-down list and select
the expression.Table I.4 explains the expression
options.

1. In the Filter dialog box, click on the Fieldname drop-down list and
select the first fieldname you want to use for the filter test expression.
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Filtering interface data (continued from page 290)

6. Click on Apply Filter. The filter expression is
displayed on the “Field Layout” tab page.

7. To change the test expression, you can change
individual criteria (e.g., fieldname, test expression,
value), select and delete a row by clicking the Delete
Row command button, or click the Delete All
command button to delete the entire test
expression and start over. Verify any changes or new
expressions by clicking on the Verify command
button.

Don’t forget that if you are using more than
one fieldname for the filter, you must use

parentheses to separate the expressions and a final
set around the outermost expression.

3. Click on the value text box and enter the value to use for the
test. The filter is case-sensitive: Description = “Project 1” is not
the same as Description = “project 1.”

4. If you are using more than one fieldname for the filter, you must
use the parentheses to separate the expressions and a final set
around the outermost expression. Click on the and/or drop-
down list and select the appropriate condition.

5. Click on Verify to verify that your expression is valid. If the
expression is valid, TimeWizard displays a Valid Expression dialog
box. If it is not valid, TimeWizard displays a Invalid Expression
dialog box, in which case you must correct the expression errors
as necessary.

Table I.4: Filter Expressions
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Example Filter Expression 1

To retrieve project “Test Project”, the correct filter is:
(Project Title = “Test Project”)

Example Filter Expression 2

To retrieve task “coding” for project “Test Project”, the correct filter is:
( (Project Title = “Test Project”) and
(Task Name = “coding”) )

Example Filter Expression 3

To retrieve Projects “Test Project 1” and “Test Project 2”, the correct filter is:
( (Project Title = “Test Project 1”) or
(Project Title = “Test Project 2”) )

Example Filter Expression 4

To retrieve tasks “coding”, “testing”, and “qa” for project “Test Project”, the
correct filter is:
( (Project Title = “Test Project”) and
( (Task Name = “coding”) or
(Task Name = “testing”)
(Task Name = “qa”) ) )

Example Filter Expression 5

To retrieve projects with Planned Start 11/20/98 and 11/30/98, the correct filter is:
( (Planned Start = 11/20/98) or
(Planned Start = 11/30/98) )

Summary

In this Introduction, you have been introduced to the TimeWizard’s Interface Controller,
which enables you to set up and maintain interfaces for one- and two-way transfers of data to
and from your TimeWizard system.
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Working with the DataBridge Toolkit

TimeWizard provides the capability for you to create automated links to other systems within
your organization—such as those used for Payroll, Accounting, Human Resources, and Project
Management—allowing a one-way transfer of data from TimeWizard to your selected sys-
tem.

The DataBridge is a sophisticated export tool that requires some understanding of relational
databases and of the data captured within TimeWizard. You can use the DataBridge interface
to guide you through the scripting and setup process; however, you may need to seek technical
assistance to achieve the desired results. If you are experienced in writing SQL statements, you
can write your own script in a DataBridge text box.

In the DataBridge interface, script variables map out what data the DataBridge will gather for
transfer. These “data maps” can be straight-forward  variables if the information you want
collected resides in a database table column. For more complex data collection, you can set
conditions that TimeWizard must meet during the information gathering. You do this by
scripting computed conditional expressions.

Objectives

1.  Introduction to Scripting a DataBridge
2.  Add a DataBridge Interface type to the Interface Controller window
3.  Use the DataBridge interface to add a DataBridge script
4.  Script a database variable
5.  Script a computed variable

•   Script a computed constant variable
•   Script a computed sequenced variable
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•   Script a computed simple expression variable
•   Script a computed conditional expression variable

6. Edit a script variable
7. Delete a script variable
8. Filter the DataBridge transaction data
9. Specify the output type
10. Script a database output target profile
11. Script a file output target profile
12. Edit a database output target profile
13. Clone a database output target profile
14. Delete a database output target profile
15. Create a file profile
16. Edit a file profile
17. Delete a file profile
18. Write your own script in SQL
19. Edit, clone, or delete a manual script

Objective 1: Introduction to Scripting a DataBridge

Building a DataBridge from TimeWizard to targeted systems contains three basic steps (though
each step involves its own unique process). Table 24.1 explains these basic steps.

Table 24.1: Steps to Building a DataBridge
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Creating DataBridge Scripts

The DataBridge Script Editor enables you to set up a data export by specifying the content of
the data, computations required, and the output format. Lists of employees, activities, depart-
ments, and other database entities can be exported subject to standard filter conditions. More
complex exports that involve accumulating transaction data or controlling updates to external
systems are subject to additional setup requirements. These include the following:

• Defining the content to be extracted

• Computing fields using arithmetic or comparison operators and a limited
conditional

• Accumulating transaction hours by specifying fields within which totals will be com-
puted and output records created

• Filtering the selection of transactions by period or date ranges, activity attributes,
employee attributes, period states, timesheet approval states, and other conditions

For each DataBridge script, users must specify the output format and destination. In so doing,
you can create database profiles or file profiles that can be re-used for later exports. You have
already assigned values to the export targets in the Code Values area of TimeWizard. We
discussed this process in Chapter 4, Objective 5, in the section entitled, “Customizing
TimeWizard.”

Posting Transactional Data

When updates to other systems occur on a regular basis and comprise required input to those
applications, several requirements arise for tracking and controlling the TimeWizard exports.
When exported data is used to update a target system for operational purposes, the exported
data should be identified accordingly. This indication is called “posting,” which identifies
both the TimeWizard record and the target system. The key purpose of posting is that it
should prevent the user from posting the same data more than one time for each target system.

In the event that an export process fails due to hardware failure, power outage, or other reason,
the user can roll back the postings that occurred during the failed process. This allows the user
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to rerun the export accurately.

Objective 2: Add a DataBridge Interface type to the Interface Controller window

To begin building a DataBridge, you must add a new Interface row in the Interface Controller
window and select DataBridge as the interface type. Once you have added the DataBridge
field to the Interface Controller window, you can begin the steps outlined in the Introduction
to this chapter. For more information about the Interface Controller window, see the Intro-
duction to Section 7: Sharing Information Between TimeWizard and Other Corporate Sys-
tems.

Figure 24.1

Adding a DataBridge

To add a DataBridge, follow these steps:

1. From the Interface Controller window, click the Add Interface icon .

2. Select DataBridge from the Interface Type data window. To locate
the selection, scroll through the drop-down menu.
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Objective 3: Use the DatBridge interface to add a DataBridge script

The first step in creating a DataBridge is to name the script you are about to write and specify
your posting preferences. The DataBridge Script contains all of the key instructions for the
DataBridge, i.e., what data it contains and where it is going to deliver that data. In the script,
you define the variables, filters, and output targets.

Adding a DataBridge script

To add a DataBridge script, follow these steps:

1. From the Interface Controller window, select the DataBridge
from the Interface Type column.

2. Click on the Setup icon or double-click on the DataBridge
interface type cell to open the Script Editor window.

3. Enter the name of the DataBridge in the Script Name data
window.

4. Click on the check box to specify whether you want to post
output to selected targets. For a detailed discussion about

posting exported data, see Objective 1: Introduction to
Scripting a DataBridge, “Posting Transactional Data,” this
chapter.

You created the overall list of DataBridge targets
when you specified the Code Value Export

Targets. The values you assigned designated certain
external systems as targets for regular updates from
TimeWizard.

Figure 24.2
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Objective 4: Script a database variable

The script variables map out what data the DataBridge will gather for transfer. These “data
maps” can be straight-forward  variables if the information you want collected resides in a
database table-column. In addition, you can specify whether you want to group by or accu-
mulate certain variables.

See the example script in Figures 24.4 through 24.7 for a start-to-finish view of this process.

Scripting  a database variable

To script a database variable, follow these steps:

1. In the Script Editor window, click the Scripts tab. (This tab is
the default setting when you first open the Script Editor
window.)

2. Right-click in the empty area of the Variable section of the
Scripts tab window to display the variable drop-down menu.

3. Select Add to open the Create/Edit Variable dialog box.

4. Select “Database (Table and Column)” as the Variable Type
(See Figure 24.4). Click Next to continue.

5. Select a Table and then an associated Column for the variable.
(See Figure 24.5). Specify if you want to “Sequence on this
variable” by checking the box in the lower left. Table 24.2 and
Example 1 explain this option. Click Next to continue or Back

to return to the previous dialog box.

The Column selections change in accordance
with each Table selection.

6. Specify if you want to “Group by” or
“Accumulate” the variable. (See Figure 24.6). Table 24.2
explains these options. Click Next to continue or Back to
return to the previous dialog box.

7. The last setup dialog box displays all prior selections.
Review your variable settings before creating the variable.
(See Figure 24.7).  Click Finish to create the variable or
Back to return to the previous dialog box.

Figure 24.3
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Example 1 We can create database variable scripts to tell our external target system how many em-
ployee records will be exported for each activity. In this example, we would follow these
steps:

1. Add a database variable script for the Employee ID column in the Employee table
and check the box to “Sequence on this variable.”

2. For the Employee ID variable, check the box to “Group by this variable.”
3. Add a database variable script for the Activity ID column in the Activity table.

Because we have sequenced on Employee ID, the values for Employee ID will be converted to
numerals that act as a counter in the output.

Figure 24.4

Figure 24.6

Figure 24.5

Figure 24.7
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Table 24.2: Variable Options
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Sample Output

Employee ID Activity ID
001 82
002 82
001 95
002 95
003 95
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Example 2 In Figures 24.4, 24.5, 24.6, and 24.7, we created a database variable script that accumulates
(i.e., sums) numeric data from the Transaction Hours column of the Transaction table.

For the same Databridge interface, we might next script a database variable for an activity
custom field. If we script a database variable for the column called “Project” from the Activity
table, and apply the “Group by this variable” option, we can output a summary of transaction
hours for each project in the database.

Sample Output

Project Transaction Hours
B2B 640.00
eCommerce 367.50
Online 425.00

Objective 5: Script a computed variable

For more complex data collection, you can set conditions that TimeWizard must meet during
the information gathering. You do this by scripting computed conditional expressions.

Due to the complex nature of scripting computed variables, this objective includes supple-
mental instructions for each Variable Value Type selection, see “Scripting  a computed vari-
able: Step 7a-7d,” following step 9, below.
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Figure 24.8

Scripting  a computed constant variable (continued on page 303)

1. In the Script Editor window, click the Scripts tab. (This
tab is the default setting when you first open the Script
Editor window.)

2. Right click in the empty area of the Variable section of
the Scripts tab window to display the variable drop-
down menu.

3. Select Add to open the Create/Edit Variable dialog box.

4. Select “Computed” as the Variable Type. (See Figure
24.8.) Click Next to continue.

5. Enter a name for the variable in the Variable Name
data filed and select the Data Type from the drop-
down menu. (See Figure 24.9.)

Your data type selections are as follows:
• Datetime
• Decimal
• Integer
• String

6. Select the Variable Value Type. (See Figures 7a, 7b, 7c,
and 7d in the special instructions following step 9,
below.)

Your value type selections are as follows:
• Constant Value
• Sequence
• Simple Expression
• Conditional Expression

Figure 24.9

To script a computed constant variable, follow these steps:
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Figure 24.10

Scripting  a computed constant variable (continued from page 302)

Table 24.3 explains these options. Click Next to continue or
Back to return to the previous dialog box.

7. For detailed instructions based on each Variable Value Type
selection, see “Scripting  a computed variable: Step 7a-7d,”
following step 9, below.

8. If applicable, specify whether you want to “Group by” or
“Accumulate” the variable. (See Figure 24.10.) Table 24.2
(Objective 4, this chapter) explains these options. Click Next
to continue or Back to return to the previous dialog box.

9. The last setup dialog box displays all prior selections. Review
your variable settings before creating the variable. Click
Finish to create the variable or Back to return to the
previous

Step 7a: Scripting  a computed constant variable

To script a computed constant variable, follow these steps:

1. Select “Constant” as the Variable Value Type. (See Figure 24.7a1.)

2. Enter the constant value in the data window. (See Figure 24.7a2.)

3. Click Next to continue or Back to return to the
previous dialog box. (Proceed to Step 9,
Objective 5.)

Figure 24.11 Figure 24.12
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Example In Figures 24.11 and 24.12, we scripted a computed constant variable with a constant value of
00124.

Figure 24.13

Step 7b: Scripting  a computed sequenced variable

To script a computed sequenced variable,
follow these steps:

1. Select “Sequence” as the Variable Value Type. (See
Figure 24.7b1.)

2. Click Next to continue or Back to return to the
previous dialog box. (Proceed to Step 9, Objective
5.)

Table 24.3: Variable Value Types
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Figure 24.14

Step 7c: Scripting  a computed simple expression variable

Figure 24.15

To script a computed simple expression variable, follow these steps:

1. Select “Simple Expression” as the Variable Value Type
and click next. (See Figure 24.14)

2. Enter the variables or constant values in the data
windows. (See Figure 24.15)

3. Click Next to continue or Back to return to the previous
dialog box. (Proceed to Step 8, Objective 5.)

Example In Figures 24.14 and 24.15, we created a simple expression with the following statement:
“Transaction, Transaction Hours multiplied by Transaction, Salary Rate 1.”
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Figure 24.18

Step 7d: Scripting  a computed conditional expression variable

1. Select “Conditional Expression” as the Variable Value
Type. (See Figure 24.16.)

2. In the “If” dialog box, enter the variables or constant
values and the appropriate operators in the data
windows. (See Figure 24.17.) Click Next to continue or
Back to return to the previous dialog box.

3. In the “Then” dialog box, enter the variables or constant

Figure 24.19

To script a computed conditional expression variable, follow these steps:

values and the appropriate operators in the data
windows. (See Figure 24.18.) Click Next to continue or
Back to return to the previous dialog box.

4. In the “Else” dialog box, enter the variables or constant
values and the appropriate operators in the data
windows. (See Figure 24.19.) Click Next to continue or
Back to return to the previous dialog box. (Proceed to
Step 8, Objective 5.)

Figure 24.16 Figure 24.17
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Example In Figure 24.17, we began a conditional expression with the following “If” statement: “If
Transaction, Transaction Hours is greater than 40. . . .”

In Figure 24.18, we continue the conditional expression with the following “Then” state-
ment: “. . . Then 40. . . .”

In Figure 24.19, we conclude the conditional expression with the following “Else” statement:
“. . . Else Transaction, Transaction Hours.”

Objective 6: Edit  a script variable

TimeWizard enables you to edit script variables to correct or redirect the DataBridge in gath-
ering data for transfer. However, before editing a script, verify that your changes will not alter
the accuracy of the DataBridge.

Editing a script variable

To edit a script variable, follow these steps:
1. In the Script Editor window, click the Scripts tab. (This tab

is the default setting when you first open the Script Editor
window.)

2. Right click on the variable row that you want to edit to
display the variable drop-down menu.

3. Select Edit to open the Create/Edit Variable dialog boxes
for the selected variable.

4. Make any changes necessary. Click Finish to save the
corrections to the variable or Back to return to the
previous dialog boxes and continue to make correc-
tions.

Figure 24.20
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Objective 7: Delete a script variable

You can delete a script variable at any time. However, before deleting a script, verify that your
changes will not alter the accuracy of the DataBridge.

Objective 8: Filter the DataBridge transaction data

TimeWizard enables you to specify a filter to be used in the DataBridge to further define
which transaction data is shared. If your script variables do not direct the DataBridge to gather
any transactional data, you may select No Filter in the normal transactions and historical
corrections filtering settings areas. Table 24.4 navigates the Transaction Filters window and
explains each area. Tables 24.5 and Table 24.6 explain the filtering options for Normal Trans-
actions and Historical Correction Transactions.

Deleting a script variable

To delete a script variable, follow these steps

1. In the Script Editor window, click the Scripts tab.
(This tab is the default setting when you first open
the Script Editor window.)

2. Right click on the variable row that you want to edit
to display the variable drop-down menu.

3. Select Delete to open the Delete confirmation dialog
box for the selected variable.

4. Click Yes to delete the selected variable.

Figure 24.21
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For filtering Historical Corrections Transactions, Transaction Date refers to the date of the
actual transaction for which a historical correction was made. Transaction Datetime Stamp
refers to the date and time that the historical correction was made, regardless of the date
transaction that the date was posted to.

Example Assume that on 08/20/99 you make a historical correction to a transaction dated 02/15/99.
Your Transaction Date equals 02/15/99, and your Transaction Datetime Stamp equals 08/20/
99.

Table 24.4: Transactions Filter Window Areas
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Filtering the DataBridge transaction data

To filter the DataBridge transaction data, follow these steps:

1. In the Script Editor window, click the Transaction Filters tab.

2. Specify the normal transactions filtering settings. Table 24.6 explains
each selection.

3. Specify the historical corrections filtering settings. Table 24.7 explains
each selection.

Figure 24.22

4. Specify the filtering settings for periods,
approval state, and posting status. Table 24.5
explains each area.

5. Specify whether you want to include audit
records.

Table 24.5: Normal Transactions Filter Options
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Table 24.6: Historical Transactions Filter Options

Objective 9: Specify the output type

For each output destination, users must specify the output type as either “Database” or “File.”
Depending on your choice of output type, this information will become part of either a
database output target profile or a file output target profile that you can re-use for later ex-
ports.

Output destinations are called “export targets.” You have already assigned values to the export
targets in the Code Values area of TimeWizard. We discussed this process in Chapter 4, Ob-
jective 5, in the section titled, “Customizing TimeWizard.”
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Specifying the output type

To specify the output type, follow these steps:

1. In the Script Editor window, click the Output tab.

2. Right-click in the empty area of the Variable section of the
Output tab window to display the variable pop-up menu.

3. Select Add to open the output target dialog box.

4. Select an export target from the list. (See Figure 24.23.) Click
Next to continue.

One DataBridge script may be used with multiple
export targets.

5. Select either “Database” or “File” as the output
type. (See Figure 24.24.) If you chose “Database,”
leave the “Include Header” checkbox unselected. If
you chose “File,” you can select “Include Header” if
you want to include header text for each variable in
the output file. Click Next to continue or Back to
return to the previous dialog box.

Figure 24.23 Figure 24.24

If you chose “Database” as the output type, continue with Objective 10: Script a database
output target profile.  If you chose “File” as the output type, continue with Objective 11:
Script a file output target profile.
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Objective 10: Script a database output target profile

An output target profile consists of an export target, an output type, and information on how
to connect to the export target.  If your output type is “Database,” in this objective you learn
to complete a database output target profile by providing connectivity information.

Scripting a database output target profile

To script a database output target, follow these steps:

1. Complete the steps in Objective 9 by selecting “Database”
as the output type and clicking Next.

2. Select a database connection profile from the list or click
the Create Profile command button to create a new
profile. (For information on creating a database profile, see
Objective 8 in the Introduction to this section.)

3. Select the appropriate output table name from the Table
Name drop-down box. (See Figure 24.25.) Click Next to
continue or Back to return to the previous dialog box.

4. In the Output Variable Set dialog box, click the Add
command button to open the Choose Variable dialog box.
Select one or more output variables from the list. Click
Choose to return to the Output Variable Set dialog box.

To select multiple variables in sequence, click on the top
variable you want to select. Then hold down the
Shift key and click on the bottom variable you
want to select. To select multiple variables not in

sequence, click on the top variable you want to select.

Figure 24.26

Then hold down the Control key and click on each
additional variable you want to select.

5. Enter the appropriate settings in the Output Column
and Date Format drop-down boxes, if applicable. (See
Figure 24.26.) Click Next to continue or Back to return
to the previous dialog box.

To change the sequence of the output variables, click on
the variable name of a row you want to move and the

cursor will become a double-headed arrow.
Continue to depress the mouse button and

drag-and-drop the variable row to the desired location
in the list.

6. Verify your variable settings before creating the
variable. Click Finish to create the variable or Back to
return to the previous dialog box and make correc-
tions.

Figure 24.25
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Scripting a file output target profile

To script a file output target profile, follow these steps:

1. Complete the steps in Objective 9 by selecting “File” as
the output type and clicking Next.

2. Select a file profile from the list or click the Create Profile
command button to create a new profile. (See Figure
24.27.) For instructions on how to create a new file profile
or edit an existing file profile, see Objectives 15 and 16 in
this chapter. Click Next to continue or Back to return to
the previous dialog box.

3. In the Output Variable Set dialog box, click the Add
command button to open the Choose Variable dialog
box. Select one or more output variables from the list.
Click Choose to return to the Output Variable Set dialog
box.

To select multiple variables in sequence, click on
the top variable you want to select. Then hold

down the Shift key and click on the bottom variable you
want to select. To select multiple variables not in

Figure 24.28

sequence, click on the top variable you want to select.
Then hold down the Control key and click on each
additional variable you want to select.

4. Enter the appropriate settings for the output variable
set. (See Figure 24.28.) Table 24.7 explains each
setting. Click Next to continue or Back to return to the
previous dialog box.

To change the sequence of the output
variables, click on the variable name of a row

you want to move and the cursor will become a
double-headed arrow. Continue to depress the mouse
button and drag-and-drop the variable row to the
desired location in the list.

5. The last setup dialog box displays all prior selections.
Review your settings before creating the output
variable. Click Finish to create the variable or Back to
return to the previous dialog box and make corrections.

Figure 24.27

Objective 11: Script a file output target profile

An output target profile consists of an export target, an output type, and information on how
to connect to the export target. If your output type is “File,” in this objective you learn to
complete a file output target profile by providing connectivity information.
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Objective 12: Edit a database output target profile

TimeWizard enables you to edit and maintain your output target profiles so that you can
ensure ease of connectivity to your export targets.

Table 24.7: Output Variable Set Options

Editing database output target profiles

To edit output target profiles, follow these steps:

1. In the Script Editor window, click the Output tab.

2. Right-click on the output target that you want to clone to display the drop-down menu.

3. Select Edit to open the Output dialog boxes. Make any necessary changes.

4. The last setup dialog box displays all prior selections. Review your settings before creating the output target. Click Finish
to create the variable or Back to return to the previous dialog box and make corrections.
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Objective 13: Clone a database output target profile

In the event you need to add a database profile that is very similar to an existing profile,
TimeWizard enables you to make an exact copy of the existing profile and then edit the copy
as needed. This saves time and helps to ensure accurate output target setup.

Cloning database output target profiles

To clone output target profiles, follow these steps:

1. In the Script Editor window, click the Output tab.

2. Click the Create Profile command button to open the New File Profile dialog box.

The Create Profile command button is located wherever you are required to select a file profile for Table Retrieval,
DataBridge, and ProjectLink interfaces.

3. Enter the appropriate setup information in the data fields. Table 24.9 explains each file profile setup selection.

4. Click Done to save the settings and exit the New File Profile dialog box.

Objective 14: Delete a database output target profile

TimeWizard enables you to delete output target profiles that you no longer require.

Deleting database output target profiles

To delete output target profiles, follow these
steps:

1. In the Script Editor window, click the Output tab.

2. Right-click on the output target that you want to
delete to display the drop-down menu.

3. Select Delete to open the Delete confirmation dialog
box.

4. Click Yes to delete the output target profile.

Figure 24.29
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Objective 15: Create a file profile

If your output type is File, you can create file profiles for export targets and have the flexibility
to re-use file interfaces—without the hassle of having to reconfigure the connection each time.

Creating file profiles

To create file profiles, follow these steps:

1. Click the Create Profile command button to open
the New File Profile dialog box.

The Create Profile command button is
located wherever you are required to select

a file profile for Table Retrieval, DataBridge, and
ProjectLink interfaces.

2. Enter the appropriate setup information in the data
fields. Table 24.8 explains each file profile setup
selection.

3. Click Done to save the settings and exit the New File
Figure 24.30
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Table 24.8: File Profile Settings

The Format Type “Line Format” will output one value per line.
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Objective 16: Edit a file profile

TimeWizard enables you to edit and maintain your file profiles so that you can ensure ease of
connectivity to your export targets.

Objective 17: Delete a file profile

TimeWizard enables you to delete file profiles that you no longer require.

Editing file profiles

To edit file profiles, follow these steps:

1. Click on a file profile to select it.

2. Click the Edit Profile command button to open the
Edit File Profile dialog box for the selected profile.

3. Edit the appropriate setup information in the data
fields. See Table 21.9 for explanations on the file
profile setup selections.

4. Click Done to save the settings and exit the Edit File
Profile dialog box.

Figure 24.31

Deleting file profiles

To delete file profiles, follow these steps:

1. Click on a file profile to select it.

2. Click the Delete Profile command button delete the selected profile.
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Objective 18: Write your own script in SQL

If you are experienced in writing SQL scripts and are familiar with the TimeWizard database,
you can write your own DataBridge script to output TimeWizard data to a flat file.

Writing “select” statements in your script is the safest policy. Data manipulation statements
such as “create,” “insert,” “update,” and “delete” statements could irrevocably damage your
TimeWizard database.

Writing your own script in SQL

To write your own script, follow these steps:

1. In the Interface Controller window, add a new DataBridge
interface.

2. Select Interface > Setup Options or click the Setup
Options icon or double-click the DataBridge application
name cell to open the DataBridge Script Editor window.

3. Click the Manual Script button to open the Manual
DataBridge Script Editor window.

4. In the Manual Script tab page, right-click in the empty
Manual Scripts area and select “Add” from the popup
menu to open the Manual databridge setup dialog box.

5. Enter a description for your script.

6. To write a completely new script, click “Script editor” to
open the Manual databridge setup dialog box. To write a
script based on an existing script, click “Browse” and
select the file to modify.

7. Write your SQLscript in the text box, including statements

Figure 25.32

to select and filter the data and to perform any
calculations needed for the output.

If you plan to post the output data (i.e., flag the
database records that are sent to a specific target), you
must select trans_id from the transactions table.

8. Click “Compile” to test whether the script could be
executed as written. If an error message displays, make
any required corrections. If no message displays,
continue with step 9 below.

9. Click “Save” to open the Select File dialog box. Enter a
unique file name, click the “Save in” drop-down box to
select where to save the SQL file, and click “Save.”

9. Enter a unique script name. To open the non-manual
Script Editor, click “Script,” or to close the window and
return to the Interface Controller, click “Close.”

10. Continue with the steps on the next page.
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Setting up the output for your manual script

To set up the output for a manual script, follow these steps:

1. In the Code Values area (Tools > Code Values), click the
DataBridge Targets tab to open the DataBridge Targets
tab page.

2. Click “Add” and enter a target name for the export
destination. Enter a description with the first word
“Manual,.”

3. Repeat step 2 to add multiple targets. Click “OK’ to save
the target(s) and close the window.

4. In the Interface Controller, select the DataBridge
application to be used. Select Interface > Setup Options or
click the Setup Options icon or double-click the
DataBridge application name cell to open the DataBridge
Script Editor window.

5. Click “Manual Script” to open the Manual DataBridge
Script Editor window.

Figure 25.33

6. Click the Manual Output tab. Right-click in the empty
area to open the Create/Edit Manual Output box. Click
“Next.”

7. Select whether the output file is to include a header for
each variable in the script and click “Next.”

8. Click “Browse.” To retain the name of the file you
want to use, select the file. To change the name of the
file, select the path, and enter a new name in the File
name box.

9. Click the Format Type drop-down box and select a
format for the output. Click “Finish.” The Manual
Output page displays the target name, the description
from Code Values, the path and file name, and the file
format.

To retain more than one manual script, add another DataBridge interface in the Interface
Controller window. In the Manual databridge setup window, enter a new, unique script name
and write the script.
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Manual script output formats

You can select any of the following file types for the output:

• Comma-separated values

• Data Interchange format

• Microsoft Excel format

• Microsoft Excel 5 format

• Text with HTML formatting

• Powersoft Report (PSR) format

• SQL syntax

• Microsoft Multiplan format

• Tab-separated columns

• Lotus 1-2-3 format

• Windows Metafile format

Editing, cloning, or deleting a manual script

To edit, clone, or delete a manual script, follow these steps:

1. To edit a script, select the interface row and open the
DataBridge Script Editor. In the Manual Script tab page,
right-click and select “Edit” from the popup menu. After
editing and compiling, click “Save” and select where to
save the SQL file. You can edit the Manual Output
settings in the same manner.

2. To clone a script (i.e., to duplicate a script to be the base
of a new script), select the interface row, select Interface >
Clone Interface or right-click the row and select “Clone

Objective 19: Edit, clone, or delete a manual script

Interface.” Open the DataBridge Script Editor and edit
the default script name, cloned script, and cloned
output settings as desired (see step 1).

3. To delete a script but retain the output settings, right-
click the script row or empty area in the Manual Script
tab page. Select “Delete” from the menu.

4. To delete output settings but retain the script, right-click
on the output target row in the Manual Output tab
page. Select “Delete” from the menu.
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Summary

In this chapter, you have learned how to write DataBridge scripts that enable you to gather
specified data in TimeWizard and deliver and post it to targeted external systems.
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28C H A P T E R

Working with the Table Retrieval

TimeWizard provides the capability for you to create automated links to other systems within
your organization—such as Payroll, Accounting, Human Resources, etc.—allowing a one-
way transfer of data from your selected system into TimeWizard. The Table Retrieval is a
sophisticated import tool that requires some understanding of the data captured within
TimeWizard, time-accounting interfaces, and relational databases. You may need to experi-
ment with this function and seek technical assistance to achieve the desired results.

In a Table Retrieval, you can choose to import into one or more tables. For example, when
importing employees, you would first want to import any departments, employee codes,
salary codes, and resource codes associated with them. You could combine all of these into a
single retrieval.

Objectives

1. Create a Table Retrieval
2. Set up a Table Retrieval
3. Add a Map Table
4. Identify the Data Source for a Flat File
5. Identify the Data Source for a DBMS
6. Designate the Employee ID (for an Employee MAP Table)
7. Map the Data
8. Map the Data (for an Employee MAP Table)
9. Preview the Table Retieval
10. Change the Employee ID (for an Employee MAP Table)
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Objective 1: Create a Table Retrieval

Objective 2: Set up a Table Retrieval

The first step in creating a Table Retrieval is to name the retrieval set you are about to map.

Figure 28.1

Creating a Table Retrieval

To create a Table Retrieval, follow either of these steps:

1. From the Interface Controller window, click the Add Interface icon.

2. Select “Table Retrieval” from the Interface Type data window. To
locate the selection, scroll through the drop-down menu.

Setting up a table retrieval

To set up a Table Retrieval, follow these steps:

1. Click on the Setup icon or double-click on the interface type
cell to open the Table Retrieve dialog box.

2. Enter a name for the retrieval set in the “Retrieval Set Name”
data window.

Figure 28.2

3. TimeWizard automatically specifies the log path.
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Objective 3: Add a Map Table

Each Map Table is a table in the TimeWizard database into which you want to import data. In
addition to the TimeWizard standard selections—Employees, Activities, Employee Codes,
Department Codes, and Salary Codes— you may add map tables for user-defined activity
keys and detail codes.

Adding a map table

To add a map table, follow these steps:

1. In the Table Retrieve dialog box, click the “Add Table” command
button to add a map table.

2. Click on the Map Table data window to select a map table. To locate
the selection, scroll through the drop-down menu.

Figure 28.3
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Objective 4: Identify the Data Source for a Flat File

For each Map Table, you must identify the data source and data mapping parameters. The
data source can be either a flat file or a DBMS.

Objective 5: Identify the Data Source for a DBMS

If you click on the external data column, TimeWizard retrieves a list of all tables and views in
the database available for mapping.

To identify the Data Source for a Flat File, follow these steps:

2. Type the appropriate file name in the File Name data
window or click on the Browse command button to
locate the file.

3. Click Apply to save the settings and remain in the Data
Source window.

Figure 28.4

Identifying the Data Source for a Flat File

1. Click on the “File Type” data window to select either TAB
(Tab Delimited) or CSV (Comma Separated Values) as the
file type. To locate the selection, scroll through the drop-
down menu.

The source file cannot have more than 30 tab
delimited columns.
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Identify the Data Source for a DBMS

To identify the Data Source for a DBMS, follow these steps:

1. Identify the data source type as DBMS.

2. Click the Database Profile command button to open the
Select Database Profile dialog box.

3. Select a database profile from the list.

For instructions on how to create a new database
profile or edit an existing database profile, see the
Introduction of this section.

4. Click OK to save the setting and return to the Data Source
window.

5. In the External Table data window, enter the name of the
table from which you want to retrieve data.

6. Click on the Filter command button to specify a filter for
the retrieval.

For instructions on how to create a new filter or
edit an existing filter, see the Introduction of this
section.

7. Click Apply to save the settings and remain in the Data
Source window, or click OK to save the settings and
return to the Interface Controller window.

Figure 28.5
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Objective 6: Designate the Employee ID (for an Employee MAP Table)

To import employee data, you must map the structure of employee names in each system and
specify employee status preferences upon retrieval. In addition, you must map certain re-
quired fields.

Designating the Employee ID (for an Employee MAP Table)

To designate the Employee ID (for an Employee MAP Table), follow these steps:

1. In the Employee ID section, click on the “Employee Name
Source” data window to specify your field preference. To
locate the selection, scroll through the drop-down menu. The
choices are as follows:

• “Names are in Separate Fields”
• “Full name is in One Field”

2. If you select “Full name is in One Field,”  click on the “Full
Name Format” drop-down windows to specify a preferred
name format (e.g., Last Name, First Name, Middle Initial).

3. Click on the “Employee Status Option” data window to
specify your preference. To locate the selection, scroll through

the drop-down menu. Table 28.1 explains the status
options.

4. If the status option is “Status is mapped from input
data,” click on the “Source Employee Active Status is
Designated by the Value” data window to enter the
value that represents an active employee. For example,
“A” could designate Active, and “I” could designate
Inactive.

5. To change the data in each TimeWizard field, click on
the data windows to specify an action and default
value.

Figure 28.6
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Objective 7: Map the Data

The TimeWizard required fields and available optional fields differ for each map table.

Mapping the Data

To map the data, follow these steps:
1. In the Data Mapping section, click the Add Field command

button.

2. Select the appropriate parameters from the drop-down boxes.
Table 28.2 explains the parameter columns.

3. To delete a datamap field, select the appropriate field
and click the Delete command button.

4. Click Apply to save the settings and remain in the Data
Mapping section, or click OK to save the settings and
return to the Interface Controller window.

Figure 28.7

Table 28.1: Employee Status Options
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Objective 8: Map the Data for an Employee MAP Table

In the Data Mapping window for an Employee MAP Table, the TimeWizard required fields
differ according to the settings in the “Employee Name Source” data field in the Employee ID
window. The available optional fields do not differ.

If you selected Separate Fields, required TimeWizard fields are: Approval Level, Employee
Code, Employee ID User, First Name, Last Name, Middle Initial, Salary Code, and Status.

If you selected One Field, required TimeWizard fields are: Approval Level, Employee Code,
Employee ID User, Salary Code, and Status. (See Section 4: Managing Resources.)

For either selection, the optional TimeWizard fields are: Department Owner, Domain Name,
Email Login ID, Email Type, Employee Status, Employee ID, Manager, Network Login ID,
Password, SSN, and Leave Balance #1-15.

Table 28.2: Data Mapping Parameters
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Mapping the Data for an Employee MAP Table

To map the data for an Employee MAP Table, follow these steps:

1. In the Data Mapping window, select the appropriate required
field parameters from the drop-down boxes. Table 28.3
explains the employee data mapping parameter selections.

2. Click the Add Field command button to add optional fields.

Figure 28.8

3. To delete a datamap field, select the appropriate field
and click the Delete command button.

4. Click Apply to save the settings and remain in the Data
Mapping window, or click OK to save the settings and
return to the Interface Controller window.
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Objective 9: Preview the Table Retrieval

If you are retrieving data from a database, TimeWizard enables you to preview your Table
Retrieval settings.

To use the preview function, the Map Table data source should be DBMS.

If you preview before mapping the data, you will see all fields available in the table. You may
choose to use this function as a tool when initially building a Table Retrieval to see what is in
the fields you want to retrieve.

Table 28.3: Employee Data Mapping Parameters
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Objective 10: Change the Employee ID Field (for an Employee MAP Table)

There are times when the need arises to change employee IDs in TimeWizard. For example,
your company moves to a new Human Resources system or a group of contract employees are
hired as permanent employees. To accomodate this need, the Change ID window enables you
to change a TimeWizard employee ID from an outside application update.

This function is not for changing employee IDs one at a time. Rather it enables you to change
an employee ID field for group alterations. If there is no change, then the values for both old
ID and new ID can be the same.

Preview the Table Retrieval

To preview the Table Retieval, follow these steps:

1. Verify that all of your Map Table settings are correct.

2. Click the Preview tab to preview your Table Retrieval settings.

Figure 28.9

3. Click OK to return to the Interface Controller window.
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Summary

In this chapter, you have learned how to create automated links to other systems within your
organization—such as Payroll, Accounting, Human Resources, etc.—allowing a one-way trans-
fer of data from your selected system into TimeWizard.

Changing the Employee ID Field

To change the Employee ID Field, follow these steps:

1. In the Change Employee ID window, enter the old employee
ID field number or column in the Old Employee ID text box.

2. Enter the new employee ID field number or column in the
New Employee ID text box.

Figure 28.10

3. Click Apply to save the settings and remain in the
Change ID window, or click OK to save the settings
and return to the Interface Controller window.
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Working with Custom Applications

In the event you require a unique interface between TimeWizard and another application,
TimeWizard enables you to set up the execution of an interface of your own design.

The custom application “.exe” must reside on the application server in the TimeWizard direc-
tory. For information about the TimeWizard application server, see Objective 2 in the Intro-
duction to this section.

Objectives

1. Set up a Custom Application
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Objective 1: Set up a Custom Application

Figure 26.1

Setting up a custom application

To set up a custom application, follow these steps:

1. Click the Add Interface icon        (Interface > Add Interface) to add a new interface field.

2. Select Custom Application from the Interface Type drop-down menu. (See Figure 26.1.)

3. Click on the setup icon or double-click on the interface type cell to open the “Enter
Application Name” dialog box. (See Figure 26.2.)

4. Type in the name of the custom application and click on OK.

5. Once you have completed the setup procedures, click the Execute Now icon (Interface >
Execute Now) to run the interface. You also can set up interface intervals for scheduled
execution. For information about the TimeWizard interface intervals, see Objective 6:
Set up the Interface Interval, in the Introduction to this section.

Summary

In this chapter you have learned how to set up an interface of your own design in the TimeWizard
system.

Figure 26.2
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Working with AutoPopulate

TimeWizard AutoPopulate enables you to have time entered automatically on employees’
timesheets. You may want to automatically populate timesheets of employees who usually
work the same amount of time on standard assignments.

For example, your accounts payable staff may work eight hours a day, Mondays through
Thursdays, on the assignment “Accounts Payable” and eight hours a day on Fridays on the
assignment “Payroll.” Employees can still enter and edit time when an exception occurs in
their routine.

Objectives

1. Set a Timesheet Template through the Timesheet
2. Set up the AutoPopulate process in the Interface Controller
3. Execute the AutoPopulate process



Section Seven • Sharing Information Between TimeWizard and Other Corporate Systems368

TimeWizard

Objective 1: Set a Timesheet Template through the Timesheet

A timesheet template is a model of the time and employee assignments for one employee, in
one period, that TimeWizard can use to automatically populate that employee’s timesheet in
other periods.  Employees who are designated as AutoPopulate users (Employees > Employee
Detail window) can make templates of their timesheets for use in the AutoPopulate process.
Department owners can also set templates in the timesheets of AutoPopulate users in their
departments.

Setting a Timesheet Template

To set a Timesheet Template, follow these steps:

1. In the Timesheet of the employee, select a period that has the
time entries for the assignments you want to include in the
template. Do not select a period that includes any time entries
you do not want in the template. The period may include
assignments without time transactions.

All of the assignments with time entries in the period
must be open assignments.

2. From the Timesheet menu, select Set Template. When
the template has been set from the period’s timesheet,
a checkmark will display to the left of the Set Template
menu item.

An employee may have only one timesheet template
at a time.

3. To select a different period for a timesheet template, first
select the desired period. Then select Set Template from the
Timesheet menu. A checkmark will display by the menu item
of the new period’s timesheet.  A checkmark will no longer
display by the menu item of the previously used period.

You can also deselect a template by clicking on the
Timesheet > Set Template menu item that displays a
checkmark.

Figure 27.1
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Objective 2: Set up the AutoPopulate process in the Interface Controller

To continue setting up AutoPopulate, you will first add the AutoPopulate Interface in the
Interface Controller window. You can then run the AutoPopulate process for the current
period or you can set up an interface interval to have the process run at regularly-scheduled
times.

AutoPopulate only populates timesheets in the current period. However, AutoPopulate can be
scheduled to run automatically once every period by setting up the appropriate interval in the
Interface Controller.

Adding the AutoPopulate Interface type

To add the AutoPopulate Interface type, follow these steps:

1. In the Interface Controller window, click the Add Interface
icon        or select Interface > Add Interface from the menu.

2. In the new interface row, select AutoPopulate from
the Interface Type drop-down menu.

Figure 27.2

If you choose to have AutoPopulate run automatically at scheduled intervals, follow the steps
in the introduction to this section in Objective 6: Set up the Interface Interval.



Section Seven • Sharing Information Between TimeWizard and Other Corporate Systems370

TimeWizard

Objective 3: Execute the AutoPopulate process

Each time AutoPopulate runs, TimeWizard checks whether employees, assignments, and the
current period meet specific AutoPopulate criteria. Some employees’ timesheets, which met
the criteria when the templates were set, may not meet all the criteria at the time when
AutoPopulate is run. When the AutoPopulate process finishes, a log file is generated that lists
the employees whose timesheets were populated and any cases of employees with timesheet
templates who did not meet the other validation criteria.

For all active employees with timesheet templates, AutoPopulate checks adherence to the
following criteria:

1.  The current period is open.

2.  The current timesheet has no previously entered time transactions.

3.  All time entries on the template are associated with assignments included on the
current timesheet.

4.  The assignments in criterion 3 above are currently open.

5.  The employee is authorized to use activities associated with the assignments in crite-
rion 3, in accordance with current Access Lists defined in the TimeWizard business
rules.

To execute AutoPopulate for the current period only, follow the steps in the introduction to
this section for Objective 4: Execute TimeWizard Interfaces. To have AutoPopulate execute at
scheduled intervals you have set, click on the Start Scheduler icon or select Interface > Start
Scheduler from the main menu.

To see the log file to learn what errors may have occurred, follow the steps in the introduction
to this section for Objective 5: Browse Interface Log Files.

Summary

In this chapter, you have learned how to use AutoPopulate to automatically populate timesheets
with time transactions.
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Working with the Close Period
Override Utility

Using the Close Period utility in the Interface Controller window, you can schedule the clos-
ing of approval periods in your TimeWizard system. In addition, you can sequence the execu-
tion of the Close Period utility so that it runs just prior to other interfaces.

When the Close Period utility executes, it closes the last unclosed period—even if timesheets
in the period have missing approvals.

Objectives

1. Define a Close Period override
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Objective 1: Define a Close Period override

Figure 28.1

Defining a close period override

To define a close period override interface type, follow these steps:

1. Click the Add Interface icon (Interface > Add Interface) to add a new interface field.

2. Select Close Period-Override from the Interface Type drop-down menu.

3. Setup interface intervals for scheduled execution of this interface. See the Introduction to this
section, Objective 6: Setup the Interface Interval.

4. Click the Execute Now icon (Interface > Execute Now) to run the interface.

Summary

In this chapter you have learned how to close the last unclosed period even if timesheets in the
period have missing approvals.
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Working with the Exception Processor

The TimeWizard Exception Processor allows you to specify circumstances under which you
want to have exception messages or email notification (specifying such conditions as missing
timesheet submittals, missing approvals, or rejected timesheets) sent to specified individuals
within your company.

You can set up multiple exception interfaces, and each exception interface can have its own set
of mail to, filter, and date specifications.

Exception data is written to an interface log file, regardless of whether TimeWizard is con-
nected to a mail system. To set up the mail link to send exception e-mail messages, refer to the
TimeWizard Implementation Guide.

Objectives

1. Add a standard exception to the Interface Controller window
2. Set up a standard exception
3. Create a custom exception
4. Edit standard or custom exception text
5. Delete a custom exception
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Objective 1: Add a standard exception to the Interface Controller window

The first step is to select a standard exception interface type in the Interface Controller win-
dow.

Objective 2: Set up a standard exception

The standard exception setup process enables you to filter the exceptions and specify who
receives the email notifications.

To have the exception data simply write to the interface log file, without connecting to an
email system, do not select any recipients in the “Mail Exception Logs To” area. (See Figure
29.2.)

Figure 29.1

Adding a standard exception

To add a standard exception, follow these steps:

1. Click the Add Interface icon (Interface > Add Interface) to add a new
interface field.

2. Select Exception Processor from the Interface Type drop-down menu.

Setting up a standard exception (continued on page 343)

To set up a standard exception, follow these steps:

1. In the Interface Controller window, select the exception
processor from the Interface Type column.

2. Click on the setup icon        or double-click on the interface
type cell to open the “Exception Processor Options” dialog
box.

3. In the Exception Processor Name data field, enter a
name for the exception interface.

4. Click the Standard tab.

5. Click on the boxes to select or deselect (turn on or
off) the standard exceptions. (Table 29.1 describes
each selection.)
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Setting up a standard exception (continued from page 342)

6. The exception data is written to an interface log file directory
named “exlogs” regardless of whether you send exception logs
by email. To send exception email messages, select the
recipients in the “Mail Exception Logs To” area from the
following:

• Employee
• Manager of Employee
• Department Owners of Employee
• TimeWizard Administrators
• Pending Department Owner
• Activity Owners
Your choices of exceptions will affect the availablity of recipients
(e.g., if you pick “Missing Dept Approvals,” then “Activity
Owner” will be unavailable).

To send mail to the TimeWizard Administrator, a fully-
qualified Internet mail account must be set up for the

user, “TWADMIN.” The same password used to access the
TimeWizard Administrator application with the Login ID,
“TWADMIN,” must be assigned to this email account.

7. Click on the “For Period Ending” drop-down box to
specify the period for which you want to report the
exceptional data. The list includes:

• Use Current Period
• Use Last Closed Period
• Period Ending Date = (in which case you must
  specify the period ending date)

You will still need to set up an interface
interval if you want to schedule when the

Exception Processor will run. (See Objective 6 in the
Introduction to this section.)

8. Click on the Filter command button to specify a filter
for the exception processor.

For instructions on how to create a new filter
or edit an existing filter, see the Introduction

of this section.

9. Click Apply to save the settings and remain in the
Exception Processor Options dialog box, or click OK to
save the settings and exit the dialog box.

Figure 29.2
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Objective 3: Create a custom exception

In addition to the standard exceptions provided, TimeWizard enables you to create an excep-
tion of your own design.

If you want to send different exception messages at different times, you can set up multiple
Exception Processor interfaces in the Interface Controller, instead of editing the exception
message.  You can also set up multiple Exception Processor interfaces if you want to send the
same exception message to different recipients at different times.

Table 29.1: Standard Exceptions
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Creating a custom exception (continued on page 346)

To create a custom exception, follow these steps:

1. In the Interface Controller window, select the exception
processor from the Interface Type column.

2.  Click on the setup icon         or double-click on the interface
type cell to open the “Exception Processor Options” dialog
box.

3. In the Exception Processor Name data field, enter a name for
the exception interface.

4. Click the Custom tab.

5. Click on the Add command button to open the “Enter
Exception Name” dialog box (see Figure 29.4). Type in the
name. In the Description box, type in the text you want
included in the exception message. Click on OK to save your
entries and close the dialog box. When the exception is
highlighted in the left frame, the text will display below the
frame.

6. Click on the boxes to select or deselect (turn on or off)
each available custom exception.

7. In the “Mail Exception Logs To” area, select the recipients
of the exception logs from the following:

• Employee
• Manager of Employee
• Department Owners of Employee
• TimeWizard Administrators
• Pending Department Owner
• Activity Owners

To send mail to the TimeWizard Administrator, a
fully-qualified Internet mail account must be set

up for the user, “TWADMIN.” The same password used
to access the TimeWizard Administrator application with
the Login ID, “TWADMIN,” must be assigned to this
email account.

Figure 29.3
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Creating a custom exception (continued from page 345)

8. Click on the “For Period Ending” drop-down box to specify
the period for which you want to report the exceptional data.
The list includes:

• Use Current Period
• Use Last Closed Period
• Period Ending Date = (in which case you must specify
  the period ending date)

You still need to set up an interface interval if you
want to schedule when the Exception Processor will

run. (See Objective 6 in the Introduction of this section.)

9. Define the detail code test statement for each custom
exception.

a. Click on the Detail Code drop-down box to select either
Total Hours or other user-defined detail codes (e.g., Cost Type).

b. Click on the Test drop-down box to select the appropriate
comparison operator (e.g., <, >, =).

c. Click on or tab to the Hours text box and enter the number
of hours.

d. If you selected a user-defined detail code in step 9a, click on
the Detail Value drop-down box to select a detail value for the
detail code (e.g., for the detail code Cost Type, pick REG or

OT).

10. Click on the Filter command button to specify a filter
for the exception processor.

For instructions on how to create a new filter or edit an
existing filter, see the Objective 9 in the
Introduction of this section.

11. Click Apply to save the settings and remain in the
Exception Processor Options dialog box, or click OK to
save the settings and exit the dialog box.

You may want to set up a missing submit exception interface to email employees only on
Friday afternoon, a second missing submit exception interface to email to the employees’
managers on Monday morning, and a third missing submit exception interface to email to
department owners on Monday at noon.

Figure 29.4
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Objective 4: Edit standard or custom exception text

Standard exception data displays with default text that describes the exception.  You can edit
standard or custom exception text or append additional text to be sent to the designated
recipients.

When an exception is highlighted in the left frame, the current text for that exception displays
below the frame.

Editing standard or custom exception text

To edit exception text, follow these steps:

1. Click the standard or custom tab.

2. Highlight the exception name.

3. Click on the Edit command button to open the “Edit
Exception” dialog box.

4. In the “Email Message Description” text box, modify the text.

5. Click on OK to save your modifications and close the dialog
box.

Figure 29.5

Objective 5: Delete a custom exception

Deleting a custom exception

To delete a custom exception, follow these steps:

1. Click the custom tab.

2. Highlight the custom exception name in the left frame.

3. Click on the Delete command button.

4. TimeWizard displays a prompt, “Are you sure you want to delete the selected Exception?” Click Yes to
delete the custom exception.
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Summary

In this chapter, you have learned how to specify circumstances under which you want to have
exception messages (specifying such conditions as missing submittals, missing approvals, or
rejected timesheets) sent via email to specified individuals within your company. Regardless of
whether you connect to an email system, exception data can be written to an interface log file.
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3C H A P T E R
I N T R O D U C T I O N

Introduction to Reporting Business
Information in TimeWizard

Let Me Draw You a Picture

All of the corporate data in the world is not worth a cent if it cannot be shared so that others can understand

it. That said, TimeWizard’s reporting capability may be the most important feature of all. In other TimeWizard

manuals, you learned how to customize TimeWizard to capture data unique to your company. You also

learned how to share that data with other systems used throughout your company. In this guide, you learn

how to gather all of that data into specific informational categories and produce interactive, presentation-

quality reports. TimeWizard has pre-installed report categories and standard reports designed to compile the

information you need to make accurate business decisions. You also have the option of customizing report

categories and reports using the Crystal Report Writer 7.0 software product.

The report setup process and the selection of pre-installed reports is the same for TimeWizard and

TimeWizard.enterprise. In the objectives in Chapter 2, follow the steps for setting parameter values

for your selected report—regardless of which TimeWizard application you are using. For your convenience,

an example setup screen from TimeWizard and TimeWizard.enterprise is provided for each report.
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This guide includes the following:

Chapter 1: Identifying Pre-installed Report Categories and Reports

Chapter 2: Setting Parameter Values for Pre-installed Reports

Chapter 3: Exporting and Printing Reports

Appendix A: Pre-installed Reports Reference

Appendix B: Custom Field Formula Specifications
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Identifying Pre-installed Report
Categories and Reports

TimeWizard has six pre-defined report categories and 21 pre-installed standard reports—all

designed to compile the information you need to make accurate business decisions. This

chapter offers administrative data on each report that will help you run and customize them

for your use.

Objective

1. Identify the pre-installed report categories and reports
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Objective 1: Identify the pre-installed report categories and reports

The tables in this objective present the six pre-defined report categories and 21 pre-installed

standard reports. TimeWizard has supplied these report categories and reports for your

convenience. However, your company is not bound by these selections. You may decide to

modify existing report categories and reports, or you may decide to compose completely

new reports to add to the existing selection. Table 1.1 lists the standard reports and identifies

the report file names for Oracle and SQL Server. Table 1.2 lists the report categories and

identifies the reports available to each category.

The Time and Attendance User categories and reports are referenced in the following tables

and are discussed in the TimeWizard Time & Attendance Suite User’s Guide.
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Table 1.1: TimeWizard Standard Reports

tropeR elcarO:emaNeliF revreSLQS:emaNeliF

eliforPeeyolpmE tpr.arOtsiLpmE tpr.LQStsiLpmE

tropeRtiduAteehsemiT tpr.arOtiduA tpr.LQStiduA

yrammuSytivitcA tpr.arOmuStcA tpr.LQSmuStcA

yrammuSteehsemiT tpr.arOthSmiT tpr.LQSthSmiT

srenwOtnemtrapeDrofstnemngissAecruoseR tpr.arOODnsAseR tpr.LQSODnsAseR

srenwOytivitcArofstnemngissAecruoseR tpr.arOMPnsAseR tpr.LQSMPnsAseR

tropeResnepxE tpr.arOpxE tpr.LQSpxE

srenwOtnemtrapeDroftrahCeiP tpr.arOODthCeiP tpr.LQSODthCeiP

srenwOytivitcAroftrahCeiP tpr.arOMPthCeiP tpr.LQSMPthCeiP

srenwOtnemtrapeDroftrahCraB tpr.arOODthCraB tpr.LQSODthCraB

srenwOytivitcAroftrahCraB tpr.arOMPthCraB tpr.LQSMPthCraB

tropeRteehsemiT tpr.arOteehsemiT tpr.LQSteehsemiT

srenwOtnemtrapeDroftropeRteehsemiT tpr.arOODteehsemiT tpr.LQSODteehsemiT

teehsemiTgnissiM tpr.arOmiTsiM tpr.LQSmiTsiM

slavorppAgnissiM tpr.arOmiTppAsiM tpr.LQSmiTppAsiM

sutatSteehsemiT tpr.arOatSmiT tpr.LQSatSmiT

tropeRgnilliB tpr.arOmuSliB tpr.LQSmuSliB

snoitaicossAedoCecruoseR tpr.arOpmEseR tpr.LQSpmEseR

rofstnemngissAecruoseRecnadnettAdnaemiT
srenwOtnemtrapeD

tpr.arOODnsAseRSAT tpr.LQSODnsAseRSAT

rofteehsemiTecnadnettAdnaemiT
srenwOtnemtrapeD

tpr.arOODteehsemiTSAT tpr.LQSODteehsemiTSAT

yrammuSecnadnettAdnaemiT tpr.arOthSmiTSAT tpr.LQSthSmiTSAT

teehsemiTecnadnettAdnaemiT tpr.arOteehsemiTSAT tpr.LQSteehsemiTSAT
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Table 1.2: TimeWizard Report Categories

seirogetaCtropeR stropeRelbaliavA

rotartsinimdA

eliforPeeyolpmE
yrammuSytivitcA
yrammuSteehsemiT
slavorppAgnissiM
teehsemiTgnissiM
sutatSteehsemiT

snoitaicossAedoCecruoseR
tropeRtiduAteehsemiT

)reganaMlanoitcnuF(renwOtnemtrapeD

eliforPeeyolpmE
yrammuSteehsemiT

srenwOtnemtrapeDrofstnemngissAecruoseR
tropeResnepxE
teehsemiTgnissiM
slavorppAgnissiM

srenwOtnemtrapeDroftrahCeiP
srenwOtnemtrapeDroftrahCraB

srenwOtnemtrapeDroftropeRteehsemiT
sutatSteehsemiT

srenwOtnemtrapeDrofstnemngissAecruoseRSAT
srenwOtnemtrapeDrofteehsemiTSAT

yrammuSecnadnettAdnaemiT

)reganaMtcejorP(renwOytivitcA

yrammuSytivitcA
srenwOytivitcArofstnemngissAecruoseR

srenwOytivitcAroftrahCeiP
srenwOytivitcAroftrahCraB

resUteehsemiT tropeRteehsemiT

laicnaniF

yrammuSytivitcA
tropeResnepxE
tropeRgnilliB

yrammuSteehsemiT
srenwOtnemtrapeDroftrahCeiP

srenwOytivitcAroftrahCeiP
srenwOtnemtrapeDroftrahCraB

srenwOytivitcAroftrahCraB

resUecnadnettAdnaemiT teehsemiTSAT
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Running TimeWizard Reports

In this chapter, you will learn how to select a report category and report, and to set the

parameter values before previewing, exporting or printing the TimeWizard reports.

Objectives

1. Select a reports category and report

2. Set parameter values for a report

2a. For an Employee Profile report

2b. For an Activity Summary report

2c. For a Timesheet Summary report

2d. For a Resource Assignments for Department Owners report

2e. For a Resource Assignments for Activity Owners report

2f. For an Expense report

2g. For a Pie Chart for Department Owners report

2h. For a Pie Chart for Activity Owners report

2i. For a Bar Chart for Department Owners report

2j. For a Bar Chart for Activity Owners report

2k. For a Timesheet report

2l. For a Timesheet Report for Department Owners report

2m. For a Missing Timesheet report

2n. For a Missing Approvals report

2o. For a Timesheet Status report

2p. For a Billing report

2q. For a Resource Code Associations report

2r. For a Timesheet Audit Report
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Objective 1: Select a report category and report

Depending on your company’s needs, your Administrator has preset your access to report

categories, which contain a specific group of reports. A typical report access setting for

timesheet users is the Timesheet User report category.

TimeWizard includes several pre-installed report categories and reports for your company’s

convenience. The report listings may change if they are customized by your company.

Selecting a report category and report

To select a report category and report, follow these steps

1. Click the Run Reports toolbar icon          or select Tools >

Reports > Run Reports from the main menu to open the

Run Reports dialog box. For TimeWizard.enterprise, click

on the reports button                     from your employee

home page.

2. In the Report Categories area (Figure 2.1A), select  a

report category from the drop-down menu. For

TimeWizard.enterprise, click on the reports command

button to populate the reports list for the category.

3. In the Report List area, select a report.

Figure 2.1A

Figure 2.1B

Figure 2.1B displays the

TimeWizard.enterprise report selection

frames.

4. Click on the Preview or Print command button to

run the report. For TimeWizard.enterprise, click on

the Execute Report command button.
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Objective 2: Set parameter values for  a report

TimeWizard requires that you specify parameter values for your reports. These values tell

TimeWizard and the Crystal Report Writer application how to construct your selected

report using the data you require. The parameter value settings differ for each report, but

the process is the same. The following steps are explained in more detail for each report in

Objectives 2a - 2r.

1. Click the Run Reports toolbar icon        or select Tools > Reports > Run Reports

from the main menu to open the Run Reports dialog box.

2. In the Run Reports dialog box, select a report category and report.

3. Click “Preview” or “Print” to open the Enter Parameter Values window for the

selected report.

4. Click each parameter value tab and enter the appropriate values. Table 2.1 explains

specific rules that apply to the parameter value setup for TimeWizard.enterprise.

5. Click “OK” to save the settings and preview or print the report.

Both the “Preview” and “Print” command buttons open the Enter Parameter Values window

for the selected report. The difference in the commands is when you complete the param-

eter values setup process and click the “OK” command button. TimeWizard then either

previews or prints the selected report, depending on which command began the setup

process.

Assuming your custom fields for activities are “Project” and “Task”:

• If you want to see hours summed by Project in the report, then select only act_ukey1.

• If you want to see hours summarized at the Task level, then select act_ukey 1 and

act_ukey2

• If you want to see hours summarized by detail code values, then select that value.

For example, the detail code field named “Cost Type”may be selected to summarize

hours by an associated value named “regular” or “overtime.”
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Objective 2a: Set parameter values for the Employee Profile report

To select a report category and report, follow these steps:

1. Click the Run Reports toolbar icon         or select Tools >

Reports > Run Reports from the main menu to open the

Run Reports dialog box.

2. In the Run Reports dialog box, select a report category

and report.

3. Click “Preview” to open the Enter Parameter Values

window for the selected report .

4. Click the departments_owned tab (Figure 2.2) to specify

the departments (that you own) for which you want to

Figure 2.2

generate the report. Click on the Value drop-down

menu to display the fields that contain the departments

owned. Select the desired field and click Add to add the

field to the selection box. To delete a selection, select a

field in the lower box and click Delete.

5. Click OK to preview the selected report with the

specified settings.

Figure 2.3 displays the TimeWizard.enterprise

parameter setup frame for the report.

Figure 2.3
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Objective 2b: Set parameter values for Activity Summary report (continued on page 16)

To set up an Activity Summary report, follow these steps:

1. Click the Run Reports toolbar icon          or select Tools >

Reports > Run Reports from the main menu to open the

Run Reports dialog box.

2. In the Run Reports dialog box, select a report category

and report.

3. Click “Preview” to open the Enter Parameter Values

window for the selected report .

4. Click the Activity Description tab (Figure 2.4). Click on the

Value drop-down menu to display the fields that contain

your activity description. Select the desired field and click

Figure 2.4

Add to add the field to the selection box. To delete a

selection, select a field in the lower box and click Delete.

Contact your company’s TimeWizard Administra-

tor for exact field descriptions.

• act_ukey = activity codes

• trans_ukey = detail codes.

5. Click the From tab (Figure 2.5). TimeWizard displays a

drop-down calendar, from which you may select a

specific period starting date. Specify the starting date

from which you want to generate the report.

Figure 2.5
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Objective 2b: Set parameter values for Activity Summary report (continued from page 15)

6. Click the To tab (Figure 2.6). TimeWizard displays a drop-

down calendar, from which you may select a specific

period ending date. Specify the ending date for which

you want to generate the report.

Figure 2.6

7. Click OK to preview the selected report with the

specified settings.

Figure 2.7 displays the TimeWizard.enterprise

parameter setup frame for the report.

Figure 2.7



TimeWizard

17Chapter Two • Running TimeWizard Reports

Objective 2c: Set parameter values for Timesheet Summary report (continued on page 18)

To set up a Timesheet Summary report, follow these steps:

1. Click the Run Reports toolbar icon          or select Tools >

Reports > Run Reports from the main menu to open the

Run Reports dialog box.

2. In the Run Reports dialog box, select a report category

and report.

3. Click “Preview” to open the Enter Parameter Values

window for the selected report .

4. Click the Report Grouping tab (Figure 2.8). Click on the

Value drop-down menu and select “E” to group by

employee (i.e., yourself) or “D” to group by a depart-

ment.

Figure 2.8

5. Click the Activity Description tab (Figure 2.9). Click on the

Value drop-down menu to display the fields that contain

your activity description. Select the desired field and click

Add to add the field to the selection box. To delete a

selection, select a field in the lower box and click Delete.

Contact your company’s TimeWizard Administra-

tor for exact field descriptions.

• act_ukey = activity codes

• trans_ukey = detail codes.

Figure 2.9
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Objective 2c: Set parameter values for Timesheet Summary report (continued from page 17)

6. Click the departments_owned tab (Figure 2.10) to

specify the departments (that you own) for which you

want to generate the report. Click on the Value drop-

down menu to display the fields that contain the

departments owned. Select the desired field and click

Add to add the field to the selection box. To delete a

selection, select a field in the lower box and click Delete.

7. Click the period_enddate tab (Figure 2.11). Specify

whether or not you want to select the period enddate

from a default list. If the box is checked, TimeWizard

displays a drop-down menu of available period enddates.

If the box is not checked, TimeWizard displays a drop-

down calendar, from which you may select a specific

period enddate.

8. Click OK to preview the selected report with the

specified settings.

Figure 2.12 displays the TimeWizard.enterprise

parameter setup frame for the report.

Figure 2.10 Figure 2.11

Figure 2.12
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Objective 2d: Set parameter values for Resource Assignments for Department Owners  report
(continued on page 20)

To set up a Resource Assignments for Department Owners report, follow these steps:

1. Click the Run Reports toolbar icon          or select Tools >

Reports > Run Reports from the main menu to open the

Run Reports dialog box.

2. In the Run Reports dialog box, select a report category

and report.

3. Click “Preview” to open the Enter Parameter Values

window for the selected report .

4. Click the Assignment Status tab (Figure 2.13). Click on

the Value drop-down menu and select “C” to group by

closed assignments or “A” to group by all assignments or

“O” to group by open assignments.

Figure 2.13

5. Click the Activity Description tab (Figure 2.14). Click on

the Value drop-down menu to display the fields that

contain your activity description. Select the desired field

and click Add to add the field to the selection box. To

delete a selection, select a field in the lower box and click

Delete.

Contact your company’s TimeWizard Administra-

tor for exact field descriptions.

• act_ukey = activity codes

• trans_ukey = detail codes.

Figure 2.14
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Objective 2d: Set parameter values for Resource Assignments for Department Owners  report
(continued from page 19)

6. Click the departments_owned tab (Figure 2.15) to

specify the departments (that you own) for which you

want to generate the report. Click on the Value drop-

down menu to display the fields that contain the

departments owned. Select the desired field and click

Add to add the field to the selection box. To delete a

selection, select a field in the lower box and click Delete.

Figure 2.15

7. Click OK to preview the selected report with the

specified settings.

Figure 2.16 displays the TimeWizard.enterprise

parameter setup frame for the report.

Figure 2.16
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Objective 2e: Set parameter values for Resource Assignments for Activity Owners  report (contin-
ued on page 22)

To set up a Resource Assingments for Activity Owners report, follow these steps:

1. Click the Run Reports toolbar icon          or select Tools >

Reports > Run Reports from the main menu to open the

Run Reports dialog box.

2. In the Run Reports dialog box, select a report category

and report.

3. Click “Preview” to open the Enter Parameter Values

window for the selected report .

4. Click the Assignment Status tab (Figure 2.17). Click on

the Value drop-down menu and select “C” to group by

closed assignments or “A” to group by all assignments or

“O” to group by open assignments.

Figure 2.17

5. Click the Activity Description tab (Figure 2.18). Click on

the Value drop-down menu to display the fields that

contain your activity description. Select the desired field

and click Add to add the field to the selection box. To

delete a selection, select a field in the lower box and click

Delete.

Contact your company’s TimeWizard Administra-

tor for exact field descriptions.

• act_ukey = activity codes

• trans_ukey = detail codes.

Figure 2.18
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Objective 2e: Set parameter values for Resource Assignments for Activity Owners  report (contin-
ued from page 21)

6. Click OK to preview the selected report with the

specified settings.

Figure 2.19 displays the TimeWizard.enterprise

parameter setup frame for the report.

Figure 2.19
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Objective 2f: Set parameter values for the Expense report (continued on page 24)

To set up a Timesheet Summary report, follow these steps:

1. Click the Run Reports toolbar icon             or select Tools

> Reports > Run Reports from the main menu to open

the Run Reports dialog box.

2. In the Run Reports dialog box, select a report category

and report.

3. Click “Preview” to open the Enter Parameter Values

window for the selected report .

4. Click the Activity Description tab (Figure 2.20). Click on

the Value drop-down menu to display the activity fields

Figure 2.20

that contain your activity descriptions. Select the desired

activity field.

5. Click the Expense Code tab (Figure 2.21). Click on the

Value drop-down menu to display the detail code fields

that contain your expense codes. Select the desired

detail code field.

Contact your company’s TimeWizard Administra-

tor for exact field descriptions.

• act_ukey = activity codes

• trans_ukey = detail codes.

Figure 2.21
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Objective 2f: Set parameter values for the Expense report (continued from page 23)

6. Click the period_enddate tab (Figure 2.22). Specify

whether or not you want to select the period enddate

from a default list. If the box is checked, TimeWizard

displays a drop-down menu of available period enddates.

If the box is not checked, TimeWizard displays a drop-

down calendar, from which you may select a specific

period enddate.

7. Click the departments_owned tab (Figure 2.23) to

specify the departments (that you own) for which you

want to generate the report. Click on the Value drop-

down menu to display the fields that contain the

departments owned. Select the desired field and click

Add to add the field to the selection box. To delete a

selection, select a field in the lower box and click Delete.

8. Click OK to preview the selected report with the

specified settings.

Figure 2.24 displays the TimeWizard.enterprise

parameter setup frame for the report.

Figure 2.22 Figure 2.23

Figure 2.24



TimeWizard

25Chapter Two • Running TimeWizard Reports

Objective 2g: Set parameter values for the Pie Chart for Department Owners  report (continued
on page 26)

To set up a Pie Chart for Department Owners report, follow these steps:

1. Click the Run Reports toolbar icon          or select Tools >

Reports > Run Reports from the main menu to open the

Run Reports dialog box.

2. In the Run Reports dialog box, select a report category

and report.

3. Click “Preview” to open the Enter Parameter Values

window for the selected report .

4. Click the departments_owned tab (Figure 2.25) to

specify the departments (that you own) for which you

want to generate the report. Click on the Value drop-

down menu to display the fields that contain the

departments owned. Select the desired field and click

Figure 2.25

Add to add the field to the selection box. To delete a

selection, select a field in the lower box and click Delete.

5. Click the Activity Description tab (Figure 2.26). Click on

the Value drop-down menu to display the fields that

contain your activity description. Select the desired field

and click Add to add the field to the selection box. To

delete a selection, select a field in the lower box and click

Delete.

Contact your company’s TimeWizard Administra-

tor for exact field descriptions.

• act_ukey = activity codes

• trans_ukey = detail codes..

Figure 2.26
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Objective 2g: Set parameter values for the Pie Chart for Department Owners  report (continued
from page 25)

6. Click the From tab (Figure 2.27). TimeWizard displays a

drop-down calendar, from which you may select a

specific period starting date. Specify the starting date

from which you want to generate ther report.

7. Click the To tab (Figure 2.28). TimeWizard displays a

drop-down calendar, from which you may select a

specific period ending date. Specify the ending date from

which you want to generate the report.

8. Click OK to preview the selected report with the

specified settings.

Figure 2.29 displays the TimeWizard.enterprise

parameter setup frame for the report.

Figure 2.27 Figure 2.28

Figure 2.29
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Objective 2h: Set parameter values for the Pie Chart for Activity Owners  report (continued on
page 28)

To set up a Pie Chart for Activity Owners report, follow these steps:

1. Click the Run Reports toolbar icon          or select Tools >

Reports > Run Reports from the main menu to open the

Run Reports dialog box.

2. In the Run Reports dialog box, select a report category

and report.

3. Click “Preview” to open the Enter Parameter Values

window for the selected report .

4. Click the Activity Description tab (Figure 2.30). Click on

the Value drop-down menu to display the fields that

contain your activity description. Select the desired field

and click Add to add the field to the selection box. To

Figure 2.30

delete a selection, select a field in the lower box and click

Delete.

Contact your company’s TimeWizard Administra-

tor for exact field descriptions.

• act_ukey = activity codes

• trans_ukey = detail codes.

5. Click the From tab (Figure 2.31). TimeWizard displays a

drop-down calendar, from which you may select a

specific period starting date. Specify the starting date

from which you want to generate the report.

Figure 2.31
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Objective 2h: Set parameter values for the Pie Chart for Activity Owners  report (continued from
page 27)

Figure 2.32 Figure 2.33

6. Click the To tab (Figure 2.32). TimeWizard displays a

drop-down calendar, from which you may select a

specific period ending date. Specify the ending date from

which you want to generate the report.

7. Click OK to preview the selected report with the

specified settings.

Figure 2.33 displays the TimeWizard.enterprise

parameter setup frame for the report.
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Objective 2i: Set parameter values for the Bar Chart for Department Owners  report (continued
on page 30)

To set up a Bar Chart for Department Owners report, follow these steps:

1. Click the Run Reports toolbar icon          or select Tools >

Reports > Run Reports from the main menu to open the

Run Reports dialog box.

2. In the Run Reports dialog box, select a report category

and report.

3. Click “Preview” to open the Enter Parameter Values

window for the selected report .

4. Click the Activity Description tab (Figure 2.34). Click on

the Value drop-down menu to display the fields that

contain the departments owned. Select the desired field

and click Add to add the field to the selection box. To

delete a selection, select a field in the lower box and click

Delete.

Figure 2.34

Contact your company’s TimeWizard Administra-

tor for exact field descriptions.

• act_ukey = activity codes

• trans_ukey = detail codes.

5. Click the departments_owned tab (Figure 2.35) to

specify the departments (that you own) for which you

want to generate the report. Click on the Value drop-

down menu to display the fields that contain your activity

description. Select the desired field and click Add to add

the field to the selection box. To delete a selection, select

a field in the lower box and click Delete.

Figure 2.35
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Objective 2i: Set parameter values for the Bar Chart for Department Owners  report (continued
from page 29)

6. Click the From tab (Figure 2.36). TimeWizard displays a

drop-down calendar, from which you may select a

specific period starting date. Specify the starting date

from which you want to generate the report.

7. Click the To tab (Figure 2.37). TimeWizard displays a

drop-down calendar, from which you may select a

specific period ending date. Specify the ending date from

which you want to generate the report.

8. Click OK to preview the selected report with the

specified settings.

Figure 2.38 displays the TimeWizard.enterprise

parameter setup frame for the report.

Figure 2.36 Figure 2.37

Figure 2.38
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Objective 2j: Set parameter values for the Bar Chart for Activity Owners  report (continued on
page 32)

To set up a Bar Chart for Activity Owners report, follow these steps:

1. Click the Run Reports toolbar icon          or select Tools >

Reports > Run Reports from the main menu to open the

Run Reports dialog box.

2. In the Run Reports dialog box, select a report category

and report.

3. Click “Preview” to open the Enter Parameter Values

window for the selected report .

4. Click the Activity Description tab (Figure 2.39). Click on

the Value drop-down menu to display the fields that

contain your activity description. Select the desired field

and click Add to add the field to the selection box. To

Figure 2.39

delete a selection, select a field in the lower box and click

Delete.

Contact your company’s TimeWizard Administra-

tor for exact field descriptions.

• act_ukey = activity codes

• trans_ukey = detail codes.

5. Click the To tab (Figure 2.40). TimeWizard displays a

drop-down calendar, from which you may select a

specific period ending date. Specify the ending date from

which you want to generate the report.

Figure 2.40
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Objective 2j: Set parameter values for the Bar Chart for Activity Owners  report (continued from
page 31)

Figure 2.41 Figure 2.42

6. Click the From tab (Figure 2.41). TimeWizard displays a

drop-down calendar, from which you may select a

specific period starting date. Specify the starting date

from which you want to generate the report.

7. Click OK to preview the selected report with the

specified settings.

Figure 2.42 displays the TimeWizard.enterprise

parameter setup frame for the report.
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Objective 2k: Set parameter values for the Timesheet report

To set up a Timesheet report, follow these steps:

1. Click the Run Reports toolbar icon          or select Tools >

Reports > Run Reports from the main menu to open the

Run Reports dialog box.

2. In the Run Reports dialog box, select a report category

and report.

3. Click “Preview” to open the Enter Parameter Values

window for the selected report .

4. In the period_enddate tab (Figure 2.43). Specify whether

or not you want to select the period endate from a

Figure 2.43

default list. If the box is checked, TimeWizard displays a

drop-down menu of available period enddates. If the box

is not checked, TimeWizard displays a drop-down

calendar, from which you may select a specific period

enddate.

5. Click OK to preview the selected report with the

specified settings.

Figure 2.44 displays the TimeWizard.enterprise

parameter setup frame for the report.

Figure 2.44
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Objective 2l: Set parameter values for the Timesheet Report for Department Owners (continued
on page 35)

To set up a Timesheet Report for Department Owners, follow these steps:

1. Click the Run Reports toolbar icon          or select Tools >

Reports > Run Reports from the main menu to open the

Run Reports dialog box.

2. In the Run Reports dialog box, select a report category

and report.

3. Click “Preview” to open the Enter Parameter Values

window for the selected report .

Figure 2.45

4. Click the period_enddate tab (Figure 2.45). Specify

whether or not you want to select the period enddate

from a default list. If the box is checked, TimeWizard

displays a drop-down menu of available period enddates.

If the box is not checked, TimeWizard displays a drop-

down calendar, from which you may select a specific

period enddate.
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Objective 2l: Set parameter values for the Timesheet Report for Department Owners (continued
from page 34)

5. Click the departments_owned tab (Figure 2.46) to

specify the departments (that you own) for which you

want to generate the report. Click on the Value drop-

down menu to display the fields that contain the

departments owned. Select the desired field and click

Add to add the field to the selection box. To delete a

selection, select a field in the lower box and click Delete.

6. Click OK to preview the selected report with the

specified settings.

Figure 2.47 displays the TimeWizard.enterprise

parameter setup frame for the report.

Figure 2.46

Figure 2.47
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Objective 2m: Set parameter values for the Missing Timesheet report (continued on page 37)

To set up a Missing Timesheet report, follow these steps:

1. Click the Run Reports toolbar icon            or select Tools >

Reports > Run Reports from the main menu to open the

Run Reports dialog box.

2. In the Run Reports dialog box, select a report category

and report.

3. Click “Preview” to open the Enter Parameter Values

window for the selected report .

4. Click the period_enddate tab (Figure 2.48). Specify

whether or not you want to select the period enddate

from a default list. If the box is checked, TimeWizard

displays a drop-down menu of available period enddates.

Figure 2.48

If the box is not checked, TimeWizard displays a drop-

down calendar, from which you may select a specific

period enddate.

5. Click the departments_owned tab (Figure 2.49) to

specify the departments (that you own) for which you

want to generate the report. Click on the Value drop-

down menu to display the fields that contain the

departments owned. Select the desired field and click

Add to add the field to the selection box. To delete a

selection, select a field in the lower box and click Delete.

Figure 2.49
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Objective 2m: Set parameter values for the Missing Timesheet report (continued from page 36)

Figure 2.50 Figure 2.51

6. Click the Missing Timesheet Hours Threshold tab (Figure

2.50). Select or enter the threshold below which a

timesheet is considered “missing.”

The default value = 1. This means that any

timesheet with fewer than one hour is

considered as “missing.” However, you may alter

this hours value.

7. Click OK to preview the selected report with the

specified settings.

Figure 2.51 displays the TimeWizard.enterprise

parameter setup frame for the report.
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Objective 2n: Set parameter values for the Missing Approvals report

Figure 2.52 Figure 2.53

To set up a Missing Approvals report, follow these steps:

1. Click the Run Reports toolbar icon         or select Tools >

Reports > Run Reports from the main menu to open the Run

Reports dialog box.

2. In the Run Reports dialog box, select a report category and

report.

3. Click “Preview” to open the Enter Parameter Values window

for the selected report .

4. Click the period_enddate tab (Figure 2.52). Specify whether

or not you want to select the period enddate from a default

list. If the box is checked, TimeWizard displays a drop-down

menu of available period enddates. If the box is not checked,

TimeWizard displays a drop-down calendar, from which you

may select a specific period enddate.

5. Click the departments_owned tab (Figure 2.53) to specify the

departments (that you own) for which you want to generate

the report. Click on the Value drop-down menu to display the

fields that contain the departments owned. Select the

desired field and click Add to add the field to the selection

box. To delete a selection, select a field in the lower box and

click Delete.

6. Click OK to preview the selected report with the

specified settings.

Figure 2.54 displays the TimeWizard.enterprise

parameter setup frame for the report.

Figure 2.54
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Objective 2o: Set parameter values for the Timesheet Status report (continued on page 40)

To set up a Timesheet Status report, follow these steps:

1. Click the Run Reports toolbar icon          or select Tools >

Reports > Run Reports from the main menu to open the

Run Reports dialog box.

2. In the Run Reports dialog box, select a report category

and report.

3. Click “Preview” to open the Enter Parameter Values

window for the selected report .

4. Click the period_enddate tab (Figure 2.55). Specify

whether or not you want to select the period enddate

from a default list. If the box is checked, TimeWizard

Figure 2.55

displays a drop-down menu of available period enddates.

If the box is not checked, TimeWizard displays a drop-

down calendar, from which you may select a specific

period enddate.

5. Click the departments_owned tab (Figure 2.56) to

specify the departments (that you own) for which you

want to generate the report. Click on the Value drop-

down menu to display the fields that contain your activity

description. Select the desired field and click Add to add

the field to the selection box. To delete a selection, select

a field in the lower box and click Delete.

Figure 2.56
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Objective 2o: Set parameter values for the Timesheet Status report (continued from page 39)

6. Click the Missing Timesheet Hours Threshold tab (Figure

2.57). Select or enter the threshold below which a

timesheet is considered “missing.”

The default value = 1. This means that any

timesheet with fewer than one hour is

considered as “missing.” However, you may alter

this hours value.

Figure 2.57

7. Click OK to preview the selected report with the

specified settings.

Figure 2.58 displays the TimeWizard.enterprise

parameter setup frame for the report.

Figure 2.58
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Objective 2p: Set parameter values for the Billing report (continued on page 42)

Figure 2.59 Figure 2.60

To set up a Billing report, follow these steps:

1. Click the Run Reports toolbar icon          or select Tools >

Reports > Run Reports from the main menu to open the

Run Reports dialog box.

2. In the Run Reports dialog box, select a report category

and report.

3. Click “Preview” to open the Enter Parameter Values

window for the selected report.

4. Click the Customer tab (Figure 2.59). Click on the Value

drop-down menu to display the field that contains your

customer name.

Contact your company’s TimeWizard Administra-

tor for exact field descriptions.

• act_ukey = key activity codes

• act_unonk = non-key activity codes

5. Click the Resource Category tab (Figure 2.60). Click on

the Value drop-down menu and select “R” to group by

Resource or “E” to group by Employee Specific.

6. Click the Rate tab (Figure 2.61). Click on the Value drop-

down menu to display the field that contains your desired

rate.

Figure 2.61
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Objective 2p: Set parameter values for the Billing report (continued from page 41 and continued
on page 43)

7. Click the Project tab (Figure 2.62). Click on the Value

drop-down menu to display the field that contains your

Project name.

Figure 2.62

8. Click the From tab (Figure 2.63). TimeWizard displays a

drop-down calendar, from which you may select a

specific period starting date. Specify the starting date

from which you want to generate the report.

Figure 2.63
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Objective 2p: Set parameter values for the Billing report (continued from page 42)

Figure 2.64 Figure 2.65

9. Click the To tab (Figure 2.64). TimeWizard displays a

drop-down calendar, from which you may select a

specific period ending date. Specify the ending date from

which you want to generate ther report.

10. Click OK to preview the selected report with the

specified settings.

Figure 2.65 displays the TimeWizard.enterprise

parameter setup frame for the report.
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Objective 2q: Set parameter values for the Resource Code Associations report

1. Click the Run Reports toolbar icon          or select Tools >

Reports > Run Reports from the main menu to open the

Run Reports dialog box.

2. In the Run Reports dialog box, select a report category

and report.

3. Click “Preview” to open the Enter Parameter Values

window for the selected report .

4. Click the departments_owned tab (Figure 2.66) to

specify the departments (that you own) for which you

Figure 2.66

want to generate the report. Click on the Value drop-

down menu to display the fields that contain the

departments owned. Select the desired field and click

Add to add the field to the selection box. To delete a

selection, select a field in the lower box and click Delete.

5. Click OK to preview the selected report with the

specified settings.

Figure 2.67 displays the TimeWizard.enterprise

parameter setup frame for the report.

Figure 2.67

To set up a Timesheet Status report, follow these steps:
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Objective 2r: Set parameter values for the Timesheet Audit report

Figure 2.68 Figure 2.69

To set up a Timesheet Audit report, follow these steps:

1. Click the Run Reports toolbar icon         or select Tools >

Reports > Run Reports from the main menu to open the

Run Reports dialog box.

2. In the Run Reports dialog box, select a report category

and report.

3. Click “Preview” to open the Enter Parameter Values

window for the selected report .

4. Click the period_enddate tab (Figure 2.68). Specify

whether or not you want to select the period enddate

from a default list. If the box is checked, TimeWizard

displays a drop-down menu of available period enddates.

If the box is not checked, TimeWizard displays a drop-

down calendar, from which you may select a specific

period enddate.

5. Click the departments_owned tab (Figure 2.69) to specify

the departments (that you own) for which you want to

generate the report. Click on the Value drop-down menu

to display the fields that contain the departments owned.

Select the desired field and click Add to add the field to

the selection box. To delete a selection, select a field in the

lower box and click Delete.

6. Click OK to preview the selected report with the

specified settings.

Figure 2.70 displays the TimeWizard.enterprise

parameter setup frame for the report.

Figure 2.70
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3C H A P T E R

Exporting and Printing Reports

Once you have completed setting up the parameter values, TimeWizard enables you to

generate the report as a file for export or to print the report.

Objectives

1. Set up printing specifications

2. Export a report

3. Print a report
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Setting up printing specifications

Objective 1: Set up printing specifications

TimeWizard enables you to specify a soecific network or local printer from which you can

send reports.

TimeWizard.enterprise uses your browser settings for printing. To print a generated report,

select File > Print in your browser’s main menu.

To set up printing specifications, follow these steps:

1. Click the Run Reports toolbar icon          or select Tools > Reports > Run

Reports from the main menu to open the Run Reports dialog box.

2. Click Print Setup to open the Printer Setup dialog box.

3. Select the appropriate printer from the printer menu.

4. Click “Setup” to specify printer setup preferences. Follow the setup

instruction supplied by your printer vendor.

5. Click “OK” to save printer settings and exit the dialog box.

Figure 3.1
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Objective 2: Export a report

Once you have completed setting up the parameter values for the selected report and you

have previewed the report, TimeWizard enables you to export the report to a specified

destination in a format of your choosing. Tables 3.1 and 3.2 list the export destination and

format options available in the TimeWizard client-server application.

The export file formats available in TimeWizard.enterprise are HTML, Word, and Excel.

You select the desired file format before executing and previewing the selected report (see

Figure 3.3).

Exporting a report

To export a report, follow these steps:

1. In the report preview window, click the Export icon         to open the

Export dialog box.

2. In the Export dialog box, click the Format drop-down box to select your

format option. Table 3.2 lists the format options.

3. Click the Destination drop-down box to select your destination option.

Table 3.1 lists the destination options.

4. Click “OK” to save the settings and begin the export.

Figure 3.3 displays the TimeWizard.enterprise file format

selection options, located in the Reports frame.

Figure 3.2

Figure 3.3
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Printing a report

To print a report, follow these steps:

1. In the report preview window, click the Print icon          to

open the Print dialog box.

2. In the Print dialog box, specify the print range and number of

copies desired.

3. Click “OK” to save the settings and print the report.

Figure 3.4

Table 3.1: Export Format Options

TimeWizard.enterprise uses your browser settings for printing. To print a generated report,

select File > Print in your browser’s main menu.

Summary

In this chapter, you have learned how to set up printer specifications, export a report in a file

format of your choosing, and print a report.

Table 3.2: Export Destination Options

Objective 3: Print a report

Once you have completed setting up the parameter values for the selected report, TimeWizard

enables you to print the report to a pre-specified printer destination. You may print the

report immediately after the parameter value setup, or you may print the report from the

report preview window.
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Pre-installed Reports Reference

This Appendix offers a reference for each pre-installed TimeWizard report. Each reference

includes a report name and description, categories to which the report belongs, and a

standard report table that includes technical data. The following page displays a TimeWizard

(client-server) example of the referenced report. Table A.1 explains the information pre-

sented in each standard report table (i.e., report file name, parameters used, and query).

Table A.2 explains the indicators used within the subsequent reference tables.

Table A.1: Reports Reference Table

ataDelbaTtropeR noitanalpxE

emaNeliFtropeR LQStfosorciMrof"LQS"roelcarOrof"arO"rehtiesedulcnieliftroperehtfoemanehT
."tpr."syawlasinoisnetxeelifehT.revreS

desUsretemaraP .emitnurtaatadtroperretlifotdesuerasretemarapehT

yreuQ sierutcurtsyreuqehT.tnemetatsLQSehtfonmulocdnaelbatehtyfitnedisnoitacificepsyreuQehT
:swollofsa

"NMULOC"."ELBAT":tceleS
"NMULOC"."ELBAT":morF

"NMULOC"."ELBAT"="NMULOC"."ELBAT":erehW
"NMULOC"."ELBAT"="NMULOC"."ELBAT":dnA

Table A.2: Table Indicator Key

rotacidnI epytataDELCARO epytataDLQSSM

* )001(2RAHCRAV )001(rahcrav

** )552(2RAHCRAV )552(rahcrav

*** REBMUN tni

REBMUN tnillams

rotacidnI epytataDELCARO epytataDLQSSM

REBMUN taolf

REBMUN )0,41(lamiced

**** ETAD emitetad

***** RAHCRAVGNOL txet



TimeWizard

Appendix A • Pre-Installed Reports Reference52

Report Name: Employee Profile

Report Categories: Administrator, Department Owner

Description: This report will return a list of employees based on the departments owned by

the user. If the user does not own any departments it will return the user’s employee record.

It includes all of the user defined fields from the security_profile table. It also will display the

departments owned by each employee and the associated permissions for those depart-

ments.

emaNeliFtropeR tpr.)LQSroarO(tsiLpmE

desUsretemaraP ,2knonu_ces,1knonu_ces,dipme,denwo_stnemtraped,gnipuorGtropeR
,8knonu_ces,7knonu_ces,6knonu_ces,5knonu_ces,4knonu_ces,3knonu_ces

01knonu_ces,9knonu_ces

)tceles(yreuQ ,"DI_PME"."ELIFORP_YTIRUCES"
,"DINIGOL"."ELIFORP_YTIRUCES","RESU_DI_PME"."ELIFORP_YTIRUCES"

,"SUTATS"."ELIFORP_YTIRUCES"
,"EMANLLUF"."ELIFORP_YTIRUCES"

,"EDOC_TPED"."ELIFORP_YTIRUCES"
,"TSEWOL_TPED"."ELIFORP_YTIRUCES"

,"EDOC_PME"."ELIFORP_YTIRUCES"
,"EDOC_YRALAS"."ELIFORP_YTIRUCES"

,"1KNONU_CES"."ELIFORP_YTIRUCES"
,"2KNONU_CES"."ELIFORP_YTIRUCES"
,"3KNONU_CES"."ELIFORP_YTIRUCES"
,"4KNONU_CES"."ELIFORP_YTIRUCES"
,"5KNONU_CES"."ELIFORP_YTIRUCES"
,"6KNONU_CES"."ELIFORP_YTIRUCES"
,"7KNONU_CES"."ELIFORP_YTIRUCES"
,"8KNONU_CES"."ELIFORP_YTIRUCES"
,"9KNONU_CES"."ELIFORP_YTIRUCES"

,"01KNONU_CES"."ELIFORP_YTIRUCES"
,"NIGOL_LIAME"."ELIFORP_YTIRUCES"

,"NIMDA_SI"."ELIFORP_YTIRUCES"
,"DENWO_TPED"."ELIFORP_TPED"

,"DI_PME"."ELIFORP_TPED"
,"HSMITNF"."ELIFORP_TPED"

,"TPEDNF"."ELIFORP_TPED"
,"SSECCAHSMIT"."ELIFORP_TPED"

,"REVORPPA_YRAMIRP"."ELIFORP_TPED"
,"EVORPPA_PUORG"."ELIFORP_TPED"

"EMANLLUF"."1ELIFORP_YTIRUCES"

)morf(yreuQ ,"ELIFORP_YTIRUCES""ELIFORP_YTIRUCES"
,"ELIFORP_TPED""ELIFORP_TPED"

"1ELIFORP_YTIRUCES""ELIFORP_YTIRUCES"

)erehW(yreuQ )+("DI_PME"."ELIFORP_TPED"="DI_PME"."ELIFORP_YTIRUCES"

)dnA(yreuQ )+("DI_PME"."1ELIFORP_YTIRUCES"="REGANAM"."ELIFORP_YTIRUCES"
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Report Name: Activity Summary

Report Categories: Administrator, Activity Owner, Financial

Description: This report will return a list of every activity in the database with a planned

start date within the range the user specifies in the period_enddates field. It will also total the

actual hours and the ETC hours from the transactions table.  It will also find the earliest

resource actual start date (Actual Start) and the latest actual finish date (Actual Finish) from

the assignments table.

emaNeliFtropeR tpr.)LQSroarO(muStcA

desUsretemaraP 4yeku_tca,3yeku_tca,2yeku_tca,1yeku_tca,setaddne_doirep,noitpircseDytivitcA

)tceles(yreuQ ,"1YEKU_TCA"."SEITIVITCA"
,"2YEKU_TCA"."SEITIVITCA"
,"3YEKU_TCA"."SEITIVITCA"
,"4YEKU_TCA"."SEITIVITCA"

,"TRATS_DENNALP"."SEITIVITCA"
,"HSINIF_DENNALP"."SEITIVITCA"

","YTIROIRP"."SEITIVITCA"
,"NOITPIRCSED"."SEITIVITCA

,"DI_YTIVITCA"."STNEMNGISSA"
,"DI_PME"."STNEMNGISSA"

,"SA_SER"."STNEMNGISSA"
,"FA_SER"."STNEMNGISSA"

,"SRH_CTE"."STNEMNGISSA"
,"SUTATS_CER"."STNEMNGISSA"

,"SRH_NALP"."STNEMNGISSA"
,"DI_PME"."SNOITCASNART"

,"DI_YTIVITCA"."SNOITCASNART"
,"EPYT_SNART"."SNOITCASNART"

"SRUOH_SNART"."SNOITCASNART"

)morf(yreuQ ,"SEITIVITCA""SEITIVITCA"
,"STNEMNGISSA""STNEMNGISSA"

"SNOITCASNART""SNOITCASNART"

)erehW(yreuQ "DI_YTIVITCA"."STNEMNGISSA"="DI_YTIVITCA"."SEITIVITCA"

)dnA(yreuQ DNA"DI_YTIVITCA"."SNOITCASNART"="DI_YTIVITCA"."STNEMNGISSA"
"DI_PME"."SNOITCASNART"="DI_PME"."STNEMNGISSA"
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Report Name: Timesheet Summary

Report Categories: Administrator, Department Owner, Financial

Description: This report displays all assignments and associated transactions on the timesheet

for the selected period_enddate.

This report will ONLY return rows for employees who have entered time in the selected

period.

emaNeliFtropeR tpr.)LQSroarO(thSmiT

desUsretemaraP ,dipme,denwo_stnemtraped,noitpircseDytivitcA,gnipuorGtropeR
4yeku_tca,3yeku_tca,2yeku_tca,1yeku_tca,setaddne_doirep

)tceles(yreuQ ,"EMANLLUF"."ELIFORP_YTIRUCES"
,"EDOC_TPED"."ELIFORP_YTIRUCES"

,"ETAD_SNART"."SNOITCASNART"
,"EPYT_SNART"."SNOITCASNART"

,"GNIDNE_DOIREP"."SNOITCASNART"
,"SRUOH_SNART"."SNOITCASNART"

,"1YEKU_TCA"."SEITIVITCA"
,"2YEKU_TCA"."SEITIVITCA"
,"3YEKU_TCA"."SEITIVITCA"

"4YEKU_TCA"."SEITIVITCA"

)morf(yreuQ ,"ELIFORP_YTIRUCES""ELIFORP_YTIRUCES"
,"SNOITCASNART""SNOITCASNART"

"SEITIVITCA""SEITIVITCA"

)erehW(yreuQ "DI_PME"."SNOITCASNART"="DI_PME"."ELIFORP_YTIRUCES"

)dnA(yreuQ "DI_YTIVITCA"."SEITIVITCA"="DI_YTIVITCA"."SNOITCASNART"
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Report Name: Resource Assignments

Report Caregories: Department Owner, Activity Owner

Description: This report contains two reports in one. Both versions let the user choose the

fields that comprise the activity description. The description can consist of one or more of

the activity key fields and is selected by setting the Activity Description parameter. Both

versions let the user select whether to display Open, Closed, or All assignments by changing

the value of the Assignment Status parameter to “O,” “C” or “A” respectively. The default

value of Assignment Status is “O.”

The value of the Report Type parameter is used to determine whether the report is of an

activity owner or a department owner.

emaNeliFtropeR tpr.)LQSroarO(nsAseR

desUsretemaraP ,dipme,denwo_stnemtraped,noitpircseDytivitcA,sutatStnemngissA,epyTtropeR
4yeku_tca,3yeku_tca,2yeku_tca,1yeku_tca

)tceles(yreuQ ,"SA_SER"."STNEMNGISSA"
,"FA_SER"."STNEMNGISSA"

,"SRH_CTE"."STNEMNGISSA"
,"SUTATS_CER"."STNEMNGISSA"

,"SRH_NALP"."STNEMNGISSA"
,"EDOC_TPED"."ELIFORP_YTIRUCES","EMANLLUF"."ELIFORP_YTIRUCES"

,"EPYT_SNART"."SNOITCASNART"
,"SRUOH_SNART"."SNOITCASNART"

,"1YEKU_TCA"."SEITIVITCA"
,"2YEKU_TCA"."SEITIVITCA"
,"3YEKU_TCA"."SEITIVITCA"
,"4YEKU_TCA"."SEITIVITCA"

,"NOITPIRCSED"."SEITIVITCA"
,"DI_REVORPPA"."RENWO_YTIVITCA"

"EMANLLUF"."1ELIFORP_YTIRUCES"

)morf(yreuQ ,"STNEMNGISSA""STNEMNGISSA"
,"ELIFORP_YTIRUCES""ELIFORP_YTIRUCES"

,"SNOITCASNART""SNOITCASNART"
,"SEITIVITCA""SEITIVITCA"

,"RENWO_YTIVITCA""RENWO_YTIVITCA"
"1ELIFORP_YTIRUCES""ELIFORP_YTIRUCES"

)erehW(yreuQ DNA"DI_PME"."ELIFORP_YTIRUCES"="DI_PME"."STNEMNGISSA"
DNA"DI_PME"."SNOITCASNART"="DI_PME"."STNEMNGISSA"

"DI_YTIVITCA"."SNOITCASNART"="DI_YTIVITCA"."STNEMNGISSA"

)dnA(yreuQ DNA)+("DI_YTIVITCA"."RENWO_YTIVITCA"="DI_YTIVITCA"."STNEMNGISSA"
)+("DI_PME"."1ELIFORP_YTIRUCES"="DI_REVORPPA"."RENWO_YTIVITCA"
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The report will display the following information for every assignment: Planned Hours,

Actual Hours, ETC (Estimated Time to Complete), Start (Resource Actual Start from the

assignment), Finish (Resource Actual Finish from the assignment), Status (whether the

assignment is Open or Closed)

If Report Type is “P” (Default), the report will be an activity owner report. The report will

display all of the activities owned by the user running the report (the value of the empid

parameter), and all of the assignments for each activity. The departments owned field is

ignored.

If Report Type is “D,” the report will be a department owner report. The report will display

all of the employees by department (for the departments selected using the departments_owned

parameter). The user can select more than one department. The report will also display all of

the assignments (based on the Assignment Status parameter) for each employee.
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Report Name: Expense Report

Report Categories: Department Owner, Financial

Description: This report displays a standard expense report for users who have entered

expense amounts into the Special Amount field associated with a detail code.

The user can select which combination of the four activity keys best describes the activity

and which detail code contains the Expense Categories. Department owners can select

which departments to include in the report. Otherwise the report will return the records for

the current user.

emaNeliFtropeR tpr.)LQSroarO(pxE

desUsretemaraP ,denwo_stnemtraped,setaddne_doirep,dipme,edoCesnepxE,noitpircseDytivitcA
,2yeku_snart,1yeku_snart,4yeku_tca,3yeku_tca,2yeku_tca,1yeku_tca

,8yeku_snart,7yeku_snart,6yeku_snart,5yeku_snart,4yeku_snart,3yeku_snart
01yeku_snart,9yeku_snart

)tceles(yreuQ ,"DI_PME"."ELIFORP_YTIRUCES"
,"RESU_DI_PME"."ELIFORP_YTIRUCES"

,"EMANLLUF"."ELIFORP_YTIRUCES"
,"EDOC_TPED"."ELIFORP_YTIRUCES"

,"EDOC_PME"."ELIFORP_YTIRUCES"
,"ETAD_SNART"."SNOITCASNART"
,"EPYT_SNART"."SNOITCASNART"

,"GNIDNE_DOIREP"."SNOITCASNART"
,"TMA_LAICEPS"."SNOITCASNART"
,"1YEKU_SNART"."SNOITCASNART"
,"2YEKU_SNART"."SNOITCASNART"
,"3YEKU_SNART"."SNOITCASNART"
,"4YEKU_SNART"."SNOITCASNART"
,"5YEKU_SNART"."SNOITCASNART"
,"6YEKU_SNART"."SNOITCASNART"
,"7YEKU_SNART"."SNOITCASNART"
,"8YEKU_SNART"."SNOITCASNART"
,"9YEKU_SNART"."SNOITCASNART"

,"01YEKU_SNART"."SNOITCASNART"
,"1YEKU_TCA"."SEITIVITCA"
,"2YEKU_TCA"."SEITIVITCA"
,"3YEKU_TCA"."SEITIVITCA"

"4YEKU_TCA"."SEITIVITCA"

)morf(yreuQ ,"ELIFORP_YTIRUCES""ELIFORP_YTIRUCES"
,"SNOITCASNART""SNOITCASNART"

"SEITIVITCA""SEITIVITCA"

)erehW(yreuQ "DI_PME"."SNOITCASNART"="DI_PME"."ELIFORP_YTIRUCES"

)dnA(yreuQ "DI_YTIVITCA"."SEITIVITCA"="DI_YTIVITCA"."SNOITCASNART"
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Report Name: Pie Chart

Report Categories: Department Owner = DO = Pie Chart for Department Owners

Activity Owner = PM = Pie Chart for Activity Owner

Financial = Both

Description: This report returns a pie graph for each department selected by the

departments_owned parameter. The graph represents different activities for which time was

charged during the period selected. The right-hand side of the report displays a list of the

activities, the percentage of the total time charged to that activity, and the total hours

charged to that activity. The top line will display the department and the total hours for the

period for that department.

emaNeliFtropeR tpr.)LQSroarO(thCeiP

desUsretemaraP ,denwo_stnemtraped,setaddne_doirep,noitpircseDytivitcA,gnipuorGtropeR
4yeku_tca,3yeku_tca,2yeku_tca,1yeku_tca,dipme

)tceles(yreuQ ,"EDOC_TPED"."ELIFORP_YTIRUCES"
,"EPYT_SNART"."SNOITCASNART"

,"GNIDNE_DOIREP"."SNOITCASNART"
,"SRUOH_SNART"."SNOITCASNART"

,"1YEKU_TCA"."SEITIVITCA"
,"2YEKU_TCA"."SEITIVITCA"
,"3YEKU_TCA"."SEITIVITCA"

"4YEKU_TCA"."SEITIVITCA"

)morf(yreuQ ","ELIFORP_YTIRUCES""ELIFORP_YTIRUCES"
,"SNOITCASNART""SNOITCASNART"

"SEITIVITCA""SEITIVITCA"

)erehW(yreuQ "DI_PME"."SNOITCASNART"="DI_PME"."ELIFORP_YTIRUCES"

)dnA(yreuQ "DI_YTIVITCA"."SEITIVITCA"="DI_YTIVITCA"."SNOITCASNART"
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Report Name: Resource Utilization Bar Chart

Report Categories: Department Owner = DO = Bar Chart for Department Owners

Activity Owner = PM = Bar Chart for Activity Owners

Financial = Both

Description: Both the department owner and the activity owner use a similar report. The

formula "Report Type" determines whether the report will display a department owner

report or an activity owner report.

The department owner report shows a stacked bar for each employee with each element of

the stack indicating a different project. When this report is run by a department owner, it

will display each department’s data on a separate page.

emaNeliFtropeR tpr.)LQSroarO(thCraB

desUsretemaraP ,denwo_stnemtraped,dipme,setaddne_doirep,noitpircseDytivitcA,epyTtropeR
4yeku_tca,3yeku_tca,2yeku_tca,1yeku_tca

)tceles(yreuQ ,"EMANLLUF"."ELIFORP_YTIRUCES"
,"EDOC_TPED"."ELIFORP_YTIRUCES"

,"EPYT_SNART"."SNOITCASNART"
,"GNIDNE_DOIREP"."SNOITCASNART"

,"SRUOH_SNART"."SNOITCASNART"
,"TMA_LAICEPS"."SNOITCASNART"

,"DI_YTIVITCA"."SEITIVITCA"
,"1YEKU_TCA"."SEITIVITCA"
,"2YEKU_TCA"."SEITIVITCA"
,"3YEKU_TCA"."SEITIVITCA"
,"4YEKU_TCA"."SEITIVITCA"

,"DI_REVORPPA"."RENWO_YTIVITCA"
"EMANLLUF"."1ELIFORP_YTIRUCES"

)morf(yreuQ ","ELIFORP_YTIRUCES""ELIFORP_YTIRUCES"
,"SNOITCASNART""SNOITCASNART"

,"SEITIVITCA""SEITIVITCA"
,"RENWO_YTIVITCA""RENWO_YTIVITCA"

"1ELIFORP_YTIRUCES""ELIFORP_YTIRUCES"

)erehW(yreuQ "DI_PME"."SNOITCASNART"="DI_PME"."ELIFORP_YTIRUCES"

)dnA(yreuQ "DI_YTIVITCA"."SEITIVITCA"="DI_YTIVITCA"."SNOITCASNART"

)dnA(yreuQ DNA)+("DI_YTIVITCA"."RENWO_YTIVITCA"="DI_YTIVITCA"."SEITIVITCA"
)+("DI_PME"."1ELIFORP_YTIRUCES"="DI_REVORPPA"."RENWO_YTIVITCA"
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The activity owner report will show a stacked bar for each project, with each element of the

stack indicating a different department.
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Report Name: Timesheet Report

Report Categories: Department Owner, Timesheet User

Description: This report displays the assignments with associated transactions on the

timesheet for the selected period_enddate.

The timesheet for the current user is displayed unless the TimesheetDOXXX report is

run.  A department owner can print the timesheets of the employees in his or her depart-

ment.

emaNeliFtropeR tpr.)LQSroarO(teehsemiT

desUsretemaraP 4yeku_tca,3yeku_tca,2yeku_tca,1yeku_tca,setaddne_doirep,dipmE

)tceles(yreuQ ,"DI_PME"."ELIFORP_YTIRUCES"
,"RESU_DI_PME"."ELIFORP_YTIRUCES"

,"EMANLLUF"."ELIFORP_YTIRUCES"
,"EDOC_TPED"."ELIFORP_YTIRUCES"

,"EDOC_PME"."ELIFORP_YTIRUCES"
,"ETAD_SNART"."SNOITCASNART"
,"EPYT_SNART"."SNOITCASNART"

,"GNIDNE_DOIREP"."SNOITCASNART"
,"SRUOH_SNART"."SNOITCASNART"

,"1YEKU_SNART"."SNOITCASNART"
,"1YEKU_TCA"."SEITIVITCA"
,"2YEKU_TCA"."SEITIVITCA"
,"3YEKU_TCA"."SEITIVITCA"
,"4YEKU_TCA"."SEITIVITCA"

"NOITPIRCSED"."SEITIVITCA"

)morf(yreuQ ,"ELIFORP_YTIRUCES""ELIFORP_YTIRUCES"
,"SNOITCASNART""SNOITCASNART"

"SEITIVITCA""SEITIVITCA"

)erehW(yreuQ "DI_PME"."SNOITCASNART"="DI_PME"."ELIFORP_YTIRUCES"

)dnA(yreuQ "DI_YTIVITCA"."SEITIVITCA"="DI_YTIVITCA"."SNOITCASNART"

)dnA(yreuQ .1="EPYT_SNART"."SNOITCASNART"



TimeWizard

67Appendix A • Pre-Installed Reports Reference



TimeWizard

Appendix A • Pre-Installed Reports Reference68

Report Name: Missing Timesheet

Report Categories: TimeWizard Administrator, Department Owner

Description: This report displays timesheets that are ""missing"" (where ""missing"" is a

user-defined threshold, e.g., 1 hour). If this report is grouped by department, it will return

records for all associated employees for the selected period_enddate. If this report is run by

an employee who does not own departments, it will return the record for that user for the

selected period_enddate.

The script to create the view is as follows:

ORACLE: create or replace view TW_V_TRNSTOT as select PERIOD_ENDING,

EMP_ID, SUM(TRANS_HOURS) TRANSTOTAL from TRANSACTIONS where

TRANS_TYPE = 1 group by PERIOD_ENDING, EMP_ID

SQL SERVER: create view TW_V_TRNSTOT as select PERIOD_ENDING, EMP_ID,

SUM(TRANS_HOURS) TRANSTOTAL from TRANSACTIONS where TRANS_TYPE

= 1 group by PERIOD_ENDING, EMP_ID

The user has the option of adjusting the “missing timesheet” threshold. All records which

have a transactions hours summary of the selected period LESS THAN the Missing Timesheet

Hours Threshold parameter will display “Missing Timesheet”  in the Timesheet Status field.

If the user is displaying the Missing Timesheet report, only those records will be displayed.

emaNeliFtropeR tpr.)LQSroarO(miTsiM

desUsretemaraP sruoH,teehsemiTgnissiM,denwo_stnemtraped,setaddne_doirep,epyTtropeR
dipme,dlohserhT

)tceles(yreuQ ,"DI_PME"."TEEHSEMIT","GNIDNE_DOIREP"."TEEHSEMIT"
,"STNEMMOC_ST"."TEEHSEMIT","ETATS_LAVORPPA"."TEEHSEMIT"

,"EDOC_TPED"."ELIFORP_YTIRUCES","EMANLLUF"."ELIFORP_YTIRUCES"
"LATOTSNART"."TOTSNRT_V_WT"

)morf(yreuQ ","TEEHSEMIT""TEEHSEMIT"
"ELIFORP_YTIRUCES"
,"ELIFORP_YTIRUCES"

"TOTSNRT_V_WT""TOTSNRT_V_WT"

)erehW(yreuQ DNA"DI_PME"."ELIFORP_YTIRUCES"="DI_PME"."TEEHSEMIT"
)+("GNIDNE_DOIREP"."TOTSNRT_V_WT"="GNIDNE_DOIREP"."TEEHSEMIT"

)dnA(yreuQ )+("DI_PME"."TOTSNRT_V_WT"="DI_PME"."TEEHSEMIT"
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Report Name: Missing Approvals

Report Categories: TimeWizard Administrator, Department Owner

Description: This report displays timesheets that have not completed the approval process.

If this report is grouped by department, it will return records for all associated employees for

the selected period_enddate. If this report is run by an employee who is not a department

owner, it will return the record for that user for the selected period_enddate.

emaNeliFtropeR tpr.)LQSroarO(ppAsiM

desUsretemaraP dipme,dlohserhTsruoHteehsemiTgnissiM,denwo_stnemtraped,setaddne_doirep

)tceles(yreuQ ,"DI_PME"."TEEHSEMIT","GNIDNE_DOIREP"."TEEHSEMIT"
,"STNEMMOC_ST"."TEEHSEMIT","ETATS_LAVORPPA"."TEEHSEMIT"

,"EDOC_TPED"."ELIFORP_YTIRUCES","EMANLLUF"."ELIFORP_YTIRUCES"
"LATOTSNART"."TOTSNRT_V_WT"

)morf(yreuQ ,"TEEHSEMITTEEHSEMIT"
,"ELIFORP_YTIRUCES""ELIFORP_YTIRUCES"

"TOTSNRT_V_WT""TOTSNRT_V_WT"

)erehW(yreuQ DNA"DI_PME"."ELIFORP_YTIRUCES"="DI_PME"."TEEHSEMIT"
"GNIDNE_DOIREP"."TOTSNRT_V_WT"=*"GNIDNE_DOIREP"."TEEHSEMIT"

"DI_PME"."TOTSNRT_V_WT"=*"DI_PME"."TEEHSEMIT"DNA
"MA00:00:00999182tcO"=>"GNIDNE_DOIREP"."TEEHSEMIT"DNA

"MA00:00:00999192tcO<"GNIDNE_DOIREP"."TEEHSEMIT"DNA
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Report Name: Timesheet Status

Report Categories: TimeWizard Administrator, Department Owner

Description: This report displays the timesheet approval status (i.e., Not Submitted, Ap-

proved, Rejected, or Unapproved) for a list of employees grouped by department for the

selected period_enddate. If this report is run by an employee who is not a department

owner, then the report displays the timesheet approval status for that user for the selected

period_enddate.

emaNeliFtropeR tpr.)LQSroarO(atSmiT

desUsretemaraP sruoHteehsemiTgnissiM,denwo_stnemtraped,setaddne_doirep,epyTtropeR
dipme,dlohserhT

)tceles(yreuQ ,"GNIDNE_DOIREP"."TEEHSEMIT"
,"DI_PME"."TEEHSEMIT"

,"ETATS_LAVORPPA"."TEEHSEMIT"
,"STNEMMOC_ST"."TEEHSEMIT"

,"EMANLLUF"."ELIFORP_YTIRUCES"
,"EDOC_TPED"."ELIFORP_YTIRUCES"

"LATOTSNART"."TOTSNRT_V_WT"

)morf(yreuQ ,"TEEHSEMITTEEHSEMIT"
,"ELIFORP_YTIRUCES""ELIFORP_YTIRUCES"

"TOTSNRT_V_WT""TOTSNRT_V_WT"

)erehW(yreuQ DNA"DI_PME"."ELIFORP_YTIRUCES"="DI_PME"."TEEHSEMIT"
"GNIDNE_DOIREP"."TOTSNRT_V_WT"=*"GNIDNE_DOIREP"."TEEHSEMIT"

"DI_PME"."TOTSNRT_V_WT"=*"DI_PME"."TEEHSEMIT"DNA
"MA00:00:00999182tcO"=>"GNIDNE_DOIREP"."TEEHSEMIT"DNA

"MA00:00:00999192tcO<"GNIDNE_DOIREP"."TEEHSEMIT"DNA
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Report Name: Billing Report

Report Categories: Financial

Description: This report allows the user to specify which activity fields are the Customer

field and Project field. The user also specifies whether to group the summary by Employee

or by Resource code. The user can specify the date range for the report. The dollar amounts

are calculated from the hourly rate (Rate 1 or Rate 2) + special amount for each transaction,

then summed.

emaNeliFtropeR tpr.)LQSroarO(muSliB

desUsretemaraP ,2yeku_tca,1yeku_tca,tcejorP,setaddne_doirep,etaR,yrogetaCecruoseR,remotsuC
,4knonu_tca,3knonu_tca,2knonu_tca,1knonu_tca,4yeku_tca,3yeku_tca

01knonu_tca,9knonu_tca,8knonu_tca,7knonu_tca,6knonu_tca,5knonu_tca

)tceles(yreuQ ,"ETAD_SNART"."SNOITCASNART"
,"EPYT_SNART"."SNOITCASNART"

,"GNIDNE_DOIREP"."SNOITCASNART"
,"SRUOH_SNART"."SNOITCASNART"

,"TMA_LAICEPS"."SNOITCASNART"
,"1ETAR"."SNOITCASNART"

,"2ETAR"."SNOITCASNART"
,"EMANLLUF"."ELIFORP_YTIRUCES"

,"EMAN"."ECRUOSERWT"
,"1YEKU_TCA"."SEITIVITCA"
,"2YEKU_TCA"."SEITIVITCA"
,"3YEKU_TCA"."SEITIVITCA"
,"4YEKU_TCA"."SEITIVITCA"

,"1KNONU_TCA"."SEITIVITCA"
,"2KNONU_TCA"."SEITIVITCA"
,"3KNONU_TCA"."SEITIVITCA"
,"4KNONU_TCA"."SEITIVITCA"
,"5KNONU_TCA"."SEITIVITCA"
,"6KNONU_TCA"."SEITIVITCA"
,"7KNONU_TCA"."SEITIVITCA"
,"8KNONU_TCA"."SEITIVITCA"
,"9KNONU_TCA"."SEITIVITCA"

,"01KNONU_TCA"."SEITIVITCA"
"NOITPIRCSED"."SEITIVITCA"

)morf(yreuQ ,"SNOITCASNART""SNOITCASNART"
,"ELIFORP_YTIRUCES""ELIFORP_YTIRUCES"

,"ECRUOSERWT""ECRUOSERWT"
"SEITIVITCA""SEITIVITCA"

)erehW(yreuQ "DI_PME"."ELIFORP_YTIRUCES"="DI_PME"."SNOITCASNART"

)dnA(yreuQ ="DI_ECRUOSER"."SNOITCASNART"

)dnA(yreuQ "DI_YTIVITCA"."SEITIVITCA"="DI_YTIVITCA"."SNOITCASNART"
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Report Name: Resource Code Associations

Report Categories: TimeWizard Administrator, Department Owner

Description: This report lists all employees associated with specific resource codes, grouped by department.

Report File Name ResAsnDO(SQL or ORA).rpt

Query(select) assignments.res_as, assignments.res_af,
assignments.etc_hrs,
assignments.rec_status,
assignments.plan_hrs,
    security_profile.fullname,
security_profile.dept_lowest,
    transactions.trans_type,
transactions.correct_status,
transactions.trans_hours,
    activities.act_ukey1,
activities.act_ukey2,
activities.act_ukey3,
activities.act_ukey4,
activities.description

Parameters Used Assignment status, activity description, departments_owned
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Query (from)     ((((assignments as assignments INNER
JOIN security_profile as security_profile ON
assignments.emp_id =
security_profile.emp_id) INNER JOIN
transactions as transactions ON
(assignments.activity_id =
transactions.activity_id) AND
(assignments.emp_id = transactions.emp_id)
AND (assignments.resource_id =
transactions.resource_id)) INNER JOIN
activities as activities ON
assignments.activity_id =
activities.activity_id) LEFT JOIN
activity_owner as activity_owner ON
assignments.activity_id =
activity_owner.activity_id) LEFT JOIN
security_profile AS security_profile1 ON
activity_owner.approver_id =
security_profile1.emp_id

Query (Where) assignments.emp_id =
security_profile.emp_id

Query (And) assignments.emp_id = transactions.emp_id
AND
    assignments.resource_id =
transactions.resource_id AND
    assignments.activity_id =
transactions.activity_id AND
    assignments.activity_id =
activities.activity_id



TimeWizard

Appendix A • Pre-Installed Reports Reference78



TimeWizard

79Appendix A • Pre-Installed Reports Reference

Report File Name

Parameters Used

Query (select)

Query (from)

Query (Where)

Query (And)

Report Name: Timesheet Audit Report

Report Categories: TimeWizard Administrator

Description: This report displays all time entries and edits made to an employee’s timesheet

within a selected period. This will allow an administrator to monitor all entries and edits

made to an employee’s timesheet.

Audit (SQL or ORA).rpt

period_enddate, departments_owned

security_profile.emp_id_user,
security_profile.fullname, security_profile.dept_code,
security_profile.dept_lowest,
security_profile.emp_code,
security_profile.salary_code,
    transactions.trans_date, transactions.period_ending,
transactions.correct_status, transactions.trans_hours,
transactions.last_update, transactions.logid_update,
transactions.trans_ukey1, transactions.trans_ukey2,
transactions.trans_ukey3, transactions.trans_ukey4,
transactions.trans_ukey5, transactions.trans_ukey6,
transactions.trans_ukey7, transactions.trans_ukey8,
transactions.trans_ukey9, transactions.trans_ukey10,
    activities.act_ukey1, activities.act_ukey2,
activities.act_ukey3, activities.act_ukey4,
activities.description,
    twresource.name

security_profile security_profile, transactions transactions,
activities activities,
twresource twresource,
periods periods

security_profile.emp_id = transactions.emp_id

transactions.activity_id = activities.activity_id AND
    transactions.resource_id = twresource.resource_id AND
    transactions.period_ending = periods.period_ending
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BA P P E N D I X

Custom Field Formula Specifications

All user-defined captions for custom fields are sent to the report automatically at runtime.

This is done by replacing the formulas in the report named for the particular field. Table B.1

lists these custom fields and identifies the default settings and field descriptions.

If you write your own custom reports for TimeWizard using Crystal Reports Professional

and wish the captions to be sent to the report at runtime rather than hard-coding the values,

then you need to create formulas using the field names specified in the following table.
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dleiF tluafeD noitpircseD

1yeku_tca >desunu< 1yeKytivitcA

2yeku_tca >desunu< 2yeKytivitcA

3yeku_tca >desunu< 3yeKytivitcA

4yeku_tca >desunu< 4yeKytivitcA

1knonu_tca >desunu< 1dleiFytivitcAyeKnoN

2knonu_tca >desunu< 2dleiFytivitcAyeKnoN

3knonu_tca >desunu< 3dleiFytivitcAyeKnoN

4knonu_tca >desunu< 4dleiFytivitcAyeKnoN

5knonu_tca >desunu< 5dleiFytivitcAyeKnoN

6knonu_tca >desunu< 6dleiFytivitcAyeKnoN

7knonu_tca >desunu< 7dleiFytivitcAyeKnoN

8knonu_tca >desunu< 8dleiFytivitcAyeKnoN

9knonu_tca >desunu< 9dleiFytivitcAyeKnoN

01knonu_tca >desunu< 01dleiFytivitcAyeKnoN

1yeku_snarT >desunu< 1edoCliateD

2yeku_snarT >desunu< 2edoCliateD

3yeku_snarT >desunu< 3edoCliateD

4yeku_snarT >desunu< 4edoCliateD

5yeku_snarT >desunu< 5edoCliateD

6yeku_snarT >desunu< 6edoCliateD

dleiF tluafeD noitpircseD

7yeku_snarT >desunu< 7edoCliateD

8yeku_snarT >desunu< 8edoCliateD

9yeku_snarT >desunu< 9edoCliateD

01yeku_snarT >desunu< 01edoCliateD

edoc_tpeD edoC.tpeD
morfdleiFedoCtnemtrapeD

eliforp_ytiruces

edoc_yralaS edoCyralaS
morfdleiFedoCyralaS

eliforp_ytiruces

edoc_pmE edoCpmE
morfdleiFedoCeeyolpmE

eliforp_ytiruces

1knonu_ceS >desunu< 1dleiFeeyolpmEyeKnoN

2knonu_ceS >desunu< 2dleiFeeyolpmEyeKnoN

3knonu_ceS >desunu< 3dleiFeeyolpmEyeKnoN

4knonu_ceS >desunu< 4dleiFeeyolpmEyeKnoN

5knonu_ceS >desunu< 5dleiFeeyolpmEyeKnoN

6knonu_ceS >desunu< 6dleiFeeyolpmEyeKnoN

7knonu_ceS >desunu< 7dleiFeeyolpmEyeKnoN

8knonu_ceS >desunu< 8dleiFeeyolpmEyeKnoN

9knonu_ceS >desunu< 9dleiFeeyolpmEyeKnoN

01knonu_ceS >desunu< 01dleiFeeyolpmEyeKnoN

Table B.1: TimeWizard Report Field Settings


